Transportation (LE-TRA)

Release 4.6C
Copyright

© Copyright 2001 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are registered trademarks of Microsoft Corporation.

IBM®, DB2®, OS/2®, DB2/6000®, Parallel Sysplex®, MVS/ESA®, RS/6000®, AIX®, S/390®, AS/400®, OS/390®, and OS/400® are registered trademarks of IBM Corporation.

ORACLE® is a registered trademark of ORACLE Corporation.

INFORMIX®-OnLine for SAP and Informix® Dynamic Server™ are registered trademarks of Informix Software Incorporated.

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

JAVA® is a registered trademark of Sun Microsystems, Inc.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, SAP Logo, R/2, R/3, ABAP, SAP ArchiveLink, SAP Business Workflow, WebFlow, SAP EarlyWatch, BAPI, SAPHIRE, Management Cockpit, mySAP.com Logo and mySAP.com are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other products mentioned are trademarks or registered trademarks of their respective companies.
## Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Caution Icon" /></td>
<td>Caution</td>
</tr>
<tr>
<td><img src="image" alt="Example Icon" /></td>
<td>Example</td>
</tr>
<tr>
<td><img src="image" alt="Note Icon" /></td>
<td>Note</td>
</tr>
<tr>
<td><img src="image" alt="Recommendation Icon" /></td>
<td>Recommendation</td>
</tr>
<tr>
<td><img src="image" alt="Syntax Icon" /></td>
<td>Syntax</td>
</tr>
<tr>
<td><img src="image" alt="Tip Icon" /></td>
<td>Tip</td>
</tr>
</tbody>
</table>
# Contents

**Transportation (LE-TRA)** .......................................................... 10

**About Transportation** ........................................................................ 12

**Transportation Planning Point** .......................................................... 13

**Procedures Valid for Entire Company Codes** ........................................... 14

**Shipment Types** .................................................................................. 15

**Shipment Outputs** ................................................................................. 25

- Information in the Shipment Document .............................................. 21
- Copying Information Relevant for Transportation ................................. 24

**Shipment document** .............................................................................. 20

**Outbound EDI messages** ........................................................................ 44

**Inbound EDI messages** .......................................................................... 47

**Report: Output for Shipments** ................................................................. 50

**Creating Output Lists** .......................................................................... 51

**Freight Codes and Freight Code Sets; Freight Classes** ................................. 52

- Determining the Freight Code .............................................................. 53
- Freight classes ....................................................................................... 55

**Transportation Processing Reports** ........................................................ 56

- Editing Shipment Lists ........................................................................... 57
- Searching for Deliveries in a Transportation List .................................... 58

**Transportation Planning** ........................................................................ 59

**Creating Shipments** ............................................................................. 63

- Creating Shipments ............................................................................... 65
- Screen Info for Delivery Selection ......................................................... 67
- Defining Selection Variants for Shipments ........................................... 71
- Creating Additional Shipment Documents ............................................ 72
- Moving Deliveries ............................................................................... 73
- Removing Deliveries from a Shipment .................................................. 75
- Creating Shipment Documents for Individual Deliveries ...................... 76
- Planning Proposal ................................................................................ 77
- Subsequent Delivery Split in Shipments ................................................. 78
- Using Collective Processing to Create Shipments ................................ 81
  - Creating Shipments with Collective Processing ................................ 83
  - Creating Transportation Chains with Collective Processing ............... 85
Reports for Transportation Planning ................................................................. 86
  Shipment Execution Monitor ........................................................................ 87
  Select Shipments: Planning ................................................................. 88
    Creating Transportation Planning Lists ........................................... 90
  Select Shipments: Utilization of Capacity ........................................... 91
    Creating Utilization Lists .................................................................. 92
  Select Shipments: Free Capacity .................................................. 93
    Creating Free Capacity Lists ........................................................... 94

Automatic Leg Determination ........................................................................ 95
  Automatic Assignment of Deliveries ................................................ 99
  Identification of Places ......................................................................... 101
  Leg Determination Categories ............................................................. 103
  Executing Automatic Leg Determination ........................................... 105
  Examples of Automatic Leg Determination ....................................... 106
    Category 1: According to the Itinerary ........................................... 107
    Category 2: Preliminary/Subsequent Leg for Point of Departure/Destination ........................................... 109
    Category 3: Preliminary and Subsequent Leg for Each Delivery ....................................................... 111
    Category 4: With Shipping Type for Preliminary Leg and Subsequent Leg ........................................... 114

Shipment Stages ..................................................................................... 115
  Creating Shipment Stages Manually ................................................ 118
  Assigning Deliveries to Stages ........................................................ 121
  Maintaining Partners for Stages ....................................................... 122
  Displaying Details About Stages .......................................................... 123
  Deleting Stages in the Shipment Document ....................................... 124
  Moving Stages in the Shipment Document ......................................... 125
  Routes and Shipment Stages ............................................................. 126

Planning Activities in the Shipment Document ......................................... 128
  Processing Shipment Documents ..................................................... 129
  Mass Shipment Changes ................................................................. 130
    Making Mass Changes to Shipments ........................................... 131
  Packing in the Shipment Document ................................................ 132
  Delivery Item Generation in the Shipment ......................................... 134
  Assigning Service Agents in the Shipment Document ....................... 136
  Maintaining Texts in the Shipment Document ................................... 137
  Maintaining Planned and Actual Deadlines in the Shipment Document ...................................................... 138
  Status in the Shipment Document .................................................... 139
    Maintaining Status in Shipment Documents ................................ 140
    Transfer of Delivery Dates to Shipments ..................................... 141
    Function Authorization for Status ................................................ 142
    Dangerous Goods Check ............................................................... 143

Completing Transportation Planning ......................................................... 144

Shipment Execution ........................................................................... 145

Activity Profiles ................................................................................... 146

Reports for Shipment Completion ............................................................ 147
  Select Shipments: Check-in ............................................................. 148
    Creating Check-in Lists ................................................................ 150
  Select Shipments: Shipment Completion ......................................... 151
    Creating Shipment Completion Lists ............................................ 153

Posting Goods Issue for Shipments ......................................................... 154
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring Shipment</td>
<td>155</td>
</tr>
<tr>
<td>Information System in Transportation</td>
<td>156</td>
</tr>
<tr>
<td>- Information System in List Form</td>
<td>157</td>
</tr>
<tr>
<td>- Graphical Information System</td>
<td>158</td>
</tr>
<tr>
<td>- Changing Network Views</td>
<td>161</td>
</tr>
<tr>
<td>- Displaying Itineraries Within a Transportation Network</td>
<td>162</td>
</tr>
<tr>
<td>- Displaying Details on Shipment Stages</td>
<td>164</td>
</tr>
<tr>
<td>- Displaying Details on Transportation Connection Points</td>
<td>166</td>
</tr>
<tr>
<td>- Displaying Deadlines for Deliveries</td>
<td>167</td>
</tr>
<tr>
<td>- Displaying a Gantt Chart for Deliveries</td>
<td>168</td>
</tr>
<tr>
<td>- Calculating Allowed Lateness of Deliveries</td>
<td>169</td>
</tr>
<tr>
<td>- Displaying Details on a Delivery</td>
<td>170</td>
</tr>
<tr>
<td>- Displaying Details on a Shipment</td>
<td>171</td>
</tr>
<tr>
<td>- Compressing Stages</td>
<td>172</td>
</tr>
<tr>
<td>- Changing the Graphical Representation</td>
<td>173</td>
</tr>
<tr>
<td>Displaying Transportation Change Documents</td>
<td>174</td>
</tr>
<tr>
<td>- Displaying Change Documents</td>
<td>175</td>
</tr>
<tr>
<td>Shipment Cost Processing</td>
<td>176</td>
</tr>
<tr>
<td>Shipment Cost Document</td>
<td>178</td>
</tr>
<tr>
<td>Shipment Costing</td>
<td>180</td>
</tr>
<tr>
<td>- Pricing Procedure Determination</td>
<td>182</td>
</tr>
<tr>
<td>- Freight Cost Estimate</td>
<td>184</td>
</tr>
<tr>
<td>- Determining the Calculation Basis</td>
<td>185</td>
</tr>
<tr>
<td>- Examples for Calculation Bases</td>
<td>189</td>
</tr>
<tr>
<td>- Consistency Check for Freight Costs</td>
<td>190</td>
</tr>
<tr>
<td>- Shipment Comparisons</td>
<td>191</td>
</tr>
<tr>
<td>- Determination of Geographical Influencing Factors</td>
<td>192</td>
</tr>
<tr>
<td>- Determining Pricing Date and Settlement Date</td>
<td>194</td>
</tr>
<tr>
<td>- Tax Determination</td>
<td>196</td>
</tr>
<tr>
<td>Scales</td>
<td>198</td>
</tr>
<tr>
<td>- Creating Scales</td>
<td>200</td>
</tr>
<tr>
<td>- Assigning Scales for Condition Types</td>
<td>202</td>
</tr>
<tr>
<td>- Creating Condition Records</td>
<td>203</td>
</tr>
<tr>
<td>- Multi-Dimensional Condition Scales</td>
<td>204</td>
</tr>
<tr>
<td>- Allocating/Loading Condition Records</td>
<td>205</td>
</tr>
<tr>
<td>- Break-Weight Calculation</td>
<td>206</td>
</tr>
<tr>
<td>- Creating Shipment Cost Documents Online</td>
<td>208</td>
</tr>
<tr>
<td>- Creating Shipment Cost Documents with Work Lists</td>
<td>210</td>
</tr>
<tr>
<td>- Processing the Shipment Cost Document</td>
<td>213</td>
</tr>
<tr>
<td>- Shipment Costs List: Calculation</td>
<td>214</td>
</tr>
<tr>
<td>- Creating Shipment Document Lists for Calculation</td>
<td>215</td>
</tr>
<tr>
<td>- Scales List</td>
<td>216</td>
</tr>
<tr>
<td>- Creating Scales Lists</td>
<td>217</td>
</tr>
<tr>
<td>Shipment Cost Settlement with Service Agent</td>
<td>218</td>
</tr>
<tr>
<td>- G/L Account Determination</td>
<td>221</td>
</tr>
<tr>
<td>- Assignments for Cost Accounting</td>
<td>222</td>
</tr>
<tr>
<td>- Purchase Order Determination</td>
<td>224</td>
</tr>
<tr>
<td>- Creation of Accruals</td>
<td>226</td>
</tr>
<tr>
<td>- Shipment Costs as Delivery Costs</td>
<td>227</td>
</tr>
<tr>
<td>- Self-billing Procedure</td>
<td>230</td>
</tr>
</tbody>
</table>
Transportation Planning in Cooperation with Forwarding Agents .....................................................346

Logical Communications Processes .......................................................................................................347
Application Transactions of the Interface ..............................................................................................351
Configuration Options...........................................................................................................................354
Technical Communication.......................................................................................................................361
IDoc Description....................................................................................................................................368

EDI_DC - IDoc Control Record.............................................................................................................371
Special Fields in the Control Segment of EDI_DC ..................................................................................373
EDI_DD - IDoc Data Record....................................................................................................................375
TPSDL01 - Plan/Change Deliveries / Remove Deliveries ...................................................................377
TPSHT01 - Create/Change/Delete Shipment ......................................................................................378
SYSTAT01 - Status Information for Transfer .........................................................................................380

IDoc Segments, Fields, and Domains .......................................................................................................381
E2EDE1x - Processes .................................................................................................................................382
E2KNVAM - Business Hours Profiles ....................................................................................................385
E2STATS - EDI Status Record ................................................................................................................387
E2TPACCC - Action Code .......................................................................................................................389

E2TPCOC - Goods Code ..........................................................................................................................391
E2TPDIH - Delivery Dimensions at Header Level ..................................................................................392
E2TPDII - Delivery Dimensions at Item Level .........................................................................................394
E2TPDIS - Dimensions of Handling Unit ..............................................................................................395
E2TPDLC - Shipment Costs at Delivery Level .......................................................................................397
E2TPDLH - Delivery Header ....................................................................................................................398
E2TPDLI - Delivery Item ..........................................................................................................................401
E2TPEQT - Means of Transport ...............................................................................................................403
E2TPFRC - Shipment Costs at Header Level ..........................................................................................404
E2TPLCT - Location Code .........................................................................................................................405
E2TPNOC - Delivery Texts .......................................................................................................................406
E2TPSHA - Transportation Activity .........................................................................................................407
E2TPSHH - Shipment Header ...................................................................................................................409
E2TPSHI - Delivery in Shipment ..............................................................................................................412
E2TPSJR - Rail Data ..............................................................................................................................413
E2TPSHT - Leg Data in Shipment ..........................................................................................................414
E2TPSHU - Handling Unit .........................................................................................................................416
E2TPSLS - Transportation Connection Points .......................................................................................417
Transportation (LE-TRA)

Purpose
Transportation is an essential element in the logistics chain. It affects both incoming and outgoing goods. Effective transportation planning and processing ensure that shipments are dispatched without delay and arrive on schedule. Transportation costs play an essential role in the calculation of the price of a product. It is important to keep these transportation costs to a minimum so that the price of a product remains competitive. Efficient transportation planning and processing helps to keep these costs down.

Integration
As illustrated in the following graphic, you can use the SAP transportation functions to plan and process:

- Incoming shipments in Materials Management based on purchase orders and shipping notifications
- Outbound shipments in Sales and Distribution based on sales orders and deliveries

The graphic below illustrates this process:

Transportation planning and processing is based on the shipment document. This document facilitates the flow of information from the shipper to the customer and to any service agents who are involved in the business transaction.

Features
The transportation component includes basic transportation processing functions:

- Transportation planning and shipment completion
- Shipment costs calculation
• Shipment costs settlement
• Shipment costs calculation for individual customers
• Billing of customer freight
• Service agent selection
• Management of means of transport and utilities
• Follow-up and supervision of shipments
• Management of shipment costs

These transportation functions can handle planning and processing for both inbound and outbound shipments. You can control and monitor the entire transportation process from the planning stage to goods issue at your shipping point (for outbound shipments) or vendor location (for inbound shipments), through to goods receipt at the customer location or your plant.

Other available functions include: shipment costs calculation and settlement with the service agent, transfer to accounting, credit memo creation and invoice verification.

This documentation describes procedures in outbound shipment processing. Unless specifically stated otherwise, the information here also applies to inbound shipment processing. Differences between the two will be pointed out where necessary.

For information on creating and processing inbound deliveries, see the Confirmations section of the R/3 Library documentation for Purchasing (MM-PUR).
About Transportation

The following text describes basic elements of shipment processing, which also include:

- the function of the organizational unit of transportation planning point [Page 13]
- the function of the shipment document [Page 20]
- output determination [Page 28]
- a compilation of the reports [Page 56] available in shipment processing
Transportation Planning Point

Definition

You can now carry out transportation planning and shipment completion using a new organizational unit, the transportation planning point. Basically, the transportation planning point consists of a group of employees responsible for organizing transportation activities. Each shipment is assigned to a specific transportation planning point for transportation planning and shipment completion. You must define the various transportation planning points used in your organization in Customizing for Corporate Structure before they can be used to perform transportation functions. You can define this organizational unit according to your company’s needs, for example, according to geographical location or mode of transport.

⚠️

The transportation planning point is assigned to a company code, but is otherwise independent of other organizational units.
Procedures Valid for Entire Company Codes

Use

It is not necessary to assign the transportation planning point to a company code for transportation planning purposes. However, company code assignment is necessary for shipment costing and settlement. Internal offsetting of costs between company codes (one company code takes care of transportation processing for all the firm’s company codes, for example) is presently not available. These must be manually entered in the financial accounting ledgers.

Prerequisites

In order for this cross-company-code manual processing to be possible in financial accounting, cost distribution for shipment costs must occur on the shipment cost item level rather than delivery level or delivery item level, since in the latter two cases, the delivery’s company code would be adapted to the transportation planning point’s company code.

A company’s plant in Japan delivers goods to a plant in Houston. The plant in Japan takes care of the shipment costs until the goods reach the airport in Japan, and the Houston plant pays the rest of the shipment costs (Japan airport → Houston airport → Houston plant).

The transportation chain with cross-company-code billing looks like this:

There are a total of three shipments:

- The first shipment is created by the transportation planning point in Japan and ends at the airport in Japan. Cost distribution occurs on the shipment cost item level.
- The second and third shipment are created by the transportation planning point in Houston. In both cases, cost distribution occurs on the shipment cost item level.
**Shipment Types**

**Definition**

The shipment type contains all the important control features for a shipment, such as the number range, whether the shipment is inbound or outbound, how leg determination is performed, and which leg indicator has been set for a shipment of this type. You can also enter a selection variant for the shipment type. The values defined in the variant appear on the selection screen when you create a shipment document of this type.

The system supports the following shipment types:

- Individual shipment
- Collective shipment
- Transportation chain

**Individual shipment**

An individual shipment includes

- One or more deliveries
- One point of departure
- One destination
- One mode of transport

**Collective shipment**

A collective (or milk-run) shipment includes

- One or more deliveries
- Several points of departure
**Transportation chain**

A transportation chain is useful if you are dealing with deliveries that will be transported using multiple modes of transportation (and are thus processed by different departments at the transportation planning point).

Transportation Chain

The department responsible for transportation by land organizes truck shipments and another department organizes ships and their cargo for goods shipment by sea. Each mode of transport (truck and ship) requires individual shipping papers. Each mode of transportation requires separate transportation papers, meaning that you need to create a shipment document for the overland leg and another for the overseas leg of the journey.
If shipments use more than one mode of transportation, it is a good idea to create a transportation chain. Because you will have a separate shipment document for each mode of transportation, you can maintain separate output, texts, statuses, and so on.

Example for using a transportation chain

At shipping points 0001 and 0002 in Germany, a large number of deliveries are to be sent to customers in the United States by the beginning of December. You and your customers agreed that part of the shipment be sent carriage paid and the other part carriage, insurance, freight paid to (CIF) New York only (meaning that the end customer must pay carriage, insurance and freight from New York to the final destination).

The goods are to be transported by land within Germany, by sea from Hamburg to New York, and by land again in the United States. It is, of course, possible to document the entire process in a shipment document. However, problems can arise if certain parts of the shipment functions are used:

- For instance, data on the shipment status always refers to the entire shipment document (for example, the status “Loading finished”). However, in this example loading takes place several times.

- For the same reason, an assignment of dates and texts to a handling unit is difficult because these can change within the shipment document. The very definition of a handling unit is in itself problematic.

- Output to be created in combination with the shipment document contains all data for the entire shipment document. When the truck driver leaves the shipping point, his printout also contains data that refers to the ship. This is unnecessary and a nuisance. Processing several required preliminary legs at different times also requires that output be printed at different times.

In cases like this, it makes more sense to use a transportation chain in which deliveries are passed on in a series of different shipments. In the above example, you would create several shipment documents in the system: ten preliminary leg shipments by truck, one main leg by ship, and if necessary, eight subsequent legs by truck again. That way, you avoid the problem of assigning deadlines, output, or texts to the packaging material.

With that in mind, you might put together your transportation chain like this:

1. Create a main leg

   At transportation planning point 0001, you create a main leg shipment for all deliveries to be sent by ship from Hamburg to New York City at the beginning of December. There should be a special shipment type set for this set in Customizing. This could include the following settings:
   - Set the leg indicator field for the shipment header to Main leg. The system will recognize that this shipment must be linked to other shipments.
   - The leg determination type for this shipment type should be ‘’. This means that no automatic leg determination will be carried out. This is reasonable since the Hamburg-to-New York leg does not include any points of departure or destinations from the delivery (however, this data will be taken into account during leg determination).
Shipment Types

- Route determination resulting in the Hamburg-to-New York route may have already been carried out in the delivery. If you want to copy this route automatically into the main leg shipment, you can specify in Customizing that routes must be copied into the shipment document. Copying starts as soon as you set the Planned status in the shipment document. (Note that the route in the deliveries must be unique.) At the same time, the service agent can also be copied automatically from the delivery provided you have made the appropriate settings in Customizing and that the same service agent has been assigned to the deliveries.

When the deliveries were created, they were given transportation planning status A, meaning they were ready for transportation planning. Now, after creating the main leg shipment, these deliveries have transportation planning status B, meaning that they have been partially planned (since a main leg shipment needs preliminary and possibly subsequent legs).

2. Create preliminary legs

The preliminary leg shipments that are used to send the goods from shipping points 0001 and 0002 to the ship in Hamburg can be organized much faster than the ship itself, which is why they are planned at this time. You must now combine all deliveries in the main leg shipment into one or more preliminary leg shipments. You can do this in the Create Shipment transaction.

To do this, you must select all deliveries in the main leg shipment. The transportation planning status of the delivery may be helpful in determining which deliveries are in the main leg shipment since their status is now set to B instead of A. Of course, this is not sufficient as a single selection criterion. He can enter further selection criteria that are used during delivery selection for the main leg. This may be impractical since you may not now what the selection criteria were or too many deliveries may be selected.

Therefore, it is better to specify the shipment number of the corresponding main leg shipment in the Reference to line when selecting deliveries. If you do not know the number, press F4 and a selection screen will appear. In this case, a further selection screen for shipment number selection appears. On this screen, you can specify the person who created the shipment document, the point of departure, and the date in order to determine the number of the main leg shipment.

You create shipments using the worklist you defined. If each delivery corresponds to exactly one truckload, the planner can call up the function Edit → Automatic planning → One dlv. one shipment, which creates a separate shipment for each delivery.

You should use the following settings:

- Set the leg indicator to preliminary leg.
- Set the leg determination type to 1 (leg determination according to pick-up sequence and itinerary).
- Do not copy the route from the delivery. It may be a good idea to copy the service agent.

When the Planned status is set, leg determination begins, but the route is not copied from the deliveries. It will determine the pick-up sequence. In addition, the system suggests Hamburg as destination since the deliveries are part of a main leg shipment that runs from Hamburg to New York.
When the shipment is saved, the system updates the delivery status. The status for the carriage paid deliveries remains B (partially planned), since the second part of the Incoterm was left blank and the system assumes that a subsequent leg is required. The status of the deliveries with CIF New York is set to C (completely planned) since the second part of the Incoterm has been specified and the system assumes that a subsequent leg is not necessary.

3. Create subsequent legs

You create subsequent legs the same way you create preliminary legs. Use these settings:

- Set the leg indicator to subsequent leg.
- Use category 1 for leg determination.
- Do not copy the route from the deliveries.

In order to create these shipments, search for deliveries with a transportation planning status of B. The system then finds only those deliveries for which a subsequent leg is to be created. If the Planned status is set, it also carries out leg determination. The system automatically suggests ‘New York’ as a point of departure, since the main leg shipment ends in New York. The sequence in which the goods are delivered (itinerary) is determined by the sequence in which the deliveries are displayed on the screen. If the subsequent leg shipments are saved, the transportation planning status of the corresponding deliveries is set to C (completely planned) since these deliveries now have preliminary, main, and subsequent legs.

Following these steps ensures that every delivery is included in the transportation chain. In the example, there are ten preliminary leg shipments to Hamburg followed by a main leg shipment and eight possible subsequent leg shipments in the United States. In this way, a group of deliveries forms a network of shipments.

4. Monitor the transportation chain

In order to monitor the shipments, choose Environment → Transportation info → Shipment list or Environment → Transportation info → Transportatio.network depending on whether you are processing orders, deliveries, or shipments. Worklists for transportation planning and processing may also provide an overview. To generate a worklist, enter one of the shipment numbers that make up the transportation network in the Reference to line. The system will then select all shipment documents in the network.
Shipment document

Definition

The shipping document is the central element of transportation planning and shipment completion. It contains all the information necessary for carrying out transportation.

Use

You create shipment documents using a worklist. Different types of shipment documents have been defined to enable you to reflect in the system the various forms of transportation used in your organization.

For example, you use the individual shipment document to plan and process the transportation of goods from one location to another. You use the collective shipment to move goods from one or more points of departure to one or more destinations. Separate document types deal with inbound and outbound shipments.

You can use shipment documents to:

- Combine deliveries into one inbound or outbound shipment
- Specify shipment stages
  - Legs
  - border crossing points
  - load transfer points
- Assign goods to handling units
- Assign service agents
- Specify planned transportation deadlines
- Record actual transportation deadlines
- Specify output required for transportation (such as shipping papers or EDI messages)
- Define transport-relevant texts
Information in the Shipment Document

Use
You can record the following information in the shipment document:

- Means of transport
- Service agents
- Deadlines
- Status
- Tendering status
- Route
- Texts
- Output
- Dangerous goods

Features

Means of transport
The means of transport necessary for a shipment is reflected in the system as a handling unit. These handling units contain information about tare weight and -volume of the means of transport as well as the weight of the packed handling unit. Information about the country providing the means of transport, details about the driver and travel time are also included in these handling units. Handling units that have already been created for delivery items are copied into the shipment document where they can be packed further, if necessary. Delivery items that have only been partially packed or not packed at all can be packed in the shipment documents.

See also:
Packing in the Shipment Document [Page 132]

Service agents
You can store information about the service agents (such as forwarding agents or customs agents) who are involved in the transportation process. You can record this information at the header or stage level of the shipment document.

See also:
Assigning Service Agents in the Shipment Document [Page 136]

Deadlines
The time required for organizing and performing the various transportation activities is stored as planned and actual deadlines in the shipment document. This information can be used for monitoring and analysis purposes.

See also:
Maintaining Planned and Actual Deadlines in the Shipment Document [Page 138]
Transportation (LE-TRA)

Information in the Shipment Document

Transfer of Delivery Dates to Shipment [Page 141]

Status

Once you have completed the planning activities for a shipment document, you can set the Planned status. As soon as you set this status, you can no longer carry out planning activities for this shipment document (remove deliveries from the document or move deliveries within the document, for example). Leg determination is carried out automatically. You can define which activities take place when you set the status in the Activity Profiles [Page 146] section.

A traffic light icon indicates the overall status of the shipment document. The icon can be interpreted as follows:

- **No traffic light:**
  - No planning activities have been performed

- **Red light:**
  - Transportation planning is complete

- **Yellow light:**
  - Loading at the plant has either started or is complete

- **Green light:**
  - Shipment has been processed and is en route or has arrived

See also:
Maintaining Status in the Shipment Document [Page 140]

Tendering status

The tendering status describes the current status of a shipment with respect to negotiations with a forwarding agent through the Internet.

See also:
Requesting Tenders for Service Agents Through the Internet [Page 439]

Route

If the route and the forwarding agent are the same in all deliveries, they are copied from the deliveries into the shipment document when you set the status to Planned.

*Country-specific restrictions with respect to total weight of the shipment* on a particular route require recording the restriction already at the route level. This upper level can be specified at route level and is then taken into consideration during shipment processing. If the allowed total weight is exceeded during delivery assignment to the shipment, the system issues a warning message. The shipment can then be changed accordingly. The fields are displayed on the planning screen.

During order processing and delivery processing, this check is not taken into consideration.

Further transportation-relevant information is copied into the shipment document if you define the Copying Routines [Ext.] in the Implementation Guide.
Texts

Additional information that could help the transportation process to run smoothly can be entered as text at header level in the shipment document. This information can be accessed by all business partners involved in the process. Shipment text types are defined in Customizing and assigned to text determination procedures. Text determination procedures are defined in the shipment document type.

See also:
Maintaining Texts in the Shipment Document [Page 137]

Output

Output processing is performed just as it is in other areas of the Sales and Distribution module: using the condition technique. The types of output that have been set in Customizing for transportation and for which you have created condition records appear in the shipment document and apply to the entire document. The output type ALTR has been defined for transportation in the standard SAP System. You can change this output type to suit your needs.

See also:
Output Determination in the Shipment Document [Page 28]

Dangerous goods

To conform to the legal requirements with respect to the transportation of dangerous goods, it is important that you check in the shipment document whether transportation of such goods is actually allowed.

Here different dangerous goods checks can run either automatically or through manual request. For example, you can check whether the transportation of certain materials is allowed in certain modes of transport. In this way, you can prevent deliveries or shipments from leaving the company when they are not suited for transport, according to dangerous goods regulations. Also, you can create dangerous goods documents using the respective dangerous goods data.

See also:
Dangerous Goods Check in the Shipment [Page 143]
Copying Information Relevant for Transportation

Use
When you create shipments, you can use information relevant for transportation as selection criteria. For example, you can group together outbound deliveries with means-of-transport type “Truck” and means of transport “Small truck” into one shipment. In sales orders and/or deliveries, you can specify that the following information is relevant for transportation:

- Means of transport
- Shipping type
- Type of means of transport
- Special processing

Integration
In order to copy proposals for dates and times from the delivery, you must create a connection between the shipment dates and delivery dates. Copy routines serve this purpose.

Prerequisites
The system uses the copy routine to copy data from sales orders into deliveries and then into shipments. In order for the system to do this, you must first carry out the following activities in the Implementation Guide (IMG):

- Specify copy control for deliveries [Ext.]
- Define shipment types [Ext.]

Features
Information relevant for transportation is copied from the order into the header of the outbound delivery, and thus supplies split criteria for outbound deliveries. For example, two order items with different shipping types, means of transport or means-of-transport types cannot be combined into the same outbound delivery.

However, information can be copied from the outbound deliveries into the shipment, provided it is unique data. You create a handling unit in the shipment for the means of transport (likewise only if this is unique). The copying takes place when you set the status “Planned”. Here you must store an appropriate copy routine in Customizing for the shipment type.

The system also checks the capacity of the mode of transport in the delivery. If this capacity is exceeded, you will receive a warning message.

Since the means of transport can also be specified on the Pack screen, the means of transport entries in the sales order, delivery header and the corresponding packing information could vary. Changes made on the Pack screen have no effect on the transportation-relevant information in sales orders and deliveries.
Shipment Outputs

Purpose

In addition to printing and faxing, electronic data exchange is becoming increasingly important as a method of communicating transportation data.Senders (shippers) transmit their shipping orders and transportation information to their service agents (forwarding agents, ship owners, customs agents). The service agents organize the transportation process and ensure that it is carried out smoothly. A logistics transportation chain involving multiple modes of transport and service agents often occurs during the shipment. To ensure efficiency in such a situation, it is especially important to get all necessary information to all parties involved at the earliest possible point in the process.

Process Flow

Sample process flow for electronic data exchange:

<table>
<thead>
<tr>
<th>Shipping</th>
<th>Inbound Processing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The shipper sends the forwarding agent a partially- or completely planned shipment (shipping order).</td>
<td>The forwarding agent receives the transportation requests and assumes responsibility for planning the shipment details.</td>
</tr>
<tr>
<td>2. The forwarding agent sends information about the completely planned shipments back to the shipper.</td>
<td>The vendor receives the completely planned shipments from the forwarding agent.</td>
</tr>
<tr>
<td>3. The shipper or forwarding agent informs the customer about the upcoming shipment (shipment notification).</td>
<td>The customer receives information about the upcoming shipment.</td>
</tr>
</tbody>
</table>
Shipment Outputs

For more information on output control, see the Output section in the online Implementation Guide.

You can find more information about output administration in Working with Output in Sales and Distribution [Ext.].
Output Control

Use

You can use output control to automate either messages or subsequent processing of partner-specific messages. The application uses interfaces that were predefined in Customizing for conditions to call up output control.

You can use these interfaces to describe different constellations of data and the processing methods of your choice. If one of these data constellations occurs in the application, it triggers the corresponding processing method (either synchronously or asynchronously). You can define processing methods in many different ways (as print output or as a shipping IDoc for EDI, for example).

Prerequisites

The Logistics Execution application always uses output control for issuing output. You can maintain settings for output control in Customizing in Message control [Ext.] activity.

Features

The condition technique is used in the SAP System for formulating data constellation conditions. If the current application data matches one of the conditions defined in Customizing, output determination [Page 28] was successful and an output proposal is generated. You can then change this proposal (edit [Page 31]) and the output will be processed [Ext.] either immediately or at a specified time. The output's processing status is saved in a status record and a processing log is created.

See also:

Message Control Structure [Ext.]

Output control only supports certain transmission media. For more information, see Transmission media [Ext.].

Activities

In Message Control Customizing [Ext.], you can define rules according to which the system accesses individual condition records.

You can define concrete messages as condition records in the application: Message definition in the application [Ext.].
Determining Output in the Shipment Document

Use
The output determination function enables you to perform tasks for shipping and transportation output for delivery and transportation processing with your customers and within your company. You can create shipment output and output for handling units. Staff members in your company can send messages. For example, the system automatically finds the message that a bill of lading is to be printed.

Integration
The output control checks whether the application data matches the condition records (that were defined in Customizing). If this is the case, one or several messages are “found”, and they can then be processed (for example, sent electronically). The condition records are searched for during output determination on the basis of a predefined hierarchy.

The Output determination function is used in output control. You can use the output control function to exchange information with internal and external partners. Output control consists of the following functions that are described in the cross-application documentation CA – Output Control:

- Output Determination [Ext.]
- Output Processing [Ext.]
- Status Management [Ext.]

Prerequisites
For output determination, the condition elements and condition records need to be defined since the output determination runs using the condition technique.

In Customizing, you can define the conditions in which the output types you define will be selected. For more information on output control, see the Output section of the Implementation Guide.

Features
The system can propose output automatically for a document. You can change this output in the document.

Output determination occurs when:
- Accessing the output screen during shipment processing
- Saving a shipment document that is new or has been changed

See also:
For more information on output, refer to the following documentation:

<table>
<thead>
<tr>
<th>Application</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basis</td>
<td>BC – SAP Communication: Configuration</td>
</tr>
</tbody>
</table>
Determining Output in the Shipment Document

**Cross-application functions**

- Output Control [Ext.]
- SAP Business Workflow [Ext.]

You will find Customizing settings and examples in the above documentation.

**Example**

**Bill of lading**

1. Output determination starts in V7STRA with output type CMR1 and the assigned access sequence.
2. The access sequence defines the fields with which the key for the condition table is read. (for example, condition table B017: shipment type of the shipment is read)
3. If the condition record is found, the system proposes an output with the output attributes found in the table.
4. The output proposal (possibly not yet processed) is stored after the document is posted as an output status record in the NAST table.
Output Type

Definition

There are predefined output types for shipments. You can display a list of predefined output types by using the input help. The output type contains parameters, such as partner functions, that are valid for all outputs that are assigned to that type.

- Shipment outputs include: ALTR general shipment, bill of lading, shipping order, EDI in general (SEDI), shipment notification, goods receipt/issue slip.
- Delivery outputs include: delivery note, mail (internal output), shipping notification, warehouse order, and package labels.

The output type signals the use of a printed form such as a delivery note that will be sent to a customer. An output type can also be an internal, electronic-mail message that you send to a mail recipient (partner).

Use

The output type is assigned, per transmission medium [Ext.], to a form routine in a program that is called up to process the output (output status record).

For more information, see Defining Output Types [Ext.].

Integration

The output type comes after the procedure in the condition element hierarchy. The output type is assigned exactly one access sequence (next hierarchical level), which in turn is assigned one or more condition tables (next and lowest hierarchy level).

Condition Components: Sample Hierarchy [Ext.]
Output Processing

Use

Output proposals are presented to you in an application transaction. You can then either change (process) the proposed output before you save the object (bill of lading, for example).

Features

The output proposal that was created includes, among other things, the output's recipient, the transmission medium and the processing time for subsequent (automatic) processing. You can change all these parameters in the application transaction.

When you create an output manually, you can specify the output type, transmission medium, print parameters, partners, and language.

You can display a determination analysis, which displays the outputs that were found in the procedure. You can display details for an output that show which application data the condition table was read with.

After you post the document, the processed output proposal is recorded in the NAST table as a message status record [Ext.].

You create a shipment with forwarding agent 1, and the system proposes a shipping order that is to be sent via EDI.

The determination analysis shows that the Shipment type and Transportation planning point application fields were read and a condition record was found.

Output partners

The output recipient of the output that is sent is defined as the output partner. Use the input help to choose an output partner (sold-to party, Electronic Data Interchange -EDI mail recipient, forwarding agent, or employee responsible, for example).

During output determination, the output recipients are determined from the partners listed in the document. In other words, the partner function is used to determine the recipient (forwarding agent, for example).

You can enter a specific output recipient in this field. Your entry overrides the standard partner that appears. Output recipients that are entered specifically must also be listed in the document as partners.

Output’s transmission medium

The type of processing is determined by the transmission medium [Ext.]. You can specify, for example, that an output be printed out or sent by mail, fax or EDI.

Processing status

Possible status values:

Status  0 (not yet processed)

1 (processed - no errors)

2 (processed - with errors)
Output Processing

Dispatch time

The dispatch time is stored in the condition record. You can have the system process and update the output either immediately or at a later time. You can use the RSNAST00 report or a special application function that triggers processing in order to process the outputs at a later time. The following are linked to the dispatch time as follows:

- **Time 1**: Send via periodically-planned jobs (next processing run) or start sending from RSNAST00 online by using the ABAP/4 Development Workbench

- **Time 2**: send via jobs (as in time 1) with additional time specification of the processing time: start from RSNAST00 in the background at a defined time (Tools → Administration, Jobs → Job definition).

  RSNAST00 processes all output status records that meet the selection criteria and whose processing times or intervals either include the current date or lie in the past. Processing times or intervals are fields in the message status record [Ext.] in the NAST table. These fields are not filled with information in the standard system. Please note: The first Time field is different from the second Time field. In order to have the system complete these fields, you can define a corresponding routine in a report as an attribute of an output type. This routine will then be run for each output determination of this output type.

- **Time 3**: Send using an application transaction (specific entry): Call up an application function.

  Print transaction VT70

  Only outputs with the status 0 and the dispatch time 3 are included in initial processing.

An output can be sent more than once. This is useful, for instance, if technical problems or other problems occurred in the first print output. The system copies the output that was selected; you can then process and send this copy.

In repeat processing, only outputs with status 1 or 2 are selected (dispatch time is not taken into account). Only outputs with status 2 are selected for error processing (once again, dispatch time is not taken into consideration).

There can be several versions of the same output that only differ in date or time of creation (because of repeat processing or multiple sending, for example). During selection, the system always chooses the last (chronologically latest) output from a group of similar outputs.

- **Time 4**: Send immediately (during save in the application). The output is processed when the document is updated.

Activities

See also:

- Selecting Output Worklist [Page 34]
- Changing Data Relevant to Output [Page 36]
- Changing Outputs in Document Processing [Page 37]
- Sending Internal Mail [Page 39]
Selecting a Worklist for Output

Use

Before you can process messages, you must first select a worklist.

Procedure

1. Call up the respective task:

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Path</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipping</td>
<td>Initial Screen Shipping [Ext.]</td>
<td></td>
</tr>
<tr>
<td>Processing delivery output</td>
<td>Communication/Printing → Outbound Delivery Output</td>
<td></td>
</tr>
<tr>
<td>Processing loading output</td>
<td>Communication/Printing → Loading Output</td>
<td></td>
</tr>
<tr>
<td>Processing handling unit output</td>
<td>Communication/Printing → HU output</td>
<td></td>
</tr>
<tr>
<td>Shipment</td>
<td>Initial Screen Transportation [Ext.]</td>
<td></td>
</tr>
<tr>
<td>Processing transportation output</td>
<td>Communication/Printing → Transportation Output</td>
<td>You can process transportation output as well as output for documents that have a reference to a shipment (for example, billing documents, deliveries). To do this, select the respective field and enter the selection criteria in the appropriate section</td>
</tr>
<tr>
<td>With background processing</td>
<td>Tools → ABAP Workbench → Development → ABAP Editor</td>
<td>Print transactions VT70</td>
</tr>
</tbody>
</table>

2. Enter the output type, the transmission medium, and, if required, further selection parameters. If you want to call up a worklist of all outputs that have not been processed successfully, enter 3 in the field Processing mode. The system displays all the incorrect outputs, and you can process them once again.

3. If you wish to look at the worklist first and/or then make changes, choose Program → Execute.
   
   If you wish to process the output as a background job, choose Program → Execute in the background. In this case, you cannot execute any changes.

4. If you wish to process output, select the respective output.
Selecting a Worklist for Output

For more information on processing output, refer to the section Processing Existing Output [Page 37].

5. Choose Edit $\rightarrow$ Process.
   The system processes the selected output.

6. If you wish to receive a log after output processing, choose Goto $\rightarrow$ Log.
# Changing Data Relevant to Output

## Prerequisites

You must have the worklist created. For more information on creating a worklist, refer to the section [Creating a Worklist for Output [Ext.]](##).

## Procedure

Select the respective output and execute the task you require.

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Path</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing print parameters</td>
<td>*Edit → Printer</td>
<td>Use this task if wish to enter the same print parameters for several outputs. All the selected outputs receive the print parameters from the screen <em>Printer specification</em> if there is 1 (Print) in the field <em>Transmission medium</em>.</td>
</tr>
<tr>
<td></td>
<td><em>specification</em></td>
<td></td>
</tr>
<tr>
<td>Issuing output (printing, sending fax, and so on)</td>
<td><em>Edit → Process</em></td>
<td>After processing, output is highlighted as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• green (processed successfully)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• red (processed incorrectly)</td>
</tr>
<tr>
<td>Changing details data</td>
<td><em>Goto → Communication</em></td>
<td>Use this task if wish to enter the separate print parameters for each output. You may only change the parameters for the transmission media <em>Printing</em> and <em>Telefax</em>. The parameters are merely displayed for all other transmission media.</td>
</tr>
<tr>
<td>Creating screen display</td>
<td><em>Goto → View</em></td>
<td>The system displays the first selected output.</td>
</tr>
<tr>
<td>Display processing log</td>
<td><em>Goto → Log</em></td>
<td>The system creates a separate log for each output.</td>
</tr>
</tbody>
</table>
Changing Outputs in Document Processing

Prerequisites

Normally, the system automatically proposes data for output control in the sales document. If you must process outputs, choose the following menu path that corresponds to the sales document you are processing:

<table>
<thead>
<tr>
<th>Document</th>
<th>Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery</td>
<td>Extras → Delivery output → Header or Item</td>
</tr>
<tr>
<td>Shipment</td>
<td>Goto → Output</td>
</tr>
</tbody>
</table>

If you selected several outputs, use Goto → Next detail screen to process the next output.

Procedure

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Path</th>
<th>What you should know</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeating an output</td>
<td>Select an output and choose Repeat output.</td>
<td>An output can be sent more than once. This is useful, for instance, if technical problems or other problems occurred in the first print output. The system copies the output that was selected; you can then process and send this copy.</td>
</tr>
<tr>
<td>Sending a change output</td>
<td>Select an output and choose Change output.</td>
<td>If you have made changes in a document, you can create and send change outputs for outputs that are based on this document and have already been sent. The system copies the output that was selected; you can then process and send this copy. An indicator identifying this output as a change output then appears in its Change column.</td>
</tr>
<tr>
<td>Changing print parameters</td>
<td>Select an output and choose Communication method.</td>
<td>The output must be set for printing: for example, the Medium field must be set to 1 (Print output) or 2 (Fax).</td>
</tr>
<tr>
<td>Changing send data</td>
<td>Select an output and choose Further data.</td>
<td>Dispatch time, for example. Processing date and status are also displayed here.</td>
</tr>
</tbody>
</table>
### Changing Outputs in Document Processing

| Carrying out output determination analysis | Goto → Determin. analysis | This function is described in detail in [Output Determination Analysis](Page 41). The system displays all accesses. You can display the fields that triggered each individual access by choosing the folder that you want more information about. |

---

**Note:**

- **Goto → Determin. analysis**
- **Output Determination Analysis**
- **Page 41**
Sending Internal Mail

Use

You can use internal mail to send a message referring to a sales document to the person responsible for that document. That person can then call up the document directly from your mail in order to check or process it, for instance.

Features

The procedure for processing internal mail can be found in Processing Internal Mails in SD [Ext.].

You can attach certain criteria to automatic proposals so that you only receive an automatic message from order processing if the value of an order is greater than $1000, for example. For more information, see Example Message Determination: Processing Condition Component Hierarchies [Ext.].

See also:

Formatting SAPoffice Messages [Ext.]
Processing Internal Mail

Procedure

To process an internal mail that you have received, proceed as follows:

1. On the initial screen, choose Office → Inbox.
2. Select the mail you wish to process and choose Document → Display.
   
   The system displays information on the created document, such as document number, name of creator, and so on. If the creator has entered a text in the mail, this text will also be displayed.
   
   You automatically branch to the transaction specified in the mail. After document processing you return to the mail. You can repeat this process as often as required.

You can process the mail directly without displaying the content if, after selecting the mail, you choose Edit → Process.
Output Determination Analysis

Use
A determination analysis can be run for outputs. For example, you can find out which keys were used to find outputs and whether output determination was successful.

Features
An output determination analysis provides you with the following information:

- Origin of the output proposal (via condition record or from the customer master, for example)
- Output search results (which outputs were found in the corresponding output procedure and which outputs could not be found)
- Access information (which accesses occurred for outputs that were found using condition records and the results of the accesses)
- Key combinations (with which key combinations, or combinations of fields, did the accesses occur?)

Activities
1. Change the corresponding document. For a shipment document, for example, you would choose:
   a. Shipment screen
   b. Shipment → Change
2. Goto → Output
3. Goto → Determin. analysis

   Determination analysis only works if you are in the change or create mode of the shipment document. (In other words, this function does not work in display mode.)

   There is no output determination analysis for the picking list.
Printing Output

Use
You can, for example, print a delivery note for a delivery.

Prerequisites
The following prerequisites apply:

- The document must have an output that is designated for printing. The output can be
  - Transmitted directly by the system to the document through Output Determination [Page 28]
  - Entered manually into the document.

If an output is allowed according to the output determination procedure, you can enter this output into the document manually.

For more information, see Output Determination Procedure Technique [Ext.].

To enter an output manually (or display an existing output), choose in the overview screen of the document Extras → Output → Header or Item → Edit. You must have 1 (Print output) set in the field Transmission medium for the output to be printed.

For more information on output, refer to the section Output Processing [Page 31].

- In addition the column Status must have the traffic light set to yellow. If the traffic light is set to red, you must repeat the print by selecting the output and choosing Repeat output.

Features
You can print in the following ways:

- Through the worklist (online)
- Through the worklist (background job)

See also:
For further information on the worklist, refer to the section Selecting Worklist for Output [Page 34].
Printing Outputs from Document Processing

Prerequisites

The general prerequisites listed in Printing Outputs [Page 42] apply.

Additionally, the following settings must be made on the output screen for the output that you want to print.

- In the second Time column: 3

Procedure

<table>
<thead>
<tr>
<th>Document</th>
<th>Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery</td>
<td>(Create/Change) Outbound delivery → Issue delivery output</td>
</tr>
<tr>
<td>Shipment</td>
<td>(Shipment screen) Goto → Output</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Menu Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing an output</td>
<td>Specify which printer</td>
</tr>
<tr>
<td>Displaying an output on a screen</td>
<td>Specify which screen</td>
</tr>
</tbody>
</table>
Outbound EDI messages

Use

Shipment documents are normally sent in one of the following two situations:

1. The shipper sends the forwarding agent a partially- or completely-planned shipment (transfer order).
2. The shipper or forwarding agent informs the customer about the upcoming shipment (shipment notification).

Prerequisites

You need to create an output type that you can use to send the shipment document per Electronic Data Interchange (EDI). Output type SEDI is provided for this purpose. You can also make a copy of this output type and tailor it to your needs, if necessary. The transmission medium must be set to 6 (EDI).

The following condition components must be maintained:

<table>
<thead>
<tr>
<th>Condition component</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access sequence</td>
<td>0001</td>
</tr>
<tr>
<td>Output type</td>
<td>SEDI (or copy of SEDI)</td>
</tr>
<tr>
<td>Schema</td>
<td>V7STRA, for example</td>
</tr>
<tr>
<td>Application</td>
<td>V7</td>
</tr>
<tr>
<td>Processing routine</td>
<td>RSNASTED program, FORM-routine EDI-PROCESSING</td>
</tr>
<tr>
<td>General data</td>
<td>Select Access to conditions and Multiple sending of output. Leave all other fields blank.</td>
</tr>
<tr>
<td>Time</td>
<td>3 (explicit request), as an example</td>
</tr>
<tr>
<td>Transmission medium</td>
<td>6</td>
</tr>
<tr>
<td>Partner function</td>
<td>CR (Carrier) or SH (Ship-to party)</td>
</tr>
</tbody>
</table>

IDoc interface

You must also enter the following values for outbound partner profiles and any additional outbound parameters under message control.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output type</td>
<td>SHPMNT or SHPADV</td>
</tr>
<tr>
<td>Partner type</td>
<td>LI (vendor/creditor) or KU (customer)</td>
</tr>
<tr>
<td>Partner function</td>
<td>CR (Carrier) or SH (Ship-to party)</td>
</tr>
<tr>
<td>Port</td>
<td>SUBSYSTEM</td>
</tr>
<tr>
<td>Output mode</td>
<td>Collect IDocs, for example</td>
</tr>
<tr>
<td>Basic type</td>
<td>SHPMNT03</td>
</tr>
<tr>
<td>Application</td>
<td>V7</td>
</tr>
<tr>
<td>Output type</td>
<td>SEDI, or your modified copy of SEDI</td>
</tr>
<tr>
<td>Process code</td>
<td>SHPM</td>
</tr>
</tbody>
</table>
1. Scenario: The shipper sends the forwarding agent a partially- or completely-planned shipment (transfer order).

You create a shipment document that is either partially or fully planned (depending on whether the transportation planning details will be carried out by the forwarding agent or if you do it yourself).

Depending on what point in the process the message determination is set to take place, the EDI is triggered immediately after posting (time 4) or when explicitly requested (time 3).

   Scenario: The shipper or forwarding agent informs the customer about the upcoming shipment (shipment notification).

   You have a fully-planned shipment document (that you have created and planned yourself, or that the forwarding agent has planned for you).

   Depending on what point in the process the message determination is set to take place, the EDI is triggered immediately after posting (time 4) or when explicitly requested (time 3).

To improve performance, you should make sure that when you use IDocs for special purposes that you only generate segments that include the data you need. You can hide certain segments by using a reduction technique.
Outbound EDI messages

To make the necessary settings in Customizing, choose Cross-Application Components → Distribution (ALE) → Processing IDocs → Set up segment filtering.
Inbound EDI messages

Use
You can create or change shipment using EDI output.

In this way, the following tasks are possible:

Collective Goods Traffic
The forwarding agent picks up deliveries from the vendor during the preliminary leg. Then the agent puts together the shipment for the main leg and passes on this information to the customer as a shipment notification. Now the customer can easily post a goods issue for the entire shipment (more precisely, for the deliveries it contains).

Transportation planning
A vendor supplies the forwarding agent with the outbound deliveries as transfer requirements. The forwarding agent plans the shipment and informs the vendor of the result, who can then start the appropriate activities for goods issue of the respective outbound deliveries. To create shipments at the customer site, you can use message SHPADV (shipment message or shipment notification). To create or change your own shipments, use message SHPMNT. Both messages are based on IDoc type SHPMNT03; processing is executed through process code SHPM. You can maintain these parameters within the EDI partner profile. For this purpose, select Tools -> Business Communication -> IDoc -> Partner profile.

Output for deadline and status
The forwarding agent confirms the planned or actual deadline via EDI, including the status for the end of the shipment with the respective time.

The inbound deliveries to which the shipment refers must exist in the system. The reference is made through the delivery number of the vendor (collective goods traffic) or directly (transportation planning). Therefore, it is necessary to notify the customer of the deliveries where collective goods traffic is concerned. You can do this using the DESADV (shipping notification) message. It is not possible to create deliveries in the initial processing of shipments, as required for direct shipments. Also, no change is made to the delivery (with effects on material planning) if there is a change in the shipment (planned arrival date, for example).

Prerequisites
The deliveries that the shipment refers to must exist in the receiving system.

Features
Control of IDoc Receipt SHPMNT03
You can control the processing of the receipt of IDoc SHPMNT03 using the specifications in the segment E1EDT18. For this purpose, you can use the following E1EDT18-QUALF qualifiers:

QUALF = ORI  Shipment document is created
QUALF = CHA  Shipment document is changed
Inbound EDI messages

QUALF = PID Specification of an identification field for the shipment document.

Processing and copy control

If you use the qualifier ORI or CHA, you can control the data transfer strategy from the IDoc into the shipment document using the parameter field. Basically, there are four strategies which are indicated by the first character in the E1EDT18-PARAM field. The respective marker characters are in the second character in the E1EDT18-PARAM field:

0 IDoc fields are always copied; empty ID fields cause document fields to be deleted (standard case; will be processed if no specification is made).
1 IDoc fields are only copied if they are empty
2 Similar to strategy 0, but an IDoc field is not transferred if it is filled completely with the marker character.
3 Similar to strategy 1, but an IDoc field is not transferred if it is filled completely with the marker character.

Example of segment E1EDT18:

<table>
<thead>
<tr>
<th>QUALF</th>
<th>PARAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORI</td>
<td>2%</td>
</tr>
<tr>
<td>CHA</td>
<td>3%</td>
</tr>
</tbody>
</table>

Control of identification

You can control the identification link between the IDoc and the shipment document in segment E1EDT18 with qualifier PID, which can appear up to three times per IDoc.

In most day-to-day cases, the PID qualifier is not present. In this case, the E1EDT20-TKNUM field is copied into VTTK-EXTI1 during creation. The system assigns the shipment number VTTK-TKNUM internally. If there is a change, the system searches for a suitable shipment document using the following criteria:

E1EDT20-TKNUM = VTTK-EXTI1

and

E1ADRE4-EXTEND_D = VTTK-TDLNR (where you must have E1ADRE4-EXTEND_Q = 300)

If PID qualifiers are specified in E1EDT18, no data is copied from TKNUM to EXTI1.

If the shipment number is to have external number assignment, you can specify the shipment number as a primary identification with E1EDT18-QUALF = PID and E1EDT18-PARAM = TKNUM. The shipment is created using VTTK-TKNUM = E1EDT20-TKNUM, and is searched for with the same condition if you want to change it.
Inbound EDI messages

You can use the IDoc fields EXTI1, EXTI2, and TKNUM for the identification.

Examples of segment E1EDT18:

<table>
<thead>
<tr>
<th>QUALF</th>
<th>PARAM</th>
<th>Function for creating</th>
<th>Function for changing</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
<td>Copy E1EDT20-TKNUM to VTTK-EXTI1 Internal number assignment</td>
<td>Search for shipment with VTTK-EXTI1 = E1EDT20-TKNUM and VTTK-TDLNR = E1ADRE4-EXTEND_D</td>
</tr>
<tr>
<td>PID</td>
<td>TKNUM</td>
<td>External number assignment VTTK-TKNUM = E1EDT20-TKNUM</td>
<td>Search with VTTK-TKNUM = E1EDT20-TKNUM</td>
</tr>
<tr>
<td>PID</td>
<td>EXTI1</td>
<td>Internal number assignment</td>
<td>Search with VTTK-EXTI1 = E1EDT20-EXTI1</td>
</tr>
<tr>
<td>PID</td>
<td>TKNUM EXTI2</td>
<td>External number assignment</td>
<td>Search with VTTK-TKNUM = E1EDT20-TKNUM and VTTK-EXTI2 = E1EDT20-EXTI2</td>
</tr>
<tr>
<td>PID</td>
<td>EXTI1 EXTI2</td>
<td>Internal number assignment</td>
<td>Search with VTTK-EXTI1 = E1EDT20-EXTI1 and VTTK-EXTI2 = E1EDT20-EXTI2</td>
</tr>
</tbody>
</table>

Activities

You must also enter the following values for outbound partner profiles and any additional outbound parameters under message control.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output type</td>
<td>SHPMNT or SHPADV</td>
</tr>
<tr>
<td>Partner type</td>
<td>LI (vendor/creditor)</td>
</tr>
<tr>
<td>Basic type</td>
<td>SHPMNT03</td>
</tr>
<tr>
<td>Application</td>
<td>V7</td>
</tr>
<tr>
<td>Output type</td>
<td>SEDI, or your modified copy of SEDI</td>
</tr>
<tr>
<td>Process code</td>
<td>SHPM</td>
</tr>
</tbody>
</table>
Report: Output for Shipments

Use

You can use this report to create a list of outputs that meet your selection criteria. You can specify whether your list should include outputs related to shipments, deliveries, handling units, or invoices. You can then display or process the output of your choice from the list.

Features

You can enter shipment numbers, planned shipment completion dates, transportation planning points or partners as selection criteria. You can also specify that you want to see only those outputs relating to shipments or deliveries, for example. Use output type, transmission medium and processing mode to further limit the search.

From the list of outputs that appears, you can start immediate processing, make changes to the processing parameters, or display either the output itself or its corresponding log. The log records how often the output is processed or printed.

This report only lists outputs that have been found via output determination or defined manually in the selected documents (shipments, deliveries, or invoices, for example). Output determination is not carried out in this report.

See also:

Creating Output Lists [Page 51]
Creating Output Lists

Procedure

To create an output list, proceed as follows:

   
   The Output for Shipments screen appears.

2. To use other selection criteria, choose Edit → All selections.
   
   To define reoccurring selection criteria, you can create a variant for the selection screen using Goto → Variants → Save as variant. You can then retrieve these variants with Goto → Variants → Get.

3. Enter the criteria you want to use for selecting the output.

4. Choose Program → Execute.
   
   The system then gives you a list of all the outputs that match the selection criteria.
Freight Codes and Freight Code Sets; Freight Classes

Definition

Forwarding agents or railroads use freight codes (and sets of freight codes) to classify the goods they transport. Freight codes are specified in the transportation papers, and some are specific to rail or road transportation.

These are compiled in freight code sets published by forwarding agents and the railroad authorities and are used specifically when referring to rail or road transport. Specific freight codes are defined in each freight code set.

<table>
<thead>
<tr>
<th>Freight code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4001</td>
<td>Methyl alcohol</td>
</tr>
<tr>
<td>4002</td>
<td>Glycol</td>
</tr>
<tr>
<td>4003</td>
<td>Alcohol</td>
</tr>
<tr>
<td>4004</td>
<td>Formaldehyde</td>
</tr>
</tbody>
</table>

Freight classes are made up of one or more freight codes and are one of the criteria for shipment costing.
Determining the Freight Code

Process Flow

Determining the freight code is carried out in two steps:

**Step 1**
Automatic freight code determination uses the following criteria:

- Country of origin
- Shipping type (truck, rail, etc.)
- Forwarding agent (forwarding agent freight group in the vendor master)

If an external transportation planning system is being used, then the freight code set can also be defined by the route.

**Step 2**
Automatic freight code determination uses the following criteria:

- Freight code set
- Material (material freight group in the material master)

This allows you to determine the freight codes of all materials in a shipment.

The following illustration shows an example of freight code determination.
Determining the Freight Code

Step 1:

Country of origin
Shipping type
Carrier freight group

Rail freight code set

Freight code:
- 9000002 Graphics card
- 9000003 Hard drive
- 9001000 Monitor
- 9001001 Keyboard

Material freight group

Freight code: 9000003 Hard drive

Step 2:
Freight classes

Definition
A freight class is a group of freight codes used to calculate shipment costs.

Use
The freight class can be used as one of the criteria for figuring shipment costs. For example, you could enter condition records for freight rates that specifically refer to a combination of tariff zone and freight class. The freight code is used if the material that is being shipped should figure into the shipment costs.

Integration
One or more freight codes are assigned to a freight class within a freight code set.
The following illustration is an example of how freight code set, freight code and freight class are interrelated.

Rail freight code set

<table>
<thead>
<tr>
<th>Freight codes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000002 Graphics card</td>
</tr>
<tr>
<td>9000003 Hard drive</td>
</tr>
<tr>
<td>9001000 Monitor</td>
</tr>
<tr>
<td>9001001 Keyboard</td>
</tr>
<tr>
<td>9001002 Speaker</td>
</tr>
</tbody>
</table>

Freight class 01

Freight class 02
Transportation Processing Reports

Use
The following reports are available in transportation processing:

Select Shipments: Planning [Page 88]
Select Shipments: Utilization of Capacity [Page 91]
Select Shipments: Free Capacity [Page 93]
Select Shipments: Shipment Completion [Page 151]
Select Shipments: Check-in [Page 148]
Displaying Transportation Change Documents [Page 174]
Report: Output for Shipments [Page 50]
Scales List [Page 216]
Shipment Costs List: Calculation [Page 214]
Shipment Costs List: Settlement [Page 238]
Editing Shipment Lists

There are various functions which you can perform in both the transportation planning and shipment completion worklists to help you locate the documents you want to edit.

Transportation List Views

To switch from the normal to the status view of the transportation list and vice versa, choose Edit → Change view.

Search Function

To find documents with a particular characteristic (for example, you want to find all documents with a specific forwarding agent), proceed as follows:

1. Choose Edit → Find → Find delivery.
   The screen Delivery selection view appears where you can specify characteristics of the delivery you are looking for.

2. Enter one or more delivery characteristics.

3. Choose Program → Execute.
   The system finds all deliveries that match your selection criteria.

Sort Function

You can navigate within the transportation list much easier by sorting it according to criteria such as shipment type or planned loading date. To do this, proceed as follows:

1. Place your cursor on the column heading according to which you want to sort your list.

2. Choose Edit → Sort → Ascending order to sort the list in ascending order. If you want to sort the list in descending order, choose Edit → Sort → Descending.
   The system sorts the list based on the column header on which you placed your cursor and, depending on the menu option you select, in either descending or ascending order.

List Viewer Functions

Some lists are managed with a special tool, the ABAP List Viewer. The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to make settings such as which columns appear in what order, for example. For more information, see ABAP List Viewer [Ext].
Searching for Deliveries in a Transportation List

To locate specific deliveries within a transportation list, proceed as follows:

1. Choose Edit → Find → Find delivery.
2. Enter your selection criteria (for example, the number of the ship-to party).
3. Choose Program → Execute.

The system issues a list of all the shipment documents in the list which contain deliveries that match your selection criteria.
Transportation Planning

Use

Transportation planning involves all the activities that must be performed before the shipment leaves the shipping point. These activities include:

- Acquiring the services of a forwarding agent
- Organizing the means of transport
- Specifying the route for the shipment
- Defining the stages for covering this route in the most efficient way.

There are different types of shipment document types to deal with the various forms of transportation (for example, individual shipments or collective shipments). The shipment documents are used as a basis for carrying out transportation planning. This includes, among other things, the execution of the above activities.

Prerequisites

Before you can carry out transportation planning, the following requirements must be met:

For outbound shipments

- Specify in Customizing for Transportation that a delivery type for the shipping notification is relevant for transportation planning and shipment completion.
- Specify a route in the deliveries.
- Specify in Customizing for Transportation that the routes in the deliveries are relevant for transportation planning and shipment completion.
- Make sure the ShpmtBlReason (shipment blocking reason) field is blank. You can find this field in the delivery header on the transportation screen.

Once these requirements have been met, the system automatically sets the transportation planning status to A (Not yet planned) in the Tms.plan.status field in the delivery header.

For inbound shipments

- Specify in Customizing for Transportation that a delivery type for the inbound delivery is relevant for transportation planning and shipment completion.
- Assign all items to the same plant in the inbound delivery. The system carries out a corresponding check.

Features

There are different types of worklists and lists you can use to perform various tasks in transportation planning:

- Shipment list
  - You use the shipment list to establish which inbound or outbound deliveries are due for shipment. After you have created the list, you can
  - Create the necessary shipment documents for particular inbound or outbound deliveries
Transportation Planning

- Specify the order in which the inbound or outbound deliveries (or shipment items) are to be delivered

Transportation planning list

When you are creating the shipment due list, you do not usually have all the information you need to complete transportation planning. For instance, you probably do not know which forwarding agent will take care of goods shipment at this stage. You could also decide not to finish the entire planning for a shipment in the shipment list because the capacity for this shipment is not yet used to the full. Once you have the information you require or once there are enough deliveries to fill the shipment, you can use the transportation-planning list to locate these documents and complete transportation planning.

This list contains shipment documents for which planning activities still have to be completed and which match selection criteria that you define. You can use the list as a basis for performing transportation planning activities, such as organizing a means of transport, scheduling loading activities and acquiring the services of forwarding agents.

Besides this “normal” transportation planning list, there are additional lists that you can use to find shipments according to certain categories. For instance, in the Utilization list, you could enter the shipment’s degree of utilization as a percent, according to weight and volume, as one of the selection criteria.

Activities

You must first determine which inbound or outbound deliveries are due for transport. A worklist for this purpose is created using selection criteria. Deliveries or outbound deliveries are then assigned automatically or manually to shipment documents. Relevant data, such as shipping points and destinations, is then used to determine the route and to break it into stages.

The route in the delivery can be used as one of the criteria for selecting deliveries due for shipment. It is not, however, copied into the shipment document. More information is available in the following sections.

You can make the appropriate settings in Customizing so that routes and service agents are copied from the deliveries into the shipment documents.

Using the Route as Selection Criterion

The route in the delivery can represent:

- One or more legs
- A link between the point of departure and the destination
- The destination region

The route in the shipment document differs from the route in the delivery. The following examples should illustrate the difference between a route in the delivery and a route in the shipment document.

Example of a route as a link between departure and destination locations

The following graphic shows the route as a link between the point of departure and the destination.
In the delivery document, the route \textbf{NA} indicates that both deliveries are to be transported across the North Atlantic.

During transportation planning, you select all deliveries with the route \textbf{NA} and then look for a ship that can transport the deliveries at the required time. You find a ship that sails from Antwerp to New York and enter the route \textbf{NA1} in the shipment document header.

**Example of a route as a target area:**

Routes can also be destination regions. The following graphic shows routes R5, R6, R7, and so on as destination regions.
During transportation planning, you select all deliveries with route R5. You notice that there is still room in the truck. To make use of this capacity, the deliveries with route R6 are selected as well.
Creating Shipments

Purpose

When you create shipments, you can choose deliveries according to certain selection criteria and then assign them to the new shipment.

On the overview screen you can, for example, assign deliveries to the shipment manually or automatically, or also remove deliveries from the shipments. On the selection screen that is within the overview screen you can also enter selection criteria for the relevant deliveries or inbound deliveries.

Process Flow

1. Activities on the Selection Screen

On the selection screen, you can enter selection criteria for the documents (inbound or outbound deliveries) that you want to assign to a shipment. You define the selection criteria that are displayed on the selection screen beforehand. You can use selection variants to specify these criteria. On the selection screen, you specify whether you want the documents due for shipment to be assigned automatically to a shipment document or whether you want to assign them manually once the shipment has been created. There are separate selection screens for inbound and outbound shipments. The selection screen for creating an inbound shipment contains, for example, the selection criteria Vendor and Destination point: Plant; in the case of an outbound shipment, the criteria are Ordering party and Destination point: Shipping point.
2. Activities on the Selection Screen

The overview screen is divided into two sections: One section contains one or several shipment documents, and the other section lists the deliveries that have not yet been assigned to shipment documents. If the documents have not been assigned automatically to a shipment document, you can do this manually on the overview screen. You can also create new shipment documents and move shipment items (inbound or outbound deliveries) within a shipment or from one shipment to another. In addition, you can remove shipment items from the shipment if, for example, you run out of room on a truck. If you decide that you do have the capacity to select additional deliveries or inbound deliveries for additional shipments, you can create a new shipment from the overview screen.

Two views are possible: For example, one view displays the address of the ship-to party, and the other displays the name of the ship-to party. Different data is made available for shipments and shipment items (delivery, inbound delivery).

The settings can be changed through trees and table controls.

You cannot place outbound deliveries and inbound deliveries together in the same shipment document. Nor is it possible to assign Items from a delivery or an inbound delivery to different shipment documents. You must decide at the delivery stage whether order items can be shipped together in one delivery and therefore require only one shipment.

See also:
Creating Shipment Worklist [Page 65]
Creating Shipments

Procedure

To create a shipment, proceed as follows:

1. From shipment [Ext.], choose Create → Single Documents.
   The Create Shipment: Initial Screen appears.
2. Enter a transportation planning point.
3. Choose the required shipment type from the list field.
4. Enter a selection variant, if necessary.
   You can assign a selection variant to each shipment type in Customizing. When you create a shipment list for the document type to which a variant has been assigned, the system automatically proposes these values on the selection screen.
5. Choose Edit → Select further deliveries.
   Depending on the type of shipment you enter, the selection screen for inbound or outbound shipments will appear. Enter your selection criteria for creating a shipment. If you have specified a selection variant or if one has already been assigned to the shipment type, the system will automatically propose these values in the relevant selection fields.
   For further information on delivery selection, refer to the section Screen Info for Delivery Selection [Page 67].
6. Enter the selection criteria you require.
   The system automatically resets the Trns. plan. status field from value A (not yet processed) to B (Partially processed) and the Total gds mvt stat. field to value A (not yet processed). Based on these values, the system selects all deliveries that need shipment documents. The system defines deliveries that need shipment documents as all deliveries with either no transportation planning or only partial transportation planning (because certain shipment stages still need to be defined, for instance).
7. If you want the deliveries selected to be assigned automatically to a shipment document, you must select the Include deliveries in processed shipment field.
8. Choose Enter.
   The system returns a list of deliveries that match your selection criteria. The system automatically creates a shipment document and assigns the selected deliveries to it if you have selected the Include deliveries in processed shipment field. If you have not set the indicator, you must make the necessary assignments manually.
Creating Shipments

9. By choosing Edit → Selection log, you can obtain information on the selection run such as the total number of deliveries and items selected, the selection criteria used, and any problems that occurred.

10. If you still have room in the shipment, you can repeat the selection procedure and fill the shipment with more deliveries. To repeat the selection procedure, choose Edit → Select further deliveries.

For information on processing the worklist, see:

- Defining Selection Variants for Shipments [Page 71]
- Creating Additional Shipment Documents [Page 72]
- Moving Deliveries [Page 73]
- Removing Deliveries from a Shipment [Page 75]
- Creating Shipment Documents for Individual Deliveries [Page 76]

See also:

- Shipment Types [Page 15]
-screen info for delivery selection

on this screen you define the selection criteria for selecting deliveries that are to be assigned to a shipment.

you can select deliveries, for example, according to geographical factors, due date, and status of the delivery.

the general term "delivery" stands for deliveries, return deliveries, or inbound deliveries.

how the delivery selection works

when you create or change a delivery, the shipment planning status of the delivery is queried. the shipment planning status indicates the current processing status of the delivery, that is, how far processing has developed so far.

the shipment planning status can have the following settings:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Transportation-relevant, but not yet processed</td>
</tr>
<tr>
<td>B</td>
<td>Transportation-relevant, partially processed</td>
</tr>
<tr>
<td>C</td>
<td>Transportation-relevant, completely processed</td>
</tr>
</tbody>
</table>

for the user to be able to select the delivery, the shipment planning status must have the setting "transportation-relevant".

you can display the shipment planning status as follows:

1. in the shipping screen [ext.], select the activity change outbound delivery.
2. select a delivery.
3. choose goto → header → shipment.
   on the detailed screen for change outbound delivery, you see the status on the tab page shipment in the field transpplingstat.

for more information on the field for the shipment planning status, refer to the f1 help.

if the shipment planning status is "transportation-relevant", you can select the delivery through the shipping screen [ext.] → create shipment.

if you cannot select a particular delivery, go through the items in the checklist.

checklist

- if the shipment planning status of the delivery is not "transportation-relevant", check the following items:
  - if the delivery type is marked as transportation-relevant, proceed to the implementation guide, and, under logistics execution → transportation → shipments → maintain transportation relevance, choose the activity maintain transportation relevance for delivery types [ext.].
  - if a route is entered in the delivery, and the route is marked as relevant for transportation, proceed in the implementation guide under logistics execution → transportation → 
Screen Info for Delivery Selection

Shipments → Maintain Transportation Relevance [Ext.] and choose the activity Maintain transportation relevance for routes.

- No transportation blocking reason may be set in the delivery!
  Choose Change Delivery, and proceed to the detailed screen through the path Header → Shipment. Under the tab page Shipment, you can see whether the field TrBlckResn is filled.

- If a transportation blocking reason is set in the delivery, you can change this in the Implementation Guide by calling up the activity Logistics Execution → Transportation → Shipments → Maintain transportation relevance → Maintain transportation relevance for delivery types.

- If you have an inbound delivery (delivery type EL), the delivery type must be marked in the Implementation Guide as relevant for transportation.

- If you change the Customizing setting after you have created a delivery, you must change and save the delivery. Then the system calculates the status on the basis of the new Customizing setting. Now call up the function Change delivery and save the delivery.

- As soon as you have checked that the transportation planning status is set to "relevant for transportation", you can choose the function Select delivery when creating or changing the shipment.

Check the following points:

- You can assign either deliveries / return deliveries or inbound deliveries to a shipment. A mixture of documents, however, is not possible.
  On the basis of the shipment type that is assigned to a shipment, the system recognizes whether the shipment is incoming or outgoing. To do so, it uses the indicator Completion type, which you can specify in Customizing for shipment type under the following activity: Logistics Execution → Transportation → Shipments → Define Shipment Types [Ext.].
  On the detailed screen of a shipment type, you can set the following processing types through the field Completion type:
  - '1' means Outbound shipment loaded
  You can select deliveries / return deliveries for this shipment.
  - 2 means Loaded incoming shipment
  You can select inbound deliveries.

- You can define selection criteria for a shipment type. In the Implementation Guide, choose Logistics Execution -> Transportation -> Shipments -> Define Shipment Types [Ext.], and then select the field Selection variant in the screen section Proposal on the details screen for Change shipment.

In a selection variant, you can enter values in certain fields and also make them invisible on the screen. This can be useful, for example, if you select deliveries from shipping point 0001. Note that with the selection variant in the example above you cannot select deliveries from shipping point 0002.
Note that the screens for deliveries / return deliveries and inbound deliveries differ from
one another.

Make sure that the transportation planning status is specified correctly. The standard
values are A and B. If you wish to select deliveries that are already fully planned, you
must choose the status *Transportation-relevant fully processed*. Deliveries with the
transportation planning status *Not relevant for transportation* are not selected.

Make sure that you have maintained the goods movement status correctly. If you wish to
select deliveries that are already fully planned, you must choose the status
*Transportation-relevant fully processed*.

If you wish to select return deliveries, deliveries, or both, select the respective radio
button in the type of delivery.

Make sure when you specify several selection criteria that these are linked by an AND
condition, not an OR condition.

Example 1: You have specified ship-to party XY and also entered shipping condition 01.
In the system, however, there are no deliveries with this ship-to party and this shipping
condition. With the criteria you have entered, the system has not found any delivery.
Example 2: In the section "Reference" you have entered shipment number A and order
number B. Through these specifications you want to select all deliveries that are included
both in shipment A and in order B. The system does not select any deliveries that are in
order B, but not in shipment A.

If the system was not able to select deliveries during creation of a shipment, you can display
the selection log. On the overview screen *Shipments and Deliveries*, choose the activity *Edit*
→ *Selection log*.

The following can be possible reasons:

The delivery is blocked by another user.

The delivery does not contain any items.

The delivery does not contain any items relevant for transportation. You can set the
transportation relevance for delivery items in Customizing under the following activity:
*Logistics Execution* → *Transportation* → *Shipments* → *Maintain Transportation
Relevance* → *Maintain transportation relevance for delivery item types*.

The delivery is a return delivery, but (also) contains outbound delivery items. Since the
point of departure and destination are no longer uniquely defined, these deliveries can no
longer be processed in the transportation system.

In the case of return deliveries with reference to an order, note that in the copy control
function in Customizing a copy routine is stored that also copies this indicator from the
order item into the delivery item.

For this purpose, proceed to the Implementation Guide and choose the activity *Specify
Copy Control for Deliveries [Ext.*] under *Logistics Execution* → *Shipping* → *Copying
control*.

The delivery contains return items.

If you have an inbound delivery, the plant in the items must be unique.
Screen Info for Delivery Selection

**Example**

Special selection options for outbound deliveries:

- Selection by status of credit limit check in the delivery selection
  
  During delivery selection you can only select deliveries where the credit limit has not been exceeded. You can also define a selection variant for this selection.

- Selection by picking status
  
  You can define that only deliveries where picking is not yet complete are selected.
Defining Selection Variants for Shipments

Procedure

In the shipment document:
1. Enter the selection criteria that you want to save as a variant on the selection screen.
2. Choose the button for selection options and select the required variant from the list.
3. Enter a code and name for the selection variant.
4. Save your data.

The system informs you that the selection variant with the code you specified in Step 3 has been saved. You can now use this selection variant when you create shipment documents.

In the shipment lists for transportation planning and processing (Transp. Planning, Utilization, Free Capacity, Check-in, Shipment Completion):
1. Enter the selection criteria that you want to save as a variant on the selection screen.
2. Choose Goto \( \rightarrow \) Variants \( \rightarrow \) Save as variant.
3. Enter a code and name for the selection variant.
4. Save your data.
Creating Additional Shipment Documents

Procedure

If you wish to assign the selected deliveries to several different shipment documents, for example, for capacity reasons, you can create additional shipment documents on the overview screen *Shipments and Deliveries*. Proceed as follows:

1. Select the deliveries and choose *Edit* → *Automatic planning* → *Shipment per delivery*. A message appears informing you that a new shipment document with a provisional number has been created.

2. Assign the deliveries to the new shipment document, as required.

3. Save the new shipment document. The system displays the number that it assigned to this document, according to the number range defined for shipment documents.
Moving Deliveries

Use
As long as you have not set the Planned status in a shipment document, you can move deliveries

- From one shipment to another
- Within a shipment
- From a shipment to the screen section

Procedure

Moving Deliveries From One Shipment to Another
To move a delivery from one shipment document to another, you can use the drag-and-drop function or the appropriate pushbutton on the overview screen.

If items or handling units of a delivery are packed into a handling unit of a shipment, the delivery can no longer be removed from the shipment. In such a case, the items or handling units in the delivery must first be unpacked from the handling unit of the shipment. See also: Packing in the Shipment Document [Page 132]

Moving Deliveries Within a Shipment
The delivery sequence in a shipment determines the shipment's itinerary. You can change the delivery sequence in a shipment using the drag-and-drop operation or by selecting the appropriate pushbutton in the overview screen.

Determining the Itinerary
The sequence of deliveries determines a shipment's itinerary. To determine delivery sequences, mark the delivery you want to reposition and choose Move or Assign. Because it can be time-consuming to change the sequence of a large number of deliveries, we recommend using the Itinerary function. Simply call up the function Itinerary.

To change the itinerary, proceed as follows:

1. On the overview screen select the shipment required and go to the screen Overview Shipment.
2. In the screen Stages, choose the pushbutton Leg Determination.
   A dialog box with sort numbers for all deliveries appears on the screen.
3. Either change the delivery numbers manually or choose Delete sort numbers to reenter all the sort numbers.
4. Choose Refresh to re-sort the list of deliveries according to the new sort numbers. The itinerary is changed accordingly.
Moving Deliveries to the Screen Section *Non-Assigned Deliveries*

In some cases, you may want to reduce the weight of a shipment by removing a delivery from the shipment and later transferring it into another shipment document. To do this, you can move deliveries temporarily to the *Non-assigned deliveries* section.

To move a delivery from a shipment document into the screen section *Non-assigned deliveries*, proceed as follows:

1. Mark the delivery or deliveries you want to move on the *Shipments and Deliveries* overview screen.
2. Move the selected deliveries using the drag-and-drop function. The delivery or deliveries are inserted in the *Non-assigned deliveries* section.
3. Save your changes.
Removing Deliveries from a Shipment

Use

You can remove deliveries from a shipment document as long as the Planned status has not been set for that shipment document. There are no restrictions for removing deliveries from the Deliveries not assigned section of the overview screen. When a delivery is removed from a shipment due list, the system determines the transportation planning status anew. Depending on this status, you can select the delivery when you create a new shipment.

Your customer postpones the delivery date for a certain delivery. The delivery has already been assigned to a shipment. The planned status has not yet been set for the shipment, so you can remove it from the shipment. The transportation planning status is reset to A (not yet planned). The delivery is included in a later shipment.

Procedure

To remove a delivery from a shipment, use the Drag & Drop operation or press the key Remove delivery from shipment.

Result

The deliveries are removed from the shipment. The transportation planning status for this delivery is determined anew by the system.
Creating Shipment Documents for Individual Deliveries

Use
To plan and process individual deliveries in a shipment using separate shipment documents (FTL (full truck load) or FCL (full container load) transactions, for example):

Procedure
1. Select the deliveries for which you wish to create a separate shipment document.
2. Choose Edit → Automatic planning → One dlv. one shipment.
   A message appears informing you how many new shipments have been created and what provisional numbers have been assigned to them.
3. Save your data.
   The new shipment documents are saved and assigned numbers.
Planning Proposal

Use

The planning proposal enables you as the material requirements planning (MRP) controller to simplify your manual planning. As you create or change shipments manually, the planning proposal gives you default profiles, which include “rules” that automatically create shipments and fill them with data. You can still make manual changes to the planning proposal during processing, unlike collective processing for shipment creation, where you cannot influence processing manually.

Features

You can save the selection criteria that you use for collective processing for shipment creation as a selection variant. You can also save combination criteria that you have maintained as a combination profile and save the data that is used to fill the shipment as a data profile. You can then access these profiles as you carry out collective processing for the automatic creation of shipments, for example. You can also save settings, selection criteria, combination criteria and data together in one planning profile. Technically, the planning profile is a variant of collective processing for shipment creation. A planning profile can be assigned to a shipment type.

If you select a planning proposal while you are creating shipments manually, a dialog box containing that planning proposal with its corresponding data appears, provided a planning proposal was assigned to the shipment type. All default values in the dialog box can be changed except for the basic data (transportation planning location and shipment type), since you just entered that data in the initial screen for creating a shipment. When you choose Execute, the selected deliveries are automatically put together in a shipment and filled in with data, according to the specifications you just made. If errors or warnings occur, they are recorded in a log.
Subsequent Delivery Split in Shipments

Use

During shipment processing it is often necessary to split a delivery up into two or more shipments because they do not all fit on to one truck, for example. However, since it is not possible to assign deliveries to shipments item by item, there is a special function called **Subsequent Delivery Split**. You can carry out a subsequent split either in **outbound deliveries [Ext.]** or in shipments. The following are a few examples in which a delivery split would be necessary:

- A customer's purchase order cannot be transported in a single shipment (for example, 100 tons of coal per truck; delivery would have fitted into a 30 foot container, but there is only a 20 foot container available).
- No suitable means of transport is available when transportation planning takes place.
- Estimates based on SAP System calculations are not appropriate for the actual situation.

In the first example, the delivery split could take place as the delivery is being created; in the second and third examples, the delivery split would happen after the delivery was created (during loading or transportation planning).

Prerequisites

So that you can use the functionality of the subsequent delivery split, you need to configure the respective settings for the activity **subsequent delivery split [Ext.]** in the Implementation Guide under the path Logistics Execution → Shipping → Deliveries. Pay attention to the conditions that are listed under the heading “Prerequisites”.

A delivery split is only allowed, for example, if the delivery has a particular status. This means that, for example, no goods movement, no invoice, and not pick quantity pending confirmation (at least for the split quantity of an item) may exist. The shipment must also be fully processed already.

The type of split is controlled through a **Split Profile** that you define in Customizing and assign to the shipment type. You store a profile for the delivery split **before** planning and **after** planning. Whether or not the split deliveries remain in the shipment depends on your Customizing settings:

- **before planning**: Already when you are making up the shipment, you know that the delivery needs splitting. The **split results** and the **split remainder** remain in the shipment.
- **after planning**: Already when you are loading up the means of transport you determine that the delivery needs splitting. In the case of a **loading ramp split**, the split results are removed from the shipment.

Features

You can use the **Subsequent delivery split** function to divide up a delivery that does not fit into one shipment and redistribute parts of that delivery to two or more shipments. You can split deliveries on the **Shipments and Deliveries** overview screen of the Create Shipment or Change Shipment transaction.

You can also split handling units, delivery items, and partial quantities of delivery items. You always have the option of running a simulation of the split beforehand.
During the subsequent delivery split, the system checks the status (no goods movements or billing documents, for example), confirms characteristics (delivery groups and correlation), copies data (texts), calculates attributes (volume and weight) and executes output determination.

The split result controls which delivery items are grouped together in the same delivery. All remaining items make up the split remainder.

Activities

You are now on the overview screen for Shipments and Deliveries. Select a delivery, choose the pushbutton Split deliveries, and break up the respective quantity. While saving the shipment, the system automatically generates further outbound deliveries for the split quantities (split results). Whether or not the split deliveries remain in the shipment depends on your Customizing settings.

The system checks whether the delivery contains items that have not been packed. If all items have already been packed, they must be unpacked (from the packing screen). If the delivery contains items that have not been packed, you can define how the delivery is to be split. You can enter as split quantity the quantity displayed under Non-packed quantity, as maximum.

One delivery can be split into several deliveries. You can use the result number to control the combination of deliveries that are involved in the split. If you assign the same result number to delivery items in one delivery, these items will remain together in the delivery after the split. If delivery items have different result numbers, the split distributes them among several deliveries (split results). Result numbers are only ever valid for one delivery at a time. In other words, the same result numbers can be assigned in splits of different deliveries. Entire deliveries cannot be combined by assigning the same result number. Combination by assigning the same result number is only valid for items, as described above.

The split produces one split remainder and one or more split results with temporary delivery numbers.
Subsequent Delivery Split in Shipments

If a delivery was assigned to a shipment before it was split, you must indicate whether the split result(s) should remain in the shipment or whether the split remainder should be assigned to the shipment instead and the split result(s) should be assigned to Deliveries not assigned. If the delivery was not assigned to a shipment before the split, both the split remainder and the split result(s) are not assigned. If the shipment is saved, the split results and split remainder are also saved. For more information, refer to the section Executing Subsequent Delivery Split [Ext.].

Please note the following points regarding delivery splits:

- Delivery items that are packed into a single shipment item cannot be split.
- The delivery-item quantity that is to be split cannot be larger than the quantity of that item that is not packed.
- Automatic delivery splits cannot be used for mass changes.
- A shipment transaction that is running can either be split or packed, but not both.
- In a transportation chain, there is no difference made between the preliminary leg, main leg, and subsequent leg during the delivery split. Depending on your Customizing settings for the current shipment type, the split results and the split remainder are also assigned in the background for all the other shipments to which the delivery is assigned, or this assignment is deleted.
- The delivery split is no longer possible after shipment completion.
Using Collective Processing to Create Shipments

Use

This function lets you create shipments automatically in the system (either in the foreground or background). You can define simple rules as to how deliveries are to be grouped into shipments.

You can use collective processing to:

- Create individual shipments
- Create collective shipments
- Create Full Truck Loads (one shipment per delivery)
- Create parts of a transportation chain
- Create entire transportation chains
- Define field groupings that can then be used as individual criteria

(You could, for example, define shipping points 1 and 2 as a group if they are near each other in the same geographical area. You can still use a shipping point as a criterion. It is, however, possible to transport deliveries from shipping points 1 and 2 together, because of the grouping you have just defined.)

You can also use groupings to define the order of deliveries within a shipment (according to zip code, transportation zone, etc.).

Integration

You can use collective processing for both inbound and outbound shipments. This way, you can combine inbound deliveries generated in purchasing or deliveries generated in sales and distribution into shipments.

Features

Collective processing normally entails three steps:

- Definition of selection variants
  Define which deliveries are to be considered in the creation process. The same selection criteria as those in the individual creation process can be used here.

- Definition of grouping criteria
  You can define which fields in the deliveries must be identical so that those deliveries can be grouped together into one shipment. You can also define in which order the deliveries appear in the shipment and enter capacity limits for those shipments that are to be considered. To define grouping and sort criteria, you can choose from over 80 delivery header fields in the field catalog.
Using Collective Processing to Create Shipments

- Set default shipment data

  You can define shipment data, such as forwarding agents or deadlines, that should appear in each shipment you create.

  When you create transportation chains, the system copies dates and times from the preliminary leg into the main leg. For example, the loading end time in the preliminary leg is automatically copied into the main leg as the loading start time.
Creating Shipments with Collective Processing

Procedure

1. From shipment [Ext.], choose Create → Collective Processing.

   A screen appears on which you can define how the collective processing for the creation of shipments should be carried out.

2. Enter which kind of shipments (inbound or outbound) you want to create in the Default settings section.

   Among other things, this entry controls which selection variants you can use to choose deliveries. One of the variants that is used to select inbound deliveries may not be used for outgoing shipments, for example.

3. Enter which outbound (or inbound) deliveries are to be processed in this collective shipment in the Select deliveries section of the screen.

   You can also enter the name of a selection variant that you may have already created, for example, for the creation of individual shipments (transaction VT01). You can either enter the name of this selection variant here or choose it from the list of possible entries in input help. You can display and change the content of this variant by choosing Maintn (to the right of the field).

   You may also create a new variant. Simply enter the name of the new variant and choose Maintn. The selection screen for selecting deliveries then appears. Specify the criteria according to which you want to select deliveries. For example, you would enter here that all deliveries that have route 000001 (north route) or 000002 (west route) should be selected.

   The Selection variant field is a mandatory entry field and therefore must contain a name.

4. Enter the rules according to which the selected deliveries should be divided into shipments in the Grouping criteria field in the Rules section of the screen.

   As with the Selection variants field (see point 3), you can enter the name of a variant that defines the rules for grouping deliveries into shipments in this field. For example, you could specify that all deliveries with the same shipping point and route should be grouped together into one shipment. You can further specify that these deliveries are to be sorted according to the ship-to party’s zip code and that the shipment may weigh no more than 30 tons.

   The Grouping criteria field is optional. If it is left blank, all deliveries that are selected are assigned to one shipment.

5. In the Data and options field in the Rules section of the screen, you can specify which data should be found in the shipment documents you create (transportation planning point, shipment type, service agent, route, etc.) and which functions should be carried out (leg determination, set status to planned, etc). As with the other fields, you must either enter the name of a variant or create a new variant here.

   This field is a mandatory entry field and therefore must be filled in.
6. Enter whether or not the system should save the shipment if errors or warnings occur in the
   Save created shipments part of the screen.

   Some errors prevent a document from being created. For example, you cannot
   create a document with a shipment type that does not exist. Other errors or warnings
   do not necessarily indicate an inconsistent document, but the system indicates that
   you may want to reconsider creating the document in its current state. For example,
   you may not want to create the document if leg determination could not be carried
   out, if the service agent could not be transferred from the delivery or if the maximum
   weight has been exceeded.
   Indicate here whether the system should save shipments if one of the above-
   mentioned minor errors occur. If you choose Do not save if warning/error, shipments
   will only be created when all necessary data was entered (when no corrections are
   necessary).
   If you choose Do not save if error, a shipment is created in spite of any warnings that
   occur. As a result, a few corrections may be necessary after the document is
   created.
   If you choose Simulation (do not save), you are only running a test process to see if
   errors would occur.
   If you choose Always save data, the document is always saved, even if errors or
   warnings have occurred. In this case, we recommend that you check the document
   manually.

7. Indicate whether you want a log to be created and how detailed it should be on the Log
   portion of the screen.

   For example, if you indicate that the log should not be saved, it is displayed at the end of
   collective processing, but disappears after the transaction is finished. Only errors, warnings
   (invalid service agent, etc.) and important messages (“Shipment 1013 was created”) are
   included in the normal log. The detailed log also contains information about partial functions
   that were carried out successfully (“Leg determination was carried out,” for example). The
   very detailed version of the log also includes technical information (“Stage with key
   1013/0004 was created,” for example).

8. Choose Execute.

Result

The log that lists the collective processing results is then displayed after collective processing
has been carried out.
Creating Transportation Chains with Collective Processing

Prerequisites

Within collective processing, you can also define that a transportation chain consisting of multiple shipment documents should be created. For example, all deliveries you select (outbound shipments, for example) are grouped together into main leg, preliminary leg and subsequent leg shipments. The selected deliveries are then processed as the system makes multiple runs through the transportation chain.

Procedure

1. From Transportation [Ext.], choose Create → Collective Processing.

2. Choose Create transportat. chain.

You can define for each run which grouping criteria should be valid and what data the runs (individual shipments within the transportation chain) should contain. This data fill-in process is similar to the one that occurs when you create collective shipments. See also Creating Shipments with Collective Processing [Page 83].

All deliveries should first be packed onto a main leg shipment, which goes by rail from Frankfurt to Hannover. So, you enter a variant that contains the transportation planning point, shipment type, service agent and route for this rail shipment in the Data and options field found in the 1st run (create main leg shipments) part of the screen. Leave the Grouping criteria field blank, since all deliveries in one shipment should be grouped together. In the second run, all deliveries are distributed among the corresponding preliminary leg shipments that lead from the shipping point to the train station in Frankfurt. Create a variant that contains the shipping point as one of the grouping criteria in the Grouping criteria field. Also specify that one shipment can hold a maximum of 30 tons. Enter a variant that contains the transportation planning point, shipment type, etc. for the preliminary leg by land in the Data and options field. Then specify that leg determination should also be carried out. In the third run, subsequent legs are created in the same way as preliminary shipments.

The dates from the preliminary leg are transferred automatically to the main leg: The load finish date from the preliminary leg will be the load start date in the main leg, for example.
Reports for Transportation Planning

Use

For transportation planning, there are three reports available that you can call up to select shipments:

- Select Shipments: Planning [Page 88]
- Select Shipments: Utilization of Capacity [Page 91]
- Select Shipments: Free Capacity [Page 93]
Shipment Execution Monitor

Use
The monitor gives an overview, grouped by status, time, and date, as to how much workload exists. In this way, the transportation planner can react quickly to situations and also have a complete overview of the overall status of all shipments.

For example, a transportation planner can view the workload during a particular shift and react to the situation as it arises. In this way, the work can be distributed more evenly.

In addition, the transportation manager has a type of control function for the current processing status.

Features
You can display the different statuses for shipment processing for an entire period by calling up the path Logistics Execution → Transportation → Transportation Planning → Lists and Logs → Shipment Processing Monitor. This period can be either the current day or a complete week. The number of shipments is listed by status.

Also, you can specify threshold values for the number of found documents for each status in the selection criteria for the report. If these values are exceeded, this is displayed in color on the monitor list. Shipments that have not been processed by the time specified by the transportation planner are marked. You can process shipments immediately by branching into the change function.
Select Shipments: Planning

Use

You can use this report to list certain shipments that match your selection criteria. You can use the list of shipments that the system has generated for information purposes, or you can use it to execute planning activities for the shipments concerned.

Features

Selection Screen

You can compile the transportation planning list by entering selection criteria. You can control which fields appear as selection criteria on the selection screen. The initial criteria displayed in the selection screen are taken from the list settings in Customizing for Transportation. For information on changing these settings, see the section entitled Maintain standard selection variants for shipment list in the Implementation Guide.

List Screen

You can select from two different views on the list screen. One contains general shipping information about the selected shipments. The second view contains information on planned and actual deadlines for individual shipments and the status of planning activities. You can access each shipment document directly from the list to complete planning activities. In the Planner list, you can select several shipments and process these at the same time (the only limitation being that the shipments must have the same shipment type and the same transportation planning point, and must not have the same deliveries).

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Processing

From this list you can branch directly to the selected shipment documents in order to execute changes in the shipments and perform shipment planning activities. If required, you can assign deliveries here or change a service agent. You can also call up the function for collective change if you wish to change several documents. For more information, refer to the Mass Shipment Changes [Page 130] section.

Example

A planner may use this report to display a list of all shipments to be planned or scheduled. He or she can also use this report as a worklist. For example, he or she enters, as selection criteria, the total shipment status 0 (= in planning), the transportation planning point, the planned check-in date, and the shipment type Truck, since this planner is responsible for planning of shipments by truck.

See also:

Creating Transportation Planning Lists [Page 90]
Creating Transportation Planning Lists

Procedure

To create a transportation planning list, proceed as follows:

   You then come to the Shipment List: Planning screen.

2. To use other selection criteria, choose Edit → All selections.
   
   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.

3. Enter the criteria you want to use for selecting the shipment document.

4. Choose Program → Execute.
   
   You obtain a list of all the shipment documents that match your selection criteria.

For more information about processing this list, see Editing Shipment Lists [Page 57].
Select Shipments: Utilization of Capacity

Use

This report enables you to combine shipments as efficiently as possible by allowing you to enter, in the selection screen of the list, the percentage of weight and volume for shipment utilization for the shipments you wish to display. For this purpose, you specify the packaging material type and the percentage rate of shipment utilization with respect to weight or volume allowed for the handling units in the shipment and for the specified packaging material type. Using this report you can determine which shipments are not utilized to the full extent and are therefore to be considered “inefficient”; on the basis of this information you can then take appropriate measures, for example, by assigning additional deliveries.

Features

The system selects all those shipments whose weight or volume percent of utilization is equal to or less than the level you specify in the selection screen. You can select two different views on the list screen. The first view contains exact details on the percentage of the shipment capacity utilized in terms of weight and volume as well as general data, such as the transportation planning point, shipment type, and forwarding agent. The second view contains the deadline specifications. The functions are the same as those provided for transportation planning.

Processing

From this list you can branch directly to the selected shipment documents in order to execute changes in the shipments and assign additional deliveries to the shipments.

Example

A planner wants to find out how the planned shipments are utilized so far, that is, shipments that are planned, but not yet finally scheduled. In addition to the standard selection criteria (shipment type, total status of shipment, planning final date), the planner can specify the packaging material type Truck, and a maximum weight utilization of 70%.

See also:

Editing Shipment Lists [Page 57]
Creating Utilization Lists [Page 92]
Creating Utilization Lists

Use
To create a worklist for transportation planning that displays shipments that are not utilized to full capacity, proceed as follows:

Procedure
1. In the Shipment [Ext.], choose List → Utilization.
   You then see the screen Shipment List: Utilization.
2. To use other selection criteria, choose Edit → All selections.
   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.
3. Enter the criteria you want to use for selecting the shipment document. Here you specify the utilization rate in percentage (between 0 and 100) with regard to the weight and/or volume allowed for the shipment units in the shipments and for the packaging material type involved.

   The system calculates the utilization degree (that is, remaining capacity that can be used) on the basis of the packaging material type you have specified. Only handling units that were created in the shipment (not in the delivery) and for which the corresponding values (such as allowed weight) have been maintained are taken into account. If you do not specify a packaging material type, the packaging material at the highest level of the packing hierarchy is used automatically. For further information, see the help text for the field PackMatltype.

4. Choose Program → Execute.
   The system lists all shipments that match your selection criteria and have a weight or volume utilization less than or equal to the percentage specified.

You can find more information on processing these lists in Editing Shipment Lists [Page 57].
Select Shipments: Free Capacity

Use
You use this report to find another shipment with sufficient capacity for an existing package. Along with other selection criteria, you specify the weight and volume of the package to be packed and you also specify whether it can be split up among several handling units.

Features
The system selects all those shipments with a remaining usable load that is equal to or greater than the value you specified in the selection criteria. You can select two different views on the list screen. The first view contains exact details on the percentage of the shipment capacity utilized in terms of weight and volume as well as general data, such as the transportation planning point, shipment type, and forwarding agent. The second view contains the deadline specifications. The functions are the same as those provided for transportation planning.

Processing
From this list you can branch directly to the selected shipment documents in order to execute changes in the shipments. For example, you can assign the delivery of the package still to be shipped to a particular shipment.

Example
A planner still has one pallet with a volume of 2 cubic meters; he/she would like to assign this pallet to a shipment that has already been created, but is not yet fully scheduled. The planner therefore enters, in addition to the standard selection criteria (transportation planning point, shipment type, planned final date), the packaging material type *Pallet* and the volume to be packed. Also, he or she specifies the shipment route. Then the system generates an overview of all shipments that are planned for the route specified and still have capacity to include the pallet. The planner can choose a suitable shipment and assign the respective delivery to it.

See also:

[Editing Shipment Lists](Page 57)
[Creating Free Capacity Lists](Page 94)
Creating Free Capacity Lists

Use

To create a list for transportation planning with the shipments that still have the available capacity you need, proceed as follows:

Procedure

1. Choose Environment → Planning → Free capacity on the Transportation screen [Ext.].
   You then come to the Shipment List: Free Capacity.
2. To use other selection criteria, choose Edit → Selection Options.
   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.
3. Enter the criteria you want to use for selecting the shipment document. Specify the weight or volume of the freight goods to be packed.
   The system calculates the capacity (for example, remaining load) on the basis of the packaging material type that you specified. Only handling units that were created in the shipment (not in the delivery) and for which the corresponding values (such as allowed weight) have been maintained are taken into account. If you do not specify a packaging material type, the packaging material at the highest level of the packing hierarchy is used automatically. For further information, see the help text for the field PackMatltype.
4. Choose Program → Execute.
   The system lists all shipments that match your selection criteria and have free capacity greater than or equal to the capacity specified in the selection screen.

For more information about processing this list, see Editing Shipment Lists [Page 57]
Automatic Leg Determination

Purpose

Automatic leg determination is an easy-to-use function that simplifies manual leg creation, or even eliminates the need for it. It does not involve optimization algorithms and also has no “geographical intelligence”.

Automatic leg determination creates legs using simple rules that determine point of departure and destination as well as some leg data (service agent, shipping type, leg indicator, and shipment cost relevance for the leg).

The result of automatic leg determination is determined by different parameters you have set; this allows you to simulate various business scenarios.

The most important parameter is the type of leg determination, which can have five characteristics. For more information, see Leg Determination Categories [Page 103].

The following data is taken from the shipment document:

- Deliveries in the shipment (departure point, destination, sequence)
- Existing shipment legs (for example, created through the route that was entered in the shipment header)
- Shipment header: Service agents
- Shipment header: Shipping type
- Shipment header: shipping type preliminary leg (this field is not always available for entry)
- Shipment header: Shipping type subsequent leg (this field is not always available for entry)
- Shipment header: Leg indicator

Process Flow

Leg determination is generally executed as follows:

1. The system checks whether leg determination can be carried out. Leg determination cannot be carried out, for example, if the leg determination type is set to ‘_’ (blank), if there are no deliveries in the shipment, or if the shipping types mentioned above have not been filled in (see step 6 for more details).

   In this case, the system responds with a message.

2. The system analyzes the deliveries in the shipment. What is the point of departure and the destination for the deliveries?

   A delivery can go from shipping point ‘0001’/ loading point ‘01’ to customer ‘123’ unloading point ‘ramp 15’. A return goes the opposite way, however. An inbound shipment goes from vendor ‘456’ to plant ‘0005’ to storage location ‘0004’.

   Warehouse number and door are also taken into account where necessary.
Places (departure points and destinations of deliveries or of a leg, etc.) are given a unique identification number during leg determination; this number is then used in further processing. See also Identification of Places [Page 101].

3. The system analyzes the stages that exist in the document as they relate to the following questions: Which stages are legs, border crossing points, or load transfer points? How were they created (did they come from a route, were they entered manually, or are they from a previous leg determination run that was changed later, and so on)? This information is important, since leg determination can calculate legs connecting to a route (or manual legs).

You can display the history of a leg on the stage detail screen. For this purpose, select Management in this screen. You can tell which route a leg originated from and whether it was created manually or automatically.

4. The system checks to see if this shipment is part of a transportation chain. This information can be determined from the leg indicator in the shipment header (not to be confused with the leg indicator in the leg of the shipment).

<table>
<thead>
<tr>
<th>Leg indicator</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘4’ (direct leg) or ‘5’ (return leg)</td>
<td>The entire shipment process appears in one shipment document. The shipment document is not related to any other shipments.</td>
</tr>
<tr>
<td>‘1’ (preliminary leg) ‘2’ (main leg) or ‘3’ (subsequent leg)</td>
<td>This shipment is part of a transportation chain that is reflected in multiple shipment documents.</td>
</tr>
</tbody>
</table>

This information is important because, as in the case of a preliminary leg shipment, for example, the deliveries are not to be delivered directly to the customer, but to another destination where they are then transferred to the main shipment.

A delivery is brought by truck from shipping point ’0001’ to Hamburg harbor as a preliminary leg shipment. The delivery is loaded onto a ship in Hamburg harbor. The ship then transports the delivery from Hamburg harbor to New York harbor (main leg). The delivery is then transferred once again and is shipped by train to customers in Chicago (subsequent leg).

For the preliminary shipment, the destination is not the customer in Chicago, but Hamburg harbor. A dialog box appears during leg determination that asks you to enter the destination. If the main leg shipment was created beforehand in the system, Hamburg is automatically taken as a default. If a destination was entered, the original destination is replaced by the new one in all deliveries. If this does not occur, leg determination is terminated.

The same is valid for a subsequent leg shipment (leg indicator value ‘3’ in the shipment header), except that the point of departure for the deliveries is replaced by the destination harbor from the main leg, as an example.

5. The system now carries out the actual leg determination. For more information, see Leg Determination Categories [Page 103]. A certain number of legs that must still be filled in with data appear.

6. The system fills the legs it created with data. If there are legs that were entered or modified manually beforehand, their data is directly transferred.
If new legs are involved, the following data is re-determined:

- Service agents in the leg
  (copied from the shipment header)
- Shipment cost relevance for the leg
  (default triggered by the shipment type)
- Leg indicator
  If a preliminary shipment is concerned, the leg also gets this indicator (the same applies to subsequent shipment). If only one leg exists or if the leg links the delivery departure point directly to the destination, the leg is a direct leg. For all other shipments, the following applies:
  If leg departure point = delivery departure point, then preliminary leg
  If leg destination = delivery destination, then subsequent leg
  If both apply = main leg
- Shipping type for the leg
  (copied from the shipment header)

**Exception:** In leg determination types '2' to '4', the shipping type preliminary leg is copied to preliminary legs and shipping type subsequent leg is copied to subsequent legs. In this case, these two shipping types can be maintained in the shipment header (on the Control tab page) and are suggested from the shipment type.

If no shipment type can be determined for a leg, the shipment type is not created. This characteristic can be used to better illustrate certain scenarios (for example, it could make sense to give the subsequent legs lower priority in the shipment since they are not important).

7. The border crossing points and load transfer points taken out in step three are replaced. The system attempts to place them correctly.

There are two existing legs from A to G and from G to B. The border crossing point G is placed between the two legs.

8. Finally, the assignments of deliveries to stages are determined. For more information, see Automatic Assignment of Deliveries [Page 99].

Step 8 is the only step carried out during leg determination of type '0'. This means that no legs at all are determined. This may be useful if you want to enter all legs manually (if a scenario is very complicated, for example), but an automatic assignment of deliveries to stages should occur at the very least.

If the standard leg determination does not meet your needs, you can activate a customer enhancement (enhancement 'V56SLDET'), in which you can create your own leg determination.
Automatic Leg Determination

See also:

Automatic Assignment of Deliveries [Page 99]
Identification of Places [Page 101]
Leg Determination Categories [Page 103]
Executing Automatic Leg Determination [Page 105]
Automatic Assignment of Deliveries

Use

It often happens that the deliveries in a shipment are only to be assigned to a few rather than all stages of the shipment. This function is useful if a shipment stops at various locations, unloading or loading goods along the way, for example. In such a situation, not all deliveries would be included in each stage of transportation.

The system provides an algorithm that attempts to determine these assignments automatically to save you from having to do so manually.

Prerequisites

This algorithm is triggered automatically in the following circumstances:

- When a route is entered in the shipment header
- After you carry out leg determination with category '0' to '4' (leg determination category '0' initiates the assignment determination process only).

Features

Assignment determination is carried out as follows:

1. The system analyzes the point of departure and destination for each delivery, one after the other (see also step 2 in Automatic Leg Determination [Page 95]).

2. If the point of departure of this delivery is found among the departure points of the existing legs and the destination is found among existing destinations, the system then looks for the legs that connect these two locations.

   If the legs are incomplete (that is, if there are gaps between them), the delivery is assigned to all legs that start at the beginning point and also to all those that end at the destination.

3. If only the departure point exists in the system, the system assigns all adjoining legs to the delivery.

4. If only the destination exists in the system, all adjoining legs are assigned to the delivery (in other words, similar to step 3, only backwards).

5. If neither the departure point nor the destination exists in the system and if the delivery is a preliminary leg shipment or subsequent leg shipment, it is assigned to all legs. All other shipments with no departure point or destination in the system are only assigned to main legs. If this does not work either (because the leg indicator is not maintained, for instance), the deliveries are assigned to all legs that were created manually.

6. Now the system assigns the deliveries to border crossing points and load transfer points. The system then also checks which legs start or end at border point G, for example. All deliveries that are found in these legs are assigned to this border crossing point, since all deliveries that are shipped to this border crossing point must most likely go through customs.
Automatic Assignment of Deliveries

Only deliveries that are to be loaded or unloaded at this point or those whose shipping type or service agent changes (meaning that they must be transferred) are assigned to a load transfer point.

If there are no legs that begin or end at this point, the system assigns all deliveries to this point.
Identification of Places

Use

During leg determination (and also as assignments of deliveries to stages are being determined), various locations must be compared to one another at many points in the component. In other words, the system checks to make sure the location defined is the same physical location that exists in the system.

This can sometimes be rather difficult, since one location can appear in the system in various ways.

A customer with the number ‘ABCD’ is created in the system. This customer’s address is Mr. Smith, 1200 Main Street, Anytown, USA 90018. A transportation connection point that refers to this customer has been entered in Customizing. A one-time customer with the same address was also entered (the same customer called up to order an express shipment and could not remember the customer number from previous orders, for example). All three of these entries describe the same physical location and should be identified as such.

Delivery 1 has a destination of customer ‘ABCD’, unloading point ‘dock door 29’; but delivery 2 has customer ‘ABCD’ and unloading point ‘dock door 1’ as its destination. These are most likely two distinct physical locations. In this case, the truck needs to go to both dock door 1 and dock door 29 at this customer’s warehouse.

Features

Location entries are analyzed by the system as follows:

The system takes the address and other important data from the location description:

- Location description:
  - Loading point at the shipping point
  - Customer’s unloading point
  - Storage location at the plant
  - Warehouse number
  - Door for the warehouse number
  - Additional information
- Address:
  - Name 1
  - Location
  - Zip code for location
  - Zip code for the post office box
Identification of Places

- Company zip code (for major customers)
- Street
- Street number
- Post office box
- Location of the post office box
- Transportation zone
- Country key

If this data is identical for two location entries, the system assumes that they are the exact same location. (Technically speaking, the system assigns a temporary number within the program for this identification. This number is then also assigned to every location that is identified with the same entries.

If this method of location comparison is not sufficient for your business scenario (if you would also like to include a phonetic comparison to allow for typing errors, for example), you can modify the analysis to fit your needs using customer enhancement 'V56LOCID'.
Leg Determination Categories

Use
The basic procedures are described in Automatic Leg Determination [Page 95].

Prerequisites
In the Customizing [Ext.] application, you can define for the shipment type (Parameters for ‘Determine legs’) how leg determination should be carried out.

You can also display this information on the overview screen of the shipment document (Control tab).

Features
The R/3 System supports the following categories of leg determination:

- Leg determination ‘’’ (blank):
  The system does not perform leg determination.

- Leg determination ‘0’:
  The system does not perform leg determination, but the assignment of deliveries to stages is determined. (See also Automatic Assignment of Deliveries [Page 99].)

- Leg determination ‘1’
  Legs are determined according to the itinerary (order of deliveries) in the shipment document.
  This type of leg determination is used for collective shipments in which the goods are picked up at individual shipping points in a certain order and then delivered to individual ship-to parties in a certain order.

- Leg determination ‘2’
  A type of leg determination in which a preliminary leg is created for each starting point and a subsequent leg is created for each destination point.
  This type of leg determination is used for transporting deliveries that are to be sent by sea in a group, but originate from different shipping points or are to be transported to different ship-to parties.

- Leg determination ‘3’
  A type of leg determination in which a preliminary leg and a subsequent leg are created for each delivery.
  This leg determination type is used for transporting extensive amounts of goods that must be distributed among multiple deliveries because one delivery would not offer enough capacity.

- Leg determination ‘4’
  This type of leg determination is similar to type ‘1’ except that shipment types for preliminary and subsequent legs (which you can enter in the shipment header) are taken into consideration. This way you can suppress certain preliminary or subsequent legs.
Leg Determination Categories

Each type of leg determination is described in detail in the following sections:

Category 1: According to the Itinerary [Page 107]
Category 2: Preliminary/Subsequent Leg for Point of Departure/Destination [Page 109]
Category 3: Preliminary and Subsequent Leg for Each Delivery [Page 111]
Category 4: With Shipping Type for Preliminary Leg and Subsequent Leg [Page 114]
Executing Automatic Leg Determination

Procedure

The following options are available for initiating automatic leg determination:

- Set the Planned status on the screen Overview Shipment in the shipment document. After setting the status, choose the tabstrip Control to check the results of leg determination.
- Choose the pushbutton Leg determination on the tabstrip Stages.

Result

The system calculates the shipment legs based on the leg determination indicator for the shipment document type. It takes into account the shipping points and ship-to parties in the deliveries, as well as the shipping type, the leg indicator, and the route (if you have defined one). If your shipment is part of a transportation chain, the system also takes this into consideration.

If you have leg determination category 1 or 4, the system displays a dialog box in which you can modify the sequence of the relevant locations. This dialog box always appears if you execute leg determination on the overview screen for the stages. However, if you set the status planned for the general header data (this means that leg determination will be initiated), this dialog box only appears if absolutely necessary (for more information, refer to the descriptions for the individual leg determination types).
Examples of Automatic Leg Determination

The following sections briefly describe business scenarios for the various types of automatic leg determination:

Category 1: According to the Itinerary [Page 107]
Category 2: Preliminary/Subsequent Leg for Point of Departure/Destination [Page 109]
Category 3: Preliminary and Subsequent Leg for Each Delivery [Page 111]
Category 4: With Shipping Type for Preliminary Leg and Subsequent Leg [Page 114]
**Category 1: According to the Itinerary**

Leg determination category 1 generates a sequence of locations that links together the departure points and destinations for the deliveries without gaps.

The system proceeds as follows:

1. The system connects the departure points of the deliveries onto one another (Example: the truck drives from shipping point 0001 to shipping point 0002, then to shipping point 0003). The sequence is set in such a way that the deliveries that need to be unloaded first at the customer are loaded onto the truck last.
   
   **Exception 1:**
   
   The shipment document already contains manually entered legs (all manually created legs and legs that originate from a route). If the departure point of a delivery is already mentioned in these legs, it must be included here once again.

   **Exception 2:**
   
   If you have already specified a particular sequence through a previous leg determination, the system will take this.

2. The system now connects up all the manual legs.

3. Finally, all the destinations of the deliveries are connected up. The sequence matches the sequence of the deliveries in the shipment (the so-called itinerary).

   **Exception:**
   
   If a target location is already mentioned in the manually created legs, it is not added on to the leg, but omitted.

You can modify the sequence of locations determined in this way in a dialog box. This can be important, for example, if the truck should not to drive to all the shipping points first, the reason being that there are customers on the routes between the shipping points, and these need to be driven to. This dialog box always appears if you execute leg determination on the overview screen for the stages.

However, if you set the status *Planned* for the general header data (this means that leg determination will be initiated), this dialog box only appears if absolutely necessary. This is usually the case if the general data is not unique or has inconsistencies. In this way, expedient processing is not hindered by a superfluous dialog box.

The 5 deliveries in your shipment depart from shipping point 0001, 0002, and 0003. The system cannot know the sequence in which these should be driven to (since the sequence of the deliveries only defines in general the sequence in which the destinations, that is, the customers, should be driven to). In this case, a dialog box appears.

The deliveries in your shipment specify a particular itinerary (for example, first to customer K1, then K2, K3, and so on).
Category 1: According to the Itinerary

If you have also specified a route in the shipment, and the transportation connection points of this route also point to the customers, then it could be that a different sequence was specified in the route. In this case, the system needs confirmation regarding which itinerary is to be taken (the system proposes the itinerary given in the route).

Now the system generates legs from the sequence of locations defined (for example, A, B, C, D).

The legs that were created are filled in with data in accordance with step 6 in Automatic Leg Determination [Page 95], and border points and load transfer points, as in step 7.

Finally, the system determines which deliveries are assigned to which legs. See also Automatic Assignment of Deliveries [Page 99].

You have created a shipment document that contains three deliveries. The deliveries are to be picked up from two different shipping points and delivered to three different ship-to parties. The deliveries are listed in the following sequence in the shipment document:

<table>
<thead>
<tr>
<th>Delivery</th>
<th>Shipping point</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>San Francisco</td>
<td>Denver</td>
</tr>
<tr>
<td>2</td>
<td>San Francisco</td>
<td>Dallas</td>
</tr>
<tr>
<td>3</td>
<td>Phoenix</td>
<td>Oklahoma City</td>
</tr>
</tbody>
</table>

On the basis of the sequence of the deliveries in the shipment document, the system creates a main leg from Phoenix to Denver, one preliminary leg from San Francisco to Phoenix, one subsequent leg from Denver to Dallas, and a second from Dallas to Oklahoma City. The illustration shows how the deliveries are assigned:

If the manually specified leg management has gaps, these are now closed.
Category 2: Preliminary/Subsequent Leg for Point of Departure/Destination

This type of leg determination forms a preliminary leg for each point of departure and a subsequent leg for each destination point. It can be used if a transportation chain is to be set up within a shipment document.

For example, multiple trucks leave from different shipping points to take deliveries to a harbor, where they are to be loaded onto the ship. The ship then carries the deliveries to the destination harbor, where they are once again loaded onto multiple trucks to be delivered to different customers. During this process, the system assumes that only one truck is needed between each departure point and destination point (Less Than Truckload - LTL).

Only preliminary, main and subsequent legs appear here, as opposed to transportation chains, which use multiple documents (preliminary shipment document(s), main shipment document, subsequent shipment document(s)) to illustrate the process.

⚠️

If you want depict a transportation chain within a shipment document, you must also accept the limited functions available to you.

The reason: Almost all shipment document functions refer to the document as a whole:

- Outputs can only be printed for the entire document, not for individual legs
- Handling units can only be created for the entire document, not for individual legs
- The same is valid for texts, deadlines in general, etc.

In our example, when the trucks go from their respective shipping points to the harbor, the freight documents should not also contain main leg and subsequent leg information. When you create texts, you would not know if they are supposed to be valid for the preliminary, main or subsequent legs.

In order to avoid such limitations, we would recommend that you denote a transportation chain using multiple shipment documents. You can create these shipment documents almost automatically by using collective processing.

However, if you only want preliminary, main and subsequent legs to show up for documentation purposes, then this is the correct leg determination type.

Procedure for this type of leg determination:

1. The system assumes that the main leg will be entered manually (here, manually means either entered directly or by way of a route entry)

   Hamburg-New York

2. Now, legs are automatically formed for all existing delivery departure points to the main leg’s starting point (which was entered manually).

   Example:
   Shipping point '0001' - Hamburg
Category 2: Preliminary/Subsequent Leg for Point of Departure/Destination

Shipping point ‘0002’ - Hamburg

3. Now the system creates legs from the end point of the main leg (which was entered manually) to all destination points of the delivery.

- New York - Customer 1,
- New York - Customer 2,
- New York - Customer 3,

Exception:

If there is no main leg, the system creates direct links between the departure points and the destination points of the delivery.

- Shipping point ‘0001’ - Customer 1,
- Shipping point ‘0001’ - Customer 2,
- Shipping point ‘0002’ - Customer 3.

The legs that were created are filled in with data in accordance with step 6 in Automatic Leg Determination [Page 95], and border points and load transfer points, as in step 7.

Finally, the system determines which deliveries are assigned to which legs. See also Automatic Assignment of Deliveries [Page 99].

You have created a shipment document that contains two deliveries to be dispatched to a ship-to party in Heidelberg. The first delivery is to be loaded in Boston, the second in Chicago. You specify the New York-Rotterdam route in the shipment header. Automatic leg determination creates a main leg from New York to Rotterdam, one preliminary leg from Chicago to New York, a second preliminary leg from Boston to New York, and one subsequent leg from Rotterdam to Heidelberg.
Category 3: Preliminary and Subsequent Leg for Each Delivery

This type of leg determination type can generally be used if a transportation chain is to be illustrated in a shipment document.

For example, multiple trucks leave from different shipping points to take deliveries to a harbor, where they are to be loaded onto the ship. The ship then carries the deliveries to the destination harbor, where they are once again loaded onto multiple trucks to be delivered to different customers. During this process, the system assumes that each delivery is so large that an entire truck is necessary for each one (Full Truckload - FTL).

Only preliminary, main and subsequent legs appear here, as opposed to transportation chains, which use multiple documents (preliminary shipment document(s), main shipment document, subsequent shipment document(s)) to illustrate the process.

⚠️

If you want depict a transportation chain within a shipment document, you must also accept the limited functions available to you.

The reason: Almost all shipment document functions refer to the document as a whole:
- Outputs can only be printed for the entire document, not for individual legs
- Handling units can only be created for the entire document, not for individual legs
- The same is valid for texts, deadlines in general, etc.

In our example, when the trucks go from their respective shipping points to the harbor, the freight documents should not also contain main leg and subsequent leg information. When you create texts, you would not know if they are supposed to be valid for the preliminary, main or subsequent legs.

In order to avoid such limitations, we would recommend that you denote a transportation chain using multiple shipment documents. You can create these shipment documents almost automatically by using collective processing.

However, if you only want preliminary, main and subsequent legs to show up for documentation purposes, then this is the correct leg determination type.

Procedure for this type of leg determination:

1. The system assumes that the main leg will be entered manually (here, manually means either entered directly or by way of a route entry)

   Hamburg-New York

2. Now, legs are automatically formed for all existing deliveries from the delivery’s departure point to the main leg’s starting point (which was entered manually).

   Shipping point ‘0001’ - Hamburg (for delivery 1),
Category 3: Preliminary and Subsequent Leg for Each Delivery

Shipping point '0001' - Hamburg (for delivery 2),
Shipping point '0002' - Hamburg (for delivery 3),
Shipping point '0002' - Hamburg (for delivery 4).

3. Now the system creates legs from the end point of the main leg (which was entered manually) to the destination point of each delivery.

   New York - customer 1 (for delivery 1),
   New York - customer 2 (for delivery 2),
   New York - customer 2 (for delivery 3),
   New York - customer 3 (for delivery 4),

Exception:

If there is no main leg, the system creates direct links between the departure points and the destination points of the delivery.

   Shipping point '0001' - customer 1 (for delivery 1),
   Shipping point '0001' - customer 2 (for delivery 2),
   Shipping point '0002' - customer 2 (for delivery 3),
   Shipping point '0002' - customer 3 (for delivery 4),

The legs that were created are filled in with data in accordance with step 6 in Automatic Leg Determination [Page 95], and border points and load transfer points, as in step 7.

Finally, the system determines which deliveries are assigned to which legs. See also Automatic Assignment of Deliveries [Page 99].

You have created a shipment document that contains three separate deliveries for a total of 60 tons of a product. Each delivery departs from Chicago and is transported to New York by truck. In New York, all the deliveries are loaded onto a ship and transported to Hamburg. In Hamburg, each delivery is loaded onto a separate truck and transported to the ship-to party in Heidelberg. You specify the New York-Hamburg route in the shipment document header. The system creates a main leg from New York to Hamburg, three preliminary legs from Chicago to New York, and three subsequent legs from Hamburg to Heidelberg.
Category 3: Preliminary and Subsequent Leg for Each Delivery

Chicago Shipping point

<Diagram showing shipping points, ports of departure and arrival, customer points, and deliveries.>

Leg 1
Delivery 1

Leg 2
Delivery 2

Leg 3
Delivery 3

Leg 4
Deliveries 1,2,3

Leg 5
Delivery 1

Leg 6
Delivery 2

Leg 7
Delivery 3

Time

Preliminary legs

Subsequent legs

Port of departure
Port of arrival
Customer

Chicago
New York
Hamburg
Heidelberg

Point
Category 4: With Shipping Type for Preliminary Leg and Subsequent Leg

This leg determination type works in exactly the same way as in Category 1: According to the Itinerary [Page 107].

Here, however, the preliminary leg shipping type and the subsequent leg shipping type (that you can maintain in the shipment header) are taken into account. These shipping types are used for the preliminary and subsequent legs that are created.

You can use this to hide subsequent legs by not maintaining the shipping type for the subsequent leg. This is helpful if you are only responsible for transportation up to a certain point and not all the way to the ship-to party location.
Shipment Stages

Definition

Stages contain information about the geographical factors for a shipment. In addition to their other functions, stages can also be the basis for calculation of shipment costs. Shipment stages can include:

- **Legs**
  
  A beginning point and end point is defined. For example, you can define main, preliminary, and subsequent legs.

- **Load transfer points**
  
  The point where a shipment is unloaded from one means of transport and loaded onto another.

- **Border crossing points**
  
  The point where a shipment crosses the border.

The various types of shipment stages are illustrated in the following figure:

Use

The following can be beginning points or end points:
Shipment Stages

- Transportation connection point (train station or port, for example)
- Shipping point (or loading point)
- Plant (or storage location)
- Customer location (may include customer’s unloading point)
- Vendor
- Freely-definable address

It is also possible to record other information about beginning or end points:

- Warehouse number/dock door
- Additional info, can be any text you choose (quay 17, for example)

If reference to a customer, shipping point, etc. is made in Customizing in the definition of a transportation connection point, that reference is automatically copied. This reference cannot be changed in the document since it was copied from the transportation connection point.

You can display the address of each point by choosing Address. If you are in change mode, you can make any necessary changes to the address. If you make changes to the address, the system simply creates a different address in the current shipment document.

Load transfer points can be defined the same way as beginning or end points of a leg. This means that it is possible to create a load transfer point at a customer or vendor address. If a transportation connection point is to serve as a location entry, however, it must have the corresponding characteristic Load transfer point in Customizing.

You can only use transportation connection points for border crossing points. These must already be set up in Customizing with the Border crossing point attribute.

Certain rules must be followed when defining a point in a shipment stage (a customer and a shipping point may not be entered at the same time, for example). You can find these rules in the Creating Shipment Stages Manually [Page 118] section.

You can create stages manually in the shipment document.

You can, however, use various functions to simplify or automate the entries:

- Entering a route in the shipment header. The stages defined in Customizing for the route are then transferred to the shipment document. You can control which stages are transferred, if any.
- Using the Leg determination function. Leg determination is a mechanism that generates stages. The determination is based on simple rules. It uses delivery information that is relevant for shipment in order to generate stages. (No optimization is involved here.)

  See also:
  Automatic Leg Determination [Page 95]

By combining various control parameters for the transfer of the routes with leg determination, you can automatically generate leg scenarios (either fully or partially).
Creating Shipment Stages Manually

Procedure

You can use the following functions when you create a shipment stage:

- Create a shipment leg
- Create a load transfer point
- Create a border crossing point

Create a shipment leg

To create a leg in the shipment document:

1. On the initial shipment screen or any of the shipment overview screens, choose `Overview → Stage overview`.
   Choose `Stage → New stage → Leg`. You can now see how a location can be defined (entry of a transportation connection point, shipping point, customer, etc.) by looking at the `Departure` and `Destination point` data fields.

2. Now enter the departure point and destination point (shipping point 0001 and customer K1, for example).
   This departure point must be defined as a transportation connection point in `Customizing for Shipping`.

   - The location definition must be unique, meaning that only one of the following fields should contain a value:
     - Transportation connection point
     - Shipping point
     - Customer
     - Plant
     - Vendor

   - An exception is made for transportation connection points that refer to shipping points, customers, plants, vendors, etc. In such a case, only the transportation connection point and the shipping point (for instance) may contain values. Except for the transportation connection point itself, all other fields are not available for entry and are only displayed.

   - Some fields are optional, meaning that they do not have to be maintained. They may only be maintained in the following situations, however:
     - Loading point: The shipping point must have been maintained
     - Storage location: The plant must have been maintained
     - Unloading point: The customer must have been maintained
     - Warehouse: The shipping point or the plant must have been maintained
Creating Shipment Stages Manually

- Dock door: The warehouse must have been maintained
- Additional info: can always be maintained
- You can always maintain the address:
  - As a newly-defined, independent address without any other field having been filled in. Example: Delivery to a construction site
  - As an alternative address for an object (alternative customer address, for instance).

After entering the locations and pressing a key, the entry fields for departure and destination point are automatically reduced in size, since now the Transportation planning point field may not contain a value for the departure point, for example, according to the above rules. You can make these fields available for input once again by either deleting the shipping point or choosing Change for the destination point.

This screen compression serves to display only the important location information so that the lower data area remains accessible, even on small screens. Choose Address to change an existing location address or add a new one.

3. Maintain other data about the stage on the various tab pages.

4. The system automatically inserts the agent’s name in the header of the shipment document. Enter the name or number of a service agent in the Service agent field if you are working with an agent other than the one defined in the shipment header.

5. Maintain the planned and actual transportation deadlines if needed.

6. Save your data.

To create another leg immediately following this transaction, you can choose Stage → New stage → Leg again from the details screen. This takes you directly to the entry screen for the next new leg.

The shipping document currently contains no scheduling. Planned deadlines on the leg level can therefore only be maintained manually.

The shipping document also has no distance determination. You therefore have to maintain the Distance field manually. If you still want to have an automatic distance determination function, you can activate customer enhancement V56DISTZ.

Creating a load transfer point

To create a load-transfer point in the shipment document:

1. On the initial shipment screen or any of the shipment overview screens, choose Overview → Stage overview.

2. Choose Stage → New stage → Load transfer point.

3. Enter the transportation connection point for the load transfer point.
Creating Shipment Stages Manually

The same rules as for definition of a departure or destination point are valid for definition of a load transfer point.

The specified transportation connection point must be classified in Customizing as a load transfer point.

4. Enter the name or number of a service agent in the Service agent field if you are working with an agent other than the one defined in the shipment header.

5. Maintain the planned and actual transportation deadlines if needed.

6. In many cases, the costs calculated for a load transfer depend on where the shipment is being transported (load transfer at the harbor, for instance). If this is the case, you can define a destination point for a load transfer point by choosing Stage → Load transfer point → Define destination. A dialog box appears in which you can enter a destination point (following the same rules as for the load transfer point).

7. Save your data.

Creating a border crossing point

To create a border-crossing point in the shipment document:

1. On the initial shipment screen or any of the shipment overview screens, choose Overview → Stage overview.

2. Choose Stage → New stage → Boarder crossing point.

3. Enter the transportation connection point for the border crossing point.

   The specified transportation connection point must be classified in Customizing as a border crossing point.

4. Enter the name or number of a service agent in the Service agent field if you are working with an agent other than the one defined in the shipment header.

5. Maintain the planned and actual transportation deadlines if needed.

6. Save your data.
Assigning Deliveries to Stages

Prerequisites

You can either assign all deliveries in the shipment to a stage or only a few deliveries to each stage. This function is useful if a shipment stops at various locations, unloading or loading goods along the way, for example. In such a situation, not all deliveries would be included in each stage of transportation.

Deliveries can be assigned to stages automatically (see Leg Determination Categories [Page 103]).

This process can also be carried out manually.

Procedure

1. Choose Overview → Stage overview on the initial screen or one of the overview screens.
2. Select the stage that the delivery is to be assigned to on this overview screen. Choose Stage → Deliveries in stage.
   A screen that is divided into two parts appears.
   – Deliveries in stage
   – Deliveries not in stage
   Here you will find data for each delivery in table format.
3. Select the deliveries and then use the movement buttons that are found between the two halves of the screen to assign deliveries to the stage. You can also delete deliveries.
Maintaining Partners for Stages

Prerequisites
You can enter a service agent on the detail screen of each stage. In a leg, the partner is the forwarding agent; at a load transfer point, it is the load transfer service provider, and at a border crossing point, it is the customs agent.

You can enter a different address for this service agent by going to the partner maintenance section of the stage. You can also enter an additional partner (carrier) for a leg. Entry of additional partner roles for load transfer points or border crossing points is not currently possible.

The partner determination procedures for stages are fixed and therefore cannot be set in Customizing.

Procedure
1. Choose Goto → Shipment Overview → Stages on the initial screen or one of the overview screens.
2. Select the stage to which deliveries are to be assigned and choose the tab page Partner.
   A partner overview screen for the stage appears. If necessary, you can enter another partner here and change address data in the detail screen.
Displaying Details About Stages

To display details about the stages in the shipment document:

1. On any of the shipment overview screens, choose Overview ➔ Stages.
2. Select the stage(s) for which you want to display details.
3. Choose Stage ➔ Stage detail.
   You can also display the deliveries or partners for the stage by choosing Deliveries in stage or Partner stage.
   You will reach the detail screen for the first stage that you selected. If you are in change mode, you can make any necessary changes. To reach the detail screen for any other stages you marked, choose Stage ➔ Next stage.
4. Save your changes.
Deleting Stages in the Shipment Document

Procedure

To delete stages from the shipment document:

1. From the shipment overview screen, choose the Stages tab.
2. Select the stages you want to delete.
3. Choose Delete section.
   The stages will be deleted.
4. Save your changes.
Moving Stages in the Shipment Document

Procedure

1. Choose the *Stage* tab on the overview screen.
2. Select the stages you want to move.
3. Place the cursor on the stage you want the selected stages to appear after.
4. Choose *Move stage*.

If you want to move the stages to the top of the list, put the cursor in a field above the overview screen (in the *Shipment number* field, for example).
Routes and Shipment Stages

Use

If you find that you use certain routes and stages often, you can define them in Customizing. This way, you spare yourself the unnecessary effort of creating and re-creating the same stages. You can find more information in the Define routes and stages section of the Implementation Guide (IMG).

Features

You can enter the route manually in the shipment's general header data. All stages of the route, including their detail screens, are then copied into the shipment automatically. The system also copies data (such as service agent, shipping type, distance and planned duration) from the route header into the shipment document header. This only occurs when the relevant fields in the document header are blank or originate from the old route. Manual entries have priority.

You can control which stages are to be transferred by maintaining the Adopt route control parameters in Customizing for the shipment type. The control parameters can have the following values:

- **blank**: All stages are copied over from the route (standard)
- **‘1’**: Only stages that have the exact same leg indicator that appears in the transport header of the current transport document are copied from the route. This is useful when you want to copy only the preliminary legs of a route into a preliminary shipment which itself is part of a transportation chain, for example.
- **‘2’**: No stages are taken from the route. In this case, the route is only a classification characteristic in the shipment header.

In the shipment header, you can also display which route stages are to be copied over by choosing Control on the general header screen.

If you change the route in the shipment document, the system automatically deletes the stages of the old route and adds the stages of the new one.

After a route is entered, the system tries to assign the deliveries in the shipment automatically to stages. For more details about this process, see Leg Determination Categories [Page 103].

Automatic Route Transfer

You can automate route entry by choosing the Route from del. option in Customizing for the shipment type. When you set the status to Planned in the shipment document, the route is automatically adopted from the deliveries into the shipment document (provided it is unique). The data transfer described above (route stages and route header data) then occurs automatically.

The service agent field can also be automatically filled in for the stages. For this, you only need to enter the service agent in the shipment header. It is also automatically copied into all existing legs that have no service agent.

If you change the service agent in the shipment header, the system also substitutes the new service agent for the old one in the stages. You can also make the service agent entry happen automatically if you choose the Frwd. agent delivery indicator in Customizing for shipment types. As in route processing, when you set the status to Planned, the forwarding agent is automatically
adopted from the deliveries into the shipment document (and, in turn, into the stages). This can only occur if the forwarding agent is unique.

A Service agent selection function is not currently available.
Planning Activities in the Shipment Document

Use

You can execute various activities in the shipment document, including assigning service agents, packing deliveries or maintaining shipment texts, for example.
Processing Shipment Documents

Procedure


2. Enter the number of the shipment document that you want to change.

3. If you do not know the document number, select the possible entries button to call up the Find Shipments selection screen. Enter your selection criteria (for example, the name of the service agent or the transportation planning point) and choose Program → Execute. The system will return a list of all the shipments that match the selection criteria. Select the document that you want to process. The system then enters that number in the Shipment number field on the initial Change Shipment screen.

4. Press ENTER.

   You see the overview screen in the shipment document. From this screen, you can maintain data such as deadlines, handling units, output data, and stages.

   Follow the same procedure to display a shipment document, but select Display instead of Change in Step 2.
Mass Shipment Changes

Use

Sometimes it is necessary to make changes to more than one shipment. For example, a forwarding agent that has agreed to ship multiple shipments for you is suddenly no longer available. Instead of changing each document individually, you can make a mass change in multiple shipment documents in one step.

Features

You can select shipments according to certain criteria and carry out changes at header level. This comprehensive change function also allows you to enter changes in a sample line and then carry those changes over into all selected shipments. That way, you can change the forwarding agent in multiple shipments by making a single entry.
Making Mass Changes to Shipments

To make changes in multiple shipments simultaneously:

1. Choose Logistics → Logistics Execution → Transportation.

2. Choose Shipment → Mass change.
   A selection criteria entry screen appears.

3. Choose which shipments you want to change by entering the corresponding selection criteria.

4. Choose Execute.
   A list of all shipments that meet your selection criteria appears. This list includes all the shipment header data. The tab pages correspond to those found on the general header screen of the shipment.

5. Make your changes.
   If you want to carry out the same changes in multiple shipments, select those shipments, enter the value you want to add to those shipments in the default line and choose Ref.doc. The value in the default line is substituted for older values in the selected shipments.

6. Save your changes.
Packing in the Shipment Document

The packing hierarchy, which is set up in the delivery, is continued in the shipment document. Delivery items that were packed into crates and loaded on pallets can be packed into containers and loaded on trucks in the shipment document.

1. To pack items in the shipment document, choose Go to Shipment and Packaging Matls on the initial screen or any of the shipment document overview screens. You see the screen for Editing Handling Units. All the delivery items not packed are displayed in the screen section Items to be packed.

   If goods have already been packed into the deliveries, the system displays the individual handling units and you can, if necessary, pack these further.

2. To pack a delivery item that has not yet been packed, mark the item and choose Extras → Allowed pack.matl to find the appropriate packaging materials.

3. Select a packaging material from the Allowed packaging materials dialog box.

4. In the quantity overview of the delivery, choose Edit → Pack → Pack.

5. In the screen section All existing HUs (into which you can pack materials), create the required handling units. You can also call up handling units that have already been created (Non-Assigned Handling Units [Ext.]). For further information on creating handling units, refer to the section Working with Handling Units [Ext.].

6. In the screen section Material to be packed or material packed, select the items that you wish to pack. Then in the section All existing HUs, select the handling units into which you wish to pack the goods and choose Pack material. See also: Pack if full [Ext.], New HU per Number of HUs [Ext.], and Packing per Partial Quantity [Ext.]).

7. To pack an existing HU into a larger HU, for example into a truck, select the HU and choose Extras → Allowed pack.matl to select the appropriate packaging material for the HUs concerned.

8. Select a packaging material from the Allowed packaging materials dialog box.

9. The system marks both the handling unit to be packed and the packaging material. Then choose Edit → Pack → Pack item.

   You either receive a message from the system that the handling units are packed or you are notified that not all the items could be packed because the system reached the weight or volume limits.

   If you have marked several handling units for packing, the handling units at the top of the list are packed fully first. If not all the items to be packed fit onto this handling unit, the packing process is automatically continued with the next selected handling unit.

   If only a partial quantity of a delivery item is to be packed, you must enter this in the section Material to be packed or packed material for the respective item in the field Partial quantity.

   The total weight of the delivery is not increased by the packing weights.
For handling units that represent means of transport, you may want to maintain the additional data such as the truck driver’s name or nationality.

1. Select the respective HU and choose Edit → Detailed data HU.
2. Maintain the necessary data and return to the Pack Items screen.
3. Save your data.

Handling units that were created in the delivery cannot be unpacked in the shipment document.
Delivery Item Generation in the Shipment

Use
Packaging materials for handling units are mostly cost items and are managed as stock in inventory management. For goods receipt from suppliers and goods issue to customers, it is therefore important to generate delivery items for the respective packaging materials so that these can be seen in the delivery note, posted in stock, and then invoiced as required.

Using the function for delivery item generation, you can generate delivery items for packaging materials that are only yet in planning for the shipment.

Prerequisites
Choose the following activities in the Implementation Guide for delivery item generation from the shipment.

Logistics Execution → Transportation → Shipments → Define Transportation Relevance [Ext.]
Logistics Execution → Transportation → Shipments → Define and Assign Activity Profiles [Ext.]
Logistics - General → Handling Unit Management → Basics → Define Packaging Material Types [Ext.]
Logistics Execution → Shipping → Deliveries → Define Delivery Types [Ext.]

Features
In delivery processing, the plant and the item category in the handling unit are decisive factors in the generation of delivery items. In the shipment, you can set the control for delivery item generation using an indicator for generation relevance in the Customizing application under Shipment Type [Ext.]. In the activity profile [Ext.] you can determine at which times (for example, during planning, processing) the delivery items for the HUs are to be generated. For example, changes can occur during planning and processing.

Also, in the Customizing section for Handling Unit Management, there is an indicator in the packaging material type [Ext.] for generation relevance.

- Delivery items generated from packaging materials are not updated if there is a change to the handling unit (plant, weight, and so on).
- Generated delivery items are deleted only if the handling unit is deleted.
- The generation of packaging materials in deliveries already posted for goods issue is not possible.
- Any change in the HU content does not affect the generated item, even if the new contents do not have any reference to this delivery.
- For technical reasons, the delivery update can only be called up during the update of the shipment. Issuing a log is no longer possible at this point.

For further information on delivery item generation, refer to the section under Delivery Item Generation for Packaging Materials [Ext.].

For further information on delivery item generation, refer to the section under Delivery Item Generation for Packaging Materials [Ext.].
Assigning Service Agents in the Shipment Document

Prerequisites
Before you assign a service agent to a shipment document, make sure that a vendor master record has been maintained for that service agent.

At Header Level
1. On the initial shipment screen or any of the shipment overview screens, choose Header → General data.
2. Enter the name of the service agent or the service agent number.
3. Save your data.

At Stage Level
1. On the overview screen of the shipment document, choose Overview → Stage overview.
2. Mark the stage to which you want to assign a service agent and choose Stage → Stage detail.
3. Enter the name or service agent number of the service agent who is responsible for this stage of the shipment.

The service agent in the shipment header is entered for the shipment leg and the load transfer point and can be overwritten. No default appears for the border crossing point.
4. Save your data.
Maintaining Texts in the Shipment Document

In the shipment document, texts are maintained manually at header level. No automatic text determination occurs for shipments.

To enter important information for shipment planning and completion as a text in the shipment document, proceed as follows:

1. On the overview screen of the shipment document, choose the tab page Texts.
   
   The text screen appears, where you can maintain various types of texts (for example, freight list texts, header notes, or forwarder’s order texts).

   The text types that appear for maintenance depend on the text procedure, which is specified for the shipment document type in Customizing.

2. Enter your text.

3. If you need additional space, mark the text and choose Edit Details.
   
   The SAPscript editor will appear and you can complete your text.

4. Save your text on the SAPscript editor screen and choose Back to return to the text screen.

5. Save your text once again on the text screen.
Maintaining Planned and Actual Deadlines in the Shipment Document

To maintain planned deadlines in the shipment document:

1. On the overview screen in the shipment document, choose the screen sections Status and Deadlines.

2. The most important shipment deadlines are listed in the screen section Status and Deadlines. Enter the planned or actual deadlines for the different activities in the Planning and Execute fields.

   You can enter actual deadlines for the required activities automatically or manually.
   - Automatically
     To enter deadlines automatically, set the status and the system fills in the current date. You can find further information in Maintaining Status in the Shipment Document [Page 140].
   - Manual
     You enter the date; the system automatically sets the status.

3. If you want to maintain deadlines that do not appear in the Dates or Status sections on the overview screen, choose More Deadlines.

   You will reach a screen where you can maintain any other planned or actual deadlines. If planned and actual deadlines are different, you can record why and where the deviation occurred by choosing Goto → Details and maintaining the fields Point and DeviationReason.

   The transportation of a shipment is delayed because of a defective freight car at the train station in Chicago. Enter the name of the station in Chicago in the Point field and record that a defective freight car delayed proceedings in the DeviationReason field.

4. Save your data.
Status in the Shipment Document

Definition

The overall shipment status shows the shipment’s processing stage. There are various transportation statuses:

- **Planned:** The shipment’s planning is complete.
- **Check-in:** The vehicle arrives at the plant.
- **Start load:** The vehicle is loaded or unloaded.
- **End load:** Loading and unloading finished.
- **Shipment completion:** The documents are created.
- **Shipment start:** The shipment starts.
- **Shipment end:** The shipment is finished.

Integration

In Customizing [Ext.], you can define Activity profiles [Page 146] for the shipment types, i.e. for the statuses for which activities are to be carried out.

Example

Possible activities of *shipment completion*:

- Posting the goods issue for the deliveries in shipment
- Billing the deliveries in shipment
- Printing outputs
Maintaining Status in Shipment Documents

Procedure

To maintain status in the shipment document, proceed as follows:

1. On the overview screen for the shipment, set the Planned status in the Deadlines section.

2. Choose the appropriate button for the relevant activity (such as Check-in) on the Deadl. tab page.

   The system records the current date and time as the actual deadline when you choose the button for the relevant activity.

When you set a status, the status traffic light icon appears on the Status tab page. For more detailed information on the status that the traffic light represents, click once on the traffic light and choose F1.

For more information on setting this status, see Transfer of Delivery Dates to Shipment [Page 141].
Transfer of Delivery Dates to Shipments

Use
You can have planned dates proposed in the shipment for the individual transportation activities. You can copy these from the outbound deliveries that belong to the shipment. You can use a copy routine to copy dates and times into the shipment document. There are two copy routine options: you can either accept the default copy routine or create your own copy routine.

Integration
In order to copy proposals for dates and times from the delivery, you must create a connection between the shipment dates and delivery dates. Copy routines serve this purpose.

Copy routines link shipment dates and times to previous documents, such as deliveries. In other words, date and time entries in the shipment can use date and time entries in previous documents as references.

Prerequisites
A copy routine must be set in the Implementation Guide (IMG) for copying the dates and times. You can choose a suitable copy routine as a standard default or create your own copy routine to use as a default in the Define shipment types [Ext.] activity under the path Logistics Execution → Transportation → Shipments.

Features
You can use this function to have the system propose shipment dates and times from the delivery. There are two methods to choose from:

- Standard default

When this indicator is set, dates and times are copied from deliveries into the shipment. There are a few rules that apply to standard defaults. First, the loading date and time in the delivery becomes check-in time and loading start in the shipment. The delivery's planned goods-issue time becomes the loading end, shipment completion and transportation start time for the shipment. If the goods-issue date and time (loading time) is unclear in the delivery, the latest goods issue date that appears in the delivery is copied into the shipment. The delivery date and time is copied into the shipment's transportation end.

When shipment planning is complete, set the Planned status. At this point, the dates and times are copied from the delivery into the shipment.

- You can create your own copy routine to use for date and time defaults by using the flexible default option.

Activities
In shipment processing, choose Planning. Shipment dates and times appear as defaults. A dialog box appears, in which you can choose whether you want the system to copy the default dates and times into the shipment or whether leg determination should be re-run.
Function Authorization for Status

Use

The scope of transportation status activities should be reserved for administrative personnel for various reasons. For example, it could be the case that some employees only process one shipment type, that some are only responsible for transportation by land while others are responsible for transportation by sea. Still others could be responsible for organizing transportation planning and some could monitor all activities up through shipment completion. It may not make sense for someone who only works with one status activity to be authorized to execute other status activities. The system should carry out an authorization check to see if the user has the authorization to set or reset a particular transportation status. Status authorization can be an important security instrument to avoid the shipment being changed after the fact by someone with no authorization because of an accident during shipping, for example.

Integration

The SAP standard function for checking authorization is used. The new authorization object V_VTTK_TSA is used with authorization fields SHTYP for the shipment type and TRSTACT for the shipment status activities to check authorization.

Features

When the shipment status is changed, the system checks whether the user is authorized to process the shipment type and status. If the user has this authorization in his or her user master record, processing of the status activity is allowed. Otherwise, a message appears in which the causes and further procedures appear.
Dangerous Goods Check

Use
In order to fulfill the statutory requirements regarding shipment of dangerous goods, it is necessary to check whether shipments containing these goods are permitted according to agreements made with the countries in which the shipments take place.

Integration
The dangerous goods check applied here is part of the standard dangerous goods management package in the SAP R/3 System.

Prerequisites
The necessary settings must be made in the dangerous goods management section of Customizing. The necessary data must also be available (transit countries must be defined, for example).
You can find further information about these prerequisites in Dangerous Goods Check in Shipment Documents [Ext.].

Features
You can carry out a dangerous goods check in the shipment document. Depending on your settings, this either happens automatically or can be initiated manually on the Dang. gds tab page in the general header data for the shipment.
If only one of the items in the deliveries grouped to make this shipment is categorized as dangerous, the indicator Contains DG is automatically set. This indicator is only for informational purposes.
Depending on your settings in the dangerous goods management section of Customizing, the overall reaction of the dangerous goods check may cause the Lock indicator DG to be set. In this case, it is not possible to assign another document status.
You can find further information about dangerous goods check features in Dangerous Goods Check in Shipment Documents [Ext.].
Completing Transportation Planning

Procedure

To complete transportation planning for a shipment document, first access the document either using the change function or using a worklist for transportation planning (see Processing Shipment Documents [Page 129]).

After you have completed all the necessary activities, such as packing, maintaining texts, or assigning service providers, you can set the Planned status in the shipment header screen. For more information on setting this status, see Maintaining Status in the Shipment Document [Page 140]. Once the Planned status has been set, leg determination is performed automatically. The shipment document is then ready for shipment completion.

Result

Setting the Planned indicator in the header screen of a shipment document will result in the following:

- You can no longer add deliveries to the shipment document.
- You cannot move deliveries within the shipment document.
- You cannot remove deliveries in the shipment document.
- You cannot reassign deliveries to other shipment documents in the transportation planning work list.
- You can copy the route from the deliveries into the shipment header if the appropriate indicator is set in the shipment type and if all deliveries in the shipment document have the same route.
- You can copy the forwarding agent from the deliveries as the transportation service agent in the shipment header. However, the indicator for copying the forwarding agent must first be set in the shipment type and all deliveries must have the same forwarding agent.
- You can transfer delivery dates to the shipment document, if you set a copy routine for Transfer of Delivery Dates [Page 141] in the Implementation Guide (IMG) [Ext.].
Shipment Execution

Use

The aim of shipment completion is to complete the formalities involved in getting a shipment ready for dispatching to the customer. Tasks in shipment completion include weighing the shipments, loading, and posting goods issue. At check-in (when a truck arrives on the company’s premises) information about the means of transport such as driver details, the weight of the truck, and its arrival time can be recorded. You can store all this information in the shipment document and it is printed out on the transportation documents, for example, when the completion status is set. There are various reports available to assist you in choosing the shipments relevant for check-in and those relevant for shipment completion.

Features

You can carry out certain functions configured in Customizing using Shpmt completion in the shipment completion list (see About Transportation Processing [Ext.] and Creating Shipment Completion Lists [Page 153]). These functions include goods issue posting or billing as well as printing transportation documents, deliveries or billing documents.

Using this function button, you can quickly and efficiently carry out all functions that you want to use during shipment completion.

You can use the Shipment completion log to display which functions were carried out or which ones led to problems.

Following shipment completion, you can compare any differences that were found between the shipment completion and the delivery (during weighing, for example) directly to the delivery.

For example, in bulk product transportation (gases or liquids), the actual quantity often is different from the quantity that was ordered.
Activity Profiles

Use
Activity profiles define activities that are to be carried out in the shipment document when a certain status is set for that shipment. You can define a different profile for each status (planning, check-in, completion, etc.) Possible activities that can be carried out as the status is set include:

- Add to the data in the dialog box
- Post goods issue for the deliveries in the shipment
- Calculate the shipping costs
- Create invoices for the deliveries in the shipment
- Print certain outputs

Prerequisites
A variant in Customizing must be maintained per shipment type for the status that is to be carried out. Define in this variant which activities should be carried out and whether a dialog box should appear when the status is set.

To configure the activity profiles, choose Define and assign activity profiles [Ext.] in the Implementation Guide (IMG).

Features
The system automatically executes the activities that you specified for the respective shipment type and status, once the relevant status is set.

You want to make sure that goods issue is always posted for all deliveries in shipments with shipment type Individual shipment immediately after the shipment is marked as complete. You also want a dialog box containing the driver’s name to appear when the status is set to Check-in.

You then define activity profiles for Check-in and Completion for shipment type Individual shipment. For check-in, you set the default for a dialog box that appears containing the contents of the field Driver. For completion, you set goods issue posting to be carried out automatically as this status is set.

Activities
Define activity profiles for your shipment types for any status at which activities should be carried out.
Reports for Shipment Completion

Use

For shipment completion, there are two reports available that you can call up to select shipments:

- Select Shipments: Shipment Completion [Page 151]
- Select Shipments: Check-in [Page 148]
Select Shipments: Check-in

Use
You can use this report to select shipments that you want to check in. An employee at the dock door of the plant could select all shipments that are expected to arrive on that day, for instance, so that check-in can occur as the trucks arrive.

Features

Selection Screen
The check-in list is compiled using selection criteria. You can control which fields appear as selection criteria on the selection screen. The set of criteria that are displayed are determined on the basis of settings made in Customizing for Transportation. For more information about changing these settings, see the Maintain selection views for lists of shipments section in the online Implementation Guide. Criteria that is especially important for check-in include planned deadlines and service agents, for example.

List Screen
You can select from two different views on the list screen. The first view list contains general shipping information for the selected shipment documents. You can switch to a second view of the list which provides you with information on the planned and actual deadlines for the documents and the status of the various transportation activities. You can access each shipment document from the list directly and perform the necessary shipment completion activities. There are various functions which enable you to pare down the list to exactly those documents you want to process. In addition, search and sort functions have been designed to help you access the information you need from the list. After you have made changes to a shipment document in the list and then returned to the list, you can use the Refresh function to update the list.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Processing
From this list, you can set the check-in status for all selected documents. Provided the relevant setting was made in the activity profile, a dialog box will appear in which the truck’s license plate number and driver’s name can be entered. See also Shipment Completion [Page 145] and Activity Profiles [Page 146].

Example
Every morning, an employee stationed at the dock door of the plant creates a list of all shipments expected that day. He or she uses the planned check-in date and status 1 (planned) as selection criteria for this list. When a truck arrives at the dock door, he or she consults the list, finds the relevant document and checks the truck in. During this process the truck’s license plate number and driver’s name are recorded. The system is configured so that a dialog box appears requesting entry of the license plate number and driver’s name as soon as the Check-in status is set.

See also:
Creating Check-in Lists

To create a transportation completion list, proceed as follows:

   You branch to the screen List Shipments: Check-in.

2. To use other selection criteria, choose Edit → All selections.
   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.

3. Enter the criteria you want to use for selecting the shipment document.

4. Choose Program → Execute.
   You obtain a list of all the shipment documents that match your selection criteria.

You can find more information on processing these lists in Editing Shipment Lists [Page 57].
Select Shipments: Shipment Completion

Use

You can use this report to select shipment documents for which planning activities have been completed and tasks such as weighing, loading, and goods issue still have to be performed.

Features

Selection Screen

The shipment completion list is compiled using selection criteria. You can control which fields appear as selection criteria on the selection screen. The set of criteria that are displayed are determined on the basis of settings made in Customizing for Transportation. For more information about changing these settings, see the Maintain selection views for lists of shipments section in the online Implementation Guide. Important criteria for shipment completion include the loading and transportation deadlines.

List Screen

You can select from two different views on the list screen. The first view list contains general shipping information for the selected shipment documents. You can switch to a second view of the list which provides you with information on the planned and actual deadlines for the documents and the status of the various transportation activities. You can access each shipment document from the list directly and perform the necessary shipment completion activities. There are various functions which enable you to pare down the list to exactly those documents you want to process. In addition, search and sort functions have been designed to help you access the information you need from the list. After you have made changes to a shipment document in the list and then returned to the list, you can use the Refresh function to update the list.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Processing

From this list, you can set the shipment completion status for all selected documents. Provided the relevant setting was made in the activity profile, the process of printing all the freight documents can be triggered automatically. See also Shipment Completion [Page 145] and Activity Profiles [Page 146].

Example

Every morning, an employee in a shipping company creates a list of all shipments for which transportation planning is to be completed on that day, which he or she uses as a general worklist. The selection criteria used to create this list include: overall shipment status of 1-4 (planned to end loading) and planned completion date. To find individual shipments, he or she sometimes even uses the truck’s license plate number and the name of the truck driver as selection criteria. This information was entered as the shipment was checked in. As this example demonstrates, this report is an important tool that can assist you in planning shipments efficiently.
Select Shipments: Shipment Completion

See also:

Creating Shipment Completion Lists [Page 153]
Editing Shipment Lists [Page 57]
Creating Shipment Completion Lists

To create a transportation processing list, proceed as follows:

1. Choose Environment → Shipment completion on the Transportation screen.

   You branch to the List Shipment screen: Transportation processing

2. To use other selection criteria, choose Edit → All selections.

   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.

3. Enter the criteria you want to use for selecting the shipment document.

4. Choose Program → Execute.

   You obtain a list of all the shipment documents that match your selection criteria.

You can find more information on processing these lists in Editing Shipment Lists [Page 57].
Posting Goods Issue for Shipments

Use

You can post goods issue for an entire shipment. This is appropriate, for example, if you have several deliveries in a shipment that you do not want to have to select and post individually.

When you enter the shipment number, the system automatically selects all the deliveries belonging to the shipment and then posts goods issue for them.

Procedure


2. The delivery monitor [Ext.] takes you to the Outbound Deliveries for Goods Issue screen. Here you enter the shipment number and select Program → Execute.
Monitoring Shipments

Use

In order to be able to plan and execute shipments, it is important that you have an overview of planned shipment activities as well as shipments already underway at all times. You have a number of tools at your disposal for this purpose.

Features

You can use both the Graphical Information System (GIS) or the Information System in list form to gain an overview of a transportation network or itinerary. You can also display a Gantt chart for deliveries or call up individual information relative to the shipments.

Moreover, you can also simply display all changes to a shipment document.
Information System in Transportation

Use
You can use the information system to gain a better perspective on shipments of different deliveries in the following ways:

- In list form
- Graphically

You can display the following information:

- Itinerary
- Transportation network

You can call up the information system:

- In the order
- In the delivery
- In the shipment

You can find this function by choosing the menu path Environment → Transportation info.

You can call it up when changing or displaying the document, and in Transportation, you can also call it up when creating a document.

See also:

Working with the Information System in List Form [Page 157]
Working with the Graphical Information System [Page 158]
Information System in List Form

Use

If you are working with the information system in list form, the system lists all the shipment documents that belong to an itinerary or transportation network.

You can use the normal list functions here (Sort, Find, Change view, and so on).

To get explanations for headings, place the cursor on a line beneath the heading and press F1.

To get explanations for a field, place the cursor on the field and press F1.

See also:

Graphical Information System [Page 158]
Graphical Information System

Use
You can display the following information about the itinerary or the transportation network:

- The route a certain delivery is taking
- How many or which shipments or deliveries are being sent from one transportation connection point to the next
- How many or which deliveries have been assigned to a certain shipment
- The weight, volume, or number of packages of a certain delivery or shipment
- The shipping type of a shipment
- Timing data for a shipment
- Information on transportation connection points

The following figure illustrates the difference between an itinerary and a transportation network:

The graphic shows the transportation network for deliveries 1 and 2. When you select Transportation network, the system displays the whole transportation network, regardless of whether you have selected the function for delivery 1 or 2.

Functions
The following functions are available:

- Changing Network Views [Page 161]
Once you have called the graphical information system, the relevant itinerary or transportation network will be displayed. Use the following table to determine the items in the network.

### Key for Transportation Connection Points

<table>
<thead>
<tr>
<th>Form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>oval</td>
<td>point of receipt (unloading point, ship-to party)</td>
</tr>
<tr>
<td>hexagon</td>
<td>issuing point (shipping point, vendor)</td>
</tr>
<tr>
<td>square</td>
<td>transportation connection point (load transfer point, customs, border crossing)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>yellow</td>
<td>in-house (loading point, unloading point)</td>
</tr>
<tr>
<td>red</td>
<td>external organization (ship-to party, vendor)</td>
</tr>
<tr>
<td>gray</td>
<td>Customs office</td>
</tr>
<tr>
<td>blue</td>
<td>border crossing point</td>
</tr>
<tr>
<td>purple</td>
<td>load transfer point</td>
</tr>
<tr>
<td>blue/gray</td>
<td>customs border crossing</td>
</tr>
<tr>
<td>green</td>
<td>other points</td>
</tr>
</tbody>
</table>

### Navigating with the Mouse

To mark certain shipment stages or transportation connection points, use the relevant menu path or keys.

You can also mark them using the mouse. The table summarizes how to use the mouse:

<table>
<thead>
<tr>
<th>do this with your mouse.</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>click the left button</td>
<td>mark an element</td>
</tr>
<tr>
<td>SHIFT + click the left mouse button</td>
<td>mark additional elements</td>
</tr>
<tr>
<td>press the left mouse button and keep it pressed down. move mouse to frame the appropriate elements release the left mouse button.</td>
<td>mark several elements</td>
</tr>
<tr>
<td>double click the left mouse button</td>
<td>display detailed information on an element</td>
</tr>
</tbody>
</table>
Graphical Information System
Changing Network Views

Use

You can view itineraries in three different ways:

- **Transportation network**
  The system displays all shipment stages that contain the selected deliveries or shipments and any related deliveries or shipments (including preliminary and subsequent legs, and so on).

- **Itinerary**
  The system displays only those shipment stages that contain the selected deliveries or shipments. To ensure the context remains clear, the system adopts the position of connection points in the network from the transportation network.

- **Simplified itinerary**
  This displays shipment stages just as described above, but the position of the connection points is simplified to offer a better overview.

To change to a network view, choose Environment → Transportation info → Transp.network.
Displaying Itineraries Within a Transportation Network

Use
Within a transportation network, you can highlight itineraries for:

- Shipments
- Deliveries
- Shipments and deliveries

Displaying by Selecting Individual Shipments and Deliveries

Procedure
1. Use one of the following menu paths:
   - Edit → Select → Deliveries
   - Edit → Select → Shipments
2. Select the shipment or delivery you want to display.
   You can branch from shipment selection to delivery selection and vice versa.
3. Press ENTER.
   Itineraries for the selected shipments and deliveries are highlighted in red.

Displaying by Selecting Shipment Stages (Legs) in the Graphic

Procedure
1. Select a stage with the required shipment or delivery in the graphic.
2. Choose Edit → Select → Selected stages → Mark.
   The corresponding itineraries are highlighted in red.
3. To remove the highlighting, choose Edit → Select → Selected stages → Delete marking.
   You can select additional stages by pressing the shift key and the left mouse button simultaneously.

Type of Marking
You can display the itineraries for all deliveries and/or shipments that belong to the selected stages as follows:

- For all deliveries
- For all shipments
- For all deliveries and shipments (standard setting)

To perform this function, choose Edit → Mark → Type of marking.
Displaying Details on Shipment Stages

You can display the following details for shipment stages:

- Leg attributes
- Deliveries

Changing and Displaying Leg Attributes

Attributes are assigned as standard to shipment stages:

- Shipment number and, if necessary, with route number
- Delivery number or number of deliveries in the shipment
- Variable leg attribute

You have the following options for variable leg attributes:

- Shipping type
- Service agents
- Mode of transport
- Handling unit
- Planned deadlines
- Actual deadlines
- Total weight
- Total volume
- Number of packing units
- Leg indicator

To change leg attributes:

1. Choose Edit → Leg attributes.
2. In the dialog box, select the attribute that you want to see.

Displaying Deliveries

To display deliveries for a shipment stage, proceed as follows:

1. Select the stage by clicking on the graphic (multiple selection is not possible).
2. Choose Details → Deliveries.

You can also double click on the left mouse button here.

You can now display the details on a delivery. You can find more information in Displaying Details on a Delivery [Page 170]
Displaying Details on Transportation Connection Points

You can display the details on a transportation connection point. The system displays a list of all deliveries with the shipment in which they enter or leave the transportation connection point.

To display details:

1. Select the transportation connection point by clicking on the graphic.
2. Choose Detail → Transportation connection points.

You can also double click on the left mouse button here.

3. In the Detail screen, you can carry out the following functions:
   - Displaying Deadlines for Deliveries [Page 167]
   - Displaying Gantt Chart for Selected Deliveries [Page 168]
   - Calculating Allowed Lateness of Deliveries [Page 169]
   - Displaying Details on a Delivery [Page 170]
   - Displaying Details on a Shipment [Page 171]
Displaying Deadlines for Deliveries

After choosing Detail → Transportation connection points, you can display the exact deadlines for a delivery:

1. Place the cursor on the desired delivery.
2. Choose Deadline details.
Displaying a Gantt Chart for Deliveries

After choosing Detail → Transportation connection points, you can display the deadlines for selected deliveries in the form of a Gantt chart:

1. Select the desired deliveries.
2. Choose the Deadline diagram.
3. For an explanation of the color code, see the key.
   
   ![Key icon]

   Maximize the key window so that you can see everything.
4. You can also set the required time period in the Time unit menu option.

The Gantt chart provides a brief description of the transportation connection point. It also includes the shipment number (with the stage number) and the service agent’s identification code.
Calculating Allowed Lateness of Deliveries

You can enter a tolerance level in order to find out whether delayed deliveries will critically affect subsequent deliveries:

1. Enter the tolerance level next to *Allowed Lateness*.

   If deliveries are delayed, they will be entered in the list.
Displaying Details on a Delivery

To display further details on a delivery:

1. Place the cursor on the desired delivery.
2. Choose Display document.

You can also double click on the left mouse button here.
Displaying Details on a Shipment

To display further details on a shipment:

1. Place the cursor on the desired shipment.
2. Choose Display document.

You can also double click on the left mouse button here.
Compressing Stages

To obtain a better perspective, you can compress shipments between two points. You can choose whether this function is to be performed:

- For all stages
- Only for selected stages

You can also reverse this compression.

To compress a shipment:

1. Mark the selected stage by clicking on it with the mouse.
   
   You can select additional stages by pressing the shift key and the left mouse button simultaneously.

2. Choose:

<table>
<thead>
<tr>
<th>Selected stages</th>
<th>Edit → Compress stages → Selected stages → Compress or undo compression</th>
</tr>
</thead>
<tbody>
<tr>
<td>All stages</td>
<td>Edit → Compress stages → All stages → Compress or Undo compression</td>
</tr>
</tbody>
</table>

You can also use the standard compression criteria. The system inserts the compression threshold (that is, the number of shipment stages between two points as from which stages are compressed).

To change the compressing threshold, choose Edit → Compress stage → Compress as from.

To display the standard compressing criteria, choose Edit → Compress stage → Standard compressing criteria.
Changing the Graphical Representation

You can change the way the graphical representation looks by expanding or reducing it or by moving the key. To do this, select the menu option View.

If your transportation network is especially large, you may have to search for particular transportation connection points. Choose View → Find points to search for them.

To display the required section of the transportation network, you can frame the corresponding point:

1. Position the mouse as required.
2. Press the left mouse button and keep it pressed.
3. Move the mouse until you have framed the section of the transportation network which you require.
4. Release the mouse button.

To display the framed section, choose View → Selected view.
Displaying Transportation Change Documents

Use

Change documents record changes to existing shipment documents. Should a problem occur, you can refer to this document to see which shipment changes were made when and by whom.

Features

If an existing shipment is changed, a change document is created when those changes are saved.

You can enter selection criteria in order to display change documents. There are also two views to choose from. One displays the changes according to shipment number. The other lists changes to all documents according to fields that were changed. For example, all shipments in which the forwarding agent was changed appear in the highest level of the list; all shipments in which the container ID was changed appear in the second level, and so on. You can call up the data that was changed from either list with a doubleclick.

You can also display the changes made to shipment documents that have already been deleted.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext].
Displaying Change Documents

Procedure

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → List → Changes.
3. Enter your selection criteria to limit the amount of change documents that appear in the list.
   Selection criteria include when the document was last changed, the shipment number or the table (for example, VTTK for the shipment header) or table field name (for example, STABF for transportation processing status).
4. Enter in the Display section of the screen whether change documents are to be sorted according to shipment or input field.
5. Choose Execute.

Result

The system displays a list of all change documents that match your selection criteria. The shipment number, change document number, user, time of change, transaction, table and field names and previous and changed values are displayed in this list. Details about changes made to individual fields are displayed when you click on that field.

You can also define your own user-specific variant for which fields you want to display and which ones you want to hide. You can then access these variants later.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].
Shipments Cost Processing

Purpose

This component contains the functions for calculating and settling shipment costs in transportation. The following items describe how the shipment costs are determined in the shipment, how they are transmitted to accounting, and how they are settled with the service provider. The system also shows you how to obtain information regarding the shipment costs to be expected in the order.

Features

Calculation of shipment costs is carried out using the condition technique in SAP pricing. For further information on pricing, see Conditions and Pricing [Ext.]. As well as general pricing functionality, the following additional functions are available for shipment costs calculation:

- **Pricing procedure determination**
  The system determines the pricing procedure to be used to calculate shipment costs. Determination is carried out by transportation planning point, service agent, shipment cost item, and shipping type.

- **Determining the Calculation Base**
  The origin of the data upon which a condition type is based during shipment costing determines the calculation basis. The following possibilities exist:
  - Delivery
  - Delivery item
  - Handling unit
  - Shipment cost item
  - All

- **Determination of Geographical Influencing Factors**
  The following options are available for representing geographical considerations in transportation:
  - Distances
    In the shipment stage and/or the shipment header, you can either enter the distance manually or it can be automatically copied from the route stage. If you want the system to determine distance automatically, you can also use a customer enhancement (enhancement V56DISTZ).
  - Locations and zones
    You can use some of the data from the address data in the shipment (e.g. country, postal code, transportation zone) for condition determination. This data is separated according to departure and destination locations. The system can also automatically determine a tariff zone. A tariff zone is the combination of a postal code area of a country from the point of view of shipment costs calculation.
• Determination of the pricing date and the settlement date
  The system can automatically determine the pricing date and/or the settlement date. You can also define a date rule in Customizing in which a sequence of shipment deadlines is defined to be used as date proposals. When defining the item categories, you can then assign a date rule for the pricing date and the settlement date.

• Shipment Comparisons
  You can combine the conditions of a pricing procedure into groups. The system evaluates these conditions and compares the values of the groups. You can configure the system so that the most favorable group is always selected.

• Tax Determination
  When determining shipment costs, you can also have the system determine the corresponding tax. Certain rules regarding the tax country of departure and destination apply to this calculation. The system takes into account whether the shipment cost items refer to the shipment header or to a shipment stage and whether the stage includes a load transfer or border crossing point.

**Constraints**

The component includes the following functionality constraints:

• It is not possible to carry out shipment costing in the customer billing document depending upon transportation-specific data (for example, freight code, means of transport).

• You cannot settle shipment costs internally if a company code is performing shipments for another company code.

**See also:**

[Shipment Cost Document](Page 178)
[Shipment Costing](Page 180)
[Shipment Costing with Service Agents](Page 218)
**Shipment cost document**

**Definition**

An object in which the shipment cost-related data are combined. The shipment cost document allows you to refer to parts of the shipment document for which shipment costing must be carried out separately.

**Structure**

The shipment cost document consists of the following parts:

- **Shipment cost header**
  
  The shipment cost header contains general information on the entire document. You can view status, reference and administration information. The status information is the cumulative status that is calculated from the individual items.

- **Shipment cost items**
  
  The items refer either to a shipment header or a shipment stage. The items contain general data for shipment costing and settlement, such as service agent, pricing date and settlement date, tax amount and tax basis as well as organizational data such as company code, plant and purchasing organization.

  There is an individual status at item level for each of the shipment costing, account assignment and forwarding to FI functions.

- **Shipment cost sub-items**
  
  Calculation of the shipment costs is carried out at the level of the shipment cost sub-items and this is also the level at which the result of the calculation is stored. Depending upon the calculation basis that was determined, this can involve single delivery items, deliveries, shipping units or the entire shipment cost item. Different information is received depending on the type of sub-item involved. The delivery item, for example, has no information on the handling units.
See also:
Determining the Calculation Basis [Page 185]

Integration
The shipment cost document is integrated in the document flow for SD documents. You can call the document flow from the shipment cost document.
Shipment Costing

Purpose
This process describes how the R/3 System calculates shipment costs for shipment documents or stages. The system does this using the R/3 condition technique in pricing.

Prerequisites
To carry out shipment costing for a shipment document, the following requirements must be met:

- The shipment must be marked as relevant for shipment costing.
- The shipment must have the required total status as set in the definition of the shipment cost type.
- The shipment must have a transportation status of at least planned.
- The shipment must have a service agent.
- Customizing for shipment cost pricing must be set.
  
  To make this setting, go to the IMG and select Logistics Execution → Transportation → Shipment costs → Pricing → Pricing Control.
- Condition records must be maintained.

Process Flow
Calculating shipment costs involves the following steps:

1. The system determines a pricing procedure for the shipment cost item (for example, a shipment stage) using transportation planning point, service agent, shipment cost item category and shipping type as criteria.
2. The system determines the shipment costing calculation basis for the individual condition types in the pricing procedure. This controls whether costing is carried out per container, for example, or per delivery item (the shipment cost sub-items).
3. The system then searches for a valid condition record in the pricing procedure for the first condition type.
4. The priority of the criteria the system uses to search for condition records is determined by the access sequence. For example, you can set the system so that it first of all checks whether condition records of the correct condition type exist for a combination of freight class and forwarding agent. If this is not the case, then the system could check whether condition records exist just for the forwarding agent (set as the second point in the access sequence). The system continues to search until it has found a valid condition record.
5. The system can use the information stored in the condition record to determine values such as the basic freight.
6. The system now searches for the second and then the third condition record, until values have been determined for all condition types in the pricing procedure.
7. The values of the individual condition types are cumulated as specified by the pricing procedure. The final amount calculated is copied to the shipment cost sub-item.
The following figure describes the steps made by the system when calculating shipment costs.

See also:
- Pricing Procedure Determination [Page 182]
- Shipment Comparisons [Page 191]
- Determining the Calculation Basis [Page 185]
- Determination of Geographical Influencing Factors [Page 192]
- Determining Pricing Date and Settlement Date [Page 194]
- Tax Determination [Page 196]
**Pricing Procedure Determination**

**Use**

Because the R/3 condition technique from pricing is used for calculating the shipment costs, the most important tool for controlling shipment costing is the pricing procedure. The pricing procedure contains all condition types that are to be used for shipment costing and it defines the sequence in which calculation is carried out in the shipment cost document. You can specify requirements in the determination procedure which define when individual conditions are considered. The pricing procedure allows any number of subtotals between the gross value and the net value.

For further information on the role of the pricing procedure in pricing, see Pricing Procedures [Ext.].

The following figure gives an example of the role of a pricing procedure within shipment costing.

![Diagram](Image)

<table>
<thead>
<tr>
<th>Level</th>
<th>Condition type</th>
<th>Description</th>
<th>Reference level</th>
<th>Manual</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FR00</td>
<td>Basic freight</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Gross value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>MG01</td>
<td>Discount %</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>MG02</td>
<td>Discount %</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>Disc. value</td>
<td>3-4</td>
<td>x</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Net value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ZS01</td>
<td>Insurance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>ZS02</td>
<td>Demurrage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>Net value 2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The pricing procedure is automatically determined during shipment costing. The pricing procedure determined for shipment costing depends upon the transaction. Therefore, a pricing procedure is determined for every shipment cost item, depending on

- Transportation planning point
- Service agents
• Shipment cost item
• Shipping type

You can also override automatic determination of the pricing procedure by specifying it in the shipment header or the shipment stage.

**Prerequisites**

To determine the pricing procedure automatically, you must make the following settings in Customizing:

• Item category determination procedure group
  You must define an item category determination group and assign the corresponding items to this group.

• Service agent determination procedure group
  You must define a service agent determination group and assign the corresponding service agents to this group.

• Shipping type determination procedure group
  You must define a shipping type determination group and assign the corresponding shipping types to this group.

• Assignment by transportation planning point
  You must then assign a valid combination of item category determination group, service agent determination group and shipping type determination group to a pricing procedure for every transportation planning point.

**Features**

Based on the configurations made in Customizing, the system automatically determines a pricing procedure. This is carried out either when you create a shipment cost item or when you carry out pricing again for an item.

You can also override automatic determination of the pricing procedure by specifying it in the shipment header or the shipment stage. You can also specify a pricing procedure in Customizing for route definition in the stages overview.
Freight Cost Estimate

Use

Using this function, the transportation planner can execute a freight cost estimate during shipment processing. In this way, he can take a look at the shipment costs that may be incurred by the shipment. The freight cost comparison forms an important basis for making a decision in transportation planning and thus also helps to reduce the shipment costs.

In transportation tendering in the business-to-business scenario through the Internet, the planner can also calculate the maximum price that is not to be exceeded by the forwarding agent.

Integration

This function is used within the framework of the business-to-business Internet functionality Transportation Tendering [Page 439].

Features

The planner can change shipment data such as the forwarding agent, shipping conditions, mode of transport, and can calculate his shipment costs on the basis of this data.

The functions include:

- Calculation and display of shipment costs
- Detailed display of shipment cost document
- Display of processing log
- Calculation of maximum price within transportation tendering

Activities

You can simulate the shipment costs during shipment processing. To do this, select the pushbutton “Freight cost estimate” on the overview screen. The system calculates a price on the basis of the data specified. Under the tab page “Tendering” you can have the system propose a maximum price that is not to be exceeded by the forwarding agent. Choose the pushbutton “Shipment cost proposal”.


Determining the Calculation Basis

Use

The origin of the data upon which a condition type is based during shipment costing determines the calculation basis. During shipment costing, the system determines the shipment cost items from the different calculation bases for the condition types of a pricing procedure. Shipment costing itself is carried out for each sub-item.

Prerequisites

You must maintain a suitable calculation base in the definition for the condition type in Customizing.

If you select handling units as the calculation basis, you must also specify the packaging material type so that only the relevant handling units are used for shipment cost calculation.

Features

The calculation bases are determined during shipment costing for a shipment cost item on the basis of the settings made in the condition type.

During pricing, the calculation base influences

- The condition types to be considered for each sub-item
- The information available for determination of the conditions
  - All condition bases contain information from the shipment header or shipment stage, as well as from the shipment cost item. This information includes service agents, geographical information (point of departure and destination) and shipping type, for example.
- How the scale base types (gross weight, net weight and volume) are calculated

The following graphic contains examples of calculation bases.
Determining the Calculation Basis

The following types of calculation bases are possible:

- **Deliveries**
  - If condition types with this calculation base exist in the pricing procedure, then the system creates a shipment cost sub-item for every relevant delivery.
  - No information from the delivery items (such as materials) or the handling units is available.
  - The scale base types (gross weight, net weight, volume) refer to the corresponding information from the delivery headers.

- **Delivery items**
  - If condition types with this calculation base exist in the pricing procedure, then the system creates shipment cost sub-items for every relevant delivery item.
  - Information from the delivery header and the relevant delivery item is available. There is no information from the handling units, however.
  - The scale base types (gross weight, net weight, volume) refer to the corresponding information from the delivery items.

- **Group of Handling Units**
  - If condition types with this calculation base exist in the pricing procedure, then the system creates shipment cost sub-items for the sum of all identical handling units with the relevant packaging material type (also specified in the condition type).
  - There is no information from the deliveries or the delivery items available.
The scale base types (gross weight, net weight, volume) refer to the corresponding cumulated information from the relevant handling units.

- **Shipment cost item**
  - If condition types with this calculation base exist in the pricing procedure, then the system creates exactly one shipment cost sub-item.
  - There is no information from the deliveries, the delivery items or the handling units.
  - The scale base types (gross weight, net weight, volume) refer to the corresponding information from the relevant delivery headers.

- **Per handling unit**
  
  This calculation basis corresponds to the calculation basis handling units, with the only difference that each handling unit is calculated individually. This calculation base is necessary for shipping packages, for example.

- **Handling unit including delivery item**
  
  If condition types with this calculation basis exist in the pricing procedure, then the system creates a shipment cost sub-item for every packaged delivery item and handling unit (per combination of delivery item and handling unit). Shipment costs are therefore calculated with content depending on the handling unit.
  - All of the information from the handling units and delivery items is available.
  - The scale basis types (gross weight, net weight, volume) refer to the gross weight of a handling unit per delivery item.

- **All**
  
  You can use this calculation base if, for example, you want to define a discount that applies to both delivery-related and handling unit-related shipment prices. A condition type with this calculation base can be used for every shipment cost sub-item.

Several calculation bases may be used within a shipment cost item. In performing a shipment comparison, for example, the calculation could be performed using two calculation bases. You could then compare the results. See also [Shipment Comparisons](#) [Page 191].

For system load and clarity reasons, we recommend selecting a calculation base that is only as detailed as absolutely necessary. For example, if only the total weight and the transportation leg are relevant, the calculation base for shipment cost items is sufficient. However, you can still distribute the costs in greater detail. The cost distribution is independent of the calculation base. For example, you can calculate shipment costs using the calculation basis for shipment cost items and distribute the costs at delivery item level. The system weights the costs and distributes them accordingly.

When defining the condition tables in Customizing (Logistics Execution → Transportation → Shipment Costs → Pricing → Pricing Control → Define price"
Determining the Calculation Basis

dependencies (condition tables), you should make sure that information is not available for every field - depending upon calculation base. If, for example, you select the field Incoterms for a condition table when condition types with the calculation basis Handling units exist in the pricing procedure, there can be no information on Incoterms for the corresponding sub-item. This means that no condition records will be found for this key. For further information on the role of the condition table in pricing, see Condition Tables [Ext].
Examples for Calculation Bases

If only the leg and total weight are relevant for you, it is sufficient to perform a calculation at the level of the shipment cost item. In this way, you achieve the greatest clarity, as additional data from deliveries or handling units is superfluous.

If you draw up your contracts with the forwarding agent in such a way that the system performs a calculation per wire box, then you should use the calculation basis for handling units. All data relating to weight and volume then refers to the handling units.

If you charge each ship-to party but do not require any delivery item information, you can select the calculation base for deliveries.

If you must take different freight classes into account in the calculation, you require material data from the delivery item and must therefore perform a calculation per delivery item.

If you use a package shipment and must calculate each shipping unit separately, use the calculation basis per handling unit.
Consistency Check for Freight Costs

Use
You can check certain settings in the price determination control for consistency.

Prerequisites
In the Implementation Guide (IMG), you can maintain the Consistency Check for Settings for Price Determination [Ext.].

Features
1. The system checks for all condition types: Do the access sequences and calculation base match?
2. The system checks for all pricing procedures: Is at least one condition type entered whose calculation base is not '?'.

If the system finds an inconsistency, it issues a warning message.
Shipment Comparisons

Use

The system can carry out two different shipment cost calculations and compare them, automatically selecting the most favorable result.

Prerequisites

To perform shipment comparisons, you must make the following settings in Customizing:

- You must define condition exclusion groups.
- You must assign condition types to the condition exclusion groups.
- You must assign two condition exclusion groups and an exclusion procedure (for example, pick the most favorable of the exclusion groups) to a pricing procedure.

You make these settings in Customizing as follows: Logistics Execution → Transportation → Shipment Costs → Pricing → Pricing Control → Condition Exclusion → Condition Exclusion for Groups of Conditions

Features

You can, for example, create condition types with the calculation basis Delivery items and condition types with the calculation basis Handling units in the same pricing procedure. You then define condition exclusion groups (A and B) and assign the two condition types with additional discounts to the two different exclusion groups. You then assign the exclusion groups to the pricing procedure and specify the exclusion procedure “least favorable of the exclusion groups”.

If you now carry out shipment costing with the pricing procedure described above, the system determines the shipment cost for exclusion group A and exclusion group B. In the first variant, costing is carried out for every delivery item. The shipment price is 1,358 USD. The second variant calculates the handling units. There are 6 pallets. The shipment price is 1,250 USD. The system selects the least favorable variant according to the exclusion procedure and performs a calculation per delivery item. All conditions for exclusion group B are inactive.
Determination of Geographical Influencing Factors

Use
Distance and other geographical considerations play an important role when calculating shipment costs.

You can define shipment cost conditions as dependent upon these considerations. For example, when defining a condition table in Customizing, you can select fields such as departure zone, destination region, destination postal code, and so on.

You define the condition tables for shipment costing in SD Customizing: Logistics Execution → Transportation → Shipment Costs → Pricing → Pricing Control → Define price dependencies (condition tables).

For further information on the role of the condition table in pricing, see Condition Tables [Ext.].

Features
You have the following options for representing geographical considerations in the system as part of pricing:

- Distances
  The distance can be used as a scale basis and calculation rule during the calculation of shipment costs. The distance can be stored in the shipment header or the shipment stage header. The distance can be entered in the following ways:

    - Manually
      You can enter the distance manually in the shipment document

    - Routes and route stages
      You can maintain the distance in route definition in Customizing for both routes and route stages. When the corresponding route is used, this value is copied to the shipment document as a system proposal.

    - Customer enhancement for distance determination
      If you want to determine distances automatically, you can activate a customer enhancement (enhancement 'V56DISTZ'), for user-defined distance determination.

- Locations and zones
  You have the following options for the origin of locations and zones that can be used to influence shipment costing. They are categorized into departure and destination-related data:

    - Address data
      Data such as the country, region, postal code or transportation zone that can be used as fields to define the condition tables, can be taken from the shipment address data.

    - Determination of tariff zones
You can set the automatic determination of tariff zones in Customizing. A tariff zone is the combination of a postal code area for a country. The tariff zone is defined in terms of the

- Transportation planning point
- Service agents
- Shipping type
- Country

For example, a postal code area has been assigned to a predefined tariff zone for a combination of transportation planning point, service agent, etc. If the system does not find a valid tariff zone for these criteria, it carries out determination again with an “empty” shipping type.

With the corresponding system settings, the tariff zone is determined automatically when it creates a shipment cost item. That is, when it creates a shipment cost document or when another item is created manually.

**Prerequisites**

- If you want the system to determine distances from the route or route stage, you must maintain the distances in Customizing for route definition. You make these settings in Customizing: *Sales and Distribution* → *Basic Functions* → *Routes* → *Define Routes* → *Define routes and stages*.

- If you want to use tariff zones for shipment costing, you must define them in Customizing and select them there for automatic determination. You make these settings in Customizing: *Logistics Execution* → *Transportation* → *Shipment Costs* → *Basic Shipping Functions* → *Define and assign tariff zones*.
Determining Pricing Date and Settlement Date

Use

The shipment document contains pricing date fields and settlement date fields at header level and at item level.

Pricing date

The pricing date is the date defined by date-dependent pricing elements such as conditions and the foreign currency rate.

Settlement date

The settlement date is the date on which the shipment cost item is entered in financial accounting or cost accounting. It is also the date entered in tax determination.

Prerequisites

To activate automatic determination of the pricing date or the settlement date, you must make the following settings in Customizing:

- Definition of the date rule
  
  When you define the date rule, you specify a sequence of shipping deadlines (for example, end of transportation planning or planned start of loading) which are used to determine the pricing date or the settlement date. The sequence of the deadlines reflects their priority for access. If there is no value for the first deadline, then the next deadline is checked, etc.

  You make these settings in Customizing: Logistics Execution → Transportation → Shipment Costs → Basic Shipping Functions → Define date rules.

- Assigning the date rule
  
  In the definition of shipment cost item categories, you can assign a date rule to the pricing date and one to the settlement date.

  You make these settings in Customizing: Logistics Execution → Transportation → Shipment Costs → Shipment Cost Document → Shipment Cost Types and Item cats → Define item categories.

Features

When calculating a shipment cost item, the system automatically determines the pricing date and the settlement date based on the settings in Customizing. You can overwrite this automatically determined date. When you create a shipment cost document manually, you can specify pricing date and settlement date manually. This date will be valid for all items and overrides the date determined. You can also overwrite this date at item level.

The following graphic illustrates automatic-date determination for the pricing date and settlement date.
Determining Pricing Date and Settlement Date

• Can be changed manually

Date rule 0005:

- Completion
- Loading start
- Loading end
- Check-in

Automatic determination:

Item category → Date rule 0005:

- Pricing date:
- Settlement date:

Item 1:

- Pricing date:
- Settlement date:

Item 2:

- Pricing date:
- Settlement date:

Item 3:

- Pricing date:
- Settlement date:

Can be maintained manually
Tax Determination

Use

When determining shipment costs, the system can also determine relevant taxes. Certain rules regarding the tax countries involved apply to this calculation.

Features

The system carries out tax determination within the framework of pricing. The settlement date is used to access the conditions. See also Determining Pricing Date and Settlement Date [Page 194].

To determine taxes within shipment costing, the system refers to the shipment document in order to determine the departure country and the destination country for tax determination.

The following rules apply to system determination of the tax countries:

Departure tax country

The departure country is determined for all relevant deliveries. If the country is the same for all of them, the system uses it as the departure tax country.

Otherwise:

If the shipment cost item refers to

- the shipment header,
  then the departure country from the first shipment leg is used as the tax country.

- a shipment stage (leg, load transfer point or border crossing point),
  then the departure country of the shipment stage is used as the tax country.

Destination tax country

The destination country is determined for all relevant deliveries. If the country is the same for all of them, the system uses it as the destination tax country.

Otherwise:

If the shipment cost item refers to

- the shipment header,
  then the receiving country of the last shipment leg is used as the tax country.

- a shipment leg,
  then the receiving country of the shipment leg is used as the tax country.

- a load transfer point or border crossing point,
  then the departure country of the shipment stage is used as the tax country.

To carry out your own tax country determination, you can use customer enhancement V54D0001.
Scales

Definition

Freight depends on certain influential sizes, which are illustrated with scales. Scales are divided into levels that have different values.

A scale consists of:

- A scale header, which includes general information about the scale (scale base type, scale type, rounding rule)
- An unlimited amount of scale levels [Ext.], each of which is made up of a value (such as weight, volume, postal code or distance) and a calculation type.

Each scale is an independent piece of master data that can be used in many different condition records. When you create a condition record, you can also maintain the condition rates or condition percentage rates according to the assigned scales.

Scale base type

The scale base type defines how the system interprets the scale. The scale can refer to weight or volume, for example. You can base a pricing element scale on one of the following criteria:

Examples of scale base types

- Gross weight
- Net weight
- Volume
- Distance
- Number of different means of transportation
- Time (travel time or wait time)
- Tariff zone (destination)
- Destination region

Scale type

A scale type is an indicator that controls how the scale levels are defined. The scale type indicates whether the scale values that were specified depict the upper- or lower boundaries for the scale levels.

- From a certain value, such as weight, onward (base scale)
- Up to a certain value, such as weight (to-scale)
- For exactly one value, such as postal code (same-scale)

Use

You can define scales when you create condition records. The scale you use determines how shipment costs are calculated. For example, you can use a scale to define that the freight rate that is used for calculation depends on the weight being transported and the distance it is being transported.
Freight rates can be maintained depending on scaling:

- Individual value (no scaling)
- One scale (weight, for example)
  Maintain freight rates for each scale value
- Two or three scales (weight and postal code, for example)
  Maintain freight rates for various combinations of the scale values

**Example**

Example of a freight matrix

<table>
<thead>
<tr>
<th>Kilometers / Tons</th>
<th>Minimum value</th>
<th>up to 5 tons</th>
<th>up to 10 tons</th>
<th>up to 20 tons</th>
<th>up to 25 tons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum value</td>
<td>2000.00</td>
<td>3200.00</td>
<td>5200.00</td>
<td>6000.00</td>
<td></td>
</tr>
<tr>
<td>up to 100 km</td>
<td>250.00</td>
<td>20.35</td>
<td>18.55</td>
<td>15.20</td>
<td>12.75</td>
</tr>
<tr>
<td>up to 500 km</td>
<td>450.00</td>
<td>33.60</td>
<td>29.50</td>
<td>25.20</td>
<td>21.30</td>
</tr>
<tr>
<td>up to 1,000 km</td>
<td>800.00</td>
<td>43.50</td>
<td>37.30</td>
<td>33.20</td>
<td>28.50</td>
</tr>
<tr>
<td>(and so on)</td>
<td>850.00</td>
<td>1.50</td>
<td>2.50</td>
<td>3.20</td>
<td>3.50</td>
</tr>
</tbody>
</table>

**Weight scale**

Scale base type: gross weight

Scale type: to-scale

**Distance scale**

Scale base type: distance

Scale type: to-scale

**Determining freight:**

Up to a *scale value* of 100 km and 5 tons, the *scale rate* is 20.35. For a scale value of 5 tons and 100 km to 500 km, the scale rate is 33.60. At a scale value of 90 km and 800 kg, the freight rate would be 20.35. The freight is calculated as follows: \(8 \times 20.35 = 162.80\). Since the minimum value is 250, however, the freight charged in this case is 250.

For more information, see:

[Creating Scales [Page 200]]
Creating Scales

Procedure

To create scales, proceed as follows:

1. Choose Logistics Execution → Master Data → Transportation → Shipment Costs → Scales → Create.

2. The Create scale: Initial screen appears.

3. Enter the scale base type. You can choose from the selection list, which includes gross weight, tariff zone, postal code, region, distance, for example.

4. Choose ENTER.

---

Create Scale: Overview Screen

1. Enter a name for the scale.

2. Indicate the scale type on the Scale tab page.

3. You can use a rounding rule for the scale base type to define that a value be rounded either up or down, for example. You can choose a suitable rounding rule from the selection list.

4. Enter a unit of measure for the scale.

5. Enter a Calculat. rule (condition basis) on the Calculatn tab page. You can choose gross weight, distance or travel time from the selection list, for example. This rule defines the multiplication factor.

6. In the Rounding rule field for the condition basis, you can specify how the value that is used as the starting value for the calculation should be rounded.

7. Enter the scale values you require.

8. Specify the calculation type.

   Calculation types (calculation rules) for scales:
   - Absolute value (an absolute value is chosen as the basis for calculation)
   - Relative to scale base type
   - Minimum value
   - Maximum value
   - Proportional rate

   It is also possible to go from absolute to relative values in the scale.

   The calculation type and rules control how the condition rate is interpreted in the condition record.

9. Enter a price unit and a value in the Price unit field (100 kg, for example).

10. Save your entries.

   The system informs you that the scale was saved. The scale creation screen reappears.
If you want to create multi-dimensional conditions (you can create up to 3 scales), simply repeat the process for creating scales.
Assigning Scales for Condition Types

Use
The condition types represent the shipments. Using the condition types, you can determine whether the deduction is to be in percentage terms or in absolute terms. You enter an access sequence in each condition type that determines which fields are checked during the condition type search.

Prerequisites
The scales must already be created.

Procedure
In the Implementation Guide (IMG) you can assign scales to the condition types:

1. Select LE → Transportation → Shipping Costs → Price Determination → Pricing Control → Define Condition Types [Ext.]
2. Select a condition type on the "Change condition types" overview screen and double-click on "Scales for condition types" in the dialog structure.
3. Enter the scale ID of the scales, to which you want to assign condition types.
4. Save your entries.
Creating Condition Records

Procedure

To define condition records (shipment rates), proceed as follows:

1. Choose Logistics Execution → Master Data → Transportation → Shipment Costs → Prices → Create.

2. In the screen "Create Condition Records", choose a condition type. The condition records refer to the condition type that you have created.

3. Choose Enter.

4. Confirm the assignment of the scales in the dialog box. You now have the option of choosing scales that were created with the same scale base type or creating new scales.
   - On the tabstrip Key, you see an overview of the selected values, and on the tabstrip Scales you see the values of the scales.

5. Using the pushbutton Scales, you can branch to the screen for creating condition records.

6. Now you can enter values in the freight matrix.

7. Save your entries.

For more information, see Condition Technique [Ext.].
Multi-Dimensional Condition Scales

Use
In the shipment costs area, it is standard procedure to bargain for multi-dimensional tariffs that include both geographical aspects (such as distances or tariff zone) and quantity aspects (such as weight or volumes) of the shipment.

Features
To define these multi-dimensional conditions, several scales are assigned to a condition. The scales can be defined as separate data, independently of the respective condition, and then assigned to several condition types. When you create a condition record, the scales assigned to the condition type appear as default values. You can, however, replace the proposed scales by other scales.

To depict a two-dimensional freight condition, assign two scales to a condition type. You can assign a maximum of three scales to depict a three-dimensional condition.

You want to make the prices depend on the postal code of the point of departure, the postal code of the destination, and the gross weight. Since you are organizing the shipments for several shipping points, the point of departure is relevant in addition to the destination. For the postal code, you can specify that only the first two characters of the postal code are to taken into account. In this way, you can save yourself the task of maintaining tariff zones, for example. In this case, a three-dimensional condition is necessary.

For each scale level, you can also specify a calculation type that defines whether an absolute amount or a relative amount (per 100 kg, for example) is to be calculated for. You could specify for up to 5 tons of weight an absolute price of 250 US$, and then for each scale level a relative price of 100 kg. You can store minimum and maximum prices for each scale level.

Constraints
Note that there are no change documents for the freight rates.

See also:
Scales List [Page 216]
Allocating/Loading Condition Records

Use
To calculate the freight costs for shipments, you can store pricing conditions with up to three scales in the SAP System. To simplify handling and reduce the processing effort required, we have extended the function for allocating the price conditions in the current ALE scenario.

Features
You can allocate multi-dimensional freight conditions from an SAP system to other systems using ALE. Here you can use the IDoc to copy conditions from an external system.

You use the change transaction to initiate the transmission of a freight condition. You can select individual records for transmission from the list of conditions (through "Condition Info").

For more information, refer to the section IDoc Tracing [Ext].
Break-Weight Calculation

Use

Break-weight calculation is required for several shipment contracts. In break-weight calculation, the system calculates at what weight onwards the price becomes cheaper, in order to get to a higher and more reasonable pricing scale level.

You have agreed on shipment rates where at scale level 5 to 10 tons of weight to be shipped the price is 6 USD per 100 kg, and at scale level 10 to 15 tons of weight to be shipped the price is only 5 DM per 100 kg. These are “From” scales, that is, from 10 tons onwards, the system calculates the price according to the second scale level. So, if you have a shipment of 9 tons, the break-weight calculation is that the price is cheaper if 10 tons are charged (= 500 USD) rather than 9 tons (= 540 USD). The break weight is the weight starting from which it is cheaper to calculate 10 tons rather than the real weight. In this example, the break weight is between 8.3 and 8.4 tons.

Features

During break-weight calculation, the use of two condition types is necessary. The first condition type is used for “standard” calculation of the shipment costs. The second condition type is used for calculation of the shipment costs at the next higher scale level. Now the system compares the two calculated values using a type of exclusion procedure and takes the most reasonable value as the price.

Activities

You create the second condition type with a reference to the first condition type (can be set using the fields Reference condition type and Reference application). The second condition type, therefore, uses the same condition records as the first condition type. When you assign the scales, select the break-weight indicator only for the second condition type. This indicator has the effect that, when the shipment costs are calculated, the next higher scale level is used for the calculation. Therefore, two calculations take place: in the “standard” way and at the next higher scale level. With multi-dimensional scales, you set the indicator in the scale where the break-weight is to be calculated (in the case of a condition type that contains a distance and weight scale, for example, you could set the indicator in the weight scale). When the shipment costs are calculated by the system, it compares the costs. For this purpose, you need to define a condition exclusion group, assign both condition types to the exclusion group, and then specify the exclusion procedure. The cheaper cost between the condition types. You then assign the exclusion procedure to your calculation procedure.

If you wish to first consider the surcharges and discounts before you execute and compare the calculations, define two exclusion groups, assign a condition type plus surcharges and discounts to an exclusion group, and select the exclusion procedure The cheaper cost between the exclusion groups.
Creating Shipment Cost Documents Online

Prerequisites

Before you create a shipment cost document, the following settings must be made in Customizing:

- The number ranges must be defined for shipment costs.
- The shipment cost types and item categories must be defined and assigned.
- For each shipment type, you must define the relevance for shipment costs for header, leg, border crossing point and load transfer point.
- You can assign shipment costs to the shipment cost types. These shipment costs are then proposed during creation of the shipment cost document.

You make these settings in Customizing. Choose: Logistics Execution → Transport → Shipment costs → Shipment cost document and select the IMG activity you require.

To create a shipment cost document for a shipment or a shipment stage, the shipment must have the overall status required in the definition of the shipment cost type. It must also have a 'planned' transportation status.

Procedure

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → Create.
4. Specify the shipment number for the shipment for which you want to calculate shipment costs.
5. If you have not defined default values in Customizing (see above, assignment to a shipment type) enter a shipment cost type.

The shipment cost type contains control elements that allow different processing options for shipment cost documents. These control elements include the overall status that the shipment must have before the shipment cost document can be created.
6. If you want to override the pricing date and the settlement date that are determined automatically (depending on settings in Customizing) for every shipment cost item, you enter a pricing date and a settlement date here.

The date that you enter here can still be overwritten at item level. For further information on pricing and settlement dates, see Determining Pricing Date and Settlement Date [Page 194].

Result

Depending on the system configuration, the system carries out the following actions automatically when the shipment cost document is created.
Creating Shipment Cost Documents Online

- Creates shipment cost items
- Creates and calculates shipment cost items
- Creates, calculates and carries out account assignment for shipment cost items
- Creates, calculates and carries out account assignment for shipment cost items and then forwards them to financial accounting and cost accounting

You maintain the level of automatic processing in Customizing. To do this, select the following path Logistics Execution → Transportation → Shipment costs → Shipment cost document → Shipment cost types and item categories → Assign shipment cost types and item categories.
Creating Shipment Cost Documents with Work Lists

Prerequisites

The work list allows you to create several shipment cost documents simultaneously. A comprehensive range of shipment selection criteria exist to help you create the work list.

The selection screen gives you a range of criteria to choose from. To get a better overview of this screen and to make maintenance easier, you can define selection variants in Customizing. In the IMG, choose: Logistics Execution → Transportation → Shipment costs → Shipment cost document → Selection variants for shipment cost list and work list. This is where you define the selection variants for the work list for shipment cost creation.

Before you create a shipment cost document, the following settings must be made in Customizing:

- The number ranges must be defined for shipment costs.
- The shipment cost types and item categories must be defined and assigned.
- For each shipment type, you must define the relevance for shipment costs of the header, leg, border crossing point and load transfer point.
- You can assign shipment cost types to the shipment costs. These shipment costs are then proposed during creation of the shipment cost documents.

You make these settings in Customizing. Choose: Logistics Execution → Transport → Shipment costs → Shipment cost document and select the IMG activity you require.

To create a shipment cost document for a shipment or a shipment stage, the shipment must have the overall status required in the definition of the shipment cost type. It must also have a 'planned' transportation status.

Procedure

To create a work list online:

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → Shipment cost worklists → Create online
   You branch to a selection screen.
4. Enter your selection criteria and choose Execute.

To create a work list in batch immediately:

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → Shipment cost worklists → Create batch
You reach a screen where you can choose the selection variants.

The system proposes standard selection variants and selection variants that have been defined in Customizing. You can still change the selection variants here but you cannot create any new ones. You can create new selection variants in the IMG. Choose Logistics Execution → Transportation → Shipment costs → Shipment cost document → Selection variants for shipment cost list and worklist → Create selection variants for shipment cost work list.

4. Place the cursor on the required selection variant for creating a work list and select Immediate start.

The shipment documents will be created in the background immediately.

To create the shipment cost documents in the work list at a specified time:

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → Shipment cost worklists → Create batch
4. Place the cursor on the required selection variant for creating a worklist and select Schedule job.

You reach a screen in which you can specify the date and time.

5. Specify the date and the time when you want the batch job to start.
6. If you want to start the batch job at regular intervals, select Schedule periodically.

A dialog box appears, in which you can specify the repeat period.

7. Select the repeat period, e.g. every month, every 2 days, etc.

**Result**

Depending on the system configuration, the system carries out the following actions automatically when the shipment cost document is created.

- Creates shipment cost items
- Creates and calculates shipment cost items
- Creates, calculates and carries out account assignment for shipment cost items
- Creates, calculates and carries out account assignment for shipment cost items and then forwards them to financial accounting and cost accounting

You maintain the level of automatic processing in Customizing. To do this, choose the following path Logistics Execution → Transportation → Shipment costs → Shipment cost document → Shipment cost types and item categories → Assign shipment cost types and item categories.

The system creates a log of the activities carried out and the errors that have occurred. You can call the log from the work list or you can view it in the shipment cost menu under Shipment costs → Shipment cost worklist → Logs.
Processing the Shipment Cost Document

Prerequisites

To process shipment cost documents you can either call up a shipment cost document in change mode or you can create lists of the shipment cost documents. You can create the following lists:

- Shipment cost documents for calculation
- Shipment cost documents for settlement

Procedure

To process a single document:

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → Change.
   You can now process the document.

To create lists of shipment cost documents to be changed:

1. Choose Logistics → Logistics Execution → Transportation.
2. Choose Shipment → Shipment costs.
3. Choose Shipment costs → List → Calculation (or Settlement)
4. Enter your selection criteria and choose Execute.
   You receive a list of shipment cost documents that meet your criteria. The list also displays the items.

   The selection screen for creating lists gives you a range of criteria to choose from. To get a better overview of this screen and to make maintenance easier, you can define selection variants in Customizing. In the IMG, choose: Logistics Execution → Transportation → Shipment costs → Shipment cost document → Selection variants for shipment cost calculation or Selection variants for shipment cost settlement list.
Shipment Costs List: Calculation

Use
You can use this report to list shipment cost documents which have not yet been completely calculated or if you still have questions regarding calculation. As selection criteria for the shipment cost documents, you can use, for example the calculation status, the date of calculation or the pricing date.

Features
After executing the report you receive a list of all shipment cost documents, which correspond to your selection criteria.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Example
An employee wishes to have an overview of the shipment cost documents he has created that week in order to determine whether some have not yet been completely calculated. He creates a list of shipment cost documents for calculation. As selection criteria he gives his user name in the field Created by and the data for the last week in the field Created on. For the calculation status he enters Not calculated and Partly calculated. He receives a list of all shipment cost documents which he has created in the last week and that are not yet completely calculated.

See also:
Creating Shipment Document Lists for Calculation [Page 215]
Editing Shipment Lists [Page 57]
Creating Shipment Document Lists for Calculation

Procedure

To create a list of shipment documents for calculation, proceed as follows:

1. Choose Logistics Execution ➔ Transportation ➔ Shipment Costs.
   You reach the Shipment costs screen.

2. Choose Shipment ➔ List ➔ Calculation.
   You branch to the List Shipment Costs: Calculation screen:

3. To use other selection criteria, choose Edit ➔ All selections.
   To define recurring selection criteria, you can create selection screen variants by choosing Goto ➔ Variants ➔ Save as a variant. Then, to retrieve these variants, choose Goto ➔ Variants ➔ Get.

4. Enter the criteria you want to use for selecting the shipment costs documents.

5. Choose Program ➔ Execute.
   You obtain a list of all the shipment documents that match your selection criteria.

For more information about processing this list, see Editing Shipment Lists [Page 57]
Scales List

Use
You can use this report, for example, when creating prices or surcharges and discounts, to gain an overview of which scales already exist for master data, in case these are needed.

Features
After executing the report you receive a list of all scales that correspond to your selection criteria. The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Example
An employee from the transportation department would like to create a two-dimensional price structure and wants to know if he can use the weight and distance scales which already exist. First, he uses the report to create a list of all scales with the scale base type Gross weight, and then a list with the scale base type Tariff zone destination. Using this list, he can find a weight scale that he can use.

See also:
Creating Scales Lists [Page 217]
Editing Shipment Lists [Page 57]
Multi-dimensional Condition Scales [Page 204]
Creating Scales Lists

Procedure

To create a scales list, proceed as follows:

1. Choose Logistics Execution → Outbound Process → Shipment → Shipment costs.
   You reach the Shipment costs screen.

2. Choose Master data → Scales → Scales List.

3. To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.

4. Enter the criteria you want to use for selecting the scales.

5. Choose Program → Execute.
   All scales matching the selection criteria are listed.

For more information about processing this list, see Editing Shipment Lists [Page 57]
Transportation (LE-TRA)

Shipment Cost Settlement with Service Agent

**Shipment Cost Settlement with Service Agent**

**Purpose**

The settlement of shipment costs with the service agent is carried out per shipment cost item.

Settlement includes:

- Assignment and forwarding of the shipment costs to FI and cost accounting for creation of accruals and posting of payables
- Automatic settlement using the self-billing procedure or manual settlement with the transportation service agent

**Prerequisites**

You can only carry out settlement for shipment cost items that have already been calculated.

The necessary settings in Customizing must also be made. This includes maintaining the account assignment category or the settings for G/L account determination. You can make these settings in the IMG under *Logistics Execution ➔ Transportation ➔ Shipment costs ➔ Settlement*.

**Process Flow**

1. **Account assignment**
   
   During account assignment, the system carries out the two following functions simultaneously:
   
   - **G/L account determination**
     
     First the system determines the correct G/L account in FI for every individual shipment cost item.
   
   - **Assignments for cost accounting**
     
     The system also determines the accounts in cost accounting. Account assignment can be carried out at several levels, depending on how closely you want to monitor costs.

2. **Release or transfer to financial accounting**
   
   After account assignment, you can start transferring to financial accounting. This phase involves two stages that can be carried out either consecutively or simultaneously. See also [Transferring Shipment Costs to Accounting](#) [Page 235].
   
   - **Purchase order determination**
     
     Transfer to accounting for the creation of accruals requires a service entry. Every service entry sheet is based on a purchase order. This purchase order must first be created in purchasing for the service agent. The first stage in the transfer involves determining these purchase orders according to certain settings.

     If several possible purchase orders were selected, the system sorts them according to the following criteria:
     
     - According to date type (ascending)
     - According to validity period start date (descending)
Shipment Cost Settlement with Service Agent

- According to validity period end date (ascending)
- According to purchase order number (ascending)
- According to purchase order item number (ascending)

- Creating the service entry sheet and creating accruals
  The second stage in the transfer involves creating the service entry sheet that refers to a purchase order. Acceptance of services performed is posted and an accounting document is created in FI for creation of accruals. The system creates further subsequent documents in FI.

3. Invoice creation
   - Self-billing procedure (Evaluated Receipt Settlement procedure -ERS)
     Using this procedure, you can settle the shipment costs with the service agent without having to receive an invoice. You can select between several settlement periods. You transfer the shipment costs that were calculated to Accounting. Invoice verification is carried out by the service agent. If the service agent finds errors, you can post these as subsequent debits.
   - Manual invoice check
     When the service agent receives the invoices, you can also carry out an invoice check manually and create the invoices manually.

The following figure illustrates the settlement process:

See also:
G/L Account Determination [Page 221]
Assignments for Cost Accounting [Page 222]
Shipment Cost Settlement with Service Agent

- Purchase Order Determination [Page 224]
- Creation of Accruals [Page 226]
- Self-billing Procedure [Page 230]
- Manual Invoice Verification [Page 236]
G/L Account Determination

Use
To create accruals and post payables, the system must first of all determine the correct G/L accounts for posting in FI.

Prerequisites
Before the system can determine the G/L accounts, certain settings must be made in Customizing. In the IMG, select: Logistics Execution → Transportation → Shipment costs → Settlement → Automatic G/L account determination. The settings required are described in detail here.

Features
G/L account determination is carried out automatically. The following parameters are used for determination:

- Chart of accounts
- Valuation grouping code
- Transaction key
- Account grouping
- Valuation class

G/L account determination can be carried out at shipment cost item level or you can have the system carry out posting at delivery or delivery item level for a more detailed process. Also refer to Cost Apportionment in Assignments for Cost Accounting [Page 222].

See also:
Carrying out Account Assignment [Page 233]
Assignments for Cost Accounting

Use

To post objects in cost accounting, the system first has to determine the correct objects. The system can carry this out automatically during account assignment. You can also enter the assignments manually.

Prerequisites

If you want the system to determine the objects in cost accounting, you must make certain that certain settings have been made in Customizing.

Features

The system automatically determines the objects to be posted in cost accounting. The following parameters are important:

- Account assignment category
  
The account assignment category determines which object needs to be posted to (e.g. cost center or order) and which account assignment data are necessary. In order to define account assignment categories, go to the IMG and choose Logistics Execution ➔ Transportation ➔ Shipment costs ➔ Settlement ➔ Maintain account assignment category.

- Cost apportionment
  
The cost apportionment determines the level at which the costs are to be forwarded. You can apportion the costs at more detailed levels than the shipment cost item, depending on the how closely you want to follow costs. Possible apportionments are:

  - Shipment cost item
  - Delivery
  - Delivery item

  These apportionments are completely independent of the calculation bases. If they do agree with the calculation bases, then the system apportions costs according to origin. If the costs are apportioned to a more detailed level than the calculation bases, then this is carried out according to the proportional weight. (Example: calculation basis = delivery; cost apportionment by delivery item).

  If costs are not to be apportioned by the proportional weight, then you can program the apportionment according to other rules in customer enhancement V54SFRC.

  You can use the origin of the CO assignments to restrict the possible levels of the cost apportionment.

  - You assign the cost apportionments in Customizing for the shipment cost item category. To make this setting, go to the IMG and choose Logistics Execution ➔ Transportation ➔ Shipment costs ➔ Shipment cost document ➔ Shipment cost types and item categories ➔ Assign shipment cost types and item categories.
• **Origin of CO assignments**

  This parameter determines the origin of the information used for determining the CO object. The possible sources of this information are:

  - **G/L account**

    If the G/L account is determined by the system or entered manually, then the system accesses a Customizing table in which a CO assignment is maintained for each G/L account. You can find this table in the IMG by selecting *Logistics Execution → Transportation → Shipment costs → Settlement → Automatic determination of CO assignments*.

  - **Delivery, order**

    The system first searches the delivery for CO assignments. If it doesn't find any, it searches the order.

  - **Delivery, order, G/L account**

    The system first searches the delivery for CO assignments. If it doesn't find any, it searches the order. If it doesn't find any in the order, it accesses the Customizing table where the CO assignments for the G/L account assignments are maintained.

**See also:**

*Carrying out Account Assignment [Page 233]*
Purchase Order Determination

Use
Forwarding to financial accounting for the creation of accruals requires a service entry. Every service entry sheet is based on a purchase order. Determining this purchase order is the first stage for forwarding to FI and therefore the first stage required for carrying out settlement.

Integration
The purchase order is created in Purchasing.

Prerequisites
This purchase order must first be created in Purchasing. Important criteria for the purchase order are:

- Service agents
- Purchasing organization
- Purchasing group
- Plant
- Item category

You must create the purchase order for a service agent. The purchase order can be valid for the following periods:

- Day
- Week
- Month

In Customizing the purchasing organization, the purchasing group and the plant must be assigned to the corresponding transportation planning point and the shipment cost type. You make these settings in the IMG. Choose Logistics Execution → Transportation → Shipment costs → Settlement → Assign purchasing data.

Features of the Purchase Order
The purchase order must have the following characteristics:

Purchase order header

<table>
<thead>
<tr>
<th>Company code</th>
<th>Company code for transportation planning point of the shipment cost item (Item detail: Reference)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchasing organization</td>
<td>from shipment cost item (Item detail: Service procurement)</td>
</tr>
<tr>
<td>Purchasing group</td>
<td>from shipment cost item (Item detail: Service procurement)</td>
</tr>
<tr>
<td>Document currency</td>
<td>from shipment cost item (Item detail: Price setting)</td>
</tr>
</tbody>
</table>
## SAP AG Transportation (LE-TRA)

### Purchase Order Determination

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Transportation service agent from shipment item (Item detail)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoicing party</td>
<td>Invoicing party from shipment cost item (Item detail: Settlement)</td>
</tr>
<tr>
<td>Run time start/end</td>
<td>If these times are specified, then the settlement date of the shipment cost item must fall within this period (Item detail: Settlement)</td>
</tr>
</tbody>
</table>

### Purchasing item

<table>
<thead>
<tr>
<th>Plant</th>
<th>from shipment cost item (Item detail: Service procurement)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase item category</td>
<td>Service</td>
</tr>
<tr>
<td>Account assignment category</td>
<td>Not blank</td>
</tr>
<tr>
<td>Delivery date</td>
<td>The settlement date of the shipment cost item must fall within this period (Item detail: Settlement)</td>
</tr>
<tr>
<td>Final invoice indicator</td>
<td>Not set</td>
</tr>
<tr>
<td>Block indicator</td>
<td>Not set</td>
</tr>
</tbody>
</table>

The shipment cost items must have status **account assigned**. In other words, G/L account determination and assignment for cost accounting must have been carried out already.

### Features

If an invalid purchase order exists, the system determines the purchase order during forwarding to FI.

**See also:**

[Transferring Shipment Costs to Accounting [Page 235]]
Creation of Accruals

Use
To create accruals in FI for the planned payments, the calculated shipment cost items must be forwarded to FI.

Prerequisites
The shipment cost items must have status account assigned. In other words, G/L account determination and assignment for cost accounting must have been carried out already.

Features
When forwarding the calculated shipment cost items to FI, the system carries out the following:

- It creates a service entry sheet that refers to the purchase order determined.
- It posts acceptance of services performed.
- It creates an accounting document for the accruals.
- Further subsequent documents are created in FI.

See also:
Transferring Shipment Costs to Accounting [Page 235]
Shipment Costs as Delivery Costs

Use

Regarding transportation processing, delivery costs can be considered for both standard purchase orders and stock transfer orders. The determined shipment costs are not directly transferred to the accounting department, but are included in the MM goods receipt document and added to the respective material. This scenario is relevant for company-internal shipments or for inbound shipments that are picked up from the vendor since the customer might get better conditions from his carriers.

The business process could be as follows:

- Entering the standard purchase order with shipping notification
- Editing the delivery from the delivery due list (VL32)
- Generating an inbound shipment with the delivery
- Creating the shipment cost document on the basis of the shipment
- Posting the goods receipt with reference to the inbound delivery

Prerequisites

To add shipment costs to delivery costs in the incoming shipments, you need the following settings in Customizing:

- Shipment cost item categories
  Under the Shipment cost types and item categories [Ext.] activity, set the Relevant for costing field to A = Relevant for calculating delivery costs (Delivery costs). This results in the shipment costs not being transferred directly into accounting. The accounting is done via the purchasing functionality for delivery costs.

- Conditions in the purchase order
  Under the Define condition types [Ext.] activity, set the Condition type field to B = Delivery costs. In addition, select the Transfer shipment costs field. The system only shows this field, if you have chosen delivery costs as condition type. In the purchase order, you have to enter the condition type in the item category section. However, you do not enter a value since this value will be determined by the shipment cost document and will then be automatically transferred to the goods receipt document.

- Goods receipt
  To find the relevant shipment cost documents, you must know the corresponding inbound deliveries. Therefore for incoming goods this must relate to confirmation-related goods receipts. Under the Set up confirmation control [Ext.] activity, select the GR-relevant and GR assignment fields for the appropriate confirmation control key (which is then entered in the purchase order).

Features

Further information can be found in Purchasing Delivery costs [Ext.].
Example

The following shows an example of shipment costs being included in material costs. These shipment costs are shown as delivery costs.

Purchase order: Material 4711, 200 pcs, DEM 20 per piece
Inbound delivery 1: 100 pcs (Date 1)
Inbound delivery 2: 100 pcs (Date 2)
Shipment 1 with inbound delivery 1: Costs DEM 250

Goods receipt for inbound delivery 1 – 100 pcs

Material costs DEM 2000
Shipment costs DEM 250

Overall costs posted

to the material account DEM 2250

Unit costs that are included

In the material master DEM 22.50

The assumption is that the stock included 50 pcs with unit costs of DEM 18.00 before this goods receipt was posted. After the goods receipt the stock would now include 150 pcs with costs of DEM 21.00 per piece:

50 pcs/ DEM 18.00 = DEM 900.00
100 pcs/DEM 22.50 = DEM 2250.00
Total = DEM 3150.00 : 150 pcs = DEM 21.00/pc.

If the system had not found any shipment costs, the costs would amount to DEM 19.33 per pc.:

50 pcs/DEM 18.00 = DEM 900.00
100 pcs/DEM 20.00 = DEM 2000.00
Total = DEM 2900.00 : 150 pcs = DEM 19.33/pc.

Shipment costs of this kind are not included in the purchase order. Therefore, the system does not display these costs on the item category view of the purchase order. The system copies these costs during the goods receipt posting. The shipment cost processing is carried out as if you had entered them in the purchase order item.

In general, such shipment costs are treated as planned delivery costs in purchase order processing.
Self-billing Procedure

Use

The self-billing procedure allows you to settle shipment costs without needing to receive an invoice. In addition to the option of receiving an invoice from the service agent for the transportation services rendered, you can also have the service agent create a credit memo. In this case, the shipment costs calculated are forwarded directly to FI. The payment is then checked by the payee.

Whether or not this self-billing procedure is used depends upon the agreement with the service agent.

The advantages of this procedure are:

- faster and more efficient completion of the business transaction
- fewer price deviations in the invoice check

The following graphic shows the self-billing procedure:

Integration

The self-billing procedure is integrated into Purchasing as an automatic goods receipt settlement or ERS procedure (ERS = Evaluated Receipt Settlement).

Prerequisites

The basic prerequisite for automatic settlement of shipment costs is reference to an existing purchase order.

The purchasing department can mark the vendor as *subject to ERS* in the vendor master record. If a vendor is marked as subject to ERS, then the ERS indicator is proposed for every purchase item in a purchase order created with this vendor. The purchaser can delete the ERS indicator proposed in a purchase item.

Features

In the self-billing procedure, a distinction is made between

- Individual credit memos
- Collective credit memos

For individual credit memos, a separate credit memo is created for each shipment cost document and service agent. In a collective credit memo, all shipment cost documents for a service agent are taken into account for the period specified.

Settlement with the service agent is usually carried out at regular intervals. The length of this period depends on the agreement with the forwarding agent. The settlement periods can be set flexibly within the ERS procedure.

Printing the log and the credit memo

The system creates a log during the ERS procedure. It lists:
- Processes that could not be settled
  Depending on the restrictions entered, all purchasing items intended for ERS, but which could not be settled, are displayed here along with the reason for the failure.
  If you have completed a procedure manually, you should exclude it from the ERS procedure so that it is not listed again every time the procedure is carried out automatically. To do this, carry out automatic goods issue settlement in test mode online, select the item and choose *Exclude from ERS*.

- Processes that were settled
  Depending on the restrictions entered, all purchasing items for which settlement has been successfully carried out (or would be carried out - if you are working in test mode) are displayed here.

- Credit memos that were printed
  During settlement for shipment costs, not only the log, but also the credit memo is issued as output by the system.
Carrying out the Self-Billing Procedure

Prerequisites

Using the self-billing procedure, you can only create invoices that have already been assigned accounts and that have been forwarded to FI.

Procedure

1. In the initial screen, choose Logistics → Material management → Invoice verification → Logistics inv. verif.
2. Choose Further processing → Execute ERS.
3. Enter your selection criteria and choose Execute.

Result

The system displays all invoices that the system has created for the material documents (acceptance of services performed) that meet your selection criteria.
Carrying out Account Assignment

Prerequisites

Account assignment for the shipment cost item, that is G/L account determination and assignment for cost accounting can only be carried out if shipment cost calculation has been carried out.

Procedure

1. In the shipment cost document, go to the detail screen of a shipment cost item, for which costing has already been carried out and for which you want to carry out account assignment.
   
   In the Settlement tab page, the field should have a status of account assigned.

2. Choose Item → Account assignment.

   You reach the Shipment cost item: Account assignment screen. This is where you can view the account assignment data and the account assignment lines, as well as the G/L account determined and the CO assignments per account assignment line. You can also change these accounts and assignments manually.

   The number of account assignment lines depends on the value in the cost apportionment field. This field determines whether account assignment is carried out per shipment cost item, per delivery or per delivery item. The definition of the shipment cost item category controls the cost apportionment.

3. If you want to change the G/L accounts or the CO assignments determined, you can overwrite the default values.

4. You can make additional entries in the detail screen for account assignment.

5. Save the shipment cost document.

   After saving, you return to the initial screen for shipment costs.

   You can still delete an account assignment that has been carried out, as long as forwarding to FI has not yet taken place. Otherwise, you must cancel forwarding first and then delete the account assignment.

   To delete the account assignment you select Settlement in the tab field of the detail screen for the shipment cost item, and then Item → Delete account assignment.

Result

The account assignment status is changed. The shipment cost item can now be forwarded to FI.

See also:

G/L Account Determination [Page 221]
Assignments for Cost Accounting [Page 222]
Carrying out Account Assignment
Transferring Shipment Costs to Accounting

Prerequisites

To transfer shipment cost items to FI, they must have status *Account assigned*. In other words, G/L account determination and assignment for cost accounting must have been carried out already.

Transferring of shipment costs in order to create accruals comprises two functions:

- Purchase Order Determination
- Transfer and creation of the relevant documents in FI

Procedure

1. In the shipment cost document, go to the detail screen of a shipment cost item, for which costing and account assignment has already been carried out and which you want to transfer to FI.
2. Select the *Transfer* indicator. This indicator can only be selected after account assignment.

   Purchase order determination is automatically started when you select the *Transfer* indicator. As long as the indicator is selected, the purchase order will be displayed in the *Service procurement* tab field in the *Purchase order* field. For further information, see *Purchase Order Determination* [Page 224].

3. Save the shipment cost document.

Result

When you save, the system creates a service entry sheet with reference to the purchase order determined, an accounting document for creation of accruals and further documents in FI.

See also:

*Creation of Accruals* [Page 226]
Manual Invoice Verification

Use

During manual invoice verification, you check and post the invoice that you have received from the service agent manually.

Prerequisites

You can only check invoices if the relevant shipment cost items have already had accounts assigned to them and if they have been transferred to Accounting (FI).

Procedure

   
   The Enter Invoice screen appears.

2. Enter the necessary header data for the invoice.

3. Select the transportation service agent as the reference in the list field in the lower section of the screen.

4. In the following field, enter the vendor’s name.

5. Choose More allocation criteria.

6. You can use the screen that appears to limit the shipment cost items further by entering the following, for example:
   
   - Shipment number or order
   - Identification
   - Means of transport, driver or alternate driver
   - Partners such as service agent, vendor, invoicing party
   - Attributes of the shipment cost header
   - Attributes of the settlement data
   - Attributes of services

7. Enter the selection criteria for the shipment cost items to which the invoice refers.

   At this point, you can also run a check by selecting Check. The system presents the results of this check in a log. This log contains the following information:

   - Invoices that have already been posted and subsequent debits for the relevant shipment cost items
   - Invoicing parties that are different from the vendor
   - Active ERS indicators in the relevant purchase orders
   - Tolerance limits for all the shipment cost items selected
– Tax values for all selected shipment cost items
8. Choose *Adopt*.

   You receive a list of all shipment cost items with the corresponding amounts.

9. Check the invoice values of the invoice that you have received from the service agent and select all the shipment cost items that the invoice refers to.

10. Choose *Post*.

    If deviations occur between the calculated shipment cost items and the items of the invoice that you receive from the service agent, you must process these deviations.

**See also:**

Invoice Verification in Dialog Mode [Ext.]
Shipment Costs List: Settlement

Use
You can use this report to list shipment cost documents which have not yet been completely calculated. As selection criteria for the shipment cost documents, you can use, for example, the account assignment status or transfer status.

Features
After executing the report you receive a list of all shipment cost documents, which correspond to your selection criteria.

The List Viewer features various functions that you can use to tailor the list to your needs. This tool allows you to total or sort columns, for example. You can also decide the sequence in which the columns are displayed. For more information, see ABAP List Viewer [Ext.].

Example
The system is set up so that the shipment cost items are automatically created when creating the shipment cost documents and the calculation is automatically implemented. The transfer is carried out twice a week in the evening as a collective batch. Then an employee creates a list of shipment costs for calculation. As selection criteria he enters the status Not assigned to an account and Not completely assigned to an account and Not transferred.

See also:
Creating List of Shipment Documents for Settlement [Page 239]
Editing Shipment Lists [Page 57]
Creating List of Shipment Documents for Settlement

Procedure

To create a list of shipment documents for calculation, proceed as follows:

1. Choose Logistics Execution → Transportation → Shipment Costs.
   The Shipment costs screen appears.

2. Choose Shipment → List → Calculation.
   You branch to the List Shipment Costs: Settlements screen.

3. To use other selection criteria, choose Edit → All selections.
   To define recurring selection criteria, you can create selection screen variants by choosing Goto → Variants → Save as a variant. Then, to retrieve these variants, choose Goto → Variants → Get.

4. Enter the criteria you want to use for selecting the shipment costs documents.

5. Choose Program → Execute.
   You obtain a list of all the shipment documents that match your selection criteria.

For more information about processing this list, see Editing Shipment Lists [Page 57]
Billing the Shipment Costs to the Customer

Use

Shipment costs can be a considerable cost factor. For this reason, they are often not included in the material price, but are billed separately by the shipper to the customer during billing.

You can bill the customer with the actual shipment costs, which include technical aspects such as distances, tariff zones, means-of-transport types, type and number of pallets.

Prerequisites

In Customizing, the following settings are required so that shipment costs that are not calculated in the shipment cost document can be billed to the customer in the customer billing document.

- In addition to the condition types that already exist, you must create condition types of the same name in the pricing procedure for shipment cost calculation and in the pricing procedure for billing price determination. In the pricing procedure for shipment cost calculation, you can mark the condition types as statistical values in order not to influence the shipment cost calculation. To do this, choose the following path in Customizing Logistics Execution → Transportation → Shipment costs → Pricing → Pricing control → Define and assign pricing procedures.

In the pricing procedure for billing price determination, these condition types must be marked manually. To do this, choose the following path in Customizing Logistics Execution → Basic functions → Pricing → Pricing control → Define and assign pricing procedures → Maintain pricing procedure.

- For the billing price procedure, the indicator Specific procedure must be selected so that the condition class and the statistical indicator are re-determined and are not copied from the shipment cost pricing procedure.

- Also, you must specify the price source “shipment costs” at the item level for copying control for billing documents. For this purpose, choose the following path in the Implementation Guide: Logistics Execution → Billing → Billing documents → Maintain copying control for billing documents → Copying Control: Delivery document to billing document, and specify the price source F for shipment costs for the respective billing and delivery types for the respective item.

Features

The shipment costs that are billed to the customer are based on the actual shipment costs that were calculated in transportation and shipment costing for settlement with the forwarding agent. The shipment costs appear as an additional entry in the customer billing document. It is possible to use all the calculation options that are available in the shipment cost document for settlement of costs with the service provider. Shipment costs that were calculated in the shipment cost document on the basis of delivery items are assigned directly to the respective billing document item. Costs that were calculated using a different calculation base, for example, on the
basis of shipment cost items, are allocated to the billing document items according to the proportionate weight of the delivery items.

A billing document whose copying control is set in Customizing so that the shipment costs are part of the billing document can only be created when the shipment costs have been calculated and billed fully.

Since a delivery for which the billing document is to be created can be part of several shipments (for example, in the case of a transportation chain), it can happen that several shipment cost documents need to be calculated so that the billing document itself can at all be created.

Also, you should be aware that the system first checks the shipment cost calculation status in the shipment document. If both the header and the leg of the respective shipment type are marked in Customizing as being relevant for shipment costs, the shipment costs calculation status at the header level and at the stage level must be completely processed.
Shipment Cost Information in the Order

Use
As the shipment costs can make up a large proportion of the total cost of a product it is important and therefore recommended that you have a rough idea of the shipment costs when the order is created. As in normal situations no deliveries, shipments or shipment cost documents exist at this point, simulated versions of these can be “created” in the background to enable you to calculate shipment costs on the basis of these documents.

This means that you can estimate shipment costs. When you make the appropriate setting it is also possible to implement several calculations at the same time, in order, for example, to determine whether transport by lorry or by train would be cheaper or how much more it would cost to send by express delivery rather than by standard transport.

Integration
Shipment cost information is called up in SD order processing but uses the transportation and shipment cost processing functions.

Prerequisites
Shipment cost information in the order can only be used if the control parameters and master data for transportation and shipment cost processing have been maintained.

Features
To calculate shipment costs in the order you can define profiles for shipment cost information. The profile for shipment cost information contains default values for shipment cost information in the order, for example, the transportation planning point, transportation type and the shipment pricing procedure. The profile for shipment cost information is assigned to a sales document type (when defining the sales document types in Customizing for Sales and Distribution). If you do not want to carry out comparisons between the calculation methods, but just want to receive an estimated value for the shipment costs, then use the details from the profile for shipment cost information (transportation planning point, transport type, pricing procedure) and the data from the order (forwarding agent, route) for calculating shipment costs and the related simulated creation of transports.

If you do not assign a profile to the sales document type, you can also enter the transportation planning point, shipment type and service agent in the order.

To carry out a comparison of different calculation methods, you can assign one or more shipment planning profiles to a profile for shipment cost information. This planning profile is used to create shipments in collective processing, in order to store specific selection variants and data, which should always be used, in the memory. A planning profile determines how deliveries should be put together with shipments and which data should be put in the shipment documents. You can assign various planning profiles to the profile for shipment cost information, in order, for example, to compare whether it is cheaper to transport by train or by lorry. It is also possible to assign a planning profile for creating transportation chains.

If you begin the calculation of shipment costs in the sales document, the data that is used to simulate the putting together of the two types of transportation, is the data which is saved in the
order and in the shipment costs profile, which is assigned to the corresponding sales document type. If the planning profile is assigned to the shipment cost type, this data is also used for the parallel calculation of shipment costs, so that it is possible to compare different transportation options.
Calling up Shipment Cost Information in the Order

Procedure

1. Choose Logistics → Sales and distribution → Sales.
2. Choose Order → Create.
3. Enter all the data from your order and save the document.
4. Call up the document again by choosing Order → Change.
5. In the order, choose Details → Shipment cost information.

You reach the screen where the planning profiles are listed. In the first line, you always have the planning profile <From order>. In this line you see the default values from the shipment cost profile that is assigned to the respective sales document type.

If you have not assigned a shipment cost profile to the sales document type, now enter the missing data for Transportation planning point, shipment type, and service provider.

If you have assigned a shipment cost profile to the sales document type, and there are shipment planning profiles assigned to this shipment cost profile, then the system will list all the shipment planning profiles that are assigned to the shipment cost profile.

6. Choose Execute.

Result

In the column Net value, you see the values calculated by the system. If several planning profiles are assigned, you can have the system make comparisons. In the log, you can display the details of the simulated shipments. If you have problems with the calculations, you can check the reasons listed on the log.
Interfaces

Purpose

The Interfaces component includes External Transportation Planning Systems [Page 247] and Communication via Internet [Page 437]. Using interfaces, the SAP System can communicate with other systems and exchange data.

Many opportunities of B2B or B2C business relationships arise:

- Supply chain: Suppliers can enter data in their business partner’s system
- Business partners can exchange customer data
- Collaboration on joint projects/products

B2B communication does not necessarily require a Web-based application. Workflow scenarios can also take place between two systems (XML-based).
EDI Output

Use

Using electronic data exchange, you can transmit shipment data between the shipper and the forwarding agent or the customer.

For more information, refer to the section Shipment Outputs [Page 25].
External Transportation Planning Systems

Definition

The use of specialized software components is becoming increasingly important as a way to optimize planning of transportation requirements. The SAP System does not offer automated support for optimizing transportation planning, since the large number of different possible transportation processing procedures and optimization criteria require software that is tailored precisely to the customer’s needs.

The SD-TPS interface (described below) between SAP R/3 and one or more specialized, external Transportation Planning Systems (TPS) can be implemented in order to fulfill such specific customer needs in the transportation planning area.

Process Overview

In regular business transactions, you define a selection of deliveries to be planned for a certain shipment as you create shipments in R/3. This is, for the most part, a manual process.

If an external transportation planning system is used, one record of deliveries to be shipped is selected in R/3 and then sent via the interface to the planning system, where the deliveries are grouped into shipments according to certain optimization criteria. The shipments that were generated are confirmed in R/3 which in turn triggers generation of the shipment documents. In order for the shipment documents to be updated properly, master data (customer address or goods acceptance times, for example) must match in both systems.

Grouping and changing of shipments occur systematically in the transportation planning system. All further shipment processing activities (printing or reporting start of shipment, for example) are treated like regular document processing in the R/3 System.

Organizational Link

In R/3, the organizational link to an external transportation planning system is established by assigning it to a transportation planning point, which allows it to function as an external planning point. Exactly one transportation planning system can be assigned to each external transportation planning point. However, it is possible to assign one planning system to multiple transportation planning points if various MRP controllers need to work in the same system.
Functions

The SD-TPS interface supports the following functions:

SAP to the transportation planning system:
- Transfer of location master data
- Transfer of deliveries to be planned
- Transfer of status values for planned shipments

Transportation planning system to SAP:
- Transfer of planned shipments
- An exchange of error status regarding the logical correctness of the transferred documents also occurs between the two systems.

Partner Concept

In order to offer our customers a flexible, secure link to transportation planning systems, we will be working with selected partners. The different tasks will be delegated as follows:

As of Release 3.1, technical tools necessary for linking to an external computer (IDocs, ALE, RFC) will be included in the SAP standard. Application functions that illustrate common business procedures (transactions, standard IDocs, Customizing) and play a part in their corresponding processing in the SAP System will also be made available.

The partners are responsible for implementation of the processing logic from the point at which data leaves SAP R/3 until the point at which data enters SAP R/3. In other words,
their responsibility includes correct interpretation of the R/3 data, planning shipments according to specifications, retransfer of the data in R/3 format and technical communications between computers. They are also the first contact customers have if errors occur during the communications process.

SAP plans to initiate a certification process for these partners which will verify that they fulfill the requirements for successfully linking an external system to SAP using the technology mentioned above. There are currently no plans to test the functions of the partners’ application software.

Technology

From a technical point of view, the interface is based on the transactional Remote Function Call (tRFC), which is basically a simplified procedure to make communications between two programs possible.

As opposed to synchronized Remote Function Call (sRFC), tRFC temporarily stores the data before it is sent, effectively separating application and communication functions.

SAP also offers a refined monitoring function for logical error analysis. When an error occurs, messages are also sent to one or more people. Follow-up posting is then possible from the inbox.

Certification Requirements

SAP will certify those partners who can demonstrate correct transfer and function for all IDoc links and successfully complete the test scenarios. The list of IDocs required for certification appears in the section describing IDocs.
Logical Communications Processes

The communications processes between R/3 and an external transportation planning system can be divided by communications procedure into:

- Location master data
- Movement data, which includes planning requirements (deliveries) and planned shipments, among other things
- Status Transmission and Error Processing

Location master data

For optimal performance, the location master data must be the same in both systems. Depending on the foreign system’s functions, this may occur via an initial data comparison with change management using IDoc TPSLOC01 or via a direct location master data transmission during communications within IDoc TPSDLS01.

Location master data includes the following:

- Customer master records with addresses and the goods receiving hours of the unloading point
- Vendor master records with addresses
- Service provider master records with addresses (service providers fall under vendor characteristics)
- Plant master records with addresses
- Shipping point master records with addresses
- Transportation connection point master records with addresses and characteristics

Transmission of master data with IDoc TPSLOC01 can occur at the following points:

- Initial transmission of all necessary location master data after the external system is activated using transaction VT60
- Partially-automated transmission of all changed location master data for customers, vendors, and service providers using the ALE change pointer for IDoc type TPSLOC (Remark in ‘Change Table, Transmission per Program’).
- Manual transmission of all changed location master data (plants, shipping points, transportation connection point).

The address records of the locations used are transmitted from SAP to the transportation planning system with the deliveries that are to be planned in IDoc TPSDLS01. This ensures that even if you’re dealing with a transportation planning system without its own location data management, at least the correct data for departure point and destination is available. The
address record transmission with deliveries that are to be planned is especially important for all external systems when using one-time customers (CPD) as references.

**Transaction Data**

Transmission of transaction data occurs in two directions. Planning requests (deliveries that are to be planned and assigned to shipments) are transmitted from R/3 to the planning system and then planned shipments are sent back to the R/3 system.

If new deliveries are to be planned into a shipment, the scenario is as follows:

---

**Outgoing Delivery / Planning Requests**

Transmission of planning requests (deliveries that are to be planned) to a transportation planning system may occur via the following various procedures and communication stages in R/3:

Optional:

- Implicit transmission following delivery creation (defined as the point at which the deliveries are sent to the transportation planning system, provided no specific criteria are relevant) by way of message control
- Explicit transmission by calling up a program with transaction VT61 with the option to select deliveries according to several selection criteria. The actual transmission occurs via message control or as a direct transmission.
- Automatic transmission by starting transmission program RB56LFTP at a defined point in time (definition of selection variants, batch transmission). The actual transmission occurs via message control or as a direct transmission.
Logical Communications Processes

- Implicit transmission using transaction VT68 by deallocating a delivery without deleting it in R/3. The actual transmission occurs via message control or as a direct transmission.

Mandatory:
- Implicit re-transmission via message control after a delivery has been changed
- Implicit transmission via direct transmission when a delivery is deleted

In R/3, selection of deliveries to be planned is carried out either:
- Using a report with an option screen that is started via transaction VT61
- Or by calling up report RV56LFTP (with variants) at regular intervals

This report uses the delivery selection function in the same way as for shipment processing (transaction VT01). A transportation planning point that corresponds to the transportation planning system must also be specified.

Transmission of deliveries is carried out as follows:
1. Determination of a transportation planning system (transportation planning point)
2. Selection of deliveries according to the criteria specified
3. Combining of deliveries and their corresponding items
4. Determination of the items that are relevant for transportation (optional)
5. Determination of the delivery’s dispatch location and point of destination where additional shipments are possible, e.g. main leg for sea transportation (optional)
6. Accumulation of delivery items according to the freight class of the delivered materials and the freight code set that was specified.
7. Customer functions for user-specific changes or enhancements of the combined delivery data and IDocs
8. Creation of the IDoc (one IDoc per delivery document with the option to combine several IDocs into packets)
9. Transmission of the IDocs to a planning system

Deliveries that were changed in R/3 (transaction VL02) after they have already been reported to the transportation planning system are automatically re-transmitted immediately after the changes are posted (provided they are relevant for transportation). This function is activated by a link to message control. When a change is made, the whole document, rather than just the changed data, is re-transmitted.

The following graphic illustrates the scenario for transportation-relevant deliveries that have been changed after data was initially transmitted to an external transportation planning system:
If a delivery is deleted in R/3, this deletion command is transmitted automatically to all transportation planning systems that had previously been planning that delivery for assignment to shipments. The delivery document is deleted in R/3, although, in certain circumstances, some references to this delivery that are still open may exist in externally-planned R/3 shipment documents. Shipment documents with these open references cannot be changed in R/3 until the change command is received from the transportation planning system for the document that no longer contains that delivery.

**Incoming Shipment**

The incoming shipment IDocs TPSSHT01 are interpreted, checked, and then used for creating, changing, or deleting R/3 shipment documents that are posted to the database afterwards.

The functional process flow can be described as follows:

- Importing the IDocs via the ALE layer
- Interpretation of the IDocs, resulting in the creation, changing or deletion of shipment documents. The individual stages for creating/changing each shipment document are determined by the shipment header, the shipment items, stages, dates, and handling units.
- Posting the created/changed documents

Shipment documents created by a transportation planning system can only be changed within very narrow limits in the R/3 system. Customizing settings may restrict or forbid you to change transportation-relevant data. Data that should not be changed includes all data that would make it necessary to change documents in the transportation planning system (legs, delivery assignment, service agents, means of transport, document numbers).
Logical Communications Processes

Outgoing Shipments

In the case of externally planned shipment documents, if you have a shipment status in Customizing that is exceeded or not reached, you can have a fixing or release message sent to the respective forwarding agent. To do this, use the IDoc TPSSHT01. After the freeze message is transmitted for a shipment document in R/3, the corresponding shipment in the planning system can no longer be changed. Similarly, a release message from the R/3 system means that the shipment document can be changed again in the planning system.

Status Transmission and Error Processing

Automatic processing of logical errors (errors that occur as a result of the message content) is carried out in the R/3 system using the workflow options provided by the ALE layer. The receiving system can react to a logical error by sending back an error message using IDoc SYSTAT01. The IDoc is constructed so that the error source can be localized precisely.

Workflow can be set in R/3 so that the employee responsible is informed when this error message is received as a reply to the transmission of delivery data to a transportation planning system.

You can make the relevant settings in Customizing for the R/3 transportation planning point so that an error message can be created and sent as a response to the transportation planning system upon receipt of incorrect incoming shipment documents.
Application Transactions of the Interface

The following sections describe the application transactions and programs with which the user can access the functions of the transportation planning interface for transmission of data from the SAP R/3 system to a planning system.

Transmission of Location Master Data

The following sections describe the functions for transmission of location data.

Initial Transmission

The initial transmission of location master data should take place when the interface is active. All necessary master data should be copied into the database of the transportation planning system. During this process, the SAP system always represents the reference.

You can start master data transmission via transaction VT60 or menu path Logistics → Sales/distribution → Transportation → External systems → Transportation planning → Transmit master data.

The first program (RV56LMTP) serves to define the planning system (transportation planning point) and the location master data that is to be transmitted. This program then starts the actual transmission program (RV56LMSL), the selection screen of which allows you to specify exactly which location master data you want to transmit.

In the selection screen of the first program (RV56LMTP), only transportation planning points that are linked to an external planning system are accepted. You can also use checkboxes to select which location master data types will appear on the selection screen of the second program (RV56LMSL).

Automatic Transmission of Changed Master Records

The master data of customers, vendors and also of forwarding agents is connected to the ALE change indicator. The function is available after activating the change indicator for message type TPSLOC in Customizing. If a data field relevant to the interface is changed in a master record that has already had details transmitted or if a new master record is added, then a change indicator is created automatically.

The change indicators must then be evaluated. This involves transmitting the changed master data documents. The evaluation of the change indicators is carried out with transaction BD21 or via Logistics → Sales/distribution → Transportation → External systems → Transportation planning → Change master data. Then enter message type TPSLOC.

Regular, automatic evaluations of the change indicators can be carried out as a job via program RBDMIDOC.

Manual Transmission of Changed Master Records

The master data records for plants, shipping points and transportation connection points cannot be connected to the ALE change indicator for technical reasons. If these master data records are changed or if new ones are added, then you need to carry out a manual transmission using the function described in the Initial Transfer section.

If the changed or new master data can be limited (by entry date, for example) then an automatic transmission can be carried out as a job with program RV56LMSL. The selection criteria can then be entered as selection variants.
Setting the Partner Profile

In the partner profile for the IDoc for location master data, combined shipping must be set in order to carry out shipping as efficiently as possible. First, IDocs are created. Afterwards, these must be sent using the report RSEOUT00 (transaction (nBD88).

Transmission of Planning Requests

Explicit Transmission by Application Transaction

Using explicit transmission, you can transmit a large number of deliveries chosen from the selection requirements and which are also available in manual shipment processing (transaction VT01) to a transportation planning system. Specifying the transportation planning point (planning system) and the processing type (outbound or inbound shipment) is obligatory.

At the moment, it is not possible to select outbound deliveries and inbound shipping notifications together with one selection run.

You can start the planning request transmission via transaction VT61 or menu path Logistics → Sales and distribution → Transportation → External systems → Transport. planning → Send deliveries.

Deliveries that have already been transmitted to a planning system once can only be re-transmitted to the same system if the delivery has been changed and message control has been activated. If you do not want this block, then it can be switched off for direct transmission using a customer function. You can read more about these functions in the section SAP System Settings and Modification Concept or in the online help documentation.

Regular Transmission per Job

Deliveries can be transmitted regularly and automatically to one or more planning systems according to certain selection criteria. This is appropriate, for example, if all shipments are to be planned overnight.

To do this, program RV56LFTP should be included as a job. Parameters must include transportation planning point, completion type, the deleted indicator for displaying the selection screen as well as a selection variant for program RV56LFSL.

Fully Automatic Transmission

Fully automatic transmission of planning requests for generating deliveries is a special case. It should only be applied if a company wishes to plan all its deliveries with an external planning system in transportation but where only one planning system (in other words, one transportation planning point) is available. In this case the function can be activated via a special configuration of message control (more information in Procedure for Transmitting Planning Requests - Automatic Transmission). Depending on the message control configuration, the message transmission will either take place immediately after posting the delivery or in later collective processing.
Removing Planning Requests

If deliveries should be taken out of the planning system because planning should be either carried out manually, using another system or not at all, the following options can be used.

Explicit Removal from Planning

Explicit removal from planning means taking a delivery out of a planning system without deleting the delivery in R/3. You can remove (deallocate) deliveries via transaction VT68 or by using menu path Logistics → Sales and distribution → Transportation → External systems → Transport. planning → Plan deliveries.

Once you have entered the delivery document number for the delivery to be removed, a list of all the planning systems that the delivery has been transmitted to will appear. You can select the system and start the process using Execute.

Automatic Removal from Planning by Deleting a Delivery

If a delivery is deleted in R/3, it is then automatically removed from planning in all the planning systems that it has already been transmitted to. This procedure needs no previous configuration.

Receipt of Planned Shipments

The receipt of planned shipments in R/3 takes place automatically via the ALE layer mechanisms. Some functions are available within inbound processing and further document processing which affect the transportation planning interface. You must also take into account other attributes that can be influenced by Customizing settings.

Deleting Shipments or Handling Units within a Shipment

Deleting handling units that have been created in a shipment or deleting a whole shipment is not possible in the transportation planning system if a handling unit is not empty, that is, if something has been packed into the handling unit.

If materials have been packed manually into a handling unit in an externally-planned shipment document, they must first be manually unpacked before the planning system can delete the handling unit or the shipment.

Automatically Setting ‘Planned’ Status

‘Planned’ status is automatically set when the system receives an externally-planned shipment document. This happens regardless of whether a planned date has been transmitted to the incoming document or not.

If the planning date is transmitted from an external planning system, this is copied over to the planning date in the shipment document. If a planning date is not
transmitted, the planning date in the R/3 document is set to the date of receipt of the external document.

### Locking Document Status for External Planning Systems

Document status can be set to two values for external planning systems:

- Document modifiable in planning system
- Document not modifiable in planning system

You can set the status of document modifiability in the R/3 shipment document depending on the shipment’s overall status. In R/3 Customizing you can set as of which shipment status (e.g. *Start load*) changing the shipment in the planning system is no longer appropriate or permitted.

If the given status is reached or overstepped because R/3 transportation activities were set manually, a fix message will be sent automatically to the transportation planning system to freeze the corresponding shipment document, whereby the shipment document must be set to *Do not change* in the planning system.

If the given status is overstepped in R/3 transportation activities by resetting the shipment’s overall status, a message is sent to the planning system, which makes it possible to re-release the processing of the shipment document.

### Modifiability of Externally-Planned Shipments

Externally planned shipments can be limited in the R/3 System with respect to their ability to be changed. You can set this through Customizing for the planning system. The following settings are possible:

- No planning-relevant changes permitted
- No planning relevant changes permitted, apart from service agent data
- No restrictions on changes
Configuration Options

When configuring the transportation planning interface in R/3-Customizing, you can specify technical or functional parameters that determine how messages are sent to the planning system and which modifications should be carried out in the messages before transfer.

R/3 Customizing

SAP uses the word Customizing to describe the necessary table settings used to tailor the R/3 system to the user’s needs. For example, in Customizing you can:

- Define key values and their attributes (shipment types, for example)
- Maintain number ranges (shipment numbers, for example)
- Create and maintain organizational units (transportation planning points, for example)
- Configure procedures for sending documents (message control, for example)
- Create procedures for modifying documents (route restrictions, for example)
- Carry out other customer-specific system settings

The descriptions for Customizing settings are available in detail in the Implementation Guide in Online help. Particular specifications for setting the transportation planning interface can be found in IMG under Tools → Customizing → Implementation projects → SAP Reference IMG → Sales and distribution → Transportation → Interfaces → External Transportation Planning Systems.

Planning Restrictions for Routes

In some planning situations, the whole transportation process is not determined by one transportation system for individual deliveries. In order to optimize the planning of domestic transportation (roads) for companies sending deliveries both at home and abroad, a planning system might be used where shipment documents can also be manually generated using R/3 transactions for transportation activities for overseas shipments (sea routes). In this case, the transportation planning system has to be notified that the destination location for planning is not the decisive factor for deliveries abroad, but that automated planning should take place for another location (e.g. departure harbor or border location). Similar situations arise for orders that are shipped from a shipping location outside the transportation planning system’s planning area and that should only have automatic subsequent leg planning carried out.

The planning restrictions are linked to the combination of transportation planning system (transportation planning point) and route. This way, you can define how a departure point or destination location substitution should be executed in the planning request for each related planning system and each delivery route separately.

Location substitution schemas are used for determining an alternative departure point or destination for planning. A substitution schema is made up of sequence of conditions that are checked one after the other until a valid substitute is found. Once an alternative location has been found, the time specifications for the location are also reset where possible.

The following conditions can be used in a substitution location procedure:
All the search strategies refer only to documents that are part of the delivery currently being processed. Locations that are used as departure and destination locations for the delivery in the existing shipments are those where the delivery is loaded or unloaded but not the absolute beginning or end of a shipment.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Time substitute</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>A, P</td>
<td>Departure location of earliest main leg shipment</td>
</tr>
<tr>
<td>002</td>
<td>A, P</td>
<td>Departure location of earliest preliminary leg shipment</td>
</tr>
<tr>
<td>003</td>
<td>A, P</td>
<td>Departure location of earliest subsequent leg shipment</td>
</tr>
<tr>
<td>004</td>
<td>F</td>
<td>Departure points in delivery route</td>
</tr>
<tr>
<td>050</td>
<td>A, P</td>
<td>Earliest departure location of any shipment</td>
</tr>
<tr>
<td>101</td>
<td>A, P</td>
<td>Destination location of latest main leg shipment</td>
</tr>
<tr>
<td>102</td>
<td>A, P</td>
<td>Destination location of latest preliminary leg shipment</td>
</tr>
<tr>
<td>103</td>
<td>A, P</td>
<td>Destination location of latest subsequent leg shipment</td>
</tr>
<tr>
<td>104</td>
<td>F</td>
<td>Destination points in delivery route</td>
</tr>
<tr>
<td>150</td>
<td>A, P</td>
<td>Latest destination location in any shipment</td>
</tr>
<tr>
<td>200</td>
<td>F</td>
<td>Fixed transportation connection points</td>
</tr>
<tr>
<td>999</td>
<td></td>
<td>User-specific substitution</td>
</tr>
</tbody>
</table>

If a substitution location is found, the system also tries to determine the connection scheduling for the departure or arrival time of the delivery at the substitution location (time substitute). This is done by using the following procedures:

<table>
<thead>
<tr>
<th>Time substitute</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Substitute with actual transportation time (this takes priority due to precision, but may only be maintained in exceptional cases).</td>
</tr>
<tr>
<td>P</td>
<td>Substitute with planned times from shipment document.</td>
</tr>
<tr>
<td>F</td>
<td>Calculates new times based on delivery / GI date and the preliminary, main and subsequent leg times of the route specified in Customizing.</td>
</tr>
</tbody>
</table>

User-specific location substitution takes place using a customer function. You can read more about customer functions in *SAP System Settings and Modifications* or in the online help documentation.
Location and Time Substitution with Reference to Existing Shipments

Automatic connection scheduling for existing R/3 shipments can only take place properly if all important data has been maintained in R/3 shipment documents. The following data is absolutely necessary in the shipment document:

- Departure and destination location
- Planned departure and arrival time in shipment header
- Delivery assignment

If a connection to a collective shipment is planned, the following data must also be maintained:

- Shipment stages
- Delivery assignment to legs
- Departure and arrival times at shipment stages

If possible, you should also ensure that all address data is maintained for the locations involved.

Location Substitution for Subsequent Leg Planning

The Straße Deutschland (Roads - Germany) planning system is used for planning the subsequent legs in the delivery route 'North America-Hamburg', which means that the departure location for the delivery is in North America (i.e. outside the planning area) and must be substituted with a starting location suitable for planning purposes. The determination procedure would identify the following condition sequence, which is processed sequentially until a substitution location has been found:

1. End of the last main leg: if one or more main legs exist for the corresponding delivery, the destination location of the last main leg is used as the starting location for planning. The shipment end date becomes the shipment departure date.
2. End of delivery route: if it exists, the end point of the delivery is used as the starting point for planning. The departure time is determined using the delivery date and the specified subsequent leg time.
3. Predefined points: points defined in Customizing are used and a departure time is not determined.
4. No substitution takes place.

The following shows the four most relevant substitution procedures with their condition steps.

**Automatic Preliminary Leg Planning: Connection to Departure Location in Existing Main Leg Shipment:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Condition</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>001</td>
<td>Departure location of earliest main leg shipment</td>
</tr>
</tbody>
</table>
Transportation (LE-TRA)

Configuration Options

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Departure points in delivery route</th>
<th>No substitution of destination location</th>
</tr>
</thead>
</table>

**Automatic Subsequent Leg Planning: Connection to Destination Location in Existing Main Leg Shipment:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Condition</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>101</td>
<td>Destination location of latest main leg shipment</td>
</tr>
<tr>
<td>002</td>
<td>104</td>
<td>Destination points in delivery route</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No substitution of departure location</td>
</tr>
</tbody>
</table>

**Automatic Main Leg Planning: Connection to Destination Location in Existing Preliminary Leg Shipment:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Condition</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>102</td>
<td>Destination location of latest preliminary leg shipment</td>
</tr>
<tr>
<td>002</td>
<td>004</td>
<td>Departure points in delivery route</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No substitution of departure location</td>
</tr>
</tbody>
</table>

**Automatic Main Leg Planning: Connection to Departure Location in Existing Subsequent Leg Shipment:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Condition</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>003</td>
<td>Departure location of earliest subsequent leg shipment</td>
</tr>
<tr>
<td>002</td>
<td>104</td>
<td>Destination points in delivery route</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No substitution of departure location</td>
</tr>
</tbody>
</table>

**Material Cumulation**

It is absolutely necessary to know all details about the materials/delivery items to be transported in order to plan shipments.

In certain circumstances, it is not always relevant whether two delivery items, 500 liters of red and 500 liters of green paint, for example, are to be transported. It is often enough to know that 1000 liters of paint have to be planned as shipment goods. The circumstances are similar in batch handling, where different batches of one material are divided among several delivery items.

Delivery items can be combined according to different criteria, in order to achieve a better overview or to reduce the amount of data that is to be transferred. This combination (cumulation)
can take place separately for each combination of transportation planning point and route. However, it can also be carried out generally for an entire transportation planning point.

Cumulation of delivery items takes place in a transportation planning interface and is always related to deliveries, i.e. a cross-delivery cumulation is not available.

There are two options for creating planning requests for the cumulation of items in the current delivery:

- **Reduction of shipment-relevant items:**
  - Activating this function results in:
    - Combination of batch items in a header item per material
    - Combination of product selection of a material in a header item
    - Deletion of BOM items irrelevant to the shipment
  - Text and value items as well as automatically-generated packing items are not normally transferred.

- **Cumulation according to freight code:**
  - A freight code set can be assigned to the combination of transportation planning point and route and the freight code can be defined together with the material freight group from the material master. The items of a delivery are combined according to freight codes and the type of material will only be represented by the freight type code in the output. The quantity is only available in weight and volume specifications and no longer as number of pieces, etc.

If both cumulation procedures are activated, the cumulation will first be carried out according to shipment-relevant items and then according to freight code.

You can implement a user specific cumulation by using a customer function. This customer function is carried out according to both the reduction of shipment-relevant items and freight class. You can read more about customer functions in *SAP System Settings and Modifications* or in the online help documentation.

**Procedure for Transferring Planning Requests**

**Standard Transfer Procedure with Output Control**

The standard transfer procedure is via output control. Other procedures should only be used in exceptional cases. Transfer with output control has the following attributes:

- Blank transfer using transaction VT61 generates entries in output control, which are used for creating planning requests for the time planned in the output type and which are then transferred.
- Transfer of planning requests based on changed deliveries takes place automatically.
- Control mechanisms are available in output control.
Configuration Options

The following settings allow you to set the standard transfer procedure for a planning system:

- Create an output type for your planning system based on template ‘TPS0’. Don’t forget to maintain the processing program as well.
- Set the required dispatch time.
- Enter your new output type in the output procedure for the shipping outputs and set the condition to ‘40’ (delivery to external TPS).
- Enter your output type in the transportation planning point assigned to the planning system.

⚠️

If several planning systems are connected to your R/3 system, then you need a different message type for each planning system.

Direct Shipping without Output Control

Direct shipping should be used particularly if using output control will lead to a considerable decrease in performance, i.e. if a large number of deliveries have to be shipped. The structure of planning requests comes about in output control by reading individual documents into R/3 whereas in direct shipping, a mass transaction takes place.

Because of the missing connection to output control, the change controls are also deactivated for delivery documents. Deliveries are therefore not automatically retransferred once they have been changed. For a retransfer you must use transaction VT61, ensuring that the customer function for avoiding the transfer lock has been activated. You can read more about customer functions in SAP System Settings and Modifications or in the online help documentation.

In order to activate direct shipping, you must not:

- Enter any output type in the transportation point.

Automatic Transfer

Automatic transfer only works with one transportation planning system where all deliveries are always shipped directly.

Automatic output control has the following attributes:

- Posting a new delivery generates entries in output control, which are used for creating planning requests for the time planned in the output type and which are then transferred.
- Transfer of planning requests based on changed deliveries takes place automatically.
- Control mechanisms are available in output control.

The following settings allow you to set the standard transfer procedure for a planning system:

- Create an output type for your planning system based on template ‘TPS0’. Don’t forget to maintain the processing program as well.
• Set the required dispatch time.
• Enter your new output type in the output procedure for the shipping outputs and leave the condition field blank.
• Enter your output type in the transportation planning point assigned to the planning system.

In addition to the automatic planning system, you can also use other systems with standard transfer procedures.
Technical Communication

The following section deals with the technical aspects of communication and data flow between SAP-R/3 and a non-SAP system (sub-system).

Transmitting Planning Requests

The following overview shows the procedure for transmitting outputs from R/3 to a sub-system.

Creating a Planning Requirement in Transportation

The planning requirement for planning deliveries can be created with the functions described in the Outbound Delivery section. The procedure can be carried out either as an online transaction or a background job using output control.

Saving the Data in the ALE Layer

Within the same process (Logical Unit of Work or LUW) the data is formatted in the form of repository (data dictionary) structures by the Application Link Enabling (ALE) level function module. These structures are called Intermediate Documents (IDocs). The IDocs that were created are saved in the database.

Communication Structure and Transmission of the IDocs

Transmission of the IDoc is carried out asynchronously to its creation, that is, ALE transmits the IDoc after it is created. An IDoc can be transmitted directly, or combined first and then sent as part of a package of several IDocs.

During IDoc transmission, the ALE uses transactional Remote Function Call (tRFC). The system starts a remote shell in the subsystem and calls up the C program to which the function to be...
called is transferred within the program. The underlying technique that allows transmission to be carried out correctly according to the log is described above as an RFC layer. A library of C development programs is available for program development.

For further information on creating C programs and further system settings, see the following sections and the documentation in the RFC libraries.

**Subsystem Tasks**

The C program for receiving the data must be provided in the sub-system. There is a sample program to this effect. This is supported by the RFC library that you receive from SAP as a certification partner (RFC SDK, Remote Function Call Software Development Kit).

The program must save the data after receiving it before the receipt confirmation is sent back to the R/3 system. Then data processing can start in the sub-system. SAP recommends this intermediate saving procedure, which allows communication of processing logic to be carried out separately in the sub-system.

Also, the sub-system should have status management for the data it received. Status management can prevent duplicate processing. You should also note that the sub-system must be able to recognize if an IDoc has already been transmitted once by the R/3 system. This is made possible through a unique transaction ID for each communication activity. (See also the technical documentation of the RFC.)

In addition to the transaction ID, the IDoc number can also be used to signify that an IDoc has already been transferred. The IDoc number is only unique within a given client of an SAP system. If communication is carried out with several clients and/or several SAP systems, then the IDoc cannot be identified using only the IDoc number.

**Error Processing in Communication**

The following problems may occur during transmission:

**Posting termination in the application (when creating a planning requirement, for example)**

In this case, the error is not critical for communication, because IDocs cannot be created without a planning requirement. Both postings are carried out in the same LUW and are therefore posted synchronously.

**Errors in the ALE Layer**

1. The data that was formatted in the LUW (which creates the IDoc) and which was sent to ALE is syntactically incorrect. The IDoc is copied and saved by ALE but cannot be transmitted. For more information about this error, see the *SAP System Settings and Modifications* section.

2. The partner profile for outbound processing is not defined for the receiver and the IDoc’s message type in ALE. The IDoc is saved but cannot be transmitted. For more information about this error, see the *SAP System Settings and Modifications* section.

**No connection**

If an IDoc is created but the connection cannot be made, then a report running in the background ensures that communication attempts are made from time to time. If the connection is restored, then the IDocs are transmitted automatically.
Receiving Planned Shipping Documents

The following overview illustrates receipt of shipping documents that have been generated from planning requests by the subsystem.

Formatting and Transmitting Shipment Data

The primary task of the subsystem is to optimize shipment planning from the planning requests that have been transmitted from the R/3 system. Fully planned shipments must be transmitted back to the R/3 system using the communication path provided (transactional RFC). The subsystem carries out the following tasks within the framework of communication with the SAP R/3 system:

Intermediate Data Storage and Formatting for IDocs

The subsystem shipment data must be saved in an IDoc-specific data structure. For information on the definition and structure of the different IDocs, see the sections IDoc descriptions [Page 274] and IDoc Segments, Fields and Domain Values [Page 288].

Calling up a Central Function Module in R/3 using the Transfer Program

You also need the RFC library for programming support for the transfer program. The central function module is part of the ALE layer.

Several IDocs can be transferred in one communication procedure - that is, when an R/3 function module is called up once, multiple IDocs can be transferred.

Updating After IDoc Transmission

During transmission, the sub-system must provide status administration for the transmitted data. If the IDoc is transmitted unsuccessfully, then it must be retransmitted later.
Duplicate transfer of IDocs must be avoided on the SAP side of things. This is where the transaction ID, which is assigned by SAP for each communication procedure, comes into play. The data that is transferred by the sub-system must always be transmitted with this transaction ID (see also the technical documentation about the RFC). The same transaction ID must be entered for subsequent retransmissions.

The SAP System does not use the IDoc number to check for duplicate transfers.

**Receipt and Posting of Data**

ALE receives the IDoc and writes it into the database. After this intermediate saving procedure, a confirmation of receipt is sent back to the subsystem. The IDoc is then forwarded to the application (asynchronously as far as receipt is concerned), where processing occurs.

The application in R/3 that creates, changes and deletes shipment documents sends a status back to ALE for each IDoc. This IDoc status is the basis for processing any possible errors.

**Error Processing**

**The following errors may occur:**

**Connection can not be made at this time**

The sub-system should also use status administration to ensure that subsequent posting can be carried out.

**Errors in the ALE layer**

An IDoc was created, but processing was not started.

This error occurs (as in transmission from R/3), if the IDoc that is received is syntactically incorrect or if the partner profile for inbound processing is missing for the sender and the message type of this IDoc. For more information about this error, see the *SAP System Settings and Modifications* section.

**Error in the application (when posting the transfer request, for example)**

This is a question of logical errors in the application. A message is issued to a position with the IDoc status mentioned above. Several users can be assigned to a position. Each user receives the error message in their own SAP OFFICE inbox. As soon as a user enters and processes the error message, it disappears from the other inboxes.

**Technical Programming for the Subsystem Connection**

This section provides you with an overview of the technical details involved in the connection of a sub-system to the R/3 System. You can find detailed documentation of the Remote Function Call in RFC SDK and in the R/3 System online documentation. This section is intended to give you an overview of the programming techniques. It is not comprehensive. Please consult the above-mentioned documentation as well if you want to make the connection yourself.

**Transmission from SAP to a Sub-system**

IDocs are transmitted from the SAP system by calling up the function module `INBOUND_IDOC_PROCESS` with a destination. The destination uses a table in the R/3 system to determine destination computer and the target program.

A C program with target program name must exist in the sub-system. The program contains a function with the name of the function module call.
Technical Communication

In the R/3 system, the application data is transferred in the internal table of structure EDI_DD. In addition, a control record from structure EDI_DC that contains administration data is also transferred for each IDoc. In the example, this data is transferred in the form of internal tables.

For further information, please see the documentation mentioned above.

**You can have a C program core from function module display SE37 generated from the R/3 system.** You can use this as the basis for your receiving/transmitting program. In order to interpret the data in the IDoc, you also need the data structures of the IDocs at C Program level. If an R/3 system is available, you can **generate an h - IDoc header file** directly from repository transaction SE11.

```
/* function IDOC_INBOUND_PROCESS */
static RFC_RC inbound_idoc_process (RFC_HANDLE handle)
char          filenam1[] = "/users/d11adm/tmp/output1" ;
...```

**Notes on TCP / IP settings**

1. The Transmission Control Protocol/Internet Protocol (TCP/IP) requirements (especially the IP addresses in both host files) must be set so that the SAP system can find the destination system.

2. In the SAP system, IDocs are transmitted from posting as standard. For this reason, the TCP/IP link must also be created for the posting system.

3. The SAP gateway must be allowed to start the C program (RFC server) via remote shell. For this reason the user that runs under Gateway (e.g. d11adm where d11 = system name) must also be recognized as a user by the target system.
4. In UNIX, the name of the gateway and dispatcher must be entered in the /etc/services, (sapgw00 and sapdp00, for example).

Please see also the RFC documentation mentioned above for more information on the settings.

**Transmitting from a Sub-system to SAP**

When you log on to the SAP R/3 system, the server name of the SAP target system, SAP logon, user, password etc. must be defined in the C program. The actual logon is supported by the RFC function RfcOpen (...). You can find details about this in the comprehensive RFC documentation.

The data needs to be processed into IDoc format and placed in an internal table with structure EDI_DD. A control record must also be created for each IDoc and placed in an internal table for structure EDI_DC. The form of data transfer is also described in detail in the documentation.

```
Sub C Program (Client)
...
*/
/* Transaction management (TID)
*/
.../
*/
/* Call function module IDOC_INBOUND_PROCESS
*/
rfc_rc = RfcCallReceive (handle,
    "INBOUND_IDOC_PROCESS",
    exporting, importing, table, & exceptions);
...
```

**RFC Library**

saprfc.h
sapitab.h
librfc.a / librfc.dll / ntlibrfc.lib ...

```
SAP System
Function module: INBOUND_IDOC_PROCESS (Server)

- Local interface:
  TABLES
  IDOC_CONTROL STRUCTURE EDI_DC
  IDOC_DATA STRUCTURE EDI_DD

- Remote Function Call supported

- Task:
  Post IDOCs
  Initiate processing
```

**Transaction ID Administration**

To ensure the security of the data to be transferred, a unique ID must be used for the communication procedure. This ID allows the receiving system to recognize whether this data has already been received and processed.
For example, communication could be terminated suddenly during the transmission of data for mobile entry of goods receipts. The user would transmit the data again in order to ensure that the entry is posted by the SAP System. If the data was successfully received and processed on the first attempt, however, the system must be able to recognize this. It should not process the data a second time.

This example would cause the following process flow between the transmitting system and the receiving system.
**IDoc Description**

**General Construction of the IDoc**

An IDoc is comprised of a number of data records in two tables:

- Control record table EDI_DC
- Data record table EDI_DD

A control record entry EDI_DC exists for each IDoc. This contains important data such as the ID of the transmitting and receiving systems, among other IDs. A data record entry EDI_DD exists for each data record. It is made up of a header section which is 55 bytes long and a data section which can hold up to 1000 bytes. The reference of data record to control record is created with an IDoc number. For each control record with document number DOCNUM, data records with the same document number must exist. There is, therefore, a 1:N relationship between control types and data types. The data records must be entered into table EDI_DD in exactly the same sequence as required by the hierarchical structure of the corresponding IDoc categories. For further information on the hierarchy, see the Overview of IDoc Structure section.

Not all fields in EDI_DC or EDI_DD are required entry fields. Some fields are not to contain values. Make sure to leave these fields blank.

If you are transmitting an IDoc from an external system to SAP, then you have to define a logical system as a communication partner in the R/3 system (SALE -> Distribution model -> Logical systems) and a partner profile for inbound processing that agrees with this partner number. The partner number of the destination system (SAP in this case) is not actually mandatory, but we recommend that you specify it, so that communication procedures can be carried out correctly. The logical system of the SAP System is maintained for each client in table T000 (SM31).

The partner profiles can be used to provide a non-standard function module for processing IDocs in the table for inbound processing methods in the ALE service level.

When creating IDocs in the R/3 system using transaction WE30, three structures are created and numbered automatically for each IDoc segment. For example, the delivery header might have E1TPDLH, E2TPDLH and E3TPDLH. E1TPDLH is release-independent, E2TPDLH is release-dependent and E3TPDLH is used for documentation. When segment names are transmitted, you must specify the E2 segment names in order to be working independently of the SAP release.

**Data Transmission Format**

Data is transmitted via the interface using CHAR format only. Conversion is carried out in the SAP system with the necessary adjustments for the entry fields in CHAR formats. The following table gives the required entries for the more important data categories.

<table>
<thead>
<tr>
<th>Field</th>
<th>Length</th>
<th>Possible entry value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMC</td>
<td>Ex: 18</td>
<td>'00000000012345678' positive, numerical char format right-aligned with preceding zeros</td>
</tr>
<tr>
<td>CHAR</td>
<td>Ex: 18</td>
<td>'Bordeaux_________' char format left-aligned with subsequent spaces</td>
</tr>
</tbody>
</table>
IDoc Description

| QUAN | Ex: 18 | '2456.12___________' or '2456.12-__________' Fixed decimal point left-aligned with decimal point as decimal symbol, possibly with subsequent +/- sign or spaces |
| DATUM | 8 | YYYYMMDD format (19961231 for Dec 31, 1996, for example) |
| UZEIT | 6 | HHMMSS format (174809 for 5:48:09 p.m., for example) |

See also:
IDoc Control Record EDI_DC [Page 278]
Special Fields in the Control Segment EDI_DC [Page 280]
EDI_DD - IDoc Data Record [Page 282]

Overview of Transmitted Message

The messages listed below are transmitted from the SAP R/3 System to the transportation planning system. The names used are those specified for the basic IDoc types and logical message types:

<table>
<thead>
<tr>
<th>Action</th>
<th>IDoc name</th>
<th>Message type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan/change/deallocate deliveries</td>
<td>TPSDLS01</td>
<td>TPSDLS</td>
</tr>
<tr>
<td>Add/change location master data (customer, vendor)</td>
<td>TPSLOC01</td>
<td>TPSLOC</td>
</tr>
<tr>
<td>Set transportation planning status</td>
<td>TPSSHT01</td>
<td>SHIPPL</td>
</tr>
<tr>
<td>Status information about transmission/possible errors</td>
<td>SYSTAT01</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

The messages listed below are transmitted from the transportation planning system to the SAP R/3 System:

<table>
<thead>
<tr>
<th>Action</th>
<th>IDoc name</th>
<th>Message type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create/change/delete shipment</td>
<td>TPSSHT01</td>
<td>SHIPPL</td>
</tr>
<tr>
<td>Status information about transmission/possible errors</td>
<td>SYSTAT01</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

⚠️ When transmitting documents between the R/3 system and a transportation planning system, you must follow these basic guidelines regardless of the direction of transmission:
- Delivery and shipment documents must all be fully transmitted when added to or changed.

If, for example, a delivery is changed in the R/3 System after it has been transmitted to the subsystem, the whole document is fully transmitted with all the
data, not just the changes. Changed shipments must also be fully re-transmitted from the planning system.

- If documents are deleted, they must be transmitted with at least the entire header information.
  
  Item segments can be ignored if the document is to be deleted.

- If fields in the IDoc are blank, then they are also blank in the original document.

- Transmitting one document per message
  
  Normally, you are not allowed to combine documents in a single IDoc. In other words, each IDoc may only contain a single header segment. IDoc TPSLOC01 is an exception to this rule because it can transmit several master data records.

- Taking the serialization of messages into account
  
  This is done to ensure that older IDoc versions for a document are not posted again after a more recent document has been processed.

- Client-dependence of the planning data must be taken into account
  
  Take special care during communication to a transportation planning system with several R/3 clients and/or R/3 Systems that data from different clients does not get mixed up (see also the EDI_DC IDoc Control Record section).

- Transmission of all data in CHAR format
  
  All data is transmitted to the IDocs in character format. For example, there are no 8-byte sliding decimals.

- Transmission of all units of measure according to ISO standard
  
  All units of measure, country codes and currency codes are transmitted into the IDoc according to the ISO guidelines (e.g. KGM instead of KG for the kilogram unit).

- Shipment number from number range
  
  Shipment document numbers that are issued by a transportation planning system must fall within a number range that can be set within the R/3 System.

### Overview of IDoc Structure

The following sections describe the structures of the different IDocs. The indentations in the Segment column indicate the hierarchical structure of the IDoc, which means that an indented segment is lower in the hierarchy than the previous segment further toward the margin. Subordinate mandatory segments are only mandatory if the segment superior in the hierarchy is present.

**TPSDLS01 - Plan/Change/Deallocate Deliveries [Page 284]**

**TPSLOC01 - Add/Change Location Master Data [Page 285]**

**TPSSHT01 - Create/Change/Delete Shipment [Page 286]**

**SYSTAT01 - Status Information for Transmission [Page 287]**
EDI_DC - IDoc Control Record

Definition

The control record IDoc EDI_DC contains important information on the transmitting and receiving partners. It can occur exactly one time per IDoc.

Only some of the fields need to be filled for IDocs that are transmitted from the transportation planning system to the R/3 system. These are identified as mandatory fields in the following field list.

If an IDoc is transmitted from the R/3 system to the planning system, then nearly all fields are filled, although the only fields that are relevant are those that are marked as TPS relevant.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Format</th>
<th>TPS-relevant</th>
<th>Req’ed field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Name of the table structure</td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Client</td>
</tr>
<tr>
<td>DOCNUM</td>
<td>NUMC 16</td>
<td>X</td>
<td>X</td>
<td>Number of the IDoc</td>
</tr>
<tr>
<td>DOCREL</td>
<td>CHAR 04</td>
<td></td>
<td></td>
<td>SAP release of IDoc</td>
</tr>
<tr>
<td>STATUS</td>
<td>CHAR 02</td>
<td></td>
<td></td>
<td>Status of the IDoc</td>
</tr>
<tr>
<td>DOCTYP</td>
<td>CHAR 08</td>
<td></td>
<td></td>
<td>IDoc type</td>
</tr>
<tr>
<td>DIRECT</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Direction</td>
</tr>
<tr>
<td>RCVPOR</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Receiver port (SAP system, EDI subsystem)</td>
</tr>
<tr>
<td>RCVPRT</td>
<td>CHAR 02</td>
<td>X</td>
<td>X</td>
<td>Partner type of receiver</td>
</tr>
<tr>
<td>RCVPRN</td>
<td>CHAR 10</td>
<td>X</td>
<td>X</td>
<td>Partner number of receiver</td>
</tr>
<tr>
<td>RCVSAD</td>
<td>CHAR 21</td>
<td></td>
<td></td>
<td>EDI: SADR fields (total)</td>
</tr>
<tr>
<td>RCVLAD</td>
<td>CHAR 70</td>
<td></td>
<td></td>
<td>Logical address of receiver</td>
</tr>
<tr>
<td>STD</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>EDI standard</td>
</tr>
<tr>
<td>STDVRS</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td>Version of EDI standard</td>
</tr>
<tr>
<td>STDMES</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td>EDI message type</td>
</tr>
<tr>
<td>MESCOD</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Logical message variant</td>
</tr>
<tr>
<td>MESFCT</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Logical address of receiver</td>
</tr>
<tr>
<td>OUTMOD</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Issue mode</td>
</tr>
<tr>
<td>TEST</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Test indicator</td>
</tr>
<tr>
<td>SNDPOR</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Transmission port (SAP system, EDI subsystem)</td>
</tr>
</tbody>
</table>
**EDI_DC - IDoc Control Record**

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNDPRT</td>
<td>CHAR</td>
<td>02</td>
<td>Partner type of transmitter</td>
</tr>
<tr>
<td>SNDPRN</td>
<td>CHAR</td>
<td>10</td>
<td>Partner number of transmitter</td>
</tr>
<tr>
<td>SNDSAD</td>
<td>CHAR</td>
<td>21</td>
<td>EDI: SADR fields (total)</td>
</tr>
<tr>
<td>SNDLAD</td>
<td>CHAR</td>
<td>70</td>
<td>Logical address of transmitter</td>
</tr>
<tr>
<td>REFINT</td>
<td>CHAR</td>
<td>14</td>
<td>Reference to transfer file</td>
</tr>
<tr>
<td>REFGRP</td>
<td>CHAR</td>
<td>14</td>
<td>Reference to message group</td>
</tr>
<tr>
<td>REFMES</td>
<td>CHAR</td>
<td>14</td>
<td>Reference to message</td>
</tr>
<tr>
<td>ARCKEY</td>
<td>CHAR</td>
<td>70</td>
<td>Document ID in the external system</td>
</tr>
<tr>
<td>CREDAT</td>
<td>DATS</td>
<td>08</td>
<td>IDoc creation date</td>
</tr>
<tr>
<td>CRETIM</td>
<td>TIMS</td>
<td>06</td>
<td>IDoc creation time</td>
</tr>
<tr>
<td>MESTYP</td>
<td>CHAR</td>
<td>06</td>
<td>Logical message category</td>
</tr>
<tr>
<td>IDOCTYP</td>
<td>CHAR</td>
<td>08</td>
<td>Name of basic IDoc category</td>
</tr>
<tr>
<td>CIMTYP</td>
<td>CHAR</td>
<td>08</td>
<td>Name of extension type</td>
</tr>
<tr>
<td>RCVPFC</td>
<td>CHAR</td>
<td>02</td>
<td>Partner function of receiver</td>
</tr>
<tr>
<td>SNDPFC</td>
<td>CHAR</td>
<td>02</td>
<td>Partner function of transmitter</td>
</tr>
<tr>
<td>SERIAL</td>
<td>CHAR</td>
<td>20</td>
<td>EDI/ALE: Serialization field</td>
</tr>
<tr>
<td>EXPRSS</td>
<td>CHAR</td>
<td>01</td>
<td>Override in inbound processing</td>
</tr>
</tbody>
</table>
Special Fields in the Control Segment of EDI_DC

Special Fields in the Control Segment of EDI_DC

Special functions must be taken into account for the following fields:

**Field EDI_DC-DOCNUM: Document number**

In the central description, the field indicates the unique number in the SAP R/3 system of the document that is transmitted. A unique number must also be entered in the subsystem so that a reference can be created to the accompanying data records. When the IDoc being transmitted from the subsystem is imported by the R/3 system, the content of DOCNUM is replaced with an internal number, determined by the R/3 system. The reference to the old DOCNUM is saved.

**Field EDI_DC-RCVPRT: Partner type of receiver**

The field indicates the type of partner system and is generally set to ‘LS’ (logical system) for communication with non-R/3 systems.

**Field EDI_DC-RCVPRN: Partner number of receiver**

Number or name of the receiving system.

**Field EDI_DC-SNDPRT: Partner type of transmitter**

The field indicates the type of partner system and is generally set to ‘LS’ (logical system) for communication with non-R/3 systems.

**Field EDI_DC-SNDPRN: Partner number of transmitter**

Number or name of the transmitting system.

The combination of fields SNDPRT and SNDPRN is extremely important for the subsystem when data in the incoming IDocs is being processed.

These two fields are used to separate documents from different R/3 systems or R/3 clients. A transportation planning system could, for example, receive two deliveries from two R/3 systems with the same delivery number. These deliveries must not get mixed up during planning. SNDPRT and SNDPRN therefore, function as an additional part of the key for all identification fields.

**Field EDI_DC-ARCKEY: Document ID in the external system**

In field ARCKEY, the subsystem can save additional information for unique identification of a transmitted document. If a document transmitted from the subsystem cannot be processed by the R/3 system, then an error message with the contents of ARCKEY is sent back in order to create a reference to the document-creating transaction.

**Field EDI_DC-MESTYP: Logical message category**

The field contains the logical name of a message. It is not bound by any EDI standard. Logical messages are assigned by SAP to the individual IDoc types.
Field EDI_DC-IDOCTYP: Name of basic IDoc category

The IDoc type is defined by the applications. They determine the sequence of the SAP segments. The IDoc types issued with the SAP standard are identified via field IDOCTYP just as IDoc types newly created by the customer are.

Field EDI_DC-serial: EDI/ALE: Serialization field

The serialization field contains a unique number, that can be used in serialization, i.e. setting the correct transmission sequence of IDocs in the receiving system. Generally, this is a time stamp that explodes the sequence sufficiently or which provides a sequence of consecutive numbers based on the unique identification of the creation sequence and/or the transmission sequence in the transmission system. The serialization field should only contain numbers.
EDI_DD - IDoc Data Record

The IDoc data record EDI_DD contains a 55 byte header section with reference information and hierarchy information as well as a data section of up to 1000 bytes. The size of the data section is determined by the length of the IDoc segment transferred there.

When the R/3 system is receiving or transmitting data, the sequence of the individual data records transferred is determined directly from table EDI_DD. The same is true for data that is being transmitted. The data records are also numbered sequentially in transmission.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Format</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td></td>
<td>Name of the table structure</td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td></td>
<td>Client</td>
</tr>
<tr>
<td>DOCNUM</td>
<td>NUMC 16</td>
<td>X</td>
<td>Number of the IDoc</td>
</tr>
<tr>
<td>SEGNUM</td>
<td>NUMC 06</td>
<td></td>
<td>sequential number</td>
</tr>
<tr>
<td>SEGNAM</td>
<td>CHAR 10</td>
<td>X</td>
<td>IDoc segment name</td>
</tr>
<tr>
<td>PSGNUM</td>
<td>NUMC 06</td>
<td></td>
<td>Number of hierarchically superior segment</td>
</tr>
<tr>
<td>HLEVEL</td>
<td>CHAR 02</td>
<td></td>
<td>Hierarchy level of the segment</td>
</tr>
<tr>
<td>DTINT2</td>
<td>CHAR 02</td>
<td></td>
<td>SAP-internal field, do not fill</td>
</tr>
<tr>
<td>SDATA</td>
<td>LCHR 1000</td>
<td>X</td>
<td>Data in the form of an IDoc segment</td>
</tr>
</tbody>
</table>

If, for example, you are transmitting two IDocs with shipment documents from a subsystem to an R/3 system, each with a shipment header, an action code and an assigned delivery - therefore each containing three segments, then you must use one EDI_DC record and three EDI_DD records per IDoc. When you call function module 'INBOUND_IDOC_PROCESS' via RFC, a total of two EDI_DC records and six EDI_DD records are transferred. The three segments of an IDoc are grouped using the unique number of the IDoc or intermediate document.

The DOCNUM is also used to identify the corresponding EDI_DC record. The R/3 client has the logical system description LS S11MAND002; the subsystem is defined using LS TRANSPLAN1.

EDI_DD

<table>
<thead>
<tr>
<th>IDoc number</th>
<th>Segment name</th>
<th>Data</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>90000000000123456</td>
<td>E2TPSHH</td>
<td>0010000101AD01ED...</td>
<td>Shipment header</td>
</tr>
<tr>
<td>90000000000123456</td>
<td>E2TPACC</td>
<td>C</td>
<td>Action code</td>
</tr>
<tr>
<td>90000000000123456</td>
<td>E2TPSHI</td>
<td>0010084000035465</td>
<td>Delivery</td>
</tr>
<tr>
<td>90000000000123457</td>
<td>E2TPSHH</td>
<td>0010000102AD01ED...</td>
<td>Shipment header</td>
</tr>
<tr>
<td>90000000000123457</td>
<td>E2TPACC</td>
<td>C</td>
<td>Action code</td>
</tr>
<tr>
<td>90000000000123457</td>
<td>E2TPSHI</td>
<td>0010084000035467</td>
<td>Delivery</td>
</tr>
</tbody>
</table>
### EDI_DC

<table>
<thead>
<tr>
<th>IDoc number</th>
<th>Receiving partner</th>
<th>Sending partner</th>
<th>Mess. type</th>
<th>IDoc type</th>
</tr>
</thead>
<tbody>
<tr>
<td>9000000000123456</td>
<td>LS S11MAND002</td>
<td>LS TRANSPLAN1</td>
<td>SHIPPL</td>
<td>TPSSHT01</td>
</tr>
<tr>
<td>9000000000123457</td>
<td>LS S11MAND002</td>
<td>LS TRANSPLAN1</td>
<td>SHIPPL</td>
<td>TPSSHT01</td>
</tr>
</tbody>
</table>
TPSDLS01 - Plan/Change Deliveries / Remove Deliveries

IDoc TPSDLS01 is used for transmitting deliveries that are yet to be scheduled for shipments into a transportation planning system. The IDoc contains the delivery information essential for the creating a shipment, as well as further address, material and transportation information.

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery header</td>
<td>E2TPDLH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Action code</td>
<td>E2TPACC</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Authorized service providers</td>
<td>E2TPALC</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Location identification</td>
<td>E2TPTRM</td>
<td>X</td>
<td>2-4</td>
</tr>
<tr>
<td>Address</td>
<td>E2TPLOC</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Location code</td>
<td>E2TPLCT</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Time frame</td>
<td>E2TPTIW</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT13</td>
<td>X</td>
<td>n</td>
</tr>
<tr>
<td>Header delivery dimensions</td>
<td>E2TPDIH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Delivery item</td>
<td>E2TPDLI</td>
<td>X</td>
<td>n</td>
</tr>
<tr>
<td>Delivery item dimensions</td>
<td>E2TPDII</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Goods code</td>
<td>E2TPCOC</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Handling unit</td>
<td>E2TPSHU</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Handling unit dimensions</td>
<td>E2TPDIS</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Handling unit contents</td>
<td>E2TPSUC</td>
<td></td>
<td>n</td>
</tr>
<tr>
<td>Texts</td>
<td>E2TPNOT</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Existing shipments</td>
<td>E2TPTRP</td>
<td></td>
<td>n</td>
</tr>
</tbody>
</table>
TPSLOC01 - Add/Change Location Master Data

IDoc TPSLOC01 is used for the initial transfer of location master data and for sending the change message to the transportation planning system.

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location identification</td>
<td>E2TPTRM</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Action code</td>
<td>E2TPACC</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Address</td>
<td>E2TPLOC</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Location code</td>
<td>E2TPLCT</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Business hours profile</td>
<td>E2KNVAM</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Time frame</td>
<td>E2TPTIW</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Texts</td>
<td>E2TPNOT</td>
<td>n</td>
<td></td>
</tr>
</tbody>
</table>

In general, every location master record is transferred with segments E2TPTRM, E2TPACC and E2TPLOC. Business hours profiles are prepared for customer unloading points. For customer master records, the address is linked to the customer. If a customer has several unloading points, then an IDoc TPSLOC01 is transferred for every unloading point. All others are transmitted without segment E2TPLOC.
**TPSSHT01 - Create/Change/Delete Shipment**

IDoc TPSSHT01 is used for data transfer in both directions between the R/3 system and the transportation planning system. The structure of the IDoc represents a shipment document, although it will be in a form that differs in part from that used in the R/3 system.

During TPS -> R/3 communication, IDoc TPSSHT01 is used to transfer planned, changed or deleted shipment documents. The individual segments occur as shown in the following table.

During R/3 -> TPS communication, IDoc TPSSHT01 is only transmitted with the shipment header and the action code. It is only used to confirm the status of an externally planned shipment in the TPS (changeable / non-changeable).

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment header</td>
<td>E2TPSHH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Action code</td>
<td>E2TPACC</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Costs</td>
<td>E2TPFRC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT10</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Means of transport</td>
<td>E2TPEQT</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Means of transport dimensions</td>
<td>E2TPDIS</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Transportation points</td>
<td>E2TPSLS</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Location identification</td>
<td>E2TPTRM</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Address</td>
<td>E2TPLOC</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT17</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Leg data</td>
<td>E2TPSHT</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>E2TPSHA</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Deliveries</td>
<td>E2TPSHI</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Delivery costs</td>
<td>E2TPDLC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Railway data</td>
<td>E2TPSHR</td>
<td>n</td>
<td></td>
</tr>
</tbody>
</table>

This IDoc contains a segment E2TPSLS and sub-segments for the description of the geographic processing of a shipment (load transfer point). A sequence of locations with the corresponding actions at that location is described in this part of the IDoc.

In the SAP R/3 system, this is carried out using a sequence of legs (links from one location to another) as well as with load transfer points and border crossing points in the shipment document. Generally, legs and border crossing points/load transfer points are represented as stages of a shipment (table VTTS). Deliveries can also be assigned to a stage (table VTSP).

For this reason, conversion is necessary when processing the incoming IDoc. The rules for conversion are explained for each segment.
**SYSTAT01 - Status Information for Transfer**

IDoc SYSTAT01 is used for transferring positive confirmations and error messages concerning the contents of IDocs TPSDLS01 and TPSSHT01.

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDI Status record</td>
<td>E2STATS</td>
<td>X</td>
<td>n</td>
</tr>
</tbody>
</table>
IDoc Segments, Fields and Domain Values

The following section describes the individual segments of IDocs TPSLOC01, TPSDLS01, TPSSHT01 and SYSTAT01. The fields contained in the segments are all listed with name, data category with length, corresponding R/3 domains, mandatory field indicators and their meanings. In the connection to the field list, segment fields that have special properties, fixed values areas or non-R/3 functions are described in greater detail.

Adjustment and Setting of Domain Values

During communication between the R/3 system and the transportation planning system, adjustment and setting of many fixed values is necessary in order to guarantee correct and efficient planning and processing. The following adjustment procedures are therefore used to determine how and in which system adjustments need to be made.

<table>
<thead>
<tr>
<th>Adjust. procedure</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SAP sets the standard that must be implemented in the planning system</td>
</tr>
<tr>
<td>2</td>
<td>Manual master data adjustment between the systems, R/3 is master system</td>
</tr>
<tr>
<td>3</td>
<td>Different value areas are used in both the R/3 system and in the planning system. Duplicated or common values can be adjusted</td>
</tr>
<tr>
<td>4</td>
<td>SAP copies the value area of the planning system for its development partner into the R/3 system</td>
</tr>
<tr>
<td>5</td>
<td>The R/3 system is adjusted in Customizing to the planning system value area</td>
</tr>
<tr>
<td>6</td>
<td>Translation / adjustment of technical expressions between the two systems</td>
</tr>
<tr>
<td>7</td>
<td>Value area is fixed and was determined by agreement between SAP and development partners</td>
</tr>
<tr>
<td>8</td>
<td>SAP defines a basic value which must be included in the planning system. It can be enhanced and must then also be enhanced in R/3 Customizing, if necessary</td>
</tr>
<tr>
<td>9</td>
<td>The value area is specified using international standards (e.g. ANSI, ISO,...)</td>
</tr>
<tr>
<td>A</td>
<td>Electronic master data adjustment per data transfer, R/3 is the master system</td>
</tr>
<tr>
<td>B</td>
<td>Master data value that can be set as customer-specific and can only be adjusted in special circumstances</td>
</tr>
</tbody>
</table>

The various adjustment procedures are listed in the table with the segment descriptions in the Adjustment column. If no specification is made here, then you only need to take the specifications on data formats into account.
E2EDT1x - Processes

Definition

Segments E2EDT10, E2EDT13 and E2EDT17 describe processes at different document levels. The structures of the segments are the same. The only differences are in the location and the categories of the processes that they represent.

Segment E2EDT10 represents processes at shipment header level, i.e., those that refer to the whole shipment. E2EDT13 contains processes at delivery header level, i.e. processes that refer to the whole delivery. E2EDT17 represents processes in the shipment at stage level, i.e. processes that refer to a specific stage or point during the shipment.

The three segment types are all structured as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUALF</td>
<td>8</td>
<td>CHAR 03</td>
<td></td>
<td>X</td>
<td>Process category</td>
</tr>
<tr>
<td>VSTZW</td>
<td>8</td>
<td>CHAR 04</td>
<td>VSTZW</td>
<td></td>
<td>Process</td>
</tr>
<tr>
<td>VSTZW_BEZ</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td></td>
<td>Process description</td>
</tr>
<tr>
<td>NTANF</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Planned start date</td>
</tr>
<tr>
<td>NTANZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Planned start time</td>
</tr>
<tr>
<td>NTEND</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Planned end date</td>
</tr>
<tr>
<td>NTENZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Planned end time</td>
</tr>
<tr>
<td>TZONE_BEGIN</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONE</td>
<td></td>
<td>Time zone of location of process start</td>
</tr>
<tr>
<td>ISDD</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Actual start date</td>
</tr>
<tr>
<td>ISDZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Actual start time</td>
</tr>
<tr>
<td>IEDD</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Actual end date</td>
</tr>
<tr>
<td>IEDZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Actual end time</td>
</tr>
<tr>
<td>TZONE_END</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONE</td>
<td></td>
<td>Time zone of location of process end</td>
</tr>
<tr>
<td>VORNR</td>
<td></td>
<td>CHAR 04</td>
<td>VORNR</td>
<td></td>
<td>Process number</td>
</tr>
<tr>
<td>VSTGA</td>
<td>5</td>
<td>CHAR 04</td>
<td>VSTGA</td>
<td></td>
<td>Code for reason of deviation</td>
</tr>
<tr>
<td>VSTGA_BEZ</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td></td>
<td>Description of reason of deviation</td>
</tr>
</tbody>
</table>
Special fields and domain values in the segments E2EDT1x

In the following fields from segments E2EDT1x, you must take note of special functions and/or allowed value areas.

**Field E2EDT1x-QUALF: Activity category**

The field can adopt the following values in the segments described, which involves entering data in the specified field from the table. Values in brackets are allowed for transmission to the IDoc, but are not evaluated during standard inbound processing:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>E2EDT10</th>
<th>E2EDT13</th>
<th>E2EDT17</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Transportation planning time</td>
<td>NTENx</td>
<td>NTENx</td>
<td></td>
</tr>
<tr>
<td>003</td>
<td>Loading time/execution</td>
<td>NTANx, NTENx</td>
<td>NTENx</td>
<td>( NTANx,NTENx)</td>
</tr>
<tr>
<td>005</td>
<td>Transportation processing</td>
<td>NTANx, NTENx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>006</td>
<td>Goods issue time</td>
<td></td>
<td>NTENx</td>
<td></td>
</tr>
<tr>
<td>007</td>
<td>Delivery time</td>
<td></td>
<td>NTENx</td>
<td></td>
</tr>
<tr>
<td>008</td>
<td>Arrival time</td>
<td></td>
<td>NTENx</td>
<td>( NTENx)</td>
</tr>
<tr>
<td>009</td>
<td>Departure time</td>
<td></td>
<td>NTENx</td>
<td>( NTANx)</td>
</tr>
<tr>
<td>010</td>
<td>Picking time</td>
<td></td>
<td>NTENx</td>
<td></td>
</tr>
<tr>
<td>011</td>
<td>Waiting time</td>
<td></td>
<td></td>
<td>NTANx, NTENx</td>
</tr>
<tr>
<td>012</td>
<td>Unloading time</td>
<td></td>
<td></td>
<td>( NTANx,NTENx)</td>
</tr>
<tr>
<td>013</td>
<td>Time of customs clearance</td>
<td></td>
<td></td>
<td>( NTANx,NTENx)</td>
</tr>
<tr>
<td>014</td>
<td>Load transfer point</td>
<td></td>
<td></td>
<td>( NTANx,NTENx)</td>
</tr>
<tr>
<td>018</td>
<td>Optimal arrival time</td>
<td></td>
<td></td>
<td>( NTENx)</td>
</tr>
<tr>
<td>019</td>
<td>Optimal departure time</td>
<td></td>
<td></td>
<td>( NTANx)</td>
</tr>
</tbody>
</table>

**Important Process Categories:**

The following process categories are extremely important and should be taken into consideration.

**Segment E2EDT13 (Process at Delivery Header Level) in IDoc TSPDLS01**

The time framework for planning the shipment is given in departure time (009) and arrival time (008). These are to be used for planning. The final planned data is entered here.

For direct shipment of the delivery (shipment from the shipping point to the customer), the departure time is the same as the loading time and the arrival time is the same as the unloading time. If, however, only a preliminary leg shipment is planned (e.g. from the shipping point to the port of departure) then the delivery time is no longer relevant for actual planning.
Segment E2EDT10 (Process at Shipment Level) in IDoc TPSSHT01

The time framework for carrying out the shipment is given in transportation processing (005) in the planned start and end dates.

Loading (003) is optional and contains planned start and end dates.

Time of transportation planning (001) is optional. It contains planned end dates. If it is not specified, then the posting time is determined automatically in the R/3 shipment document as the transportation planning time.

Segment E2EDT17 (Process at Shipment Stage Level) in IDoc TSPSHT01

Field QUALF: Only the date with qualifier '011' (Waiting time) is taken into account. All other dates are ignored.

The planned and actual dates (both start and end) for a location are converted into the planned and actual dates for the legs. This means that the end date for a location becomes the start date for the leg that starts at this location. Similarly, the start date of the next location becomes the end date of the leg that finishes at this location.

This can be summarized as follows:

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Location, E2EDT17-NTEND</td>
<td>First leg, VTTS-DPTBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-NTENZ</td>
<td>First leg, VTTS-UPTBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-IEDD</td>
<td>First leg, VTTS-DATBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-IEDZ</td>
<td>First leg, VTTS-UATBG</td>
</tr>
<tr>
<td>2. Location, E2EDT17-NTANF</td>
<td>First leg, VTTS-DPTEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-NTANZ</td>
<td>First leg, VTTS-UPTEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-ISDD</td>
<td>First leg, VTTS-DATEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-ISDZ</td>
<td>First leg, VTTS-UATEN</td>
</tr>
</tbody>
</table>

This table would continue similarly for other locations.

The beginning date of the first location and the final dates of the last location are ignored. All the other fields are ignored.

Field E2EDT1x-TZONE_xxx: Time zone:

Time zone code. Value area according to R/3 table field TTZZ-TZONE.
Definition
Business hours profile for the goods receiving times during the week for a customer unloading point.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Required field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSGFN</td>
<td>CHAR 03</td>
<td>MSGFN</td>
<td></td>
<td></td>
<td>Message function (blank)</td>
</tr>
<tr>
<td>ABLAD</td>
<td>A</td>
<td>CHAR 25</td>
<td>ABLAD</td>
<td></td>
<td>Unloading point</td>
</tr>
<tr>
<td>KNKAL</td>
<td>8</td>
<td>CHAR 02</td>
<td>KNKAL</td>
<td></td>
<td>Factory calendar</td>
</tr>
<tr>
<td>WANID</td>
<td>8</td>
<td>CHAR 03</td>
<td>WANID</td>
<td>X</td>
<td>Profile number of goods receiving profile</td>
</tr>
<tr>
<td>WAMOAB1</td>
<td>TIMS 06</td>
<td>WAMOAB1</td>
<td></td>
<td></td>
<td>Business hours begin Monday morning</td>
</tr>
<tr>
<td>WAMOBI1</td>
<td>TIMS 06</td>
<td>WAMOBI1</td>
<td></td>
<td></td>
<td>Business hours end Monday morning</td>
</tr>
<tr>
<td>WAMOAB2</td>
<td>TIMS 06</td>
<td>WAMOAB2</td>
<td></td>
<td></td>
<td>Business hours begin Monday afternoon</td>
</tr>
<tr>
<td>WAMOBI2</td>
<td>TIMS 06</td>
<td>WAMOBI2</td>
<td></td>
<td></td>
<td>Business hours end Monday afternoon</td>
</tr>
<tr>
<td>WADIAB1</td>
<td>TIMS 06</td>
<td>WADIAB1</td>
<td></td>
<td></td>
<td>Business hours begin Tuesday morning</td>
</tr>
<tr>
<td>WADIBI1</td>
<td>TIMS 06</td>
<td>WADIBI1</td>
<td></td>
<td></td>
<td>Business hours end Tuesday morning</td>
</tr>
<tr>
<td>WADIAB2</td>
<td>TIMS 06</td>
<td>WADIAB2</td>
<td></td>
<td></td>
<td>Business hours begin Tuesday afternoon</td>
</tr>
<tr>
<td>WADIBI2</td>
<td>TIMS 06</td>
<td>WADIBI2</td>
<td></td>
<td></td>
<td>Business hours end Tuesday afternoon</td>
</tr>
<tr>
<td>WAMIAB1</td>
<td>TIMS 06</td>
<td>WAMIAB1</td>
<td></td>
<td></td>
<td>Business hours begin Wednesday morning</td>
</tr>
<tr>
<td>WAMIBI1</td>
<td>TIMS 06</td>
<td>WAMIBI1</td>
<td></td>
<td></td>
<td>Business hours end Wednesday morning</td>
</tr>
<tr>
<td>WAMIAB2</td>
<td>TIMS 06</td>
<td>WAMIAB2</td>
<td></td>
<td></td>
<td>Business hours begin Wednesday afternoon</td>
</tr>
<tr>
<td>WAMIBI2</td>
<td>TIMS 06</td>
<td>WAMIBI2</td>
<td></td>
<td></td>
<td>Business hours end Wednesday afternoon</td>
</tr>
<tr>
<td>WADOAB1</td>
<td>TIMS 06</td>
<td>WADOAB1</td>
<td></td>
<td></td>
<td>Business hours begin Thursday morning</td>
</tr>
<tr>
<td>WADOBI1</td>
<td>TIMS 06</td>
<td>WADOBI1</td>
<td></td>
<td></td>
<td>Business hours end Thursday morning</td>
</tr>
<tr>
<td>WADOAB2</td>
<td>TIMS 06</td>
<td>WADOAB2</td>
<td></td>
<td></td>
<td>Business hours begin Thursday afternoon</td>
</tr>
<tr>
<td>WADOBI2</td>
<td>TIMS 06</td>
<td>WADOBI2</td>
<td></td>
<td></td>
<td>Business hours end Thursday afternoon</td>
</tr>
<tr>
<td>Code</td>
<td>Time</td>
<td>Code</td>
<td>Time</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>---------</td>
<td>--------</td>
<td>--------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>WAFRAB1</td>
<td>TIMS 06</td>
<td>WAFRAB1</td>
<td></td>
<td>Business hours begin Friday morning</td>
<td></td>
</tr>
<tr>
<td>WAFRBI1</td>
<td>TIMS 06</td>
<td>WAFRBI1</td>
<td></td>
<td>Business hours end Friday morning</td>
<td></td>
</tr>
<tr>
<td>WAFRAB2</td>
<td>TIMS 06</td>
<td>WAFRAB2</td>
<td></td>
<td>Business hours begin Friday afternoon</td>
<td></td>
</tr>
<tr>
<td>WAFRBI2</td>
<td>TIMS 06</td>
<td>WAFRBI2</td>
<td></td>
<td>Business hours end Friday afternoon</td>
<td></td>
</tr>
<tr>
<td>WASAAB1</td>
<td>TIMS 06</td>
<td>WASAAB1</td>
<td></td>
<td>Business hours begin Saturday morning</td>
<td></td>
</tr>
<tr>
<td>WASABI1</td>
<td>TIMS 06</td>
<td>WASABI1</td>
<td></td>
<td>Business hours end Saturday morning</td>
<td></td>
</tr>
<tr>
<td>WASAAB2</td>
<td>TIMS 06</td>
<td>WASAAB2</td>
<td></td>
<td>Business hours begin Saturday afternoon</td>
<td></td>
</tr>
<tr>
<td>WASABI2</td>
<td>TIMS 06</td>
<td>WASABI2</td>
<td></td>
<td>Business hours end Saturday afternoon</td>
<td></td>
</tr>
<tr>
<td>WASOAB1</td>
<td>TIMS 06</td>
<td>WASOAB1</td>
<td></td>
<td>Business hours begin Sunday morning</td>
<td></td>
</tr>
<tr>
<td>WASOBI1</td>
<td>TIMS 06</td>
<td>WASOBI1</td>
<td></td>
<td>Business hours end Sunday morning</td>
<td></td>
</tr>
<tr>
<td>WASOAB2</td>
<td>TIMS 06</td>
<td>WASOAB2</td>
<td></td>
<td>Business hours begin Sunday afternoon</td>
<td></td>
</tr>
<tr>
<td>WASOBI2</td>
<td>TIMS 06</td>
<td>WASOBI2</td>
<td></td>
<td>Business hours end Sunday afternoon</td>
<td></td>
</tr>
<tr>
<td>DEFAB</td>
<td>CHAR 01</td>
<td>DEFAB</td>
<td></td>
<td>Indicator for the standard unloading point</td>
<td></td>
</tr>
</tbody>
</table>
E2STATS - EDI Status Record

Definition

Status and error information is transferred into segment E2STATS.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjus. t.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td></td>
<td>Name of the table structure (blank)</td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td>MANDT</td>
<td></td>
<td>Client</td>
<td></td>
</tr>
<tr>
<td>DOCNUM</td>
<td>CHAR 16</td>
<td></td>
<td></td>
<td>X</td>
<td>IDoc number of incorrect document</td>
</tr>
<tr>
<td>LOGDAT</td>
<td>DATS 08</td>
<td></td>
<td></td>
<td>X</td>
<td>Date</td>
</tr>
<tr>
<td>LOGTIM</td>
<td>TIMS 06</td>
<td></td>
<td></td>
<td>X</td>
<td>Time</td>
</tr>
<tr>
<td>STATUS</td>
<td>1 CHAR 02</td>
<td></td>
<td></td>
<td>X</td>
<td>Status of incorrect IDoc</td>
</tr>
<tr>
<td>UNAME</td>
<td>CHAR 12</td>
<td></td>
<td></td>
<td>User name</td>
<td></td>
</tr>
<tr>
<td>REPID</td>
<td>CHAR 08</td>
<td></td>
<td></td>
<td>Program name</td>
<td></td>
</tr>
<tr>
<td>ROUTID</td>
<td>CHAR 30</td>
<td></td>
<td></td>
<td>Subroutine name</td>
<td></td>
</tr>
<tr>
<td>STACOD</td>
<td>3 CHAR 08</td>
<td></td>
<td></td>
<td>X</td>
<td>Status code</td>
</tr>
<tr>
<td>STATXT</td>
<td>3, 6 CHAR 70</td>
<td></td>
<td></td>
<td>X</td>
<td>Status code text</td>
</tr>
<tr>
<td>SEGNUM</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td>Segment number</td>
<td></td>
</tr>
<tr>
<td>SEGFLD</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Field name</td>
<td></td>
</tr>
<tr>
<td>STAPA1</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Parameter 1</td>
<td></td>
</tr>
<tr>
<td>STAPA2</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Parameter 2</td>
<td></td>
</tr>
<tr>
<td>STAPA3</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Parameter 3</td>
<td></td>
</tr>
<tr>
<td>STAPA4</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Parameter 4</td>
<td></td>
</tr>
<tr>
<td>REFINT</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td>Reference to file</td>
<td></td>
</tr>
<tr>
<td>REFGRP</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td>Reference to message</td>
<td></td>
</tr>
<tr>
<td>REFMES</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td>Reference to message</td>
<td></td>
</tr>
<tr>
<td>ARCKEY</td>
<td>CHAR 70</td>
<td></td>
<td></td>
<td>Document ID in the external system</td>
<td></td>
</tr>
<tr>
<td>STATYP</td>
<td>1 CHAR 01</td>
<td></td>
<td></td>
<td>System message category</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2STATS

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2STATS.

E2STATS-STATUS Field : Status of incorrect IDoc Status of incorrect IDoc

Status values for IDoc used within the communication.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>IDoc was successfully processed (possibly with warnings)</td>
</tr>
<tr>
<td>17</td>
<td>IDoc could not be processed</td>
</tr>
</tbody>
</table>
E2STATS-STACOD Field: Status Code

Status or error message code, as available in the R/3 system. Generally, the code is always ‘SAPV6xxx’, whereby digits ‘xxx’ are predefined as follows:

<table>
<thead>
<tr>
<th>Area</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>000-499</td>
<td>Messages from the transportation planning system to R/3</td>
</tr>
<tr>
<td>500-999</td>
<td>Messages from the R/3 system to the transportation planning system</td>
</tr>
</tbody>
</table>

You can compare the messages manually between the systems so that if there is a message in the destination system only defined by a status code, its corresponding long text will appear.

E2STATS-ARCKEY Field: Document ID in External System

An identification predefined by the subsystem is created in the ARCKEY field. If you cannot process a document sent by the subsystem to the R/3 system, the contents of the ARCKEY field from the incorrect IDoc will be sent back in the ARCKEY field in the error message. This will allow you to recreate the reference to the process that generated the document.

E2STATS-STATYP Field: System Message Category

Category of the system message

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Status message after successful transaction</td>
</tr>
<tr>
<td>I</td>
<td>Information message (note)</td>
</tr>
<tr>
<td>W</td>
<td>Warning</td>
</tr>
<tr>
<td>E</td>
<td>Error message</td>
</tr>
<tr>
<td>A</td>
<td>Termination message (serious error)</td>
</tr>
</tbody>
</table>
# E2TPACC - Action Code

## Definition
Actions code which specifies which action should be carried out with the corresponding document. The segment is used in IDocs TPSLOC01, TPSDLS01 and TPSSHT01.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTCD</td>
<td>1</td>
<td>CHAR 01</td>
<td>X</td>
<td></td>
<td>Action code</td>
</tr>
</tbody>
</table>

## Special fields and domain values in segment E2TPACC
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPACC.

### E2TPACC-ACTCD Field: Action Code
This field can have the following values in the IDocs specified:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>TPSLOC01</th>
<th>TPSDLS01</th>
<th>TPSSHT01</th>
<th>TPSSHT01 R/3-TPS</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Create document</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>Change document</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Delete document</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Fix shipment document status (no changes permitted)</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>U</td>
<td>Set shipment document status to released (changes permitted)</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
E2TPALC - Authorized Service Provider

Definition

In this segment, which can appear several times, you can enter alternative service agents for carrying out the delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARRID</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td>X</td>
<td>Allowed forwarding agent</td>
</tr>
</tbody>
</table>
E2TPCOC - Goods Code

Definition
Goods code for material in a delivery item. A delivery item can have several codes.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODTYP</td>
<td>8</td>
<td>CHAR 03</td>
<td>X</td>
<td>Code type</td>
<td></td>
</tr>
<tr>
<td>CODNUM</td>
<td>(9)</td>
<td>CHAR 35</td>
<td>X</td>
<td>Code number</td>
<td></td>
</tr>
<tr>
<td>CODTXT</td>
<td></td>
<td>CHAR 50</td>
<td></td>
<td>Code description</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPCOC
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPCOC.

E2TPCOC-CODTYP Field: Code Type
The code category specifies which code type the code number is related to:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Commodity code</td>
</tr>
<tr>
<td>002</td>
<td>Freight code</td>
</tr>
<tr>
<td>003</td>
<td>Material freight group</td>
</tr>
</tbody>
</table>
E2TPDIH - Delivery Dimensions at Header Level

Definition

Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRSWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>GRSVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td></td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

Special fields and domains in segment E2TPDIH

Please note that all weight and volume units are transferred in ISO standard notes.

Field E2TPDIH-WUNIT: Weight Unit

Possible weight units in ISO:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGM</td>
<td>Centigram</td>
</tr>
<tr>
<td>DTN</td>
<td>Centner, deciton</td>
</tr>
<tr>
<td>GRM</td>
<td>Gram</td>
</tr>
<tr>
<td>GRT</td>
<td>Gross register ton</td>
</tr>
<tr>
<td>DTH</td>
<td>Hectokilogram</td>
</tr>
<tr>
<td>KGM</td>
<td>Kilogram</td>
</tr>
<tr>
<td>KTN</td>
<td>Kiloton</td>
</tr>
<tr>
<td>TNE</td>
<td>Ton</td>
</tr>
<tr>
<td>MGM</td>
<td>Milligram</td>
</tr>
<tr>
<td>NTT</td>
<td>Net register ton</td>
</tr>
<tr>
<td>LBR</td>
<td>Pound</td>
</tr>
<tr>
<td>SHT</td>
<td>Shipping tons</td>
</tr>
<tr>
<td>STN</td>
<td>Short ton (GB)</td>
</tr>
</tbody>
</table>

Field E2TPDIH-VUNIT: Volume unit

Possible volume units in ISO:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLT</td>
<td>Centiliter</td>
</tr>
<tr>
<td>CMQ</td>
<td>Cubic centimeter</td>
</tr>
</tbody>
</table>
## E2TPDIH - Delivery Dimensions at Header Level

<table>
<thead>
<tr>
<th>Code</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMQ</td>
<td>Cubic decimeter</td>
</tr>
<tr>
<td>FTQ</td>
<td>Cubic foot</td>
</tr>
<tr>
<td>INQ</td>
<td>Cubic inch</td>
</tr>
<tr>
<td>MTQ</td>
<td>Cubic meter</td>
</tr>
<tr>
<td>MMQ</td>
<td>Cubic millimeter</td>
</tr>
<tr>
<td>YDQ</td>
<td>Cubic yard</td>
</tr>
<tr>
<td>DLT</td>
<td>Deciliter</td>
</tr>
<tr>
<td>BLD</td>
<td>Dry barrel</td>
</tr>
<tr>
<td>GLD</td>
<td>Dry gallon</td>
</tr>
<tr>
<td>PTD</td>
<td>Dry pint</td>
</tr>
<tr>
<td>QTD</td>
<td>Dry quart</td>
</tr>
<tr>
<td>OZI</td>
<td>Fluid ounce (28,413 cm³)</td>
</tr>
<tr>
<td>OZA</td>
<td>Fluid ounce (29,5735 cm³)</td>
</tr>
<tr>
<td>GLI</td>
<td>Gallon</td>
</tr>
<tr>
<td>HLT</td>
<td>Hectoliter</td>
</tr>
<tr>
<td>GLL</td>
<td>Liquid gallon</td>
</tr>
<tr>
<td>PTL</td>
<td>Liquid pint</td>
</tr>
<tr>
<td>QTL</td>
<td>Liquid quart</td>
</tr>
<tr>
<td>LTR</td>
<td>Liter</td>
</tr>
<tr>
<td>MAL</td>
<td>Megaliter</td>
</tr>
<tr>
<td>PTI</td>
<td>Pint</td>
</tr>
<tr>
<td>QTI</td>
<td>Quart</td>
</tr>
</tbody>
</table>
E2TPDII - Delivery Dimensions at Item Level

**Definition**
Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRSWGT</td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td></td>
<td>Gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>GRSVOL</td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPDII**
Please note that all weight and volume units are transferred in ISO standard notes. The domain values are the same as those for segment E2TPDIH.
E2TPDIS – Dimensions of Handling Unit

Definition

Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TARWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Tare weight</td>
</tr>
<tr>
<td>GRSWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>TARVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Tare volume</td>
</tr>
<tr>
<td>GRSVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>LENGTH</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Length</td>
</tr>
<tr>
<td>WIDTH</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Width</td>
</tr>
<tr>
<td>HEIGHT</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Height</td>
</tr>
<tr>
<td>DUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO length unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td></td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDIS

Please note that all weight and volume units are transmitted in ISO standard notes. The domain values are similar to the values for segment E2TPDIH.

Field E2TPDIH-DUNIT: Unit of length

Possible ISO length units:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMT</td>
<td>Centimeter</td>
</tr>
<tr>
<td>DMT</td>
<td>Decimeter</td>
</tr>
<tr>
<td>FOT</td>
<td>Foot</td>
</tr>
<tr>
<td>INH</td>
<td>Inch</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Transportation connection point</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
<tr>
<td>-----</td>
<td>-------</td>
</tr>
</tbody>
</table>

E2TPDIS – Dimensions of Handling Unit
E2TPDLC - Shipment Costs at Delivery Level

Definition
Shipment costs item for a delivery within a shipment.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td>Cost element</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td></td>
<td>QUAN 18</td>
<td>X</td>
<td>Rate</td>
<td></td>
</tr>
<tr>
<td>CURRC</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>X</td>
<td>Currency (ISO norm)</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDLC
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLC.

**E2TPDLC-CSTTYP Field: Cost element**
Cost types have not yet been determined but are defined when shipment costs are entered.

**E2TPDLC-CURRC Field: Currency (ISO norm)**
Currency key set to ISO norms with the value area of R/3 table field TCURC-ICOCD.
**E2TPDLH - Delivery Header**

**Definition**
Organizational and status information at delivery header level.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELID</td>
<td></td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Delivery indicator/number</td>
</tr>
<tr>
<td>SHPPPT</td>
<td>5, 8</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation Planning Point (TPP)</td>
</tr>
<tr>
<td>SHPPRJ</td>
<td></td>
<td>CHAR 12</td>
<td></td>
<td>X</td>
<td>Shipment in the same vehicle</td>
</tr>
<tr>
<td>SCHDMN</td>
<td></td>
<td>CHAR 06</td>
<td></td>
<td>X</td>
<td>Planning process number</td>
</tr>
<tr>
<td>SALORG</td>
<td>B</td>
<td>CHAR 04</td>
<td>VKORG</td>
<td></td>
<td>Org. unit for defining plan number</td>
</tr>
<tr>
<td>DSTCHN</td>
<td>B</td>
<td>CHAR 02</td>
<td>VTWEG</td>
<td></td>
<td>Org. unit for defining plan number</td>
</tr>
<tr>
<td>DIVISN</td>
<td>B</td>
<td>CHAR 02</td>
<td>SPART</td>
<td></td>
<td>Org. unit for defining plan number</td>
</tr>
<tr>
<td>CPONUM</td>
<td></td>
<td>CHAR 20</td>
<td>BSTNK</td>
<td></td>
<td>customer’s purchase order number</td>
</tr>
<tr>
<td>SHPCND</td>
<td>8</td>
<td>CHAR 02</td>
<td>VSBED</td>
<td></td>
<td>Shipping condition</td>
</tr>
<tr>
<td>SHPTYP</td>
<td>8</td>
<td>CHAR 02</td>
<td>VSART</td>
<td>X</td>
<td>Shipping type</td>
</tr>
<tr>
<td>SHPPRI</td>
<td>1</td>
<td>CHAR 02</td>
<td>LPRIO</td>
<td></td>
<td>Shipping priority</td>
</tr>
<tr>
<td>DIREC</td>
<td>7</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Direction of the delivery</td>
</tr>
<tr>
<td>FTERM</td>
<td>9</td>
<td>CHAR 03</td>
<td>INCO1</td>
<td>X</td>
<td>Incoterms</td>
</tr>
<tr>
<td>FTLOC</td>
<td></td>
<td>CHAR 28</td>
<td>INCO2</td>
<td></td>
<td>Incoterms location</td>
</tr>
<tr>
<td>ROUTE</td>
<td>8</td>
<td>CHAR 06</td>
<td>ROUTE</td>
<td>X</td>
<td>Route</td>
</tr>
<tr>
<td>ROUTXT</td>
<td></td>
<td>CHAR 40</td>
<td>TEXT40</td>
<td></td>
<td>Route text</td>
</tr>
<tr>
<td>PREFCA</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Preferred forwarding agent</td>
</tr>
<tr>
<td>CNSFLG</td>
<td>4</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Consolidation status</td>
</tr>
<tr>
<td>LODSEQ</td>
<td>4</td>
<td>NUMC 01</td>
<td></td>
<td></td>
<td>Loading sequence</td>
</tr>
<tr>
<td>ALSTAT</td>
<td>4</td>
<td>CHAR 01</td>
<td></td>
<td>X</td>
<td>Availability status</td>
</tr>
<tr>
<td>REVENU</td>
<td></td>
<td>CHAR 18</td>
<td></td>
<td></td>
<td>Payment on picking up</td>
</tr>
<tr>
<td>REVCUR</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Payment currency</td>
</tr>
<tr>
<td>RRCODE</td>
<td>4</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Rail code (US requirement)</td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPDLH**
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLH.

**E2TPDLH-SHPPRJ Field: Shipment in the same vehicle**
This field groups together all the deliveries (IDocs) within a planning run, which are to be planned for the same vehicle in transportation planning.

This field is normally not processed and can be completed from customer functions.

Default value: blank.
E2TPDLH - Delivery Header

E2TPDLH-SCHDNM Field: Planning process number
This field groups together all the deliveries (IDocs) that have to be planned within the same planning run (for separate planning of a ‘north’ and ‘south’ tour, for example).
This field is normally not processed and can be completed from customer functions.
Default value: ‘1’.

E2TPDLH-DIREC Field: Direction of the delivery
The value for field DIREC is determined using delivery document category
The field can have the following values:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>IB</td>
<td>Inbound - incoming delivery returns, shipping notifications</td>
</tr>
<tr>
<td>OB</td>
<td>Outbound - outgoing delivery: normal delivery document</td>
</tr>
</tbody>
</table>

Field E2TPDLH-FTERM: Incoterm
This field can have the following values according to international standards:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFR</td>
<td>Cost and Freight</td>
</tr>
<tr>
<td>CIF</td>
<td>Cost, Insurance and Freight</td>
</tr>
<tr>
<td>CIP</td>
<td>Carriage and Insurance Paid to</td>
</tr>
<tr>
<td>CPT</td>
<td>Carriage Paid to</td>
</tr>
<tr>
<td>DAF</td>
<td>Delivered at Frontier</td>
</tr>
<tr>
<td>DDP</td>
<td>Delivered Duty Paid</td>
</tr>
<tr>
<td>DDU</td>
<td>Delivered Duty Unpaid</td>
</tr>
<tr>
<td>DEQ</td>
<td>Delivered Ex Quay (duty paid)</td>
</tr>
<tr>
<td>DES</td>
<td>Delivered Ex Ship</td>
</tr>
<tr>
<td>EXW</td>
<td>Ex Works</td>
</tr>
<tr>
<td>FAS</td>
<td>Free Alongside Ship</td>
</tr>
<tr>
<td>FCA</td>
<td>Free Carrier</td>
</tr>
<tr>
<td>FH</td>
<td>Carriage paid (to customer’s address)</td>
</tr>
<tr>
<td>FOB</td>
<td>Free on board</td>
</tr>
<tr>
<td>UN</td>
<td>Not paid</td>
</tr>
</tbody>
</table>

E2TPDLH-CNSFLG Field: Consolidation status
The consolidation status determines whether deliveries may be shipped together with other deliveries or not.
This field is normally not processed and can be completed from customer functions.
Default value: blank.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
E2TPDLH - Delivery Header

<table>
<thead>
<tr>
<th>0</th>
<th>Delivery may be shipped together with others</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Deliveries may not be shipped together with others</td>
</tr>
<tr>
<td>2</td>
<td>Only consolidate deliveries to the same destination</td>
</tr>
</tbody>
</table>

**E2TPDLH-LODSEQ Field: Load sequence**

The load sequence determines when a delivery has to be loaded onto the means of transport. It does not set a fixed sequence but it indicates priorities.

This field is normally not processed and can be completed using customer functions.

Default value: blank.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delivery must be loaded first</td>
</tr>
<tr>
<td>2</td>
<td>Load delivery first</td>
</tr>
<tr>
<td>3</td>
<td>Load delivery normally</td>
</tr>
<tr>
<td>4</td>
<td>Load delivery last</td>
</tr>
<tr>
<td>5</td>
<td>Delivery must be loaded last</td>
</tr>
</tbody>
</table>

**E2TPDLH-ALSTAT Field: Allocation status**

The allocation status indicates whether the delivery has already been checked as available and whether the stock has been reserved.

Due to dynamic availability checks in the R/3 system, this field is entered as a default value.

Default value: ‘0’.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Delivery available/reserved/planned</td>
</tr>
<tr>
<td>1</td>
<td>Delivery not planned</td>
</tr>
</tbody>
</table>

**E2TPDLH-REVCUR field: Payment currency**

The value fields for the currency of payment correspond to the ISO currency code and also match the ISO currency codes proposed by the R/3 system.
E2TPDLI - Delivery Item

Definition

Delivery item with quantity specifications and material ID.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELITM</td>
<td></td>
<td>CHAR 06</td>
<td>POSNR</td>
<td>X</td>
<td>Delivery item number</td>
</tr>
<tr>
<td>MATNR</td>
<td>B</td>
<td>CHAR 35</td>
<td>MATNR</td>
<td>X</td>
<td>Material number</td>
</tr>
<tr>
<td>MATTXT</td>
<td></td>
<td>CHAR 80</td>
<td>ARKTX</td>
<td></td>
<td>Material description</td>
</tr>
<tr>
<td>HAZMAT</td>
<td>B</td>
<td>CHAR 18</td>
<td>STOFF</td>
<td></td>
<td>Dangerous goods number</td>
</tr>
<tr>
<td>MILMAT</td>
<td>1</td>
<td>CHAR 01</td>
<td>ITARK</td>
<td></td>
<td>Military goods indicator</td>
</tr>
<tr>
<td>QUANT</td>
<td></td>
<td>QUAN 15</td>
<td>LFIMG</td>
<td>X</td>
<td>Delivery quantity</td>
</tr>
<tr>
<td>QNUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>VRKME</td>
<td>X</td>
<td>Unit of measure</td>
</tr>
<tr>
<td>LDGRP</td>
<td>8</td>
<td>CHAR 04</td>
<td>LADGR</td>
<td></td>
<td>Loading group</td>
</tr>
<tr>
<td>TRGRP</td>
<td>8</td>
<td>CHAR 04</td>
<td>TRAGR</td>
<td></td>
<td>Transportation group</td>
</tr>
<tr>
<td>STRCND</td>
<td>8</td>
<td>CHAR 02</td>
<td>RAUBE</td>
<td></td>
<td>Storage conditions</td>
</tr>
<tr>
<td>TMPCN</td>
<td>8</td>
<td>CHAR 02</td>
<td>TEMPB</td>
<td></td>
<td>Temperature conditions</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDLI

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLI.

**E2TPDLI-HAZMAT field : Dangerous goods number**

Freely-definable number or classification for dangerous goods.

**E2TPDLI-MILMAT field : Military goods indicator**

Indicates that the materials delivered are military goods.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>non-military material</td>
</tr>
<tr>
<td>1</td>
<td>military material</td>
</tr>
</tbody>
</table>

**E2TPDLI-QNUNIT field : Unit of measure**

Possible units of quantity according to ISO norms:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DZN</td>
<td>Dozen</td>
</tr>
<tr>
<td>DZP</td>
<td>Dozen packs</td>
</tr>
<tr>
<td>DPR</td>
<td>Dozen pairs</td>
</tr>
<tr>
<td>DPC</td>
<td>Dozen pieces</td>
</tr>
<tr>
<td>DRL</td>
<td>Dozen rolls</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
</tr>
<tr>
<td>GGR</td>
<td>Great gross</td>
</tr>
<tr>
<td>GRO</td>
<td>Gross</td>
</tr>
<tr>
<td>KAR</td>
<td>Box</td>
</tr>
<tr>
<td>NMB</td>
<td>Number</td>
</tr>
<tr>
<td>NAR</td>
<td>Number of articles</td>
</tr>
<tr>
<td>NMP</td>
<td>Number of packs</td>
</tr>
<tr>
<td>NPR</td>
<td>Number of pairs</td>
</tr>
<tr>
<td>NPL</td>
<td>Number of packages</td>
</tr>
<tr>
<td>NPT</td>
<td>Number of parts</td>
</tr>
<tr>
<td>NRL</td>
<td>Number of rolls</td>
</tr>
<tr>
<td>CMK</td>
<td>Square centimeters</td>
</tr>
<tr>
<td>D MK</td>
<td>Square decimeters</td>
</tr>
<tr>
<td>FTK</td>
<td>Square feet</td>
</tr>
<tr>
<td>INK</td>
<td>Square inch</td>
</tr>
<tr>
<td>MTK</td>
<td>Square meter</td>
</tr>
<tr>
<td>YDK</td>
<td>Square yard</td>
</tr>
<tr>
<td>PCE</td>
<td>Piece</td>
</tr>
</tbody>
</table>

**E2TPDLI-LDGRP field: Loading group**

Classification for the loading device (fork lift, for example). Value area according to R/3 table TLGR.

**Field E2TPDLI-TRAGR: Transportation group**

Classification for the transport equipment (pallet, for example). Value area according to R/3 table TTGR.

**E2TPDLI-STRCND field: Storage conditions**

Classification for storage conditions (store dry, for example). Value area according to R/3 table T142.

**E2TPDLI-TMPCND field: Temperature conditions**

Classification for storage conditions in terms of temperature (2-8° C, for example). Value area according to R/3 table T143.
E2TPEQT - Means of Transport

Definition
Segment E2TPEQT contains specifications for the means of transport used in the shipment (vehicle and packing material).

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUID</td>
<td></td>
<td>CHAR 20</td>
<td>VENUM</td>
<td>X</td>
<td>Means of transport ID</td>
</tr>
<tr>
<td>EQUUTYP</td>
<td>2</td>
<td>CHAR 35</td>
<td>VHILM</td>
<td>X</td>
<td>Packaging material type</td>
</tr>
<tr>
<td>EQUTXT</td>
<td></td>
<td>CHAR 40</td>
<td>VEBEZ</td>
<td></td>
<td>Packaging material text</td>
</tr>
<tr>
<td>DRVID1</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Driver 1</td>
</tr>
<tr>
<td>DRVID2</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Driver 2</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPEQT
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPEQT.

Field E2TPEQT-VENUM: Identification of means of transport
A unique ID for the means of transport within a shipment document, which can be the sequential numbering of the means of transport, for example. The identification can, for example, be a sequential number for the means of transport. If the means of transport is changed, the ID serves as a reference. The same ID numbers may be entered in different shipment documents.

Field E2TPEQT-EQUTYP: Packaging material type
The material number for the packaging material type (20-ft. container, for example). The material numbers of the available packaging materials have to be synchronized manually between the R/3 system and the transportation planning system.
E2TPFRC - Shipment Costs at Header Level

Definition

Shipment cost item related to an entire shipment.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td>Cost type</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td></td>
<td>QUAN 18</td>
<td>X</td>
<td>Amount</td>
<td></td>
</tr>
<tr>
<td>CURRC</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>X</td>
<td>Currency (ISO norm)</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPFRC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPFRC.

**E2TPFRC-CSTTYP field: Cost type**

Cost types are defined when the shipment costs are entered, rather than at this point.

**E2TPFRC-CURRC field: Currency (ISO norm)**

Currency key set to ISO norms with the value area of R/3 table field TCURC-ICOCD.
E2TPLCT - Location Code

**Definition**
Location code for a location master record. A location master record can have several codes.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCCTP</td>
<td>8</td>
<td>CHAR 06</td>
<td>X</td>
<td></td>
<td>Code category</td>
</tr>
<tr>
<td>LOCCOD</td>
<td></td>
<td>CHAR 35</td>
<td>X</td>
<td></td>
<td>Code number</td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPLCT**
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPLCT.

**E2TPLCT-LOCCTP field: Code category**
The code category specifies which code type the code number is related to:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCAC</td>
<td>Standard carrier code</td>
</tr>
<tr>
<td>SPLC</td>
<td>Standard location code</td>
</tr>
<tr>
<td>ILN</td>
<td>International location number</td>
</tr>
</tbody>
</table>
## E2TPLOC - Location Master Record Address

### Definition

The address and other status data for a location master record are transferred in segment E2TPLOC.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCID</td>
<td></td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Location identification</td>
</tr>
<tr>
<td>LOCCLS</td>
<td>1</td>
<td>CHAR 02</td>
<td></td>
<td></td>
<td>Location category</td>
</tr>
<tr>
<td>LOCNAM</td>
<td></td>
<td>CHAR 40</td>
<td></td>
<td></td>
<td>Location description</td>
</tr>
<tr>
<td>LOCTPR</td>
<td>8</td>
<td>CHAR 03</td>
<td>WANID</td>
<td></td>
<td>Business hours profile</td>
</tr>
<tr>
<td>FACCAL</td>
<td>8</td>
<td>CHAR 02</td>
<td>KNKAL</td>
<td></td>
<td>Factory calendar</td>
</tr>
<tr>
<td>TITLE</td>
<td></td>
<td>CHAR 15</td>
<td>TEXT15</td>
<td></td>
<td>Form of address</td>
</tr>
<tr>
<td>NAME1</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td>X</td>
<td>Name 1</td>
</tr>
<tr>
<td>NAME2</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Name 2</td>
</tr>
<tr>
<td>NAME3</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Name 3</td>
</tr>
<tr>
<td>NAME4</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Name 4</td>
</tr>
<tr>
<td>ZIPCOD</td>
<td></td>
<td>CHAR 10</td>
<td>PSTLZ</td>
<td>X</td>
<td>Zip code</td>
</tr>
<tr>
<td>CITY1</td>
<td></td>
<td>CHAR 35</td>
<td>TEXT35</td>
<td>X</td>
<td>City 1</td>
</tr>
<tr>
<td>CITY2</td>
<td></td>
<td>CHAR 35</td>
<td>TEXT35</td>
<td></td>
<td>City 2</td>
</tr>
<tr>
<td>ZIPPO</td>
<td></td>
<td>CHAR 10</td>
<td>PSTLZ</td>
<td></td>
<td>Zip code for the post office box</td>
</tr>
<tr>
<td>POBOX</td>
<td></td>
<td>CHAR 10</td>
<td>PFACH</td>
<td></td>
<td>Post office box</td>
</tr>
<tr>
<td>STRT1</td>
<td></td>
<td>CHAR 35</td>
<td>TEXT35</td>
<td>X</td>
<td>Street 1</td>
</tr>
<tr>
<td>STRT2</td>
<td></td>
<td>CHAR 35</td>
<td>TEXT35</td>
<td></td>
<td>Street 2</td>
</tr>
<tr>
<td>HSNUM</td>
<td></td>
<td>CHAR 06</td>
<td>CHAR6</td>
<td></td>
<td>House number (if not in the street field)</td>
</tr>
<tr>
<td>FLOOR</td>
<td></td>
<td>CHAR 06</td>
<td>STOCK</td>
<td></td>
<td>Floor</td>
</tr>
<tr>
<td>CNTRY</td>
<td>2</td>
<td>CHAR 03</td>
<td>LAND1</td>
<td>X</td>
<td>Country</td>
</tr>
<tr>
<td>CNYTXT</td>
<td></td>
<td>CHAR 15</td>
<td>LANDX</td>
<td></td>
<td>Country description</td>
</tr>
<tr>
<td>STATE</td>
<td>2</td>
<td>CHAR 03</td>
<td>REGIO</td>
<td></td>
<td>State</td>
</tr>
<tr>
<td>STATXT</td>
<td></td>
<td>CHAR 20</td>
<td>TEXT20</td>
<td></td>
<td>State description</td>
</tr>
<tr>
<td>COUNTY</td>
<td>B</td>
<td>CHAR 03</td>
<td>COUNC</td>
<td></td>
<td>County</td>
</tr>
</tbody>
</table>
E2TPLOC - Location Master Record Address

<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Length</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CNTCT1</td>
<td>CHAR</td>
<td>35</td>
<td>NAME Contact person 1</td>
</tr>
<tr>
<td>CNTCT2</td>
<td>CHAR</td>
<td>35</td>
<td>NAME Contact person 2</td>
</tr>
<tr>
<td>PHONE</td>
<td>CHAR</td>
<td>30</td>
<td>TEXT30 Telephone number</td>
</tr>
<tr>
<td>PHNSPD</td>
<td>CHAR</td>
<td>10</td>
<td>Speed dial number</td>
</tr>
<tr>
<td>FAX</td>
<td>CHAR</td>
<td>31</td>
<td>TEXT31 Fax number</td>
</tr>
<tr>
<td>PZONE</td>
<td>CHAR</td>
<td>10</td>
<td>ZONE Transportation zone</td>
</tr>
<tr>
<td>TZONE</td>
<td>CHAR</td>
<td>06</td>
<td>TZNZONE Time zone</td>
</tr>
<tr>
<td>LATITD</td>
<td>NUMC</td>
<td>12</td>
<td>LATITD Latitude coordinates</td>
</tr>
<tr>
<td>LONGTD</td>
<td>NUMC</td>
<td>12</td>
<td>LONGTD Longitude coordinates</td>
</tr>
<tr>
<td>COORDS</td>
<td>CHAR</td>
<td>04</td>
<td>COORDS Coordinate system</td>
</tr>
<tr>
<td>APPREQ</td>
<td>CHAR</td>
<td>01</td>
<td>APPREQ Indicator: consultation recommended</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPLOC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPLOC.

**E2TPLOC-LOCCLS field: Location category**

Category of location described by address.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Plant</td>
</tr>
<tr>
<td>CU</td>
<td>Customer</td>
</tr>
<tr>
<td>SU</td>
<td>Vendor</td>
</tr>
<tr>
<td>OC</td>
<td>One-time customer</td>
</tr>
<tr>
<td>NO</td>
<td>Transportation connection point, distribution center</td>
</tr>
<tr>
<td>SP</td>
<td>Shipping point</td>
</tr>
<tr>
<td>CA</td>
<td>Service agents</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
</tr>
</tbody>
</table>

**E2TPLOC-WANID field: Business hours profile**

Profile of goods acceptance times for customer’s unloading point. Value area according to R/3 table field TVWA-WANID.
E2TPLOC-KNKLAL field: Factory calendar
Factory calendar profile. Value area according to R/3 table field TFACD-IDENT.

E2TPLOC-PZONE field: Country-specific transportation zones
Code for country-specific transportation zone. Value area according to R/3 table field TZONE-ZONE1.

E2TPLOC-TZONE field: Time zone
Time zone code Value area according to R/3 table field TTZZ-TZONE.

E2TPLOC-COORDS field: Coordinate system
Code for coordinate system in fields LATITD and LONGTD.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>GK</td>
<td>Gauss-Krueger</td>
</tr>
<tr>
<td>UTM</td>
<td>UTM grid</td>
</tr>
<tr>
<td>GEO</td>
<td>Latitude and longitude</td>
</tr>
</tbody>
</table>

This segment is ignored when processing the inbound shipment (IDoc TPSSHT01).
E2TPNOT - Delivery Texts

Definition

Shipping-specific texts for the delivery that are grouped according to categories. Texts with more than one line are stored in sequential segments.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td>Text category</td>
<td></td>
</tr>
<tr>
<td>NOTTXT</td>
<td></td>
<td>CHAR 200</td>
<td>X</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPNOT

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPNOT.

**E2TPNOT-NOTTYP field: Text category**

The text category specifies the type of text in the segment. Possible text categories come from the value area of the R/3 table field TTXID-TDID for text object TTXID-TDOBJECT = ‘VBBK’ (SD header texts).
E2TPSHA - Transportation Activity

Definition
Activity within a shipment document that is assigned to a transportation connection point.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASQNUM</td>
<td></td>
<td>NUMC 06</td>
<td></td>
<td>X</td>
<td>Activity number</td>
</tr>
<tr>
<td>ACTVTY</td>
<td>8</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Activity category</td>
</tr>
<tr>
<td>DELID</td>
<td></td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Relevant delivery</td>
</tr>
<tr>
<td>SRVAGT</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Relevant service agent</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSHA
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHA.

E2TPSHA-ASQNUM field: Activity number
Sequential numbering of activities in a transportation connection point. Different transportation connection points may contain the same activity numbers. Think of activity numbers as sequence specifications.

E2TPSHA-ACTVTY field: Activity category
The activity category specifies which activities are to be carried out. While processing an inbound shipment, the activity for a defined delivery (field DELID) is carried out by a defined service agent (field SRVAGT).

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD / UL</td>
<td>Load / unload delivery</td>
<td>A delivery with number DELID is loaded at the relevant location and remains loaded until it is unloaded at another location (ACTVTY = UL). This means that this delivery is assigned to all legs in the shipment document that are situated between the two locations (function ‘deliveries to stage’ at stage overview in the shipment document, table VTSP). As soon as the service agent has been determined for one of these two activities and if this deviates from the normal service agent for the leg, a new stage is generated in the shipment document with a ‘load transfer’ category. The deliveries that are (un)loaded by the service agent are assigned to this stage.</td>
</tr>
</tbody>
</table>
E2TPSHA - Transportation Activity

<table>
<thead>
<tr>
<th>LT</th>
<th>Load transfer</th>
<th>Here, a new stage from the 'load transfer' category (regardless of the value in the service agent field) is generated and the delivery specified is assigned to it. (If 4 deliveries are to be transferred, the 'load transfer' activity must take place for each delivery.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CU</td>
<td>Clear delivery for customs</td>
<td>In this way, a shipment stage of the type 'border' is generated in the same way as the 'load' activity.</td>
</tr>
</tbody>
</table>


E2TPSHH - Shipment Header

Definition
Organizational and status information at shipment header level.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPID</td>
<td></td>
<td>CHAR 10</td>
<td>TKNUM</td>
<td>X</td>
<td>Shipment number</td>
</tr>
<tr>
<td>SHPTYP</td>
<td>5</td>
<td>CHAR 04</td>
<td>SHTYP</td>
<td>X</td>
<td>Shipment type</td>
</tr>
<tr>
<td>CARRID</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Service agents</td>
</tr>
<tr>
<td>SHPPPT</td>
<td>5, 8</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation Planning Point (TPP)</td>
</tr>
<tr>
<td>DISTNC</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Total distance</td>
</tr>
<tr>
<td>DSUNIT</td>
<td>8, 9</td>
<td>QUAN 03</td>
<td>MEINS</td>
<td></td>
<td>Unit of distance, according to ISO norms</td>
</tr>
<tr>
<td>DRVTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Traveling time only</td>
</tr>
<tr>
<td>TOTTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Total shipment time</td>
</tr>
<tr>
<td>TMUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEIZT</td>
<td></td>
<td>Standard ISO unit of time</td>
</tr>
<tr>
<td>SRVID1</td>
<td></td>
<td>CHAR 20</td>
<td>EXTI1</td>
<td></td>
<td>External identification 1</td>
</tr>
<tr>
<td>SRVID2</td>
<td></td>
<td>CHAR 20</td>
<td>EXTI2</td>
<td></td>
<td>External identification 2</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSHH
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHH.

E2TPSHH-SHPID field: Shipment number
Shipment document number. The shipment number is subject to important marginal conditions, which must be guaranteed by the transportation planning system.

The shipment number
- May only contain numerical characters
- Must be unique to the shipment document
- Must come from the external number range assigned to the transportation planning point in R/3 Customizing (transaction 0VTP). The number range can be set to your requirements in the R/3 system client setup so that the given corresponding document numbers are also guaranteed in the transportation planning system.

E2TPSHH-SHPTYP field: Shipment type
Shipment type is defined in R/3 Customizing (transaction 0VTK) and describes the following aspects of the shipment:
- Shipment mode (partial load, full load)
- Means of transport (truck, rail)
- Direction (inbound or outbound shipment)
E2TPSHH - Shipment Header

- Leg indicator (direct leg, preliminary leg, main leg, subsequent leg)

The shipment types that have to be made available to the transportation planning system must be created in R/3 Customizing with the corresponding parameters in order to guarantee seamless interface performance.

E2TPSHH-SHPPPT field: Transportation planning point

The transportation planning point corresponds to the transportation planning system and must be adopted directly from field E2TPDLH-SHPPPT of IDoc TPSDLS0. As it is not possible to plan across planning points in a shipment, only one transportation planning point can appear in a shipment for consolidated deliveries.

If a planning system is linked to several planning points, it is important that you ensure that the deliveries for the different transportation planning points are processed separately. These deliveries must not get mixed up during planning.

E2TPSHH-DSUNIT field: Unit of distance, according to ISO norms

Available ISO units of distance:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMI</td>
<td>Nautical miles</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Knots</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
</tbody>
</table>

E2TPSHH-TMUNIT field: Standard ISO unit of time

Available ISO units of time:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAY</td>
<td>Days</td>
</tr>
<tr>
<td>HUR</td>
<td>Hours</td>
</tr>
<tr>
<td>MIN</td>
<td>Minutes</td>
</tr>
<tr>
<td>MON</td>
<td>Months</td>
</tr>
<tr>
<td>SEC</td>
<td>Seconds</td>
</tr>
<tr>
<td>WEE</td>
<td>Weeks</td>
</tr>
<tr>
<td>ANN</td>
<td>Years</td>
</tr>
</tbody>
</table>
**E2TPSHI - Delivery in Shipment**

**Definition**

Delivery assigned to a shipment document.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPITM</td>
<td></td>
<td>NUMC 04</td>
<td>TPNUM</td>
<td>X</td>
<td>Loading sequence of the delivery</td>
</tr>
<tr>
<td>DELID</td>
<td></td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Delivery number</td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPSHI**

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHI.

**E2TPSHI-SHPITM field: Loading sequence of the delivery**

Sequential numbering of deliveries in a shipment; also represents the shipping sequence.
E2TPSHR - Rail Data

Definition
This segment contains specialized data related to railways.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RRDESC</td>
<td></td>
<td>CHAR 100</td>
<td>X</td>
<td></td>
<td>Railway route description</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSHR

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHR.

E2TPSHR-RRDESC field: Railway route description

The code that describes the railway route (special US requirement).
E2TPSHT - Leg Data in Shipment

Definition
Data about leg stages and their related duration within a shipment. Each piece of data must be stored with reference to a shipment point and represents distance and duration from the referenced point to the following point. Therefore, the last point in the transportation connection point list contains no leg data.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISTNC</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Distance of the following leg</td>
</tr>
<tr>
<td>DSUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>Unit of distance, according to ISO norms</td>
</tr>
<tr>
<td>DRVTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Traveling time only - following leg</td>
</tr>
<tr>
<td>TOTTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Total time of the following leg</td>
</tr>
<tr>
<td>TMUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEIZT</td>
<td></td>
<td>Standard ISO unit of time</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSHT
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHT.

E2TPSHT-DSUNIT field: Unit of distance, according to ISO norms
Available ISO units of distance:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMI</td>
<td>Nautical miles</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Knots</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
</tbody>
</table>

E2TPSHT-TMUNIT field: Standard ISO unit of time
Available ISO units of time:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAY</td>
<td>Days</td>
</tr>
<tr>
<td>HUR</td>
<td>Hours</td>
</tr>
</tbody>
</table>
### E2TPSHT - Leg Data in Shipment

<table>
<thead>
<tr>
<th>MIN</th>
<th>Minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>MON</td>
<td>Months</td>
</tr>
<tr>
<td>SEC</td>
<td>Seconds</td>
</tr>
<tr>
<td>WEE</td>
<td>Weeks</td>
</tr>
<tr>
<td>ANN</td>
<td>Years</td>
</tr>
</tbody>
</table>
**E2TPSHU - Handling Unit**

**Definition**
Handling unit for packing delivery items.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHUNUM</td>
<td></td>
<td>CHAR 10</td>
<td>VENUM</td>
<td>X</td>
<td>HU number</td>
</tr>
<tr>
<td>SHPUID</td>
<td>2</td>
<td>CHAR 35</td>
<td>VHILM</td>
<td>X</td>
<td>Packaging material type</td>
</tr>
<tr>
<td>SHPUTX</td>
<td></td>
<td>CHAR 80</td>
<td>MAKTX</td>
<td>X</td>
<td>Packaging material text</td>
</tr>
</tbody>
</table>

**Special Fields and Domain Values in Segment E2TPSHU**
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHU.

**Field E2TPSHU-SHUNUM: HU number**
Number of the handling unit This number is used for unique identification of the handling unit.

**Field E2TPSHU-SHPUID: Packaging material type**
The material number for the packaging material type (20-ft. container, for example). The material numbers of the available packaging materials have to be synchronized manually between the R/3 system and the transportation planning system.
E2TPSLS - Transportation Connection Points

Definition

Location or transportation points visited in the course of a shipment and at which activities take place or which have processes that need to be completed.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSQNUM</td>
<td></td>
<td>NUMC 06</td>
<td>X</td>
<td>Location number (sequence)</td>
<td></td>
</tr>
<tr>
<td>CARRID</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td>Relevant service agent</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSLS

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSLS.

**E2TPSLS-LSQNUM field: Location number**

Sequential numbering of locations visited or transportation points involved in the shipment run. The location number must be in sequence specification form and should be specified beginning with 1 in ascending order with no gaps.

**E2TPSLS-CARRID field: Relevant service agent**

Service agent who carries out the shipment in the following leg stage.

The following example is plausible when processing the inbound shipment (IDoc TPSSHT01).

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Location</td>
<td>1. Leg from first location to second location with service</td>
</tr>
<tr>
<td>with service</td>
<td>agent A</td>
</tr>
<tr>
<td>agent A</td>
<td></td>
</tr>
<tr>
<td>2. Location</td>
<td>2. Leg from second location to third location with service</td>
</tr>
<tr>
<td>with service</td>
<td>agent B</td>
</tr>
<tr>
<td>agent B</td>
<td></td>
</tr>
<tr>
<td>3. Location</td>
<td>Service agent C is ignored</td>
</tr>
<tr>
<td>with service</td>
<td></td>
</tr>
<tr>
<td>agent C</td>
<td></td>
</tr>
</tbody>
</table>
E2TPSUC - Handling Unit Contents

Definition

Description of a contents item of a handling unit. A handling unit contain altogether several items that are listed as full delivery items, partial delivery items, or even further handling units. The specifications for the contents can contain as many hierarchy levels as you like. One content item is represented in each segment E2TPSUC.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHUITM</td>
<td>CHAR 06</td>
<td>VEPOS</td>
<td></td>
<td></td>
<td>Content item number</td>
</tr>
<tr>
<td>CONTYP</td>
<td>1</td>
<td>CHAR 01</td>
<td>VELIN</td>
<td>X</td>
<td>Content type</td>
</tr>
<tr>
<td>DELITM</td>
<td>CHAR 06</td>
<td>POSNR</td>
<td></td>
<td></td>
<td>Item number of delivery item</td>
</tr>
<tr>
<td>SUBSHU</td>
<td>CHAR 10</td>
<td>UNVEL</td>
<td></td>
<td></td>
<td>Number of included HU</td>
</tr>
<tr>
<td>DELQUN</td>
<td>QUAN 15</td>
<td>VEMNG</td>
<td></td>
<td></td>
<td>Quantity of packed delivery items</td>
</tr>
<tr>
<td>DELUNT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>VEMEH</td>
<td></td>
<td>Quantity unit in ISO norms</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSUC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSUC.

Field E2TPSUC-CONTYP: Content type

This value specifies what type of content item the handling unit is. Different data fields from segment E2TPSUC are completed according to the type of content.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Completed segment fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delivery item</td>
<td>DELITM, DELQUN, DELUNT</td>
</tr>
<tr>
<td>3</td>
<td>Handling unit</td>
<td>SUBSHU</td>
</tr>
</tbody>
</table>
E2TPTIW - Time Frame

Definition
Description of alternative opening and closing time frames for weekdays or a certain date.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINMOD</td>
<td>1</td>
<td>CHAR</td>
<td>01</td>
<td>X</td>
<td>Time frame mode</td>
</tr>
<tr>
<td>WINDOW</td>
<td>1</td>
<td>CHAR</td>
<td>01</td>
<td></td>
<td>Weekday</td>
</tr>
<tr>
<td>WINDAT</td>
<td></td>
<td>DATS</td>
<td>08</td>
<td></td>
<td>Date</td>
</tr>
<tr>
<td>WINTM1</td>
<td></td>
<td>TIMS</td>
<td>06</td>
<td>X</td>
<td>Beginning time of time frame</td>
</tr>
<tr>
<td>WINTM2</td>
<td></td>
<td>TIMS</td>
<td>06</td>
<td>X</td>
<td>End time of time frame</td>
</tr>
<tr>
<td>ETZONE</td>
<td>8</td>
<td>CHAR</td>
<td>06</td>
<td>TZNZONE</td>
<td>Time zone</td>
</tr>
<tr>
<td>WINPRF</td>
<td>8</td>
<td>CHAR</td>
<td>03</td>
<td>WANID</td>
<td>Business hours profile</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTIW
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTIW.

E2TPTIW-WINMOD field: Time frame mode
This mode value specifies whether the frame defines an opening or closing time.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>Open time frame</td>
</tr>
<tr>
<td>C</td>
<td>Close time frame</td>
</tr>
</tbody>
</table>

E2TPTIW-WINDOW field: Weekday
If this field is completed, then the time frame is valid regularly for a certain weekday.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monday</td>
</tr>
<tr>
<td>2</td>
<td>Tuesday</td>
</tr>
<tr>
<td>3</td>
<td>Wednesday</td>
</tr>
<tr>
<td>4</td>
<td>Thursday</td>
</tr>
<tr>
<td>5</td>
<td>Friday</td>
</tr>
<tr>
<td>6</td>
<td>Saturday</td>
</tr>
<tr>
<td>7</td>
<td>Sunday</td>
</tr>
</tbody>
</table>

E2TPTIW-ETZONE field: Time zone
Time zone code Value area according to R/3 table field TTZZ-TZONE.
E2TPTRM- Location Identification

Definition

Segment E2TPTRM contains the identification numbers of a location which can be used as a key to an address database. The segment may occur within IDoc TPSDLS01 from two to four times. With the minimum number of 2, the departure and destination location identification are transferred and in the next two segments, the sold-to party and payer ID can be defined.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLCCAT</td>
<td>1</td>
<td>CHAR 01</td>
<td>X</td>
<td>Location status</td>
<td></td>
</tr>
<tr>
<td>TRMTYP</td>
<td>1</td>
<td>CHAR 02</td>
<td>X</td>
<td>Location category</td>
<td></td>
</tr>
<tr>
<td>SHPPNT</td>
<td>A</td>
<td>CHAR 04</td>
<td>VSTEL</td>
<td>Shipping point</td>
<td></td>
</tr>
<tr>
<td>LODPNT</td>
<td>A</td>
<td>CHAR 02</td>
<td>LSTEL</td>
<td>Loading point</td>
<td></td>
</tr>
<tr>
<td>LDPTXT</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td>Loading point text</td>
<td></td>
</tr>
<tr>
<td>PLANT</td>
<td>A</td>
<td>CHAR 04</td>
<td>WERKS</td>
<td>Plant</td>
<td></td>
</tr>
<tr>
<td>STRLOC</td>
<td>A</td>
<td>CHAR 04</td>
<td>LGORT</td>
<td>Storage location</td>
<td></td>
</tr>
<tr>
<td>STLTXT</td>
<td></td>
<td>CHAR 16</td>
<td>LGOBE</td>
<td>Storage location text</td>
<td></td>
</tr>
<tr>
<td>SHPPTY</td>
<td>A</td>
<td>CHAR 10</td>
<td>KUNNR</td>
<td>Ship-to party, customer number</td>
<td></td>
</tr>
<tr>
<td>ULDPNT</td>
<td>A</td>
<td>CHAR 25</td>
<td>ABLAD</td>
<td>Unloading point</td>
<td></td>
</tr>
<tr>
<td>SUPPLR</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td>Vendor</td>
<td></td>
</tr>
<tr>
<td>SLDPNT</td>
<td>A</td>
<td>CHAR 25</td>
<td>BELAD</td>
<td>Loading point</td>
<td></td>
</tr>
<tr>
<td>NODEID</td>
<td>A</td>
<td>CHAR 10</td>
<td>KNOTN</td>
<td>Transportation connection point</td>
<td></td>
</tr>
<tr>
<td>NODTYP</td>
<td></td>
<td>CHAR 10</td>
<td>KNOTN</td>
<td>Transportation connection point characteristic</td>
<td></td>
</tr>
<tr>
<td>BORDER</td>
<td></td>
<td>CHAR 01</td>
<td></td>
<td>Border location indicator</td>
<td></td>
</tr>
<tr>
<td>TSPNT</td>
<td></td>
<td>CHAR 01</td>
<td></td>
<td>Load transfer point indicator</td>
<td></td>
</tr>
<tr>
<td>ADRNR</td>
<td></td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td>Address number</td>
<td></td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTRM

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTRM.

E2TPTRM-TLCCAT field: Location status

This indicator specifies the status of the current segment for planning specifications.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Departure location that corresponds to the delivery’s shipping location</td>
</tr>
<tr>
<td>D</td>
<td>Destination that corresponds to the delivery’s destination</td>
</tr>
<tr>
<td>1</td>
<td>Departure location that does not correspond to the delivery’s shipping location</td>
</tr>
<tr>
<td>2</td>
<td>Destination that does not correspond to the delivery’s destination</td>
</tr>
<tr>
<td>B</td>
<td>Sold-to party</td>
</tr>
<tr>
<td>P</td>
<td>Payer</td>
</tr>
</tbody>
</table>
Indicators 1 and 2 occur if a transportation planning system is used only for preliminary and subsequent leg planning, for example, and not for the entire planning of a delivery. For instance, one segment E2TPTRM with location status S and one with location status 2 would appear for the preliminary leg between the shipping point and the departure harbor.

**E2TPTRM-TRMTYP field: Location category**

Category of current location. Different fields within the segment are filled with data according to category.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Completed fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Plant</td>
<td>PLANT, STRLOC, STLTXT, ADRNR</td>
</tr>
<tr>
<td>CU</td>
<td>Customer</td>
<td>SHPPTY, ULPNT</td>
</tr>
<tr>
<td>SU</td>
<td>Vendor</td>
<td>SUPPLR, SLDPNT</td>
</tr>
<tr>
<td>OC</td>
<td>One-time customer</td>
<td>SHPPTY, ADRNR</td>
</tr>
<tr>
<td>NO</td>
<td>Transportation connection point, distribution center</td>
<td>NODEID, NODTYP, BORDER, TSPNT, ADRNR</td>
</tr>
<tr>
<td>SP</td>
<td>Shipping point</td>
<td>SHPPNT, LODPNT, LDPTXT, ADRNR</td>
</tr>
<tr>
<td>CA</td>
<td>Service agents</td>
<td>SUPPLR, SLDPNT</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
<td>ADRNR</td>
</tr>
</tbody>
</table>

**Field E2TPTRM-NODTYP: Transportation connection point characteristic**

The field lists the different characteristics of a transportation connection point. Each characteristic is coded with a single letter. Up to 10 characteristics can be shown in field E2TPTRM-NODTYP as a character string.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Distribution center</td>
</tr>
<tr>
<td>A</td>
<td>Airport</td>
</tr>
<tr>
<td>R</td>
<td>Railway station</td>
</tr>
<tr>
<td>E</td>
<td>Express railway station</td>
</tr>
<tr>
<td>H</td>
<td>Harbor</td>
</tr>
<tr>
<td>S</td>
<td>Street</td>
</tr>
</tbody>
</table>

Example: E2TPTRM-NODTYP = CRS means a distribution center with railway and road connections.

**E2TPTRM-BORDER field: Border location indicator**

This indicator specifies whether the transportation connection point is a border location.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Non-border location</td>
</tr>
</tbody>
</table>
E2TPTRM- Location Identification

1 Border location

E2TPTRM-TSPNT field: Load transfer point indicator

This indicator specifies whether the transportation connection point is a load transfer point.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Non-load transfer point</td>
</tr>
<tr>
<td>1</td>
<td>Load transfer point</td>
</tr>
</tbody>
</table>

Please note the following when processing an inbound shipment (IDoc TPSSHT01).

The NODEID, SHPPNT, LODPNT, SHPPTY, ULDPNT, SUPPLR, SLDPNT, PLANT and STRLOC fields are included in the location definition of the departure or destination location of a leg in the shipment document.

This occurs according to the following schema:

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st location</td>
<td>1st leg departure location</td>
</tr>
<tr>
<td>2nd location</td>
<td>1st leg destination + 2nd leg starting point</td>
</tr>
<tr>
<td>3rd location</td>
<td>2nd leg destination + 3rd leg starting point</td>
</tr>
</tbody>
</table>

Fields are completed as follows:

<table>
<thead>
<tr>
<th>IDoc</th>
<th>Leg: departure location</th>
<th>Leg: destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>E2TPTRM-NODEID</td>
<td>VTTS-KNOTA</td>
<td>VTTS-KNOTZ</td>
</tr>
<tr>
<td>E2TPTRM-SHPPNT</td>
<td>VTTS-VSTEL</td>
<td>VTTS-VSTEZ</td>
</tr>
<tr>
<td>E2TPTRM-LODPNT</td>
<td>VTTS-LSTEL</td>
<td>VTTS-LSTEZ</td>
</tr>
<tr>
<td>E2TPTRM-SHPPTY</td>
<td>VTTS-KUNNA</td>
<td>VTTS-KUNNZ</td>
</tr>
<tr>
<td>E2TPTRM-ULDPNT/SLDPNT</td>
<td>VTTS-BELAD</td>
<td>VTTS-ABLAD</td>
</tr>
<tr>
<td>E2TPTRM-SUPPLR</td>
<td>VTTS-LIFNA</td>
<td>VTTS-LIFNZ</td>
</tr>
<tr>
<td>E2TPTRM-PLANT</td>
<td>VTTS-WERKA</td>
<td>VTTS-WERKZ</td>
</tr>
<tr>
<td>E2TPTRM-STRLOC</td>
<td>VTTS-LGORTA</td>
<td>VTTS-LGORTZ</td>
</tr>
</tbody>
</table>

Only one of the following fields can be completed: NODEID, SHPPNT, SHPPTY, SUPPLR and PLANT.

The LODPNT field is optional and should only be completed if the SHPPNT field has been completed.
The STRLOC field is optional and should only be completed if the PLANT field has been completed.

The ULDPNT field is optional and should only be completed if the SHPPTY field has been completed.

The SLDPNT field is optional and should only be completed if the SUPPLR field has been completed.

All other fields in this segment are ignored.

If the location definition does not follow the rules listed above, an error occurs.
E2TPTRP - Existing Shipment

Definition

In segment E2TPTRP, shipment documents that have already been created in the R/3 system and which contain the current delivery are transferred. In certain circumstances, this can lead to improved connection planning to existing shipments in the transportation planning system. In addition, planning requests are documented, meaning that there is a record if the current delivery was sent to another planning system but is not yet included in the shipment document. Existing shipment documents are recognized by their assigned shipment numbers whereas this would still be blank for a planning request.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPPPT</td>
<td>5, 8</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation planning point</td>
</tr>
<tr>
<td>SHPID</td>
<td></td>
<td>CHAR 10</td>
<td>TKNUM</td>
<td></td>
<td>Shipment number (existing shipment)</td>
</tr>
<tr>
<td>SHPTYP</td>
<td>5</td>
<td>CHAR 04</td>
<td>SHTYP</td>
<td></td>
<td>Shipment type (existing shipment)</td>
</tr>
<tr>
<td>LEGIND</td>
<td>1</td>
<td>CHAR 01</td>
<td>LAUFK</td>
<td></td>
<td>Shipment leg indicator (existing shipment)</td>
</tr>
<tr>
<td>LOCCL1</td>
<td>1</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Location category - departure point</td>
</tr>
<tr>
<td>LOCID1</td>
<td>A</td>
<td>CHAR 10</td>
<td></td>
<td>X</td>
<td>Location ID - departure point</td>
</tr>
<tr>
<td>SUBID1</td>
<td>A</td>
<td>CHAR 35</td>
<td></td>
<td></td>
<td>Additional ID - departure point</td>
</tr>
<tr>
<td>ADRNR1</td>
<td></td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td></td>
<td>Address number - departure point</td>
</tr>
<tr>
<td>LOCCL2</td>
<td>1</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Location category - destination</td>
</tr>
<tr>
<td>LOCID2</td>
<td>A</td>
<td>CHAR 10</td>
<td></td>
<td>X</td>
<td>Location ID - destination</td>
</tr>
<tr>
<td>SUBID2</td>
<td>A</td>
<td>CHAR 35</td>
<td></td>
<td></td>
<td>Additional ID - destination</td>
</tr>
<tr>
<td>ADRNR2</td>
<td></td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td></td>
<td>Address number - destination</td>
</tr>
<tr>
<td>DATBEG</td>
<td></td>
<td>DATS 08</td>
<td>DPTBG</td>
<td>X</td>
<td>Departure date</td>
</tr>
<tr>
<td>TIMBEG</td>
<td></td>
<td>TIMS 06</td>
<td>UPTBG</td>
<td>X</td>
<td>Departure time</td>
</tr>
<tr>
<td>TZONBG</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONET</td>
<td></td>
<td>Time zone - departure point</td>
</tr>
<tr>
<td>DATEND</td>
<td></td>
<td>DATS 08</td>
<td>DPTENS</td>
<td>X</td>
<td>Arrival date</td>
</tr>
<tr>
<td>TIMEND</td>
<td></td>
<td>TIMS 06</td>
<td>UPTENS</td>
<td>X</td>
<td>Arrival time</td>
</tr>
<tr>
<td>TZONEN</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONET</td>
<td></td>
<td>Time zone - destination</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTRP

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTRP.

E2TPTRP-LEGIND field: Leg indicator

This indicator specifies the type of the planned shipment.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Preliminary leg shipment</td>
</tr>
</tbody>
</table>
E2TPTRP - Existing Shipment

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Main leg shipment</td>
</tr>
<tr>
<td>3</td>
<td>Subsequent leg shipment</td>
</tr>
<tr>
<td>4</td>
<td>Direct leg shipment</td>
</tr>
<tr>
<td>5</td>
<td>Return leg shipment</td>
</tr>
</tbody>
</table>

**E2TPTRP-LOCCLx field: Location category**

Departure and destination location categories.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Plant</td>
</tr>
<tr>
<td>CU</td>
<td>Customer</td>
</tr>
<tr>
<td>SU</td>
<td>Vendor</td>
</tr>
<tr>
<td>OC</td>
<td>One-time customer</td>
</tr>
<tr>
<td>NO</td>
<td>Transportation connection point, distribution center</td>
</tr>
<tr>
<td>SP</td>
<td>Shipping point</td>
</tr>
<tr>
<td>CA</td>
<td>Service agents</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
</tr>
</tbody>
</table>

**E2TPTRP-TZONxx field: Time zone**

Time zone code. Value area according to R/3 table field TTZZ-TZONE.
SAP System Settings and Modifications

This section provides an overview of the necessary settings within the SAP R/3 System as well as information on additional adjustments made available in the R/3 customer functions.

Overview of Information Sources

You can also use the following sources of information:

- **Implementation Guide/SAP Reference IMG (Online)**
  
  Tools → Business Engineer → Customizing → Implementation projects → SAP Reference IMG → Logistics Execution → Transportation → Interfaces → External Transportation Planning Systems

  The overview shows you which settings you must carry out in the R/3 system in order to activate and configure the transportation planning interface. Details about specific parts of the interface follow:

- **Master Menu (Online)**

  Logistics Execution → Transportation → Transportation Planning → External Planning System → ALE Monitoring.

  The ALE functions allow you to monitor IDocs that you sent or received.

- More in-depth can be found in the following printed documentation:
  - RFC manual
    
    Exact technical description of the programming interface
  - ALE consultant’s manual
    
    General information about ALE and its functions
  - Workflow manual
    
    General information on the workflow concept (see error processing)

Standard Error Processing with ALE

Transmitting IDocs using Remote Function Call takes place on the Transmission Control Protocol/Internet Protocol (TCP/IP) basis. If an error occurs during this process, the connection between transmitter and recipient is interrupted. The transmitter can use the return codes of the RFC functions to control whether the function was successfully called up in the recipient system or not. If there are any TCP/IP errors, the connection must be disconnected and the IDoc must be re-transmitted.

Errors in the ALE service layer that occur during transmission or receipt of the IDoc are indicated as **technical errors**. The R/3 system generates a work item for every incorrect IDoc when technical or logical errors occur (see below). A work item is part of the workflow processing. For the most part, the work item is an **error message** that is sent to all the users in the system who are assigned to a particular **position**. The error message contains an error text. If one of the users views the message in the inbox, analyzes the error and posts the document, the error message will disappear from all inboxes.
On receipt, the IDoc is saved in the database before any processing begins, thus unlinking the communication from processing. In this way, the communication is unlinked from processing. If an error occurs during processing, such as updating with disallowed or incorrect transaction type (=logical application error), SAP creates a work item with the appropriate error text.

**Activating Standard Error Processing**

If a logical error occurs during processing of an IDoc, a message is sent to one or several users. The following text describes how error processing is set up.

Technically, the system triggers a standard task specific to the message category. The standard task must be assigned to a position that has either a user or holder.

You can create one or several positions. These are contained within a central organizational unit.

You then have the following options:

- You can enter an organizational unit in the partner definition but no further specifications in the partner profile per message category. All the messages will then go to the users assigned to that organizational unit who have a position where the standard task appeared.

- You enter a certain position instead of the organizational unit in the partner definition.

- You override the entry in the partner definition with entries in the partner profile for a message category.

Normally, you would use the first alternative. However, if you have two subsystems that serve two different transportation planning points, where the administrators for the errors are two different people, you could use the second alternative to send the same error via the two different partner numbers.

**Display in the Inbox**

The inbox display can be adjusted individually. The following describes a setting that allows you to display the messages by IDoc category:

Call up transaction SIN1. Click on Configuration under settings and create a new configuration. Choose the switch for “Start configuration”. In this way you ensure that you always use this configuration automatically. Save to the database.

Select Settings → Group and choose the required field in the right-hand column for sorting in the overview display. Significant fields are (1) Task and (2) Creation date.

Error Analysis

Technical Errors in the ALE Service Layer

The following errors can occur in the ALE service layer:

- Syntax error in the IDoc
- Missing partner profile
- IDoc not transferred to the transactional Remote Function Call (tRFC) at transmission
- IDoc not transferred to the application at receipt

Outbound Processing

Syntax error in the IDoc: IDoc status 07

On transmitting or receiving IDocs, the syntax of the individual IDoc is checked. When the IDoc is defined, the syntax, which includes the following, is determined:

- The individual IDoc category segments
- The relationship between the individual segments
- How many segments can be transmitted in one IDoc or how often an individual segment may occur in one IDoc

An IDoc syntax check can be activated in the partner profile for an IDoc category and a certain partner. We recommend that you activate this check, particularly for any IDocs that you have created yourself. Otherwise, this error normally only occurs in the test run. The incorrect IDocs cannot be repaired so they have to be transmitted again once the IDoc structure has been corrected in the SAP system.

Missing or Incorrect Partner Profile: IDoc status 29

To transmit an IDoc from SAP to the subsystem, you must define the partner profile’s outbound processing for the IDoc category (message type) and all relevant partners. You will find a more detailed description of partner profiles in the online documentation for the Implementation Guidelines (IMG). If the partner (subsystem) for the IDoc to be transmitted cannot be determined, you must proceed as follows:

- Maintain the partner profile
- All IDocs for transmission have to be set for retransmission. Since this error triggered a work item for the standard task ALE/EDI: error processing (outbound) and sent it to the relevant user’s inbox, the incorrect IDoc also has to be set for subsequent transmission from the inbox. On subsequent transmission, the incorrect IDoc is flagged with status 31 and copied to a new one which is enhanced with data from the partner profile and transferred to the asynchronous Remote Function Call (aRFC).

Errors in partner profiles normally only occur in the test run.

IDoc not transferred to asynchronous Remote Function Call (aRFC) on transmission: IDoc status 30

Although the partner profile has been maintained the IDoc is not transferred to the aRFC. In other words, the IDoc is structured but not sent. The corresponding subsystem does not have any
open entries in the RFC transaction evaluation (SM58). The IDoc is ready for transmission, but you must initiate the transmission explicitly.

To do this, use the report RSEOUT00, which you can plan as a periodic job or start directly through the transportation menu Logistics → Sales and distribution → Transportation → External systems → Transportation planning → ALE monitoring → Periodic processing → Process ALE outbound IDocs → Send.

Here, the outbound mode for the relevant IDoc should be checked in the partner profile. In outbound mode 2, the created IDoc is transmitted directly, in 4, the IDocs are collected together and sent in defined package sizes. We recommend that the IDocs should not be directly transmitted in mode 4.

Status 30 in the IDoc can normally only occur if outbound mode is set to 4.

### Inbound Processing

**Syntax error in the IDoc: IDoc status 60**

As in outbound processing, an IDoc syntax check can be activated in the partner profile for an IDoc category and a certain partner. We recommend that you activate this check. Otherwise, this error normally only occurs in the test run. The incorrect IDocs cannot be repaired so they have to be transmitted again once the IDoc structure has been corrected in the sending system.

**Missing or Incorrect Partner Profile: IDoc status 63**

On receipt of an IDoc in SAP, the partner profile inbound processing for IDoc category (message type) and the transmitting partner must be defined. You will find a more detailed description of partner profiles in the online documentation for the Implementation Guidelines (IMG). If the partner profile and therefore the inbound method for the recipient IDoc cannot be found, then the application cannot be activated and the IDoc remains in the system with open status. For this type of error, proceed as follows:

- Maintain the partner profile

  All IDocs open for transmission must be set for retransmission. Since this error triggered a work item for the standard task ALE/EDI: error processing (inbound) and sent it to the relevant user’s inbox, the incorrect IDoc’s new profile data for the processing application also has to be executed from the inbox.

Errors in partner profiles normally only occur in the test run.

**IDoc not transferred to the application at receipt IDoc status 64**

Although the partner profile has been maintained, the received IDoc was not processed and flagged as incorrect, which means that the application is not controlled for processing this IDoc. Although the IDoc is ready for transmission to the application, you need to explicitly set the application for processing the IDoc.

To do this, call up the report RBDAPP01, which you can plan as a periodic job or start directly through the transportation menu Logistics → Sales and distribution → Transportation → External systems → Transportation planning → ALE monitoring → Periodic processing → Process ALE outbound IDocs → Post.

As in transmission, you check the processing type in the partner profile. In processing 1, the IDocs are transferred immediately after receipt to the application for processing. In processing 3 and partially in 2, we recommend that processing be explicitly rather than directly controlled.

Status 64 in the IDoc can normally only occur in conjunction with processing 3 and 2.
Error Analysis

Logical Errors in the Application

The errors described below, which occur in the application, are related to an inbound IDoc in SAP. The IDoc that is to be transferred is structured in the application in such a way that the system will immediately notice any missing or incorrect Customizing settings in SAP processing (while creating planning requests, for example).

During inbound processing of an IDoc in the SAP System, the following errors may occur in the application:

- Missing or incorrect Customizing settings in the SAP System
- Missing or incorrect data in the IDoc
- Error due to blocked objects

The incorrect IDoc is flagged with status 51.

Missing or incorrect Customizing settings in the SAP System

The IDoc that was received cannot be processed because certain IDoc data has not been maintained in the system. For example, a shipment category is transferred from a shipment registered in the subsystem that has not been defined in the SAP system. You must make the Customizing settings accordingly for these errors; posting the incorrect IDoc can be controlled afterwards. Reposting can either take place from the inbox of the person responsible or via report RBDMANIN, which can be planned as a periodic job or started via the transportation menu Logistics → Sales/distribution → Transportation → External systems → Transportation planning → ALE monitoring → Periodic processing → Process ALE inbound IDocs → Repost.

Missing or incorrect data in the IDoc

If the data in the received IDoc is incomplete, you must decide whether the incorrect IDoc should be transmitted again or whether it is possible or appropriate to carry out corrections in the SAP system. You can also make corrections directly in the IDoc. It is possible to do this using the IDoc Editor but this should only be used for exceptional cases.

Like errors in Customizing settings, the incorrect IDoc can also be posted from the inbox of the user responsible or via report RBDMANIN.

Error due to blocked objects

There are often problems in SAP processing with blocking individual objects. Multiple attempts (by different users) to access the same SAP object, processing will be terminated, with an error note for the blocked object. This error is treated like all other errors in IDoc processing. No action is required by the user here to recover the error. Repeating the processing at a later point will automatically solve the problem. This means that using background processing (periodic job) in the RBDMANIN report can be used for reposting the IDoc. The error status parameter in this report uses the error message ID to limit posting for certain errors; in this case only for each error message related to a blocking error.

Important Error Notes in Inbox

For each error described, a work item is created and put in the inbox of the user responsible. Work items are used for certain important error notes that are either transmitted directly from the subsystem or structured in IDoc processing internally in the application. These work items do not serve the purpose of starting IDoc processing again from the inbox. They are used to inform the user of a conflict situation or to pass on an important message from the subsystem to the SAP System. The message is transferred to SAP by IDoc SYSTAT01.
Unlike errors, work items for notes must be completed rather than processed from the inbox.
Modifications (Customer Functions)

This section provides an overview on the customer functions and change options in processing that affect the interface.

Inbound Processing (Receipt of IDocs from Subsystem)

The following modifications are possible:

- You are using standard IDoc TPSSHT01, but you want to process the IDoc according to your own requirements.
- You are using standard IDoc TPSSHT01 but want to influence the standard IDoc processing method, (error processing are to be modified or IDoc contents are to be interpreted according to the customer’s requirements, for example).
- You are using a modified IDoc with your own segments and want to implement a certain processing for the data in these segments.
- You are using a modified IDoc with your own segments and want to process the IDoc according to your own requirements.
- You are using your own IDoc with a new message type and need to process the IDoc according to your own requirements.

The following describes individual modification options.

Once an IDoc has been received and saved, a framework function module in the SAP application is triggered which takes over the processing of the IDoc. This provides the first option where you can generate your own processing function module. In order to call this up you will have to enter it in an ALE Customizing table (transaction WE42 : Process codes inbound → Inbound with ALE service → Processing by function module). You can then specify the defined process code in the inbound partner profile. Available framework function modules are assigned according to the following message categories:

### Inbound Framework Function Module

<table>
<thead>
<tr>
<th>Message type</th>
<th>Function module</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIPPL</td>
<td>IDOC_INPUT_SHIPPL</td>
<td>Shipment document</td>
</tr>
</tbody>
</table>

The framework function module filters out the user data per IDoc and calls up your own processing function module in the application for every IDoc in a loop. All data is then saved together in the database.

A customer function is implemented before and after processing each IDoc and after saving all shipment data.

You can use the customer function before processing the IDoc to manipulate data in the IDoc before it is transmitted to the application functions. After IDoc processing, the customer function allows you to process your own segments.

Customer functions for the transportation planning interface can be found in function group XV56 in the R/3 system with the description EXIT_SAPLV56I_0xx. You can use transaction SMOD to access enhancements. The names begin with ‘V56I’. The documentation for each function module describes how to use the available customer functions. Activating customer functions
Customer Functions Inbound Shipment

<table>
<thead>
<tr>
<th>Modification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIT_SAPLV56l_010</td>
<td>Modification of IDoc segments</td>
</tr>
<tr>
<td>EXIT_SAPLV56l_011</td>
<td>Modification of shipment tables</td>
</tr>
<tr>
<td>EXIT_SAPLV56l_012</td>
<td>Save your own shipment tables</td>
</tr>
</tbody>
</table>

When creating your own function module or using customer functions, you must make sure that you do not set Commit work, because the function module branches back into the ALE service level after processing. Application errors are copied, IDoc status is set and rollbacks may be listed in the ALE service level. After Commit work, a rollback can no longer be carried out if an error occurs. This could lead to partially-posted IDocs and therefore to inconsistencies during error processing.

Keep in mind that further I/Os that occur in the customer functions can reduce performance.

You can define your own IDoc segments in IDoc maintenance (WE30). Refer to the corresponding documentation for the ALE group.

You can define your own IDoc the same way you maintain your own segments. This IDoc needs to be assigned to a new output type. For this output type, you must set a partner profile. You must also maintain the tables for entry in transaction WE42.

You have the following modification options for the individual modification scenarios:

- For IDoc processing, you can create your own processing function module, which can be copied from the standard function module and then adjusted, if necessary.
- You can activate the customer functions in the standard function module. If you want to change error processing, you must enhance the customer function after IDoc processing by adding Own error status and then activating it. If you want to modify IDoc processing, then you need to activate and use customer function Own update.
- You can define your own IDoc segments in the standard IDoc and use the customer function for Own update in order to process the data from your own segments.
- You can define your own IDoc segments in the standard IDoc and create your own processing function module as in scenario 1.
- You can define your own IDoc and create your own processing function module. When creating the function module, you can use the standard help function modules.

**Outbound Processing (Transmitting IDocs to a Subsystem)**

The following modifications are possible:

- You are using standard IDoc TPSDLS01, but want to change standard processing (the structure or content of this IDoc, for example).
- You are using a modified IDoc with your own segments and want to set your own processing to assemble the data from this segment.
- You use a modified IDoc with your own segments and want to process the IDoc structure according to your own requirements.
You are using your own IDoc with a new message type and need to process the IDoc according to your own requirements.

The following describes individual modification options.

The formatting for the transmission of IDocs is carried out in the application. The IDoc is assembled, the partner is determined and the configurations are made for the ALE layer. IDoc assembly is carried out in the application function modules.

This is your first opportunity to carry out modifications by creating your own function modules. To ensure that this is called up by the application, you have to link it to the required application menu yourself.

The following function modules from function group V561 are used in the transportation planning interface for constructing and transmitting standard IDocs:

**Function modules outbound processing**

<table>
<thead>
<tr>
<th>IDOC_OUTPUT_CFPREQ</th>
<th>Individual planning requests (when transmitting using message control)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDOC_OUTPUT_SHIPPL</td>
<td>Shipment status</td>
</tr>
<tr>
<td>IDOC_OUTPUT_STATUS_TPS</td>
<td>Error status</td>
</tr>
</tbody>
</table>

For the outbound function modules for transmission of planning requests, the following customer functions are available for adding your own IDoc segments and/or changing the standard IDoc construction. The following list displays all available customer functions for outbound processing of planning requests. The function groups and transactions displayed for inbound processing are also valid for customer functions in outbound processing.

**Customer Functions for Outbound Planning Requests**

<table>
<thead>
<tr>
<th>EXIT_SAPLV56I_001</th>
<th>Modification of the delivery header segment in the IDoc</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIT_SAPLV56I_002</td>
<td>Modification of the delivery item segments in the IDoc</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_003</td>
<td>Modification of the packing data segments in the IDoc</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_004</td>
<td>Modification of the entire IDoc before transmission</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_005</td>
<td>Modification of material accumulation</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_006</td>
<td>User-specific location substitution</td>
</tr>
<tr>
<td>EXIT_SAPLV56L_007</td>
<td>Deactivation of the conversion block for deliveries</td>
</tr>
<tr>
<td>EXIT_SAPLV56L_020</td>
<td>Change in IDoc control record</td>
</tr>
</tbody>
</table>

As mentioned in inbound processing, you define your own IDoc segments in IDoc maintenance. A customer-specific IDoc can also be defined for outbound processing. Apart from IDoc definition, you only need to maintain the partner profile for outbound processing here.
You have the following modification options for the individual modification scenarios:

- For IDoc processing, you can create your own processing function module, which can be copied from the standard function module and then adjusted, if necessary.

- You can activate the customer function in the standard function module in order to change the standard IDoc structure.

- You can define your own IDoc segments in the standard IDoc and use the customer exit to fill your own segment with data.

- You can define your own IDoc segments in the standard IDoc and create your own function module that can be copied from the standard function module of the corresponding message type and then adjusted as required.
Transportation Planning in Cooperation with Forwarding Agents

Use

The cooperation between the shipper and the forwarding agent can have synergic effects that save both partners time and money. Particularly in business relationships where a forwarding agent works primarily for a particular shipper, there can be many advantages to having joint transportation planning. The forwarding agent takes over planning functions in cooperation with the shipper, and thus simplifies the transportation planning for the shipper.

Integration

In the standard business setting, the transportation planner selects deliveries for the respective shipment while he is creating the shipments.

If there is cooperation between the shipper and the forwarding agents, parts of this transportation planning process can be outsourced.

Features

The shipper selects a record from the shipments to be transported and sends this to the forwarding agent. There the deliveries are combined into shipments. Grouping and changing of shipments occur at the forwarding agent’s system site. The shipments that are created are reported back to the shipper.

The communication between the shipper and the forwarding agent takes place through IDocs. The forwarding agent receives an IDoc from the shipper with deliveries scheduled for planning, and then transmits the planned or rejected shipments and changes back to the shipper per IDoc.

In the following sections, we describe the settings that are required for communication with forwarding agents.
Logical Communications Processes

The communications processes between R/3 and an external transportation planning system can be divided by communications procedure into:

- Movement data, which includes planning requirements (deliveries) and planned shipments, among other things
- Status Transmission and Error Processing

Transaction Data

Transmission of transaction data occurs in two directions. Planning requests (deliveries that are to be planned and assigned to shipments) are transmitted from R/3 to the forwarding agent and then planned shipments are sent back to the R/3 system.

If new deliveries are to be planned into a shipment, the scenario is as follows:

Outgoing Delivery / Planning Requests

Transmission of planning requests (deliveries that are to be planned) to a forwarding agent may occur via the following various procedures and communication stages in R/3:

Optional:
- Implicit transmission following delivery creation (defined as the point at which the deliveries are sent to the forwarding agent, provided no specific criteria are relevant) by way of message control
- Explicit transmission by calling up a program under Logistics Execution → Transportation → Transportation Planning → Scheduling in Cooperation with Forwarding Agents → Send Deliveries to Forwarding Agent with the option of delivery selection using different criteria. The actual transmission occurs via message control or as a direct transmission.
Logical Communications Processes

- Automatic transmission by starting the transmission program RB56LFTP at a defined point in time (definition of selection variants, batch transfer). The actual transmission occurs via message control or as a direct transmission.

- Implicit transmission by deallocating a delivery through Logistics Execution → Transportation → Transportation Planning → Scheduling in Cooperation with Forwarding Agents → Plan Deliveries from Freight Planning, without deleting these in R/3. The actual transmission occurs via message control or as a direct transmission.

Mandatory:

- Implicit re-transmission via message control after a delivery has been changed

- Implicit transmission via direct transmission when a delivery is deleted

In R/3, selection of deliveries to be planned is carried out either:

- Using a report with a selection screen that you can start up through Logistics Execution → Transportation → Transportation Planning → Scheduling in Cooperation with Forwarding Agents → Send Deliveries to Forwarding Agent.

- Or by calling up report RV56LFTP (with variants) at regular intervals

This report uses the delivery selection function in the same way as for shipment processing (transaction VT01n). A transportation planning point that corresponds to the planning system of the forwarding agent must also be specified.

Transmission of deliveries is carried out as follows:

10. Selection of service agent

11. Selection of transmission profile

12. Combining of deliveries and their corresponding items

13. Determination of the items that are relevant for transportation (optional)

14. Determination of the delivery’s dispatch location and point of destination where additional shipments are possible, e.g. main leg for sea transportation (optional)

15. Accumulation of delivery items according to the freight class of the delivered materials and the freight code set that was specified.

16. Customer functions for user-specific changes or enhancements of the combined delivery data and IDocs

17. Creation of the IDoc (one IDoc per delivery document with the option to combine several IDocs into packets)

18. Transmission of the IDocs to a forwarding agent

Deliveries that were changed in R/3 (transaction VL02) after they have already been reported to the forwarding agent are automatically re-transmitted to the forwarding agent immediately after the changes are posted (provided they are relevant for transportation). This function is activated by a link to message control. When a change is made, the whole document, rather than just the changed data, is re-transmitted.

The following graphic illustrates the scenario for transportation-relevant deliveries that have been changed after data was initially transmitted to an external transportation planning system:
If a delivery is deleted in R/3, this deletion command is transmitted automatically to all forwarding agents that had previously been planning that delivery for assignment to shipments. The delivery document is deleted in R/3, although, in certain circumstances, some references to this delivery that are still open may exist in externally-planned R/3 shipment documents. Shipment documents with these open references cannot be changed in R/3 until the change command is received from the forwarding agent for the document that no longer contains that delivery.

**Incoming Shipment**

The incoming shipment IDocs TPSSHT01 are interpreted, checked, and then used for creating, changing, or deleting R/3 shipment documents that are then posted afterwards to the database.

The functional process flow can be described as follows:

- Importing the IDocs via the ALE layer
- Interpretation of the IDocs, resulting in the creation, changing or deletion of shipment documents. The individual stages for creating/changing each shipment document are determined by the shipment header, the shipment items, stages, dates, and handling units.
- Posting the created/changed documents

**Outgoing Shipments**

In the case of externally planned shipment documents, if you have a shipment status in Customizing that is exceeded or not reached, you can have a fixing or release message sent to the respective forwarding agent. To do this, use the IDoc TPSSHT01. After the freeze message is transmitted for a shipment document in R/3, the corresponding shipment in the planning system can no longer be changed. Similarly, a release message from the R/3 system means that the shipment document can be changed again in the planning system.

**Status Transmission and Error Processing**

Automatic processing of logical errors (errors that occur as a result of the message content) is carried out in the R/3 system using the workflow options provided by the ALE layer. The receiving
Logical Communications Processes

system can react to a logical error by sending back an error message using IDoc SYSTAT01. The IDoc is constructed so that the error source can be localized precisely.

Workflow can be set in R/3 so that the employee responsible is informed when this error message is received as a reply to the transmission of delivery data to a forwarding agent.

You can make the relevant settings in Customizing for the R/3 transportation planning point so that an error message can be created and sent as a response to the forwarding agent upon receipt of incorrect incoming shipment documents.
Application Transactions of the Interface

The following sections describe the application transactions and programs with which the user can operate the functions for transmission in the direction from SAP → forwarding agent.

Transmission of Planning Requests

Explicit Transmission by Application Transaction

Using the explicit transmission function, you can transmit to a forwarding agent a large number of deliveries that you can select using selection requirements also available in manual shipment processing (transaction VT01). Specifying the transportation planning point (planning system) and the processing type (outbound or inbound shipment) is obligatory.

At the moment, it is not possible to select outbound deliveries and inbound shipping notifications together with one selection run.

You can call up the transmission of planning requests by calling up the transaction VT62 or through the menu path Logistics Execution → Transportation → Transportation Planning → Scheduling in Cooperation with Forwarding Agents → Send Deliveries to Forwarding Agent.

Deliveries that were already transmitted once can only be transmitted to the same system again if the delivery has been changed and the output control is activated. If you do not want this block, then it can be switched off for direct transmission using a customer function. You can read more about these functions in the section SAP System Settings and Modification Concept or in the online help for the customer function.

Regular Transmission per Job

You can have deliveries transmitted regularly and automatically using certain selection criteria. This is appropriate, for example, if all shipments are to be planned overnight.

To do this, program RV56LFTPC should be included as a job. Parameters must include transportation planning point, shipment completion type, the deleted indicator for displaying the selection screen as well as a selection variant for program RV56LFSLC.

Fully Automatic Transmission

Fully automatic transmission of planning requests for generating deliveries is a special case. It should only be applied if a company wishes to plan all its deliveries with an external planning system in transportation but where only one planning system (in other words, one transportation planning point) is available. In this case the function can be activated via a special configuration of message control (more information in Procedure for Transmitting Planning Requests - Automatic Transmission). Depending on the message control configuration, the message transmission will either take place immediately after posting the delivery or in later collective processing.
Removing Planning Requests

If deliveries are to be removed from the planning system because planning should be either carried out manually, using another system, or not at all, the following options are at your disposal.

Explicit Removal from Planning

Explicit removal from planning means taking a delivery out of a planning system without deleting the delivery in R/3. You can call up the exclusion of deliveries from planning by calling up the transaction VT69 or through the menu path Logistics Execution → Transportation → Transportation Planning → Scheduling in Cooperation with Forwarding Agents → Plan Deliveries from Freight Planning.

Once you have entered the delivery document number for the delivery to be removed, a list of all the planning systems that the delivery has been transmitted to will appear. You can select the system and start the process using Execute.

Automatic Removal from Planning by Deleting a Delivery

If a delivery is deleted in R/3, it is then automatically removed from planning in all the planning systems that it has already been transmitted to. This procedure needs no previous configuration.

Receipt of Planned Shipments

The receipt of planned shipments in R/3 takes place automatically via the ALE layer mechanisms. Some functions are available within inbound processing and further document processing which affect the transportation planning interface. You must also take into account other attributes that can be influenced by Customizing settings.

Deleting Shipments or Handling Units within a Shipment

Deleting handling units that have been created in a shipment or deleting a whole shipment is not possible in the transportation planning system if a handling unit is not empty, that is, if something has been packed into the shipping unit.

If materials have been packed manually into a handling unit in an externally-planned shipment document, they must first be manually unpacked before the planning system can delete the handling unit or the shipment.

Automatically Setting ‘Planned’ Status

‘Planned’ status is automatically set when the system receives an externally-planned shipment document. This happens regardless of whether a planned date has been transmitted to the incoming document or not.

If the planning date is transmitted from a forwarding agent, this is copied over to the planning date in the shipment document. If a planning date is not transmitted, the planning date in the R/3 document is set to the date of receipt of the external document.
Document Status

The document status must not be changed by the forwarding agent.

If the given status is reached or exceeded through manual setting in R/3 transportation processing, a message will be sent automatically to the forwarding agent to freeze the corresponding shipment document, whereby the shipment document must be set to *Do not change* in the planning system.

Modifiability of Externally-Planned Shipments

Changes that were made in R/3 are not transmitted to the forwarding agent to avoid possible inconsistencies in data.
Configuration Options

During configuration in R/3 Customizing, you can specify technical or functional parameters that determine how messages are sent to the planning system and which modifications should be carried out in the messages before transmission.

R/3 Customizing

SAP uses the word Customizing to describe the necessary table settings used to tailor the R/3 system to the user’s needs. For example, in Customizing you can:

- Define key values and their attributes (shipment types, for example)
- Maintain number ranges (shipment numbers, for example)
- Create and maintain organizational units (transportation planning points, for example)
- Configure procedures for sending documents (message control, for example)
- Create procedures for modifying documents (route restrictions, for example)
- Carry out other customer-specific system settings

The descriptions for Customizing settings are available in detail in the Implementation Guide in Online help. Particular specifications for setting the transportation planning interface can be found in the IMG under Tools → Customizing → Implementation projects → SAP Reference IMG → Logistics Execution → Transportation → Interfaces → Scheduling in Cooperation with Forwarding Agents [Ext.].

Planning Restrictions for Routes

There are certain planning situations where the entire transportation process is not determined for individual deliveries. In order to optimize the planning of domestic transportation (roads) for companies sending deliveries both at home and abroad, a planning system might be used where shipment documents can also be manually generated using R/3 transactions for transportation activities for overseas shipments (sea routes). In this case, the forwarding agent has to be notified that the destination location for planning is not the decisive factor for deliveries abroad, but that automated planning should take place for another location (for example, a departure harbor or border location). Similar situations can arise for orders that are shipped from a shipping location outside the planning area and that should only have automatic subsequent leg planning carried out.

The planning restrictions are linked to the combination of forwarding agent (transportation planning point) and route. This way, you can define how a departure point or destination location substitution should be executed in the planning request for each related planning system and each delivery route separately.

Location substitution schemas are used for determining an alternative departure point or destination for planning. A substitution schema is made up of sequence of conditions that are checked one after the other until a valid substitute is found. Once an alternative location has been found, the time specifications for the location are also reset where possible.

The following conditions can be used in a substitution location procedure:
All the search strategies refer only to documents that are part of the delivery currently being processed. Locations that are used as departure and destination locations for the delivery in the existing shipments are those where the delivery is loaded or unloaded but not the absolute beginning or end of a shipment.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Time substitute</th>
<th>Location substituted with...</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>A, P</td>
<td>Departure location of earliest main leg shipment</td>
</tr>
<tr>
<td>002</td>
<td>A, P</td>
<td>Departure location of earliest preliminary leg shipment</td>
</tr>
<tr>
<td>003</td>
<td>A, P</td>
<td>Departure location of earliest subsequent leg shipment</td>
</tr>
<tr>
<td>004</td>
<td>F</td>
<td>Departure points in delivery route</td>
</tr>
<tr>
<td>050</td>
<td>A, P</td>
<td>Earliest departure location of any shipment</td>
</tr>
<tr>
<td>101</td>
<td>A, P</td>
<td>Destination location of latest main leg shipment</td>
</tr>
<tr>
<td>102</td>
<td>A, P</td>
<td>Destination location of latest preliminary leg shipment</td>
</tr>
<tr>
<td>103</td>
<td>A, P</td>
<td>Destination location of latest subsequent leg shipment</td>
</tr>
<tr>
<td>104</td>
<td>F</td>
<td>Destination points in delivery route</td>
</tr>
<tr>
<td>150</td>
<td>A, P</td>
<td>Latest destination location in any shipment</td>
</tr>
<tr>
<td>200</td>
<td>F</td>
<td>Fixed transportation connection points</td>
</tr>
<tr>
<td>999</td>
<td></td>
<td>User-specific substitution</td>
</tr>
</tbody>
</table>

If a substitution location is found, the system also tries to determine the connection scheduling for the departure or arrival time of the delivery at the substitution location (time substitute). This is done by using the following procedures:

<table>
<thead>
<tr>
<th>Time substitute</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Substitute with actual transportation time (this takes priority due to precision, but may only be maintained in exceptional cases).</td>
</tr>
<tr>
<td>P</td>
<td>Substitute with planned times from shipment document.</td>
</tr>
<tr>
<td>F</td>
<td>Calculates new times based on delivery / GI date and the preliminary, main and subsequent leg times of the route specified in Customizing.</td>
</tr>
</tbody>
</table>

User-specific location substitution takes place using a customer function. You can read more about these functions in the section SAP System Settings and Modification Concept or in the online help documentation.
Automatic connection scheduling for existing R/3 shipments can only take place properly if all important data has been maintained in R/3 shipment documents. The following data is absolutely necessary in the shipment document:

- Departure and destination location
- Planned departure and arrival time in shipment header
- Delivery assignment

If a connection to a collective shipment is planned, the following data must also be maintained:

- Shipment Stages
- Delivery assignment to legs
- Departure and arrival times at shipment stages

If possible, you should also ensure that all address data is maintained for the locations involved.

**Location Substitution for Subsequent Leg Planning**

The planning system “Roads in Germany” is implemented for the delivery route “North America – Hamburg” to plan the subsequent legs. For this reason, the departure location of the delivery that is in North America, that is, outside of the planning area, is replaced by a departure location better suited for planning. The determination procedure would identify the following condition sequence, which is processed sequentially until a substitution location has been found:

1. End of last main leg. If one or more main legs exist for the corresponding delivery, the destination location of the last main leg is used as the starting location for planning. The shipment end date becomes the shipment departure date.

2. End of delivery route. The destination point of the delivery is used as the starting point for planning. The departure time is determined using the delivery date and the specified subsequent leg time.

3. Specified point: the point specified in Customizing is used. There is no departure time determination.

4. No substitution takes place.

The following shows the four most relevant substitution procedures with their condition steps.

**Automatic Preliminary Leg Planning: Connection to Departure Location in Existing Main Leg Shipment:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Condition</th>
<th>Location substituted with...</th>
</tr>
</thead>
</table>

356 April 2001
Material Accumulation

It is absolutely necessary to know all details about the materials/delivery items to be transported in order to plan shipments.

In certain circumstances, it is not always relevant whether two delivery items, 500 liters of red and 500 liters of green paint, for example, are to be transported. It is often enough to know that 1000 liters of paint have to be planned as shipment goods. The circumstances are similar in batch handling, where different batches of one material are divided among several delivery items.
Configuration Options

Delivery items can be combined according to different criteria, in order to achieve a better overview or to reduce the amount of data that is to be transmitted. This combination (accumulation) can take place separately for each combination of transportation planning point and route. However, it can also be carried out generally for an entire transportation planning point.

Accumulation of delivery items takes place in a transportation planning interface and is always related to deliveries, i.e. a cross-delivery accumulation is not available.

There are two options for creating planning requests for the accumulation of items in the current delivery:

- **Reduction of shipment-relevant items:**
  
  Activating this function results in:
  
  - Combination of batch items in a header item per material
  - Combination of product selection of a material in a header item
  - Deletion of BOM items irrelevant to the shipment

  Text and value items as well as automatically-generated packing items are not normally transmitted.

- **Accumulation according to freight code:**
  
  You can assign a freight code set to the combination of transportation planning point and route. In this way, the freight code can be determined together with the material freight group from the material master. The items of a delivery are grouped together by freight codes. The type of materials is only shown by the freight code in the message. The quantity is only available in weight and volume specifications and no longer as number of pieces, etc.

If both accumulation procedures are activated, the accumulation will first be carried out according to shipment-relevant items and then according to freight code.

You can implement a user specific accumulation by using a customer function. This customer function is carried out according to both the reduction of shipment-relevant items and freight class. You can read more about customer functions in the section *SAP System Settings and Modification Concept* or in the online help documentation of the customer function.

Procedure for Transmiting Planning Requests

**Standard Transmission Procedure with Output Control**

The use of the output control function is to be viewed as a standard transmission procedure. Other procedures should only be used in exceptional cases. Transmission with output control has the following attributes:

- Blank transmission using transaction VT61 generates entries in output control that are used for creating planning requests for the time planned in the output type and are then transmitted.
Transmission of planning requests based on changed deliveries takes place automatically.

Control mechanisms are available in output control.

The following settings allow you to set the standard transmission procedure for a planning system:

- Create an output type for your planning system based on CFPR. Do not forget to maintain the processing program.
- Set the required dispatch time.
- Enter your new output type in the output procedure for the shipping messages and set the condition to ‘41’ (delivery to forwarding agent).
- Enter your output type in a transmission profile.

A transmission file is made up of a combination of transmission parameters, such as output type, planning specifications for forwarding agents (which transportation planning point it is to use, which delivery texts are to be transmitted). This can be changed in Transaction VT62.

If several forwarding agents are connected to your R/3 system, then you need a different output type for each forwarding agent.

**Automatic Transmission**

Automatic transmission only works with one forwarding agent since all deliveries are always shipped there directly.

Automatic output control has the following attributes:

- Posting a new delivery generates entries in output control, which are used for creating planning requests for the time planned in the output type and which are then transmitted.
- Transmission of planning requests based on changed deliveries takes place automatically.
- Control mechanisms are available in output control.

The following settings allow you to set the standard transmission procedure for a planning system:

- Create an output type for your planning system based on TPSO. Do not forget to maintain the processing program.
- Set the required dispatch time.
- Enter your new output type in the output procedure for the shipping outputs and leave the condition field blank.
- Enter your output type in the transportation planning point assigned to the forwarding agent.
In addition to the automatic planning system, you can also use other systems with standard transmission procedures.
Technical Communication

The following section deals with the technical aspects of communication and data flow between SAP-R/3 and a non-SAP system (sub-system).

Transmitting Planning Requests

The following overview shows the procedure for transmitting outputs from R/3 to a sub-system.

Creating a Planning Requirement in Transportation

The planning requirement for planning deliveries can be created with the functions described in the Outbound Delivery section. The procedure can be carried out either as an online transaction or a background job using output control.

Saving the Data in the ALE Layer

Within the same process (Logical Unit of Work or LUW) the data is formatted in the form of repository (data dictionary) structures by the Application Link Enabling (ALE) level function module. These structures are called Intermediate Documents (IDocs). The IDocs that were created are saved in the database.

Communication Structure and Transmission of the IDocs

Transmission of the IDoc is carried out asynchronously to its creation, that is, ALE transmits the IDoc after it is created. An IDoc can be transmitted directly, or combined first and then sent as part of a package of several IDocs.
Technical Communication

During IDoc transmission, the ALE uses transactional Remote Function Call (tRFC). The system starts a remote shell in the subsystem and calls up the C program to which the function to be called is transferred within the program. The underlying technique that allows transmission to be carried out correctly according to the log is described above as an RFC layer. A library of C development programs are available for program development.

For further information on creating C programs and further system settings, see the following sections and the documentation in the RFC libraries.

Subsystem Tasks

The C program for receiving the data must be provided in the sub-system. There is a sample program to this effect. This is supported by the RFC library that you receive from SAP as a certification partner (RFC SDK, Remote Function Call Software Development Kit).

The program must save the data after receiving it before the receipt confirmation is sent back to the R/3 system. Then data processing can start in the subsystem. SAP recommends this intermediate saving procedure, which allows communication of processing logic to be carried out separately in the sub-system.

Also, the sub-system should have status management for the data it received. Status management can prevent duplicate processing. You should also note that the sub-system must be able to recognize if an IDoc has already been transmitted once by the R/3 system. This is made possible through a unique transaction ID for each communication activity. (See also the technical documentation of the RFC.)

In addition to the transaction ID, the IDoc number can also be used to signify that an IDoc has already been transferred. The IDoc number is only unique within a given client of an SAP system. If communication is carried out with several clients and/or several SAP systems, then the IDoc can not be identified using only the IDoc number.

Error Processing in Communication

The following problems may occur during transmission:

Posting termination in the application (when creating a planning requirement, for example)

In this case, the error is not critical for communication, because IDocs cannot be created without a planning requirement. Both postings are carried out in the same LUW and are therefore posted synchronously.

Errors in the ALE layer

3. The data that was formatted in the LUW (which creates the IDoc) and which was sent to ALE is syntactically incorrect. The IDoc is copied and saved by ALE but cannot be transmitted. For more information about this error, see the SAP System Settings and Modifications section.

4. The partner profile for outbound processing is not defined for the receiver and the IDoc’s message type in ALE. The IDoc is saved but cannot be transmitted. For more information about this error, see the SAP System Settings and Modifications section.

No connection

If an IDoc is created but the connection cannot be made, then a report running in the background ensures that communication attempts are made from time to time. If the connection is restored, then the IDocs are transmitted automatically.
Receiving Planned Shipping Documents

The following overview illustrates receipt of shipping documents that have been generated from planning requests by the subsystem.

### Subsystem

<table>
<thead>
<tr>
<th>Application</th>
<th>Preparing shipment data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface</td>
<td>Transmitting data</td>
</tr>
<tr>
<td>RFC</td>
<td>Receiving data</td>
</tr>
<tr>
<td>ALE</td>
<td>Generating the IDoc</td>
</tr>
<tr>
<td>WS-transfer</td>
<td>Processing the IDoc</td>
</tr>
<tr>
<td>R/3</td>
<td></td>
</tr>
</tbody>
</table>

#### Formatting and Transmitting Shipment Data

The primary task of the subsystem is to optimize shipment planning from the planning requests that have been transmitted from the R/3 system. Fully-planned shipments must be transmitted back to the R/3 system using the communication path provided (transactional RFC). The subsystem carries out the following tasks within the framework of communication with the SAP R/3 system:

1. **Intermediate Data Storage and Formatting for IDocs**
   
   The subsystem shipment data must be saved in an IDoc-specific data structure. For information on the definition and structure of the different IDocs, see the sections [IDoc Descriptions](#) and [IDoc Segments, Fields and Domain Values](#).

2. **Calling up a Central Function Module in R/3 using the Transfer Program**
   
   You also need the RFC library for programming support for the transfer program. The central function module is part of the ALE layer.
   
   Several IDocs can be transferred in one communication procedure - that is, when an R/3 function module is called up once, multiple IDocs can be transferred.
Technical Communication

Updating After IDoc Transmission

During transmission, the sub-system must provide status administration for the transmitted data. If the IDoc is transmitted unsuccessfully, then it must be retransmitted later.

Duplicate transfer of IDocs must be avoided on the SAP side of things. This is where the transaction ID, which is assigned by SAP for each communication procedure, comes into play. The data that is transferred by the sub-system must always be transmitted with this transaction ID (see also the technical documentation about the RFC). The same transaction ID must be entered for subsequent retransmissions.

The SAP System does not use the IDoc number to check for duplicate transfers.

Receipt and Posting of Data

ALE receives the IDoc and writes it into the database. After this intermediate saving procedure, a confirmation of receipt is sent back to the subsystem. The IDoc is then forwarded to the application (asynchronously as far as receipt is concerned), where processing occurs.

The application in R/3 that creates, changes and deletes shipment documents sends a status back to ALE for each IDoc. This IDoc status is the basis for processing any possible errors.

Error Processing

The following errors may occur:

Connection can not be made at this time

The sub-system should also use status administration to ensure that subsequent posting can be carried out.

Errors in the ALE layer

An IDoc was created, but processing was not started.

This error occurs (as in transmission from R/3), if the IDoc that is received is syntactically incorrect or if the partner profile for inbound processing is missing for the sender and the message type of this IDoc. For more information about this error, see the SAP System Settings and Modifications section.

Error in the application (when posting the transfer request, for example)

This is a question of logical errors in the application. A message is issued to a position with the IDoc status mentioned above. Several users can be assigned to a position. Each user receives the error message in their own SAP OFFICE inbox. As soon as a user enters and processes the error message, it disappears from the other inboxes.

Technical Programming for the Subsystem Connection

This section provides you with an overview of the technical details involved in the connection of a sub-system to the R/3 System. You can find detailed documentation of the Remote Function Call in RFC SDK and in the R/3 System online documentation. This section is intended to give you an overview of the programming techniques. It is not comprehensive. Please consult the above-mentioned documentation as well if you want to make the connection yourself.
Transmission from SAP to a Sub-system

IDocs are transmitted from the SAP system by calling up the function module `INBOUND_IDOC_PROCESS` with a destination. The destination uses a table in the R/3 system to determine destination computer and the target program.

A C program with target program name must exist in the sub-system. The program contains a function with the name of the function module call.

In the R/3 system, the application data is transferred in the internal table of structure EDI_DD. In addition, a control record from structure EDI_DC that contains administration data is also transferred for each IDoc. In the example, this data is transferred in the form of internal tables.

For further information, please see the documentation mentioned above.

You can have a C program core from function module display SE37 generated from the R/3 system. You can use this as the basis for your receiving/transmitting program. In order to interpret the data in the IDoc, you also need the data structures of the IDocs at C Program level.

If an R/3 system is available, you can generate an h - IDoc header file directly from repository transaction SE11.

Notes on TCP/IP settings

5. The Transmission Control Protocol/Internet Protocol (TCP/IP) requirements (especially the IP addresses in both host files) must be set so that the SAP system can find the destination system.

6. In the SAP system, IDocs are transmitted from posting as standard. For this reason, the TCP/IP link must also be created for the posting system.
7. The SAP gateway must be allowed to start the C program (RFC server) via remote shell. For this reason the user that runs under Gateway (e.g. d11adm where d11 = system name) must also be recognized as a user by the target system.

8. In UNIX, the name of the gateway and dispatcher must be entered in the /etc/services, (sapgw00 and sapdp00, for example).

Please see also the RFC documentation mentioned above for more information on the settings.

Transmitting from a Sub-system to SAP

When you log on to the SAP R/3 system, the server name of the SAP target system, SAP logon, user, password etc. must be defined in the C program. The actual logon is supported by the RFC function RfcOpen (...). You can find details about this in the comprehensive RFC documentation.

The data needs to be processed into IDoc format and placed in an internal table with structure EDI_DD. A control record must also be created for each IDoc and placed in an internal table for structure EDI_DC. The form of data transfer is also described in detail in the documentation.

Transaction ID Administration

To ensure the security of the data to be transferred, a unique ID must be used for the communication procedure. This ID allows the receiving system to recognize whether this data has already been received and processed.

For example, communication could be terminated suddenly during the transmission of data for mobile entry of goods receipts. The user would transmit the data again in order to ensure that the entry is posted by the SAP System. If the data was successfully received and processed on the first attempt, however, the system must be able to recognize this. It should not process the data a second time.
This example would cause the following process flow between the transmitting system and the receiving system.

**Sender (Client)**
- Create / get TID (Unique number worldwide)
- Save TID with data records
- Call server: transmit data and TID
- Confirmation not o.k.
  - Transmit again with same TID
- Confirmation: Data received
  - Check: TID already exists/processed?
    - yes
      - Status update
      - Delete TID and data immediately or later
    - no
      - No action

**Receiver (Server)**
- Save data and TID
- Confirmation: Data received
  - Check: TID already exists/processed?
    - yes
      - Status update
      - Delete TID and data immediately or later
    - no
      - Process data
- Update TID status
**IDoc Description**

**General Construction of the IDoc**

An IDoc is comprised of a number of data records in two tables:

- Control record table EDI_DC
- Data record table EDI_DD

A control record entry EDI_DC exists for each IDoc. This contains important data such as the ID of the transmitting and receiving systems, among other IDs. A data record entry EDI_DD exists for each data record. It is made up of a header section which is 55 bytes long and a data section which can hold up to 1000 bytes. The reference of data record to control record is created with an IDoc number. For each control record with document number DOCNUM, data records with the same document number must exist. There is, therefore, a 1:N relationship between control records and data records. The data records must be entered into table EDI_DD in exactly the same sequence as required by the hierarchical structure of the corresponding IDoc categories. For further information on the hierarchy, see the *Overview of IDoc Structure* section.

Not all fields in EDI_DC or EDI_DD are required entry fields. Some fields are not to contain values. Make sure to leave these fields blank.

If you are transmitting an IDoc from an external system to SAP, then you have to define a logical system as a communication partner in the R/3 system (SALE -> Distribution model -> Logical systems) and a partner profile for inbound processing that agrees with this partner number. The partner number of the destination system (SAP in this case) is not actually mandatory, but we recommend that you specify it, so that communication procedures can be carried out correctly. The logical system of the SAP System is maintained for each client in table T000 (SM31).

The partner profiles can be used to provide a non-standard function module for processing IDocs in the table for inbound processing methods in the ALE service level.

When creating IDocs in the R/3 system using transaction WE30, three structures are created and numbered automatically for each IDoc segment. For example, the delivery header might have E1TPDLH, E2TPDLH and E3TPDLH. E1TPDLH is release-independent, E2TPDLH is release-dependent and E3TPDLH is used for documentation. When segment names are transferred, you must specify the E2 segment names in order to be working independently of the SAP release.

**Data Transfer Format**

Data is transferred via the interface using CHAR format only. Conversion is carried out in the SAP system with the necessary adjustments for the entry fields in CHAR formats. The following table gives the required entries for the more important data categories.

<table>
<thead>
<tr>
<th>Field</th>
<th>Length</th>
<th>Possible entry value</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMC</td>
<td>Ex: 18</td>
<td>'00000000012345678' positive, numerical char format right-aligned with preceding zeros</td>
</tr>
<tr>
<td>CHAR</td>
<td>Ex: 18</td>
<td>'Bordeaux__________' char format left-aligned with subsequent spaces</td>
</tr>
</tbody>
</table>
Overview of Transferred Message

The messages listed below are transferred from the SAP R/3 System to the forwarding agent. The names used are those specified for the basic IDoc types and logical message types:

<table>
<thead>
<tr>
<th>Action</th>
<th>IDoc name</th>
<th>Message type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan/change/deallocate deliveries</td>
<td>TPSDLS01</td>
<td>CFREQ</td>
</tr>
<tr>
<td>Add/change location master data (customer, vendor)</td>
<td>TPSLOC01</td>
<td>TPSLOC</td>
</tr>
<tr>
<td>Set transportation planning status</td>
<td>TPSSHT01</td>
<td>SHIPPL</td>
</tr>
<tr>
<td>Status information about transfer/possible errors</td>
<td>SYSTAT01</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

The messages listed below are transmitted from the forwarding agent to the SAP R/3 System:

<table>
<thead>
<tr>
<th>Action</th>
<th>IDoc name</th>
<th>Message type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create/change/delete shipment</td>
<td>TPSSHT01</td>
<td>SHPCPR</td>
</tr>
<tr>
<td>Status information about transfer/possible errors</td>
<td>SYSTAT01</td>
<td>STATUS</td>
</tr>
</tbody>
</table>

When transmitting documents between the R/3 system and a forwarding agent, you must follow these basic guidelines regardless of the direction of transfer:

- **Delivery and shipment documents must all be fully transferred when added to or changed.**
  
  If, for example, a delivery is changed in the R/3 System after it has been transferred to the subsystem, the whole document is fully transferred with all the data, not just the changes. Changed shipments must also be fully retransferred from the planning system.
If documents are deleted, they must be transferred with at least the entire header information.

Item segments can be ignored if the document is to be deleted.

If fields in the IDoc are blank, then they are also blank in the original document.

Transferring one document per message

Normally, you are not allowed to combine documents in a single IDoc. In other words, each IDoc may only contain a single header segment. IDoc TPSLOC01 is an exception to this rule because it can transfer several master data records.

Taking the serialization of messages into account

This is done to ensure that older IDoc versions for a document are not posted again after a more recent document has been processed.

Client-dependence of the planning data must be taken into account

Take special care during communication with a forwarding agent with several R/3 clients and/or R/3 Systems that data from different clients does not get mixed up (see also the EDI_DC IDoc Control Record section).

Transfer of all data in CHAR format

All data is transferred to the IDocs in character format. For example, there are no 8-byte sliding decimals.

Transfer of all units of measure according to ISO standard

All units of measure, country codes and currency codes are transferred into the IDoc according to the ISO guidelines (e.g. KGM instead of KG for the kilogram unit).

Shipment number from number range

Shipment document numbers that are issued by a forwarding agent must fall within a number range that can be set within the R/3 System.

Overview of IDoc Structure

The following sections describe the structures of the different IDocs. The indentations in the Segment column indicate the hierarchical structure of the IDoc, which means that an indented segment is lower in the hierarchy than the previous segment further toward the margin. Subordinate mandatory segments are only mandatory if the segment superior in the hierarchy is present.

TPSDLS01 - Plan/Change/Deallocate Deliveries [Page 284]
TPSSHT01 - Create/Change/Delete Shipment [Page 286]
SYSTAT01 - Status Information for Transfer [Page 287]
EDI_DC - IDoc Control Record

Definition

The IDoc control record EDI_DC contains important information on partners who transmit and receive IDocs. It can occur exactly once for each IDoc.

Only some of the fields need to be filled for IDocs that are transmitted from the forwarding agent to the R/3 system. These are identified as mandatory fields in the following field list.

If an IDoc is transmitted from the R/3 system to the forwarding agent, then nearly all fields are filled, although the only fields that are relevant are those that are marked as such.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Format</th>
<th>TPS-relevant</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Name of the table structure</td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Client</td>
</tr>
<tr>
<td>DOCNUM</td>
<td>NUMC 16</td>
<td>X</td>
<td>X</td>
<td>Number of the IDoc</td>
</tr>
<tr>
<td>DOCREL</td>
<td>CHAR 04</td>
<td></td>
<td></td>
<td>SAP release of IDoc</td>
</tr>
<tr>
<td>STATUS</td>
<td>CHAR 02</td>
<td></td>
<td></td>
<td>Status of the IDoc</td>
</tr>
<tr>
<td>DOCTYP</td>
<td>CHAR 08</td>
<td></td>
<td></td>
<td>IDoc type</td>
</tr>
<tr>
<td>DIRECT</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Direction</td>
</tr>
<tr>
<td>RCVPOR</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Receiver port (SAP system, EDI subsystem)</td>
</tr>
<tr>
<td>RCVPRT</td>
<td>CHAR 02</td>
<td>X</td>
<td>X</td>
<td>Partner type of receiver</td>
</tr>
<tr>
<td>RCVPRN</td>
<td>CHAR 10</td>
<td>X</td>
<td>X</td>
<td>Partner number of receiver</td>
</tr>
<tr>
<td>RCVSAD</td>
<td>CHAR 21</td>
<td></td>
<td></td>
<td>EDI: SADR fields (total)</td>
</tr>
<tr>
<td>RCVLAD</td>
<td>CHAR 70</td>
<td></td>
<td></td>
<td>Logical address of receiver</td>
</tr>
<tr>
<td>STD</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>EDI standard</td>
</tr>
<tr>
<td>STDVRS</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td>Version of EDI standard</td>
</tr>
<tr>
<td>STDMES</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td>EDI message type</td>
</tr>
<tr>
<td>MESCOD</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Logical message variant</td>
</tr>
<tr>
<td>MESFCT</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Logical address of receiver</td>
</tr>
<tr>
<td>OUTMOD</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Issue mode</td>
</tr>
<tr>
<td>TEST</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Test indicator</td>
</tr>
<tr>
<td>SNDPOR</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td>Transmission port (SAP system, EDI subsystem)</td>
</tr>
<tr>
<td>SNDPRT</td>
<td>CHAR 02</td>
<td>X</td>
<td>X</td>
<td>Partner type of transmitter</td>
</tr>
<tr>
<td>Field</td>
<td>Type</td>
<td>Length</td>
<td>Mandatory</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
<td>--------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>SNDPRN</td>
<td>CHAR</td>
<td>10</td>
<td>X</td>
<td>Partner number of transmitter</td>
</tr>
<tr>
<td>SNDSAD</td>
<td>CHAR</td>
<td>21</td>
<td></td>
<td>EDI: SADR fields (total)</td>
</tr>
<tr>
<td>SNDLAD</td>
<td>CHAR</td>
<td>70</td>
<td></td>
<td>Logical address of transmitter</td>
</tr>
<tr>
<td>REFINT</td>
<td>CHAR</td>
<td>14</td>
<td></td>
<td>Reference to transfer file</td>
</tr>
<tr>
<td>REFGRP</td>
<td>CHAR</td>
<td>14</td>
<td></td>
<td>Reference to message group</td>
</tr>
<tr>
<td>REFMES</td>
<td>CHAR</td>
<td>14</td>
<td></td>
<td>Reference to message</td>
</tr>
<tr>
<td>ARCKEY</td>
<td>CHAR</td>
<td>70</td>
<td>X</td>
<td>Document ID in the external system</td>
</tr>
<tr>
<td>CREDAT</td>
<td>DATS</td>
<td>08</td>
<td>X</td>
<td>IDoc creation date</td>
</tr>
<tr>
<td>CRETIM</td>
<td>TIMS</td>
<td>06</td>
<td>X</td>
<td>IDoc creation time</td>
</tr>
<tr>
<td>MESTYP</td>
<td>CHAR</td>
<td>06</td>
<td>X</td>
<td>Logical message category</td>
</tr>
<tr>
<td>IDOCTYP</td>
<td>CHAR</td>
<td>08</td>
<td>X</td>
<td>Name of basic IDoc category</td>
</tr>
<tr>
<td>CIMTYP</td>
<td>CHAR</td>
<td>08</td>
<td></td>
<td>Name of extension type</td>
</tr>
<tr>
<td>RCVPFC</td>
<td>CHAR</td>
<td>02</td>
<td></td>
<td>Partner function of receiver</td>
</tr>
<tr>
<td>SNDPFC</td>
<td>CHAR</td>
<td>02</td>
<td></td>
<td>Partner function of transmitter</td>
</tr>
<tr>
<td>SERIAL</td>
<td>CHAR</td>
<td>20</td>
<td>X</td>
<td>EDI/ALE: Serialization field</td>
</tr>
<tr>
<td>EXPRSS</td>
<td>CHAR</td>
<td>01</td>
<td></td>
<td>Override in inbound processing</td>
</tr>
</tbody>
</table>
Special Fields in the Control Segment of EDI_DC

Special functions must be taken into account for the following fields:

**Field EDI_DC-DOCNUM: Document number**

This field indicates the unique number in the SAP R/3 system of the document that is transmitted. A unique number must also be given by the forwarding agent so that a reference can be created to the accompanying data records. When the IDoc being transmitted from the forwarding agent is imported by the R/3 system, the content of DOCNUM is replaced with an internal number determined by the R/3 system. The reference to the old DOCNUM is saved.

**Field EDI_DC-RCVPRT: Partner type of receiving system**

The field indicates the type of partner system and is generally set to ‘LS’ (logical system) for communication with non-R/3 systems.

**Field EDI_DC-RCVPRN: Partner type of receiving system**

Number or name of the receiving system.

**Field EDI_DC-SNDPRT: Partner type of transmitting system**

The field indicates the type of partner system and is generally set to ‘LS’ (logical system) for communication with non-R/3 systems.

**Field EDI_DC-SNDPRN: Partner type of transmitting system**

Number or name of the transmitting system.

The combination of fields SNDPRT and SNDPRN is extremely important for the subsystem when data in the incoming IDocs is being processed. These two fields are used to separate documents from different R/3 systems or R/3 clients. A transportation planning system could, for example, receive two deliveries from two R/3 systems with the same delivery number. These deliveries must not get mixed up during planning. SNDPRT and SNDPRN therefore, function as an additional part of the key for all identification fields.

**Field E2STATS-ARCKEY: Document ID in External System**

In field ARCKEY, the subsystem can save additional information for unique identification of a transmitted document. If a document transmitted from the subsystem cannot be processed by the R/3 system, then an error message with the contents of ARCKEY is sent back in order to create a reference to the document-creating transaction.

**Field EDI_DC-MESTYP: Logical output type**

The field contains the logical name of a message. It is not bound by any EDI standard. Logical messages are assigned by SAP to the individual IDoc types.
Special Fields in the Control Segment of EDI_DC

Field EDI_DC-IDOCTYP: Name of basis IDoc type

The IDoc type is defined by the applications. They determine the sequence of the SAP segments. The IDoc types issued with the SAP standard are identified via field IDOCTYP just as IDoc types newly created by the customer are.

Field EDI_DC-SERIAL: EDI/ALE: Serialization field

The serialization field contains a unique number, that can be used in serialization, i.e. setting the correct transmission sequence of IDocs in the receiving system. Generally, this is a time stamp that explodes the sequence sufficiently or which provides a sequence of consecutive numbers based on the unique identification of the creation sequence and/or the transmission sequence in the transmission system. The serialization field should only contain numbers.
EDI_DD - IDoc Data Record

Definition

The IDoc data record EDI_DD contains a 55 byte header section with reference information and hierarchy information as well as a data section of up to 1000 bytes. The size of the data section is determined by the length of the IDoc segment transferred there.

When the R/3 system is receiving or transmitting data, the sequence of the individual data records transferred is determined directly from table EDI_DD. When data is being transmitted, this is also the case. In addition, the data records are also numbered consecutively when data is being transmitted.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Format</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td>Name of the table structure</td>
<td></td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td>Client</td>
<td></td>
</tr>
<tr>
<td>DOCNUM</td>
<td>NUMC 16</td>
<td>Number of the IDoc</td>
<td></td>
</tr>
<tr>
<td>SEGNUM</td>
<td>NUMC 06</td>
<td>sequential number</td>
<td></td>
</tr>
<tr>
<td>SEGNAM</td>
<td>CHAR 10</td>
<td>IDoc segment name</td>
<td></td>
</tr>
<tr>
<td>PSGNUM</td>
<td>NUMC 06</td>
<td>Number of hierarchically superior segment</td>
<td></td>
</tr>
<tr>
<td>HLEVEL</td>
<td>CHAR 02</td>
<td>Hierarchy level of the segment</td>
<td></td>
</tr>
<tr>
<td>DTINT2</td>
<td>CHAR 02</td>
<td>SAP-internal field, do not fill</td>
<td></td>
</tr>
<tr>
<td>SDATA</td>
<td>LCHR 1000</td>
<td>Data in the form of an IDoc segment</td>
<td></td>
</tr>
</tbody>
</table>

If, for example, you are transmitting two IDocs with shipment documents from a subsystem to an R/3 system, each with a shipment header, an action code and an assigned delivery - therefore each containing three segments, then you must use one EDI_DC record and three EDI_DD records per IDoc. When you call function module 'INBOUND_IDOC_PROCESS' via RFC, a total of two EDI_DC records and six EDI_DD records are transferred. The three segments of an IDoc are grouped using the unique number of the IDoc or intermediate document.

The DOCNUM is also used to identify the corresponding EDI_DC record. The R/3 client has the logical system description LS S11MAND002; the subsystem is defined using LS TRANSPLAN1.
### EDI_DD - IDoc Data Record

<table>
<thead>
<tr>
<th>IDoc number</th>
<th>Segment name</th>
<th>Data</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>90000000000123456</td>
<td>E2TPSHH</td>
<td>0010000101AD01ED</td>
<td>Shipment header</td>
</tr>
<tr>
<td>9000000000123456</td>
<td>E2TPACC</td>
<td>C</td>
<td>Action code</td>
</tr>
<tr>
<td>90000000000123456</td>
<td>E2TPSHI</td>
<td>0001008400035465</td>
<td>Delivery</td>
</tr>
<tr>
<td>9000000000123457</td>
<td>E2TPSHH</td>
<td>0010000102AD01ED</td>
<td>Shipment header</td>
</tr>
<tr>
<td>90000000000123457</td>
<td>E2TPACC</td>
<td>C</td>
<td>Action code</td>
</tr>
<tr>
<td>9000000000123457</td>
<td>E2TPSHI</td>
<td>0001008400035467</td>
<td>Delivery</td>
</tr>
</tbody>
</table>

### EDI_DC

<table>
<thead>
<tr>
<th>IDoc number</th>
<th>Receiving partner</th>
<th>Sending partner</th>
<th>Mess. type</th>
<th>IDoc type</th>
</tr>
</thead>
<tbody>
<tr>
<td>90000000000123456</td>
<td>LS S11MAND002</td>
<td>LS TRANSPLAN1</td>
<td>SHIPCPR</td>
<td>TPSSHT01</td>
</tr>
<tr>
<td>90000000000123457</td>
<td>LS S11MAND002</td>
<td>LS TRANSPLAN1</td>
<td>SHIPCPR</td>
<td>TPSSHT01</td>
</tr>
</tbody>
</table>
IDoc TPSDLS01 is used for transmitting deliveries that are yet to be scheduled for shipments to a forwarding agent. The IDoc contains the delivery information essential for the creating a shipment, as well as further address, material and transportation information.

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery header</td>
<td>E2TPDLH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Action code</td>
<td>E2TPACC</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Authorized service providers</td>
<td>E2TPALC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Location identification</td>
<td>E2TPTRM</td>
<td>X</td>
<td>2-4</td>
</tr>
<tr>
<td>Address</td>
<td>E2TPLOC</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Location code</td>
<td>E2TPLCT</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Time frame</td>
<td>E2TPTIW</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT13</td>
<td>X</td>
<td>n</td>
</tr>
<tr>
<td>Header delivery dimensions</td>
<td>E2TPDIH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Delivery item</td>
<td>E2TPDLI</td>
<td>X</td>
<td>n</td>
</tr>
<tr>
<td>Delivery item dimensions</td>
<td>E2TPDII</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Goods code</td>
<td>E2TPCOC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Handling unit</td>
<td>E2TPSHU</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Handling unit dimensions</td>
<td>E2TPDIS</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Handling unit contents</td>
<td>E2TPSUC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Texts</td>
<td>E2TPNOT</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Existing shipments</td>
<td>E2TPTRP</td>
<td></td>
<td>n</td>
</tr>
</tbody>
</table>
TPSSHT01 - Create/Change/Delete Shipment

IDoc TPSSHT01 is used for data transfer in both directions between the R/3 system and the forwarding agent. The structure of the IDoc represents a shipment document, although it will be in a form that differs in part from that used in the R/3 system.

During TPS -> R/3 communication, IDoc TPSSHT01 is used to transfer planned, changed or deleted shipment documents. The individual segments occur as shown in the following table.

During R/3 -> TPS communication, IDoc TPSSHT01 is only transmitted with the shipment header and the action code. It is only used to confirm the status of an externally planned shipment in the TPS (changeable / non-changeable).

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment header</td>
<td>E2TPSHH</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Action code</td>
<td>E2TPACC</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Costs</td>
<td>E2TPFRC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT10</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Means of transport</td>
<td>E2TPEQT</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Means of transport dimensions</td>
<td>E2TPDIS</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Transportation points</td>
<td>E2TPSLS</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Location identification</td>
<td>E2TPTRM</td>
<td>X</td>
<td>1</td>
</tr>
<tr>
<td>Address</td>
<td>E2TPLOC</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Process</td>
<td>E2EDT17</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Leg data</td>
<td>E2TPSHT</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Action</td>
<td>E2TPSHA</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Deliveries</td>
<td>E2TPSHI</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Delivery costs</td>
<td>E2TPDLC</td>
<td>n</td>
<td></td>
</tr>
<tr>
<td>Railway data</td>
<td>E2TPSHR</td>
<td>n</td>
<td></td>
</tr>
</tbody>
</table>

This IDoc contains a segment E2TPSLS and sub-segments for the description of the geographic processing of a shipment (load transfer point). A sequence of locations with the corresponding actions at that location is described in this part of the IDoc.

In the SAP R/3 system, this is carried out using a sequence of legs (links from one location to another) as well as with load transfer points and border crossing points in the shipment document. Generally, legs and border crossing points/load transfer points are represented as stages of a shipment (table VTTS). Deliveries can also be assigned to a stage (table VTSP).

For this reason, conversion is necessary when processing the incoming IDoc. The rules for conversion are explained for each segment.
If ACTCD = X, only segments: SHH; ACC; SHI
SYSTAT01 - Status Information for Transfer

IDoc SYSTAT01 is used for transferring positive confirmations and error messages concerning the contents of IDocs TPSDLS01 and TPSSHT01.

<table>
<thead>
<tr>
<th>Segment</th>
<th>Segment name</th>
<th>Mandatory segment</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDI Status record</td>
<td>E2STATS</td>
<td>X</td>
<td>n</td>
</tr>
</tbody>
</table>
IDoc Segments, Fields, and Domains

The following section describes the individual segments of IDocs TPSLOC01, TPSDLS01, TPSSHT01 and SYSTAT01. The fields contained in the segments are all listed with name, data category with length, corresponding R/3 domains, mandatory field indicators and their meanings. In the connection to the field list, segment fields that have special properties, fixed values areas or non-R/3 functions are described in greater detail.

Adjustment and Setting of Domain Values

During communication between the R/3 system and the forwarding agent, adjustment and setting of many fixed values is necessary in order to guarantee correct and efficient planning and processing. The following adjustment procedures are therefore used to determine how and in which system adjustments need to be made.

<table>
<thead>
<tr>
<th>Adjust. procedure</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SAP sets the standard that must be implemented in the planning system</td>
</tr>
<tr>
<td>2</td>
<td>Manual master data adjustment between the systems, R/3 is master system</td>
</tr>
<tr>
<td>3</td>
<td>Different value areas are used in both the R/3 system and in the planning system. Duplicated or common values can be adjusted</td>
</tr>
<tr>
<td>4</td>
<td>SAP copies the value area of the planning system for its development partner into the R/3 system</td>
</tr>
<tr>
<td>5</td>
<td>The R/3 system is adjusted in Customizing to the planning system value area</td>
</tr>
<tr>
<td>6</td>
<td>Translation / adjustment of technical expressions between the two systems</td>
</tr>
<tr>
<td>7</td>
<td>Value area is fixed and was determined by agreement between SAP and development partners</td>
</tr>
<tr>
<td>8</td>
<td>SAP defines a base value range that must be included into the planning system. It can be extended, in which case the changes must be entered into the R/3 Customizing.</td>
</tr>
<tr>
<td>9</td>
<td>The value area is specified using international standards (e.g. ANSI, ISO,..)</td>
</tr>
<tr>
<td>A</td>
<td>Electronic master data adjustment per data transfer, R/3 is the master system</td>
</tr>
<tr>
<td>B</td>
<td>Master data value that can be set as customer-specific and can only be adjusted in special circumstances</td>
</tr>
</tbody>
</table>

The various adjustment procedures are listed in the table with the segment descriptions in the Adjustment column. If no specification is made here, then you only need to take the specifications on data formats into account.
**E2EDT1x - Processes**

**Definition**

Segments E2EDT10, E2EDT13, and E2EDT17 describe processes at different document levels. The structures of the segments are the same. The only differences are in the location and the categories of the processes that they represent.

Segment E2EDT10 represents processes at shipment header level, i.e., those that refer to the whole shipment. E2EDT13 contains processes at delivery header level, i.e., processes that refer to the whole delivery. E2EDT17 represents processes in the shipment at stage level, i.e., processes that refer to a specific stage or point during the shipment.

The three segment types are all structured as follows:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUALF</td>
<td>8</td>
<td>CHAR 03</td>
<td></td>
<td>X</td>
<td>Process category</td>
</tr>
<tr>
<td>VSTZW</td>
<td>8</td>
<td>CHAR 04</td>
<td>VSTZW</td>
<td></td>
<td>Process</td>
</tr>
<tr>
<td>VSTZW_BEZ</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td></td>
<td>Process description</td>
</tr>
<tr>
<td>NTANF</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Planned start date</td>
</tr>
<tr>
<td>NTANZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Planned start time</td>
</tr>
<tr>
<td>NTEND</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Planned end date</td>
</tr>
<tr>
<td>NTENZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Planned end time</td>
</tr>
<tr>
<td>TZONE_BE G</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONE</td>
<td></td>
<td>Time zone of location of process start</td>
</tr>
<tr>
<td>ISDD</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Actual start date</td>
</tr>
<tr>
<td>ISDZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Actual start time</td>
</tr>
<tr>
<td>IEDD</td>
<td></td>
<td>DATS 08</td>
<td>DATUM</td>
<td></td>
<td>Actual end date</td>
</tr>
<tr>
<td>IEDZ</td>
<td></td>
<td>TIMS 06</td>
<td>UZEIT</td>
<td></td>
<td>Actual end time</td>
</tr>
<tr>
<td>TZONE_END</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONE</td>
<td></td>
<td>Time zone of location of process end</td>
</tr>
<tr>
<td>VORNR</td>
<td></td>
<td>CHAR 04</td>
<td>VORNR</td>
<td></td>
<td>Process number</td>
</tr>
<tr>
<td>VSTGA</td>
<td>5</td>
<td>CHAR 04</td>
<td>VSTGA</td>
<td></td>
<td>Code for reason of deviation</td>
</tr>
<tr>
<td>VSTGA_BEZ</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td></td>
<td>Description of reason of deviation</td>
</tr>
</tbody>
</table>
Special fields and domain values in the segments E2EDT1x

In the following fields from segments E2EDT1x, you must take note of special functions and/or allowed value areas.

Field E2EDT1x-QUALF: Activity category

The field can adopt the following values in the segments described, which involves entering data in the specified field from the table. Values in brackets are allowed for transfer to the IDoc, but are not evaluated during standard inbound processing:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>E2EDT10</th>
<th>E2EDT13</th>
<th>E2EDT17</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Transportation planning time</td>
<td>NTENx</td>
<td>NTENx</td>
<td></td>
</tr>
<tr>
<td>003</td>
<td>Loading time/execution</td>
<td>NTANx, NTENx</td>
<td>NTENx</td>
<td>( NTANx,NTENx)</td>
</tr>
<tr>
<td>005</td>
<td>Transportation processing</td>
<td>NTANx, NTENx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>006</td>
<td>Goods issue time</td>
<td>NTENx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>007</td>
<td>Delivery time</td>
<td>NTENx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>008</td>
<td>Arrival time</td>
<td>NTENx</td>
<td>( NTENx)</td>
<td></td>
</tr>
<tr>
<td>009</td>
<td>Departure time</td>
<td>NTENx</td>
<td>( NTANx)</td>
<td></td>
</tr>
<tr>
<td>010</td>
<td>Picking time</td>
<td>NTENx</td>
<td></td>
<td></td>
</tr>
<tr>
<td>011</td>
<td>Waiting time</td>
<td></td>
<td>NTANx, NTENx</td>
<td></td>
</tr>
<tr>
<td>012</td>
<td>Unloading time</td>
<td></td>
<td>( NTANx,NTENx)</td>
<td></td>
</tr>
<tr>
<td>013</td>
<td>Time of customs clearance</td>
<td></td>
<td>( NTANx,NTENx)</td>
<td></td>
</tr>
<tr>
<td>014</td>
<td>Load transfer point</td>
<td></td>
<td>( NTANx,NTENx)</td>
<td></td>
</tr>
<tr>
<td>018</td>
<td>Optimal arrival time</td>
<td></td>
<td>( NTENx)</td>
<td></td>
</tr>
<tr>
<td>019</td>
<td>Optimal departure time</td>
<td></td>
<td>( NTANx)</td>
<td></td>
</tr>
</tbody>
</table>

Important Process Categories:

The following process categories are extremely important and should be taken into consideration.

Segment E2EDT13 (Process at Delivery Header Level) in IDoc TSPDLS01

The time framework for planning the shipment is given in departure time (009) and arrival time (008). These are to be used for planning. The final planned data is entered here.

For direct shipment of the delivery (shipment from the shipping point to the customer), the departure time is the same as the loading time and the arrival time is the same as the unloading time. If, however, only a preliminary leg shipment is planned (e.g. from the shipping point to the port of departure) then the delivery time is no longer relevant for actual planning.
E2EDT1x - Processes

Segment E2EDT10 (Process at Shipment Level) in IDoc TPSSHT01

The time framework for carrying out the shipment is given in transportation processing (005) in the planned start and end dates.

Loading (003) is optional and contains planned start and end dates.

Time of transportation planning (001) is optional. It contains planned end dates. If it is not specified, then the posting time is determined automatically in the R/3 shipment document as the transportation planning time.

Segment E2EDT17 (Process at Shipment Stage Level) in IDoc TSPSHT01

Field QUALF: Only the date with qualifier '011' (Waiting time) is taken into account. All other dates are ignored.

The planned and actual dates (both start and end) for a location are converted into the planned and actual dates for the legs. This means that the end date for a location becomes the start date for the leg that starts at this location. Similarly, the start date of the next location becomes the end date of the leg that finishes at this location.

This can be summarized as follows:

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Location, E2EDT17-NTEND</td>
<td>First leg, VTTS-DPTBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-NTENZ</td>
<td>First leg, VTTS-UPTBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-IEDD</td>
<td>First leg, VTTS-DATBG</td>
</tr>
<tr>
<td>1. Location, E2EDT17-IEDZ</td>
<td>First leg, VTTS-UATBG</td>
</tr>
<tr>
<td>2. Location, E2EDT17-NTANF</td>
<td>First leg, VTTS-DPTEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-NTANZ</td>
<td>First leg, VTTS-UPTEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-ISDD</td>
<td>First leg, VTTS-DATEN</td>
</tr>
<tr>
<td>2. Location, E2EDT17-ISDZ</td>
<td>First leg, VTTS-UATEN</td>
</tr>
</tbody>
</table>

This table would continue similarly for other locations.

The beginning date of the first location and the final dates of the last location are ignored. All the other fields are ignored.

Field E2EDT1x-TZONE_xxx: Time zone:

Time zone code. Value area according to R/3 table field TTZZ-TZONE.
Definition

Business hours profile for the goods receiving times during the week for a customer unloading point.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSGFN</td>
<td>CHAR 03</td>
<td>MSGFN</td>
<td></td>
<td></td>
<td>Message function (blank)</td>
</tr>
<tr>
<td>ABLAD</td>
<td>A</td>
<td>CHAR 25</td>
<td>ABLAD</td>
<td></td>
<td>Unloading point</td>
</tr>
<tr>
<td>KNKAL</td>
<td>8</td>
<td>CHAR 02</td>
<td>KNKAL</td>
<td></td>
<td>Factory calendar</td>
</tr>
<tr>
<td>WANID</td>
<td>8</td>
<td>CHAR 03</td>
<td>WAMOAB1</td>
<td>X</td>
<td>Profile number of goods receiving profile</td>
</tr>
<tr>
<td>WAMOAB1</td>
<td>TIMS 06</td>
<td>WAMOAB1</td>
<td></td>
<td></td>
<td>Business hours begin Monday morning</td>
</tr>
<tr>
<td>WAMOBI1</td>
<td>TIMS 06</td>
<td>WAMOBI1</td>
<td></td>
<td></td>
<td>Business hours end Monday morning</td>
</tr>
<tr>
<td>WAMOAB2</td>
<td>TIMS 06</td>
<td>WAMOAB2</td>
<td></td>
<td></td>
<td>Business hours begin Monday afternoon</td>
</tr>
<tr>
<td>WAMOBI2</td>
<td>TIMS 06</td>
<td>WAMOBI2</td>
<td></td>
<td></td>
<td>Business hours end Monday afternoon</td>
</tr>
<tr>
<td>WADIAB1</td>
<td>TIMS 06</td>
<td>WADIAB1</td>
<td></td>
<td></td>
<td>Business hours begin Tuesday morning</td>
</tr>
<tr>
<td>WADIBI1</td>
<td>TIMS 06</td>
<td>WADIBI1</td>
<td></td>
<td></td>
<td>Business hours end Tuesday morning</td>
</tr>
<tr>
<td>WADIAB2</td>
<td>TIMS 06</td>
<td>WADIAB2</td>
<td></td>
<td></td>
<td>Business hours begin Tuesday afternoon</td>
</tr>
<tr>
<td>WADIBI2</td>
<td>TIMS 06</td>
<td>WADIBI2</td>
<td></td>
<td></td>
<td>Business hours end Tuesday afternoon</td>
</tr>
<tr>
<td>WAMIAB1</td>
<td>TIMS 06</td>
<td>WAMIAB1</td>
<td></td>
<td></td>
<td>Business hours begin Wednesday morning</td>
</tr>
<tr>
<td>WAMIBI1</td>
<td>TIMS 06</td>
<td>WAMIBI1</td>
<td></td>
<td></td>
<td>Business hours end Wednesday morning</td>
</tr>
<tr>
<td>WAMIAB2</td>
<td>TIMS 06</td>
<td>WAMIAB2</td>
<td></td>
<td></td>
<td>Business hours begin Wednesday afternoon</td>
</tr>
<tr>
<td>WAMIBI2</td>
<td>TIMS 06</td>
<td>WAMIBI2</td>
<td></td>
<td></td>
<td>Business hours end Wednesday afternoon</td>
</tr>
</tbody>
</table>
## E2KNVAM - Business Hours Profiles

<table>
<thead>
<tr>
<th>Code</th>
<th>Time</th>
<th>Code</th>
<th>Time</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WADOAB1</td>
<td>TIMS 06</td>
<td>WADOAB1</td>
<td></td>
<td>Business hours begin Thursday morning</td>
</tr>
<tr>
<td>WADOBI1</td>
<td>TIMS 06</td>
<td>WADOBI1</td>
<td></td>
<td>Business hours end Thursday morning</td>
</tr>
<tr>
<td>WADOAB2</td>
<td>TIMS 06</td>
<td>WADOAB2</td>
<td></td>
<td>Business hours begin Thursday afternoon</td>
</tr>
<tr>
<td>WADOBI2</td>
<td>TIMS 06</td>
<td>WADOBI2</td>
<td></td>
<td>Business hours end Thursday afternoon</td>
</tr>
<tr>
<td>WAFRAB1</td>
<td>TIMS 06</td>
<td>WAFRAB1</td>
<td></td>
<td>Business hours begin Friday morning</td>
</tr>
<tr>
<td>WAFRBI1</td>
<td>TIMS 06</td>
<td>WAFRBI1</td>
<td></td>
<td>Business hours end Friday morning</td>
</tr>
<tr>
<td>WAFRAB2</td>
<td>TIMS 06</td>
<td>WAFRAB2</td>
<td></td>
<td>Business hours begin Friday afternoon</td>
</tr>
<tr>
<td>WAFRBI2</td>
<td>TIMS 06</td>
<td>WAFRBI2</td>
<td></td>
<td>Business hours end Friday afternoon</td>
</tr>
<tr>
<td>WASAAB1</td>
<td>TIMS 06</td>
<td>WASAAB1</td>
<td></td>
<td>Business hours begin Saturday morning</td>
</tr>
<tr>
<td>WASABI1</td>
<td>TIMS 06</td>
<td>WASABI1</td>
<td></td>
<td>Business hours end Saturday morning</td>
</tr>
<tr>
<td>WASAAB2</td>
<td>TIMS 06</td>
<td>WASAAB2</td>
<td></td>
<td>Business hours begin Saturday afternoon</td>
</tr>
<tr>
<td>WASABI2</td>
<td>TIMS 06</td>
<td>WASABI2</td>
<td></td>
<td>Business hours end Saturday afternoon</td>
</tr>
<tr>
<td>WASOAB1</td>
<td>TIMS 06</td>
<td>WASOAB1</td>
<td></td>
<td>Business hours begin Sunday morning</td>
</tr>
<tr>
<td>WASOBI1</td>
<td>TIMS 06</td>
<td>WASOBI1</td>
<td></td>
<td>Business hours end Sunday morning</td>
</tr>
<tr>
<td>WASOAB2</td>
<td>TIMS 06</td>
<td>WASOAB2</td>
<td></td>
<td>Business hours begin Sunday afternoon</td>
</tr>
<tr>
<td>WASOBI2</td>
<td>TIMS 06</td>
<td>WASOBI2</td>
<td></td>
<td>Business hours end Sunday afternoon</td>
</tr>
<tr>
<td>DEFAB</td>
<td>CHAR 01</td>
<td>DEFAB</td>
<td></td>
<td>Indicator for the standard unloading point</td>
</tr>
</tbody>
</table>
# E2STATS - EDI Status Record

## Definition

Status and error information is transferred into segment E2STATS.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TABNAM</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td></td>
<td>Name of the table structure (blank)</td>
</tr>
<tr>
<td>MANDT</td>
<td>CHAR 03</td>
<td>MANDT</td>
<td></td>
<td></td>
<td>Client</td>
</tr>
<tr>
<td>DOCNUM</td>
<td>CHAR 16</td>
<td>X</td>
<td></td>
<td></td>
<td>IDoc number of incorrect document</td>
</tr>
<tr>
<td>LOGDAT</td>
<td>DATS 08</td>
<td>X</td>
<td></td>
<td></td>
<td>Date</td>
</tr>
<tr>
<td>LOGTIM</td>
<td>TIMS 06</td>
<td>X</td>
<td></td>
<td></td>
<td>Time</td>
</tr>
<tr>
<td>STATUS</td>
<td>1</td>
<td>CHAR 02</td>
<td>X</td>
<td></td>
<td>Status of incorrect IDoc</td>
</tr>
<tr>
<td>UNAME</td>
<td>CHAR 12</td>
<td></td>
<td></td>
<td></td>
<td>User name</td>
</tr>
<tr>
<td>REPID</td>
<td>CHAR 08</td>
<td></td>
<td></td>
<td></td>
<td>Program name</td>
</tr>
<tr>
<td>ROUTID</td>
<td>CHAR 30</td>
<td></td>
<td></td>
<td></td>
<td>Subroutine name</td>
</tr>
<tr>
<td>STACOD</td>
<td>3</td>
<td>CHAR 08</td>
<td>X</td>
<td></td>
<td>Status code</td>
</tr>
<tr>
<td>STATXT</td>
<td>3, 6</td>
<td>CHAR 70</td>
<td>X</td>
<td></td>
<td>Status code text</td>
</tr>
<tr>
<td>SEGNUM</td>
<td>CHAR 06</td>
<td></td>
<td></td>
<td></td>
<td>Segment number</td>
</tr>
<tr>
<td>SEGFLD</td>
<td>CHAR 10</td>
<td></td>
<td></td>
<td></td>
<td>Field name</td>
</tr>
<tr>
<td>STAPA1</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td></td>
<td>Parameter 1</td>
</tr>
<tr>
<td>STAPA2</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td></td>
<td>Parameter 2</td>
</tr>
<tr>
<td>STAPA3</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td></td>
<td>Parameter 3</td>
</tr>
<tr>
<td>STAPA4</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td></td>
<td>Parameter 4</td>
</tr>
<tr>
<td>REFINT</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td></td>
<td>Reference to file</td>
</tr>
<tr>
<td>REFGRP</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td></td>
<td>Reference to message</td>
</tr>
<tr>
<td>REMES</td>
<td>CHAR 14</td>
<td></td>
<td></td>
<td></td>
<td>Reference to message</td>
</tr>
<tr>
<td>ARCKEY</td>
<td>CHAR 70</td>
<td></td>
<td></td>
<td></td>
<td>Document ID in the external system</td>
</tr>
<tr>
<td>STATYP</td>
<td>1</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>System message category</td>
</tr>
</tbody>
</table>

## Special fields and domain values in segment E2STATS

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2STATS.
E2STATS - EDI Status Record

**Feld E2STATS-STATUS: Status of incorrect IDoc**

Status values for IDoc used within the communication.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>IDoc was successfully processed (possibly with warnings)</td>
</tr>
<tr>
<td>17</td>
<td>IDoc could not be processed</td>
</tr>
</tbody>
</table>

**E2STATS-STACOD Field : Status Code**

Status or error message code, as available in the R/3 system. Generally, the code is always 'SAPV6xxx', whereby digits 'xxx' are predefined as follows:

<table>
<thead>
<tr>
<th>Area</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>000-499</td>
<td>Messages from the forwarding agent to R/3</td>
</tr>
<tr>
<td>500-999</td>
<td>Messages from the R/3 system to the forwarding agent</td>
</tr>
</tbody>
</table>

You can compare the messages manually between the systems so that if there is a message in the destination system only defined by a status code, its corresponding long text will appear.

**E2STATS-ARCKEY Field: Document ID in External System**

An identification predefined by the subsystem is created in the ARCKEY field. If you cannot process a document sent by the subsystem to the R/3 system, the contents of the ARCKEY field from the incorrect IDoc will be sent back in the ARCKEY field in the error message. This will allow you to recreate the reference to the process that generated the document.

**E2STATS-STATYP Field: System Message Category**

Category of the system message

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Status message after successful transaction</td>
</tr>
<tr>
<td>I</td>
<td>Information message (note)</td>
</tr>
<tr>
<td>W</td>
<td>Warning</td>
</tr>
<tr>
<td>E</td>
<td>Error message</td>
</tr>
<tr>
<td>A</td>
<td>Termination message (serious error)</td>
</tr>
</tbody>
</table>
E2TPACC - Action Code

Definition

Actions code that specifies which action should be carried out with the corresponding document. The segment is used in IDocs TPSLOC01, TPSDLS01 and TPSSHT01.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTCD</td>
<td>1</td>
<td>CHAR 01</td>
<td>X</td>
<td></td>
<td>Action code</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPACC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPACC.

E2TPACC-ACTCD Field: Action Code

This field can have the following values in the IDocs specified:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>TPSLOC01</th>
<th>TPSDLS01</th>
<th>TPSSHT01</th>
<th>TPSSH01</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Create document</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>Change document</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Delete document</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Fix shipment document status (no changes permitted)</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>U</td>
<td>Set shipment document status to released (changes permitted)</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>X</td>
<td>Rejection of deliveries for planning SHPCPR new segments E2TPSHH header ACC action code SHI rejected delivery</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
E2TPCOC - Goods Code

Definition
Goods code for material in a delivery item. A delivery item can have several codes.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODTYP</td>
<td>8</td>
<td>CHAR 03</td>
<td>X</td>
<td>X</td>
<td>Code category</td>
</tr>
<tr>
<td>CODNUM</td>
<td>(9)</td>
<td>CHAR 35</td>
<td>X</td>
<td>X</td>
<td>Code number</td>
</tr>
<tr>
<td>CODTXT</td>
<td></td>
<td>CHAR 50</td>
<td></td>
<td></td>
<td>Code description</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPCOC
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPCOC.

Field E2TPCOC-CODTYP: Code category
The code category specifies which code type the code number is related to:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>Commodity code</td>
</tr>
<tr>
<td>002</td>
<td>Freight code</td>
</tr>
<tr>
<td>003</td>
<td>Material freight group</td>
</tr>
</tbody>
</table>
**E2TPDIH - Delivery Dimensions at Header Level**

Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRSWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>GRSVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td></td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

**Special fields and domains in segment E2TPDIH**

Please note that all weight and volume units are transferred in ISO standard notes.

**Field E2TPDIH-WUNIT: Unit of weight**

Possible weight units in ISO:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CGM</td>
<td>Centigram</td>
</tr>
<tr>
<td>DTN</td>
<td>Hundredweight, deciton</td>
</tr>
<tr>
<td>GRM</td>
<td>Gram</td>
</tr>
<tr>
<td>GRT</td>
<td>Gross register ton</td>
</tr>
<tr>
<td>DTH</td>
<td>Hectokilogram</td>
</tr>
<tr>
<td>KGM</td>
<td>Kilogram</td>
</tr>
<tr>
<td>KTN</td>
<td>Kiloton</td>
</tr>
<tr>
<td>TNE</td>
<td>Ton</td>
</tr>
<tr>
<td>MGM</td>
<td>Milligram</td>
</tr>
<tr>
<td>NTT</td>
<td>Net register ton</td>
</tr>
<tr>
<td>LBR</td>
<td>Pound</td>
</tr>
<tr>
<td>SHT</td>
<td>Shipping tons</td>
</tr>
<tr>
<td>STN</td>
<td>Short ton (GB)</td>
</tr>
</tbody>
</table>

**Field E2TPDIH-VUNIT: Unit of volume**

Possible volume units in ISO:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLT</td>
<td>Centiliter</td>
</tr>
<tr>
<td>CMQ</td>
<td>Cubic centimeter</td>
</tr>
<tr>
<td>DMQ</td>
<td>Cubic decimeter</td>
</tr>
<tr>
<td>FTQ</td>
<td>Cubic foot</td>
</tr>
<tr>
<td>INQ</td>
<td>Cubic inch</td>
</tr>
<tr>
<td>Code</td>
<td>Unit Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>MTQ</td>
<td>Cubic meter</td>
</tr>
<tr>
<td>MMQ</td>
<td>Cubic millimeter</td>
</tr>
<tr>
<td>YDQ</td>
<td>Cubic yard</td>
</tr>
<tr>
<td>DLT</td>
<td>Deciliter</td>
</tr>
<tr>
<td>BLD</td>
<td>Dry barrel</td>
</tr>
<tr>
<td>GLD</td>
<td>Dry gallon</td>
</tr>
<tr>
<td>PTD</td>
<td>Dry pint</td>
</tr>
<tr>
<td>QTD</td>
<td>Dry quart</td>
</tr>
<tr>
<td>OZI</td>
<td>Fluid ounce (28,413 cm³)</td>
</tr>
<tr>
<td>OZA</td>
<td>Fluid ounce (29,573 cm³)</td>
</tr>
<tr>
<td>GLI</td>
<td>Gallon</td>
</tr>
<tr>
<td>HLT</td>
<td>Hectoliter</td>
</tr>
<tr>
<td>GLL</td>
<td>Liquid gallon</td>
</tr>
<tr>
<td>PTL</td>
<td>Liquid pint</td>
</tr>
<tr>
<td>QTL</td>
<td>Liquid quart</td>
</tr>
<tr>
<td>LTR</td>
<td>Liter</td>
</tr>
<tr>
<td>MAL</td>
<td>Megaliter</td>
</tr>
<tr>
<td>PTI</td>
<td>Pint</td>
</tr>
<tr>
<td>QTI</td>
<td>Quart</td>
</tr>
</tbody>
</table>
E2TPDII - Delivery Dimensions at Item Level

Definition
Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRSWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>GRSVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td></td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDII
Please note that all weight and volume units are transferred in ISO standard notes. The domain values are the same as those for segment E2TPDIH.
E2TPDIS – Dimensions of Handling Unit

Definition
Segment E2TPDIH contains the dimensions of the whole delivery.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TARWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Tare weight</td>
</tr>
<tr>
<td>GRSWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>gross weight</td>
</tr>
<tr>
<td>NETWGT</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net weight</td>
</tr>
<tr>
<td>WUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO weight unit</td>
</tr>
<tr>
<td>TARVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Tare volume</td>
</tr>
<tr>
<td>GRSVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Gross volume</td>
</tr>
<tr>
<td>NETVOL</td>
<td></td>
<td>QUAN 18</td>
<td>MENG15</td>
<td></td>
<td>Net volume</td>
</tr>
<tr>
<td>VUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO volume unit</td>
</tr>
<tr>
<td>LENGTH</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Length</td>
</tr>
<tr>
<td>WIDTH</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Width</td>
</tr>
<tr>
<td>HEIGHT</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Height</td>
</tr>
<tr>
<td>DUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>ISO length unit</td>
</tr>
<tr>
<td>ITMNUM</td>
<td></td>
<td>NUMC 05</td>
<td>ANZPK</td>
<td></td>
<td>Number of packing units</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDIS
Please note that all weight and volume units are transferred in ISO standard notes. The domain values are similar to the values for segment E2TPDIH.

Field E2TPDIH-DUNIT: Unit of length
Possible ISO length units:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMT</td>
<td>Centimeter</td>
</tr>
<tr>
<td>DMT</td>
<td>Decimeter</td>
</tr>
<tr>
<td>FOT</td>
<td>Foot</td>
</tr>
<tr>
<td>INH</td>
<td>Inch</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Transportation connection point</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
</tbody>
</table>
E2TPDLC - Shipment Costs at Delivery Level

Definition
Shipment costs item for a delivery within a shipment.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td>Cost type</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td></td>
<td>QUAN 18</td>
<td>X</td>
<td>Amount</td>
<td></td>
</tr>
<tr>
<td>CURRC</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>X</td>
<td>Currency (ISO norm)</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDLC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLC.

Field E2TPDLC-CSTTYP: Cost element
Cost types are not defined when the shipment costs are entered. They are defined when the shipment costs are implemented.

Field E2TPDLC-CURRC: Currency in ISO Standard
Currency key set to ISO norms with the value area of R/3 table field TCURC-ICOCD.
E2TPDLH - Delivery Header

**Definition**

Organizational and status information at delivery header level.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELID</td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Delivery indicator/number</td>
<td></td>
</tr>
<tr>
<td>SHPPPT</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation Planning Point (TPP)</td>
<td></td>
</tr>
<tr>
<td>SHPPRJ</td>
<td>CHAR 12</td>
<td></td>
<td>X</td>
<td>Shipment in the same vehicle</td>
<td></td>
</tr>
<tr>
<td>SCHDNM</td>
<td>CHAR 06</td>
<td></td>
<td>X</td>
<td>Planning process number</td>
<td></td>
</tr>
<tr>
<td>SALORG</td>
<td>CHAR 04</td>
<td>VKORG</td>
<td></td>
<td>Org. unit for defining plan number</td>
<td></td>
</tr>
<tr>
<td>DSTCHN</td>
<td>CHAR 02</td>
<td>VTWEG</td>
<td></td>
<td>Org. unit for defining plan number</td>
<td></td>
</tr>
<tr>
<td>DIVISN</td>
<td>CHAR 02</td>
<td>SPART</td>
<td></td>
<td>Org. unit for defining plan number</td>
<td></td>
</tr>
<tr>
<td>CPONUM</td>
<td>CHAR 20</td>
<td>BSTNK</td>
<td></td>
<td>Customer’s purchase order number</td>
<td></td>
</tr>
<tr>
<td>SHPCND</td>
<td>CHAR 02</td>
<td>VSBED</td>
<td></td>
<td>Shipping condition</td>
<td></td>
</tr>
<tr>
<td>SHPTYP</td>
<td>CHAR 02</td>
<td>VSART</td>
<td>X</td>
<td>Shipping type</td>
<td></td>
</tr>
<tr>
<td>SHPPRI</td>
<td>CHAR 02</td>
<td>LPRIO</td>
<td></td>
<td>Shipping priority</td>
<td></td>
</tr>
<tr>
<td>DIREC</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Direction of the delivery</td>
<td></td>
</tr>
<tr>
<td>FTERM</td>
<td>CHAR 03</td>
<td>INCO1</td>
<td>X</td>
<td>Incoterm</td>
<td></td>
</tr>
<tr>
<td>FTLOC</td>
<td>CHAR 28</td>
<td>INCO2</td>
<td></td>
<td>Incoterm location</td>
<td></td>
</tr>
<tr>
<td>ROUTE</td>
<td>CHAR 06</td>
<td>ROUTE</td>
<td>X</td>
<td>Route</td>
<td></td>
</tr>
<tr>
<td>ROUTXT</td>
<td>CHAR 40</td>
<td>TEXT40</td>
<td></td>
<td>Route text</td>
<td></td>
</tr>
<tr>
<td>PREFCA</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Preferred forwarding agent</td>
<td></td>
</tr>
<tr>
<td>CNSFLG</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Consolidation status</td>
<td></td>
</tr>
<tr>
<td>LODSEQ</td>
<td>NUMC 01</td>
<td></td>
<td></td>
<td>Load sequence</td>
<td></td>
</tr>
<tr>
<td>ALSTAT</td>
<td>CHAR 01</td>
<td></td>
<td>X</td>
<td>Availability status</td>
<td></td>
</tr>
<tr>
<td>REVENU</td>
<td>CHAR 18</td>
<td></td>
<td></td>
<td>Payment on picking up</td>
<td></td>
</tr>
<tr>
<td>REVCUR</td>
<td>CHAR 03</td>
<td></td>
<td></td>
<td>Payment currency</td>
<td></td>
</tr>
<tr>
<td>RRCODE</td>
<td>CHAR 20</td>
<td></td>
<td></td>
<td>Rail code (US requirement)</td>
<td></td>
</tr>
<tr>
<td>CPONUM2</td>
<td>CHAR 35</td>
<td>BSTNK</td>
<td></td>
<td>Order number of customer (long)</td>
<td></td>
</tr>
<tr>
<td>SHPMNT</td>
<td>CHAR 4</td>
<td>SHTYP</td>
<td></td>
<td>Shipment type (default)</td>
<td></td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPDLH**

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLH.

**Field E2TPDLH-SHPPRJ: Shipment on same vehicle**

This field groups together all the deliveries (IDocs) within a planning run, which are to be planned for the same vehicle in transportation planning.

This field is normally not processed and can be completed using customer functions.

Default value: blank.
Field E2TPDLH-SCHDNM: Planning process number
This field groups together all the deliveries (IDocs) that have to be planned within the same planning run (for separate planning of a 'north' and 'south' tour, for example).
This field is normally not processed and can be completed using customer functions.
Default value: 1.

Field E2TPDLH-DIREC: Direction of delivery
The value for field DIREC is determined using delivery document category
The field can have the following values:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>IB</td>
<td>Inbound - incoming delivery: Returns, shipping notification</td>
</tr>
<tr>
<td>OB</td>
<td>Outbound - outgoing delivery: standard delivery document</td>
</tr>
</tbody>
</table>

Field E2TPDLH-FTERM: INCO term
This field can have the following values according to international standards:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFR</td>
<td>Cost and Freight</td>
</tr>
<tr>
<td>CIF</td>
<td>Cost, Insurance and Freight</td>
</tr>
<tr>
<td>CIP</td>
<td>Carriage and Insurance Paid to</td>
</tr>
<tr>
<td>CPT</td>
<td>Carriage Paid to</td>
</tr>
<tr>
<td>DAF</td>
<td>Delivered at Frontier</td>
</tr>
<tr>
<td>DDP</td>
<td>Delivered Duty Paid</td>
</tr>
<tr>
<td>DDU</td>
<td>Delivered Duty Unpaid</td>
</tr>
<tr>
<td>DEQ</td>
<td>Delivered Ex Quay (duty paid)</td>
</tr>
<tr>
<td>DES</td>
<td>Delivered Ex Ship</td>
</tr>
<tr>
<td>EXW</td>
<td>Ex Works</td>
</tr>
<tr>
<td>FAS</td>
<td>Free Alongside Ship</td>
</tr>
<tr>
<td>FCA</td>
<td>Free Carrier</td>
</tr>
<tr>
<td>FH</td>
<td>Carriage paid (to customer's address)</td>
</tr>
<tr>
<td>FOB</td>
<td>Free on board</td>
</tr>
<tr>
<td>UN</td>
<td>Not paid</td>
</tr>
</tbody>
</table>

Field E2TPDLH-CNSFLG: Consolidation status
The consolidation status determines whether deliveries may be shipped together with other deliveries or not.
This field is normally not processed and can be completed using customer functions.
Default value: blank.
E2TPDLH - Delivery Header

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Delivery may be shipped together with others</td>
</tr>
<tr>
<td>1</td>
<td>Deliveries may not be shipped together with others</td>
</tr>
<tr>
<td>2</td>
<td>Only consolidate deliveries to the same destination</td>
</tr>
</tbody>
</table>

Field E2TPDLH-LODSEQ: Load sequence

The load sequence determines when a delivery has to be loaded onto the means of transport. It does not set a fixed sequence but it indicates priorities.

This field is normally not processed and can be completed using customer functions.

Default value: blank.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delivery must be loaded first</td>
</tr>
<tr>
<td>2</td>
<td>Load delivery first</td>
</tr>
<tr>
<td>3</td>
<td>Load delivery normally</td>
</tr>
<tr>
<td>4</td>
<td>Load delivery last</td>
</tr>
<tr>
<td>5</td>
<td>Delivery must be loaded last</td>
</tr>
</tbody>
</table>

Field E2TPDLH-ALSTAT: Allocation status

The allocation status indicates whether the delivery has already been checked as available and whether the stock has been reserved.

Due to dynamic availability checks in the R/3 system, this field is entered as a default value.

Default value: 0.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Delivery available/reserved/planned</td>
</tr>
<tr>
<td>1</td>
<td>Delivery not planned</td>
</tr>
</tbody>
</table>

Field E2TPDLH-REVCUR: Refund currency

The value fields for the currency of payment correspond to the ISO currency code and also match the ISO currency codes proposed by the R/3 system.
E2TPDLI - Delivery Item

Definition
Delivery item with quantity specifications and material ID.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELITM</td>
<td></td>
<td>CHAR 06</td>
<td>POSNR</td>
<td>X</td>
<td>Delivery item number</td>
</tr>
<tr>
<td>MATNR</td>
<td>B</td>
<td>CHAR 35</td>
<td>MATNR</td>
<td>X</td>
<td>Material number</td>
</tr>
<tr>
<td>MATTXT</td>
<td></td>
<td>CHAR 80</td>
<td>ARKTX</td>
<td></td>
<td>Material description</td>
</tr>
<tr>
<td>HAZMAT</td>
<td>B</td>
<td>CHAR 18</td>
<td>STOFF</td>
<td></td>
<td>Dangerous goods number</td>
</tr>
<tr>
<td>MILMAT</td>
<td>1</td>
<td>CHAR 01</td>
<td>ITARK</td>
<td></td>
<td>Military goods indicator</td>
</tr>
<tr>
<td>QUANT</td>
<td></td>
<td>QUAN 15</td>
<td>LFIMG</td>
<td>X</td>
<td>Delivery quantity</td>
</tr>
<tr>
<td>QNUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>VRKME</td>
<td>X</td>
<td>Unit of measure</td>
</tr>
<tr>
<td>LDGRP</td>
<td>8</td>
<td>CHAR 04</td>
<td>LADGR</td>
<td></td>
<td>Loading group</td>
</tr>
<tr>
<td>TRGRP</td>
<td>8</td>
<td>CHAR 04</td>
<td>TRAGR</td>
<td></td>
<td>Transportation group</td>
</tr>
<tr>
<td>STRCND</td>
<td>8</td>
<td>CHAR 02</td>
<td>RAUBE</td>
<td></td>
<td>Storage conditions</td>
</tr>
<tr>
<td>TMPCEBND</td>
<td>8</td>
<td>CHAR 02</td>
<td>TEMPB</td>
<td></td>
<td>Temperature conditions</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPDLI
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPDLI.

Field E2TPDLI-HAZMAT: Dangerous goods number
Freely-definable number or classification for dangerous goods.

Field E2TPDLI-MILMAT: Indicator for military goods
Indicates that the materials delivered are military goods.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>non-military material</td>
</tr>
<tr>
<td>1</td>
<td>military material</td>
</tr>
</tbody>
</table>

Field E2TPDLI-QNUNIT: Unit of measure
Possible units of quantity according to ISO norms:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DZN</td>
<td>Dozen</td>
</tr>
<tr>
<td>DZP</td>
<td>Dozen packs</td>
</tr>
<tr>
<td>DPR</td>
<td>Dozen pairs</td>
</tr>
<tr>
<td>DPC</td>
<td>Dozen pieces</td>
</tr>
</tbody>
</table>
**E2TPDLI - Delivery Item**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DRL</td>
<td>Dozen rolls</td>
</tr>
<tr>
<td>GGR</td>
<td>Great gross</td>
</tr>
<tr>
<td>GRO</td>
<td>Gross</td>
</tr>
<tr>
<td>KAR</td>
<td>Box</td>
</tr>
<tr>
<td>NMB</td>
<td>Number</td>
</tr>
<tr>
<td>NAR</td>
<td>Number of articles</td>
</tr>
<tr>
<td>NMP</td>
<td>Number of packs</td>
</tr>
<tr>
<td>NPR</td>
<td>Number of pairs</td>
</tr>
<tr>
<td>NPL</td>
<td>Number of packages</td>
</tr>
<tr>
<td>NPT</td>
<td>Number of parts</td>
</tr>
<tr>
<td>NRL</td>
<td>Number of rolls</td>
</tr>
<tr>
<td>CMK</td>
<td>Square centimeters</td>
</tr>
<tr>
<td>DMK</td>
<td>Square decimeters</td>
</tr>
<tr>
<td>FTK</td>
<td>Square feet</td>
</tr>
<tr>
<td>INK</td>
<td>Square inch</td>
</tr>
<tr>
<td>MTK</td>
<td>Square meter</td>
</tr>
<tr>
<td>YDK</td>
<td>Square yard</td>
</tr>
<tr>
<td>PCE</td>
<td>Piece</td>
</tr>
</tbody>
</table>

**Field E2TPDLI-LDGRP: Loading group**
Classification for the loading device (fork lift, for example). Value area according to R/3 table TLGR

**Field E2TPDLI-TRAGR: Transportation group**
Classification for the transport equipment (pallet, for example). Value area according to R/3 table TTGR

**Field E2TPDLI-STRCND: Storage condition**
Classification for storage conditions (store dry, for example). Value area according to R/3 table T142.

**Field E2TPDLI-TMPCND: Temperature condition**
Classification for storage conditions in terms of temperature (2-8°C, for example). Value area according to R/3 table T143.
E2TPEQT - Means of Transport

Definition

Segment E2TPEQT contains specifications for the means of transport used in the shipment (vehicle and packing material).

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUID</td>
<td></td>
<td>CHAR 20</td>
<td>VENUM</td>
<td>X</td>
<td>Means of transport ID</td>
</tr>
<tr>
<td>EQUotyp</td>
<td>2</td>
<td>CHAR 35</td>
<td>VHILM</td>
<td>X</td>
<td>Packaging material type</td>
</tr>
<tr>
<td>EQUITXT</td>
<td></td>
<td>CHAR 40</td>
<td>VEBEZ</td>
<td></td>
<td>Packaging material text</td>
</tr>
<tr>
<td>DRVID1</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Driver 1</td>
</tr>
<tr>
<td>DRVID2</td>
<td></td>
<td>CHAR 35</td>
<td>NAME</td>
<td></td>
<td>Driver 2</td>
</tr>
<tr>
<td>EXTID2</td>
<td></td>
<td>CHAR 20</td>
<td>NAME</td>
<td></td>
<td>External ID 2</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPEQT

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPEQT.

Field E2TPEQT-VENUM: Identification of means of transport

A unique ID for the means of transport within a shipment document, which can be the sequential numbering of the means of transport, for example. The identification can, for example, be a sequential number for the means of transport. If the means of transport is changed, the ID serves as a reference. The same ID numbers may be entered in different shipment documents.

Field E2TPEQT-EQUotyp: Packaging material type

The material number for the packaging material type (20-ft. container, for example). The material numbers of the available packaging materials have to be synchronized manually between the R/3 system and the forwarding agent system.
E2TPFRC - Shipment Costs at Header Level

Definition

Shipment cost item related to an entire shipment.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td>Cost type</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td></td>
<td>QUAN 18</td>
<td>X</td>
<td>Amount</td>
<td></td>
</tr>
<tr>
<td>CURRC</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>X</td>
<td>Currency (ISO norm)</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPFRC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPFRC.

Field E2TPFRC-CSTTYP: Cost element

'ACST' current costs: Mapping to current costs shipment header

Field E2TPFRC-CURRC: Currency in ISO Standard

Currency key set to ISO norms with the value area of R/3 table field TCURC-ICOCD.
E2TPLCT - Location Code

Definition
Location code for a location master record. A location master record can have several codes.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCCTP</td>
<td>8</td>
<td>CHAR 06</td>
<td>X</td>
<td>Code category</td>
<td></td>
</tr>
<tr>
<td>LOCCOD</td>
<td></td>
<td>CHAR 35</td>
<td>X</td>
<td>Code number</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPLCT
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPLCT.

Field E2TPLCT-CODTYP: Code category
The code category specifies which code type the code number is related to:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCAC</td>
<td>Standard carrier code</td>
</tr>
<tr>
<td>SPLC</td>
<td>Standard location code</td>
</tr>
<tr>
<td>ILN</td>
<td>International location number</td>
</tr>
</tbody>
</table>
E2TPNOT - Delivery Texts

Definition

Shipping-specific texts for the delivery. Texts are grouped according to types. Texts with more than one line are stored in sequential segments.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTTYP</td>
<td>8</td>
<td>CHAR 04</td>
<td>X</td>
<td></td>
<td>Text category</td>
</tr>
<tr>
<td>NOTTXT</td>
<td></td>
<td>CHAR 200</td>
<td>X</td>
<td></td>
<td>Text</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPNOT

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPNOT.

Field E2TPNOT-NOTTYP: Text type

The text category specifies the type of text in the segment. Possible text categories come from the value area of the R/3 table field TTXID-TDID for text object TTXID-TDOBJECT = ‘VBBK’ (SD header texts).
**E2TPSHA - Transportation Activity**

**Definition**

Activity within a shipment document that is assigned to a transportation connection point.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASQNUM</td>
<td></td>
<td>NUMC 06</td>
<td></td>
<td>X</td>
<td>Activity number</td>
</tr>
<tr>
<td>ACTVTY</td>
<td>8</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Activity category</td>
</tr>
<tr>
<td>DELID</td>
<td></td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Relevant delivery</td>
</tr>
<tr>
<td>SRVAGT</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Relevant service agent</td>
</tr>
</tbody>
</table>

**Special Fields and Domain Values in Segment E2TPSHA**

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHA.

**Field E2TPSHA-ASQNUM: Activity number**

Sequential numbering of activities in a transportation connection point. Different transportation connection points may contain the same activity numbers. Think of activity numbers as sequence specifications.

**Field E2TPSHA-ACTVTY: Activity category**

The activity category specifies which activities are to be carried out. While processing an inbound shipment, the activity for a defined delivery (field DELID) is carried out by a defined service agent (field SRVAGT).

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD / UL</td>
<td>Load / unload delivery</td>
<td>A delivery with the number DELID is loaded at the respective location. It remains loaded until it is unloaded at another location (ACTVTY = UL). This means that this delivery is assigned to all legs in the shipment document that are situated between the two locations (function ‘deliveries to stage’ at stage overview in the shipment document, table VTSP). As soon as the service agent has been determined for one of these two activities and if this deviates from the normal service agent for the leg, a new stage is generated in the shipment document with a ‘load transfer’ category. The deliveries that are (un)loaded by the service agent are assigned to this stage.</td>
</tr>
</tbody>
</table>
### E2TPSHA - Transportation Activity

<table>
<thead>
<tr>
<th>Code</th>
<th>Activity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LT</td>
<td>Load transfer</td>
<td>Here, a new stage from the 'load transfer' category (regardless of the value in the service agent field) is generated and the delivery specified is assigned to it. (If 4 deliveries are to be transferred, the 'load transfer' activity must take place for each delivery.)</td>
</tr>
<tr>
<td>CU</td>
<td>Clear delivery for customs</td>
<td>In this way, a shipment stage of the type 'border' is generated in the same way as the 'load' activity.</td>
</tr>
</tbody>
</table>
E2TPSHH - Shipment Header

Definition
Organizational and status information at shipment header level.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req'd field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPID</td>
<td></td>
<td>CHAR 10</td>
<td>TKNUM</td>
<td>X</td>
<td>Shipment number</td>
</tr>
<tr>
<td>SHPTYP</td>
<td>5</td>
<td>CHAR 04</td>
<td>SHTYP</td>
<td>X</td>
<td>Shipment type</td>
</tr>
<tr>
<td>CARRID</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Service agents</td>
</tr>
<tr>
<td>SHPPPT</td>
<td>5, 8</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation planning point</td>
</tr>
<tr>
<td>DISTNC</td>
<td>QUAN 15</td>
<td>MEING13</td>
<td></td>
<td></td>
<td>Total distance</td>
</tr>
<tr>
<td>DSUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>Unit of distance, according to ISO norms</td>
</tr>
<tr>
<td>DRVTIM</td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td></td>
<td>Traveling time only</td>
</tr>
<tr>
<td>TOTTIM</td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td></td>
<td>Total shipment time</td>
</tr>
<tr>
<td>TMUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEIZT</td>
<td></td>
<td>Standard ISO unit of time</td>
</tr>
<tr>
<td>SRVID1</td>
<td>CHAR 20</td>
<td>EXTI1</td>
<td></td>
<td></td>
<td>External identification 1</td>
</tr>
<tr>
<td>SRVID2</td>
<td>CHAR 20</td>
<td>EXTI2</td>
<td></td>
<td></td>
<td>External identification 2</td>
</tr>
<tr>
<td>SIGNAT</td>
<td>CHAR 20</td>
<td>SIGNI</td>
<td></td>
<td></td>
<td>Signature</td>
</tr>
<tr>
<td>DESCRP</td>
<td>CHAR 20</td>
<td>TPBEZ</td>
<td></td>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>A0001</td>
<td>CHAR 10</td>
<td>VTTK_A0001</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text 1</td>
<td>CHAR 40</td>
<td>VTTK_TXT1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSHH

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHH.

Field E2TPSHH-SHPID: Shipment number

Shipment document number. The shipment number is subject to important marginal conditions, which must be guaranteed by the transportation planning system.

The shipment number
- May only contain numerical characters
- Must be unique to the shipment document
- Must come from the external number range assigned to the transportation planning point in R/3 Customizing (transaction 0VTP). The number range can be set to your requirements in the R/3 system client setup so that the given corresponding document numbers are also guaranteed in the transportation planning system.
- Empty: Internal number assignment by shipment type
E2TPSHH - Shipment Header

CARRID and SRVID1 for identification

- Filled: External number assignment

Field E2TPSHH-SHPTYP: Shipment type

You define the shipment type in R/3 Customizing (transaction OVTK). It describes the following aspects of the shipment:

- Shipment mode (partial load, full load)
- Means of transport (truck, rail)
- Direction (inbound or outbound shipment)
- Leg indicator (direct leg, preliminary leg, main leg, subsequent leg)

The shipment types that have to be made available to the transportation planning system must be created in R/3 Customizing with the corresponding parameters in order to guarantee seamless interface performance.

Field E2TPSHH-SHPPPT: Transportation planning point

The transportation planning point corresponds to the transportation planning system and must be adopted directly from field E2TPDLH-SHPPPT of IDoc TPSDL0. As it is not possible to plan across planning points in a shipment, only one transportation planning point can appear in a shipment for consolidated deliveries.

If a planning system is linked to several planning points, it is important that you ensure that the deliveries for the different transportation planning points are processed separately. These deliveries must not get mixed up during planning.

Field E2TPSHH-DSUNIT: Unit of measure for distance in ISO standard

Available ISO units of distance:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMI</td>
<td>Nautical miles</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Transportation connection point</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
</tbody>
</table>

Field E2TPSHH-TMUNIT: Unit of measure for distance in ISO standard

Available ISO units of time:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAY</td>
<td>Days</td>
</tr>
<tr>
<td>HUR</td>
<td>Hours</td>
</tr>
<tr>
<td>MIN</td>
<td>Minutes</td>
</tr>
<tr>
<td>MON</td>
<td>Months</td>
</tr>
<tr>
<td>SEC</td>
<td>Seconds</td>
</tr>
<tr>
<td>WEE</td>
<td>Weeks</td>
</tr>
<tr>
<td>-----</td>
<td>-------</td>
</tr>
<tr>
<td>ANN</td>
<td>Years</td>
</tr>
</tbody>
</table>
E2TPSHI - Delivery in Shipment

Definition
Delivery assigned to a shipment document.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPITM</td>
<td>NUMC 04</td>
<td>TPNUM</td>
<td>X</td>
<td>Loading sequence of the delivery</td>
<td></td>
</tr>
<tr>
<td>DELID</td>
<td>CHAR 10</td>
<td>VBELN</td>
<td>X</td>
<td>Delivery number</td>
<td></td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSHI
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHI.

Field E2TPSHI-SHPITM: Load sequence for delivery
Sequential numbering of deliveries in a shipment. The numbering also represents the load sequence.
E2TPSHR - Rail Data

**Definition**

This segment contains specialized data related to railways.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RRDESC</td>
<td></td>
<td>CHAR 100</td>
<td></td>
<td>X</td>
<td>Railway route description</td>
</tr>
</tbody>
</table>

**Special fields and domain values in segment E2TPSHR**

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHR.

**Field E2TPSHR-RRDESC: Rail route description**

The code that describes the railway route (special US requirement).
E2TPSHT - Leg Data in Shipment

Definition

Data about leg stages and their related duration within a shipment. Each piece of data must be stored with reference to a shipment point and represents distance and duration from the referenced point to the following point. Therefore, the last point in the transportation connection point list contains no leg data.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjus.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISTNC</td>
<td></td>
<td>QUAN 15</td>
<td>MENG13</td>
<td></td>
<td>Distance of the following leg</td>
</tr>
<tr>
<td>DSUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEINS</td>
<td></td>
<td>Unit of distance, according to ISO norms</td>
</tr>
<tr>
<td>DRVTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Traveling time only - following leg</td>
</tr>
<tr>
<td>TOTTIM</td>
<td></td>
<td>QUAN 05</td>
<td>DIFZT</td>
<td></td>
<td>Total time of the following leg</td>
</tr>
<tr>
<td>TMUNIT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>MEIZT</td>
<td></td>
<td>Standard ISO unit of time</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSHT

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHT.

Field E2TPSHT-DSUNIT: Unit of measure for distance in ISO standard

Available ISO units of distance:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>NMI</td>
<td>Nautical miles</td>
</tr>
<tr>
<td>KMT</td>
<td>Kilometer</td>
</tr>
<tr>
<td>KNT</td>
<td>Transportation connection point</td>
</tr>
<tr>
<td>MTR</td>
<td>Meter</td>
</tr>
</tbody>
</table>

Field E2TPSHT-TMUNIT: Unit of measure for distance in ISO standard

Available ISO units of time:

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAY</td>
<td>Days</td>
</tr>
<tr>
<td>HUR</td>
<td>Hours</td>
</tr>
<tr>
<td>MIN</td>
<td>Minutes</td>
</tr>
<tr>
<td>MON</td>
<td>Months</td>
</tr>
<tr>
<td>SEC</td>
<td>Seconds</td>
</tr>
<tr>
<td>WEE</td>
<td>Weeks</td>
</tr>
<tr>
<td>ANN</td>
<td>Years</td>
</tr>
</tbody>
</table>
E2TPSHU - Handling Unit

Definition
Handling unit for packing delivery items.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHUNUM</td>
<td></td>
<td>CHAR 10</td>
<td>VENUM</td>
<td>X</td>
<td>HU number</td>
</tr>
<tr>
<td>SHPUID</td>
<td>2</td>
<td>CHAR 35</td>
<td>VHILM</td>
<td>X</td>
<td>Packaging material type</td>
</tr>
<tr>
<td>SHPUTX</td>
<td></td>
<td>CHAR 80</td>
<td>MAKTX</td>
<td>X</td>
<td>Packaging material text</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSHU
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSHU.

Field E2TPSHU-SHUNUM: HU number
Number of handling unit. This number is used for unique identification of the handling unit.

Field E2TPSHU-SHPUID: Packaging material type
The material number for the packaging material type (20-ft. container, for example). The material numbers of the available handling units have to be synchronized manually between the R/3 system and the transportation planning system.
E2TPSLS - Transportation Connection Points

Definition

Location or transportation points visited in the course of a shipment and at which activities take place or which have processes that need to be completed.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSQNUM</td>
<td></td>
<td>NUMC 06</td>
<td>X</td>
<td></td>
<td>Location number (sequence)</td>
</tr>
<tr>
<td>CARRID</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td></td>
<td>Relevant service agent</td>
</tr>
</tbody>
</table>

Special fields and domain values in segment E2TPSLS

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSLS.

Field E2TPSLS-LSQNUM: Location number

Sequential numbering of locations visited or transportation points involved in the shipment run. The location number must be in sequence specification form and should be specified beginning with 1 in ascending order with no gaps.

Field E2TPSLS-CARRID: Executing service agent

Service agent who carries out the shipment in the following leg stage.

The following example is plausible when processing the inbound shipment (IDoc TPSSHT01).

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Location with service agent A</td>
<td>1. Leg from first location to second location with service agent A</td>
</tr>
<tr>
<td>2. Location with service agent B</td>
<td>2. Leg from second location to third location with service agent B</td>
</tr>
<tr>
<td>3. Location with service agent C</td>
<td>Service agent C is ignored</td>
</tr>
</tbody>
</table>
E2TPSUC - Handling Unit Contents

Definition

Description of a contents item of a handling unit. A handling unit can have altogether several contents items that are listed as full delivery items, partial delivery items, or even further handling units. The specifications for the contents can contain as many hierarchy levels as you like. One content item is represented in each segment E2TPSUC.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHUITM</td>
<td></td>
<td>CHAR 06</td>
<td>VEPOS</td>
<td></td>
<td>Content item number</td>
</tr>
<tr>
<td>CONTYP</td>
<td>1</td>
<td>CHAR 01</td>
<td>VELIN</td>
<td>X</td>
<td>Content type</td>
</tr>
<tr>
<td>DELITM</td>
<td></td>
<td>CHAR 06</td>
<td>POSNR</td>
<td></td>
<td>Item number of delivery item</td>
</tr>
<tr>
<td>SUBSHU</td>
<td></td>
<td>CHAR 10</td>
<td>UNVEL</td>
<td></td>
<td>Number of included HU</td>
</tr>
<tr>
<td>DELQUN</td>
<td></td>
<td>QUAN 15</td>
<td>VEMNG</td>
<td></td>
<td>Quantity of packed delivery items</td>
</tr>
<tr>
<td>DELUNT</td>
<td>8, 9</td>
<td>CHAR 03</td>
<td>VEMEH</td>
<td></td>
<td>Quantity unit in ISO norms</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPSUC

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPSUC.

Field E2TPSUC-CONTYP: Content type

This value specifies what type of content item the handling unit is. Different data fields from segment E2TPSUC are completed according to the type of content.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Completed segment fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delivery item</td>
<td>DELITM, DELQUN, DELUNT</td>
</tr>
<tr>
<td>3</td>
<td>Handling unit</td>
<td>SUBSHU</td>
</tr>
</tbody>
</table>
E2TPTIW - Time Frame

Definition
Description of alternative opening and closing time frames for weekdays or a certain date.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>WINMOD</td>
<td>1</td>
<td>CHAR 01</td>
<td>X</td>
<td></td>
<td>Time frame mode</td>
</tr>
<tr>
<td>WINDOW</td>
<td>1</td>
<td>CHAR 01</td>
<td></td>
<td></td>
<td>Weekday</td>
</tr>
<tr>
<td>WINDAT</td>
<td></td>
<td>DATS 08</td>
<td></td>
<td></td>
<td>Date</td>
</tr>
<tr>
<td>WINTM1</td>
<td></td>
<td>TIMS 06</td>
<td>X</td>
<td></td>
<td>Beginning time of time frame</td>
</tr>
<tr>
<td>WINTM2</td>
<td></td>
<td>TIMS 06</td>
<td>X</td>
<td></td>
<td>End time of time frame</td>
</tr>
<tr>
<td>ETZONE</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZONE</td>
<td></td>
<td>Time zone</td>
</tr>
<tr>
<td>WINPRF</td>
<td>8</td>
<td>CHAR 03</td>
<td>WANID</td>
<td></td>
<td>Business hours profile</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTIW
Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTIW.

Field E2TPTIW-WINMOD: Mode of time frame
This mode value specifies whether the frame defines an opening or closing time.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>O</td>
<td>Open time frame</td>
</tr>
<tr>
<td>C</td>
<td>Close time frame</td>
</tr>
</tbody>
</table>

Feld E2TPTIW-WINDOW: Weekday
If this field is completed, then the time frame is valid regularly for a certain weekday.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monday</td>
</tr>
<tr>
<td>2</td>
<td>Tuesday</td>
</tr>
<tr>
<td>3</td>
<td>Wednesday</td>
</tr>
<tr>
<td>4</td>
<td>Thursday</td>
</tr>
<tr>
<td>5</td>
<td>Friday</td>
</tr>
</tbody>
</table>
**Field E2TPTIW-ETZONE: Time zone**

Time zone code. Value area according to R/3 table field TTZZ-TZONE.
E2TPTRM- Location Identification

Definition

Segment E2TPTRM contains the identification numbers of a location which can be used as a key to an address database. The segment may occur within IDoc TPSDLS01 from two to four times. With the minimum number of 2, the departure and destination location identification are transferred and in the next two segments, the sold-to party and payer ID can be defined.

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjust.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>TLCCAT</td>
<td>1</td>
<td>CHAR 01</td>
<td>X</td>
<td>Location status</td>
<td></td>
</tr>
<tr>
<td>TRMTYP</td>
<td>1</td>
<td>CHAR 02</td>
<td>X</td>
<td>Location category</td>
<td></td>
</tr>
<tr>
<td>SHPPNT</td>
<td>A</td>
<td>CHAR 04</td>
<td>VSTEL</td>
<td>Shipping point</td>
<td></td>
</tr>
<tr>
<td>LODPNT</td>
<td>A</td>
<td>CHAR 02</td>
<td>LSTEL</td>
<td>Loading point</td>
<td></td>
</tr>
<tr>
<td>LDPTXT</td>
<td></td>
<td>CHAR 20</td>
<td>BEZEI20</td>
<td>Loading point text</td>
<td></td>
</tr>
<tr>
<td>PLANT</td>
<td>A</td>
<td>CHAR 04</td>
<td>WERKS</td>
<td>Plant</td>
<td></td>
</tr>
<tr>
<td>STRLOC</td>
<td>A</td>
<td>CHAR 04</td>
<td>LGORT</td>
<td>storage location</td>
<td></td>
</tr>
<tr>
<td>STLTXT</td>
<td></td>
<td>CHAR 16</td>
<td>LGOBE</td>
<td>Storage location text</td>
<td></td>
</tr>
<tr>
<td>SHPPTY</td>
<td>A</td>
<td>CHAR 10</td>
<td>KUNNR</td>
<td>Ship-to party, customer number</td>
<td></td>
</tr>
<tr>
<td>ULDPNT</td>
<td>A</td>
<td>CHAR 25</td>
<td>ABLAD</td>
<td>Unloading point</td>
<td></td>
</tr>
<tr>
<td>SUPPLR</td>
<td>A</td>
<td>CHAR 10</td>
<td>LIFNR</td>
<td>Vendor</td>
<td></td>
</tr>
<tr>
<td>SLDPNT</td>
<td>A</td>
<td>CHAR 25</td>
<td>BELAD</td>
<td>Loading point</td>
<td></td>
</tr>
<tr>
<td>NODEID</td>
<td>A</td>
<td>CHAR 10</td>
<td>KNOTN</td>
<td>transportation connection point</td>
<td></td>
</tr>
<tr>
<td>NODTYP</td>
<td></td>
<td>CHAR 10</td>
<td></td>
<td>Transportation connection point</td>
<td></td>
</tr>
<tr>
<td>BORDER</td>
<td></td>
<td>CHAR 01</td>
<td></td>
<td>Border location indicator</td>
<td></td>
</tr>
<tr>
<td>TSPNT</td>
<td></td>
<td>CHAR 01</td>
<td></td>
<td>Load transfer point indicator</td>
<td></td>
</tr>
<tr>
<td>ADRNR</td>
<td></td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td>Address number</td>
<td></td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTRM

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTRM.

Field E2TPTRM-TLCCAT: Location status

This indicator specifies the status of the current segment for planning specifications.
E2TPTRM- Location Identification

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Departure location that corresponds to the delivery's shipping location</td>
</tr>
<tr>
<td>D</td>
<td>Destination that corresponds to the delivery's destination</td>
</tr>
<tr>
<td>1</td>
<td>Departure location that does not correspond to the delivery's shipping location</td>
</tr>
<tr>
<td>2</td>
<td>Destination that does not correspond to the delivery's destination</td>
</tr>
<tr>
<td>B</td>
<td>Sold-to party</td>
</tr>
<tr>
<td>P</td>
<td>Payer</td>
</tr>
</tbody>
</table>

Indicators 1 and 2 occur if a transportation planning system is used only for preliminary and subsequent leg planning, for example, and not for the entire planning of a delivery. For instance, one segment E2TPTRM with location status S and one with location status 2 would appear for the preliminary leg between the shipping point and the departure harbor.

Field E2TPTRM-TRMTYP: Location category

Category of current location. Different fields within the segment are filled with data according to category.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
<th>Completed fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Plant</td>
<td>PLANT, STRLOC, STLTXT, ADRNR</td>
</tr>
<tr>
<td>CU</td>
<td>Customer</td>
<td>SHPPTY, ULDPNT</td>
</tr>
<tr>
<td>SU</td>
<td>Vendor</td>
<td>SUPPLR, SLDPNT</td>
</tr>
<tr>
<td>OC</td>
<td>One-time customer</td>
<td>SHPPTY, ADRNR</td>
</tr>
<tr>
<td>NO</td>
<td>Transportation connection point, distribution center</td>
<td>NODEID, NODTYP, BORDER, TSPNT, ADRNR</td>
</tr>
<tr>
<td>SP</td>
<td>Shipping point</td>
<td>SHPPNT, LODPNT, LDPTXT, ADRNR</td>
</tr>
<tr>
<td>CA</td>
<td>Service agents</td>
<td>SUPPLR, SLDPNT</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
<td>ADRNR</td>
</tr>
</tbody>
</table>

Field E2TPTRM-NODTYP: Characteristic of the transportation connection point

The field lists the different characteristics of a transportation connection point. Each characteristic is coded with a single letter. Up to 10 characteristics can be shown in field E2TPTRM-NODTYP as a character string.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Distribution center</td>
</tr>
<tr>
<td>A</td>
<td>Airport</td>
</tr>
</tbody>
</table>
Example: E2TPTRM-NODTYP = CRS means a distribution center with railway and road connections.

**Field E2TPTRM-BORDER: Indicator for border location**
This indicator specifies whether the transportation connection point is a border location.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Non-border location</td>
</tr>
<tr>
<td>1</td>
<td>Border location</td>
</tr>
</tbody>
</table>

**Field E2TPTRM-TSPNT: Indicator for load transfer point**
This indicator specifies whether the transportation connection point is a load transfer point.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Non-load transfer point</td>
</tr>
<tr>
<td>1</td>
<td>Load transfer point</td>
</tr>
</tbody>
</table>

Please note the following when processing an inbound shipment (IDoc TPSSHT01).
The NODEID, SHPPNT, LODPNT, SHPPTY, ULDPNT, SUPPLR, SLDPNT, PLANT and STRLOC fields are included in the location definition of the departure or destination location of a leg in the shipment document.

This occurs according to the following schema:

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Location</td>
<td>1. 1st leg departure location</td>
</tr>
<tr>
<td>2. Location</td>
<td>1. 1st leg destination + 2nd leg starting point</td>
</tr>
<tr>
<td>3. Location</td>
<td>2. 2nd leg destination + 3rd leg starting point</td>
</tr>
</tbody>
</table>

Fields are completed as follows:
### E2TPTRM - Location Identification

<table>
<thead>
<tr>
<th>IDoc</th>
<th>R/3 System shipment document</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>E2TPTRM-NODEID</td>
<td>VTTS-KNOTA</td>
</tr>
<tr>
<td>E2TPTRM-SHPPNT</td>
<td>VTTS-VSTEL</td>
</tr>
<tr>
<td>E2TPTRM-LODPNT</td>
<td>VTTS-LSTEL</td>
</tr>
<tr>
<td>E2TPTRM-SHPPTY</td>
<td>VTTS-KUNNA</td>
</tr>
<tr>
<td>E2TPTRM-ULDPNT/SLDPNT</td>
<td>VTTS-BELAD</td>
</tr>
<tr>
<td>E2TPTRM-SUPPLR</td>
<td>VTTS-LIFNA</td>
</tr>
<tr>
<td>E2TPTRM-PLANT</td>
<td>VTTS-WERKA</td>
</tr>
<tr>
<td>E2TPTRM-STRLOC</td>
<td>VTTS-LGORTA</td>
</tr>
</tbody>
</table>

⚠️ Only one of the following fields can be completed: NODEID, SHPPNT, SHPPTY, SUPPLR and PLANT.

The LODPNT field is optional and should only be completed if the SHPPNT field has been completed.

The STRLOC field is optional and should only be completed if the PLANT field has been completed.

The ULDPNT field is optional and should only be completed if the SHPPTY field has been completed.

The SLDPNT field is optional and should only be completed if the SUPPLR field has been completed.

All other fields in this segment are ignored.

If the location definition does not follow the rules listed above, an error occurs.
E2TPTRP - Existing Shipment

Definition

In segment E2TPTRP, shipment documents that have already been created in the R/3 system and which contain the current delivery are transferred. In certain circumstances, this can lead to improved connection planning to existing shipments in the transportation planning system. In addition, planning requests are documented, meaning that there is a record if the current delivery was sent to another planning system but is not yet included in the shipment document. Existing shipment documents are recognized by their assigned shipment numbers whereas this would still be blank for a planning request. For planning requests, this is set to the initial value (blank).

<table>
<thead>
<tr>
<th>Field name</th>
<th>Adjus t.</th>
<th>Format</th>
<th>SAP domain</th>
<th>Req’d field</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHPPPT</td>
<td>5, 8</td>
<td>CHAR 04</td>
<td>TPLST</td>
<td>X</td>
<td>Transportation planning point</td>
</tr>
<tr>
<td>SHPID</td>
<td></td>
<td>CHAR 10</td>
<td>TKNUM</td>
<td></td>
<td>Shipment number (existing shipment)</td>
</tr>
<tr>
<td>SHPTYP</td>
<td>5</td>
<td>CHAR 04</td>
<td>SHTYP</td>
<td></td>
<td>Shipment type (existing shipment)</td>
</tr>
<tr>
<td>LEGIND</td>
<td>1</td>
<td>CHAR 01</td>
<td>LAUFK</td>
<td></td>
<td>Shipment leg indicator (existing shipment)</td>
</tr>
<tr>
<td>LOCCL1</td>
<td>1</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Location category - departure point</td>
</tr>
<tr>
<td>LOCID1</td>
<td>A</td>
<td>CHAR 10</td>
<td></td>
<td>X</td>
<td>Location ID - departure point</td>
</tr>
<tr>
<td>SUBID1</td>
<td>A</td>
<td>CHAR 35</td>
<td></td>
<td></td>
<td>Additional ID - departure point</td>
</tr>
<tr>
<td>ADRNR1</td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td></td>
<td></td>
<td>Address number - departure point</td>
</tr>
<tr>
<td>LOCCL2</td>
<td>1</td>
<td>CHAR 02</td>
<td></td>
<td>X</td>
<td>Location category - destination</td>
</tr>
<tr>
<td>LOCID2</td>
<td>A</td>
<td>CHAR 10</td>
<td></td>
<td>X</td>
<td>Location ID - destination</td>
</tr>
<tr>
<td>SUBID2</td>
<td>A</td>
<td>CHAR 35</td>
<td></td>
<td></td>
<td>Additional ID - destination</td>
</tr>
<tr>
<td>ADRNR2</td>
<td>CHAR 10</td>
<td>ADRNR</td>
<td></td>
<td></td>
<td>Address number - destination</td>
</tr>
<tr>
<td>DATBEG</td>
<td>DATS 08</td>
<td>DPTBG</td>
<td>X</td>
<td></td>
<td>Departure date</td>
</tr>
<tr>
<td>TIMBEG</td>
<td>TIMS 06</td>
<td>UPTBG</td>
<td>X</td>
<td></td>
<td>Departure time</td>
</tr>
<tr>
<td>TZONBG</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZON E</td>
<td></td>
<td>Time zone - departure point</td>
</tr>
<tr>
<td>DATEND</td>
<td>DATS 08</td>
<td>DPTENS</td>
<td>X</td>
<td></td>
<td>Arrival date</td>
</tr>
<tr>
<td>TIMEND</td>
<td>TIMS 06</td>
<td>UPTENS</td>
<td>X</td>
<td></td>
<td>Arrival time</td>
</tr>
<tr>
<td>TZONEN</td>
<td>8</td>
<td>CHAR 06</td>
<td>TZNZON E</td>
<td></td>
<td>Time zone - destination</td>
</tr>
</tbody>
</table>

Special Fields and Domain Values in Segment E2TPTRP

Please take into account these particular functions and/or permitted value areas in the following fields in segment E2TPTRP.

Field E2TPTRP-LEGIND: Leg indicator

This indicator specifies the type of the planned shipment.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Preliminary leg shipment</td>
</tr>
</tbody>
</table>
E2TPTRP - Existing Shipment

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Main leg shipment</td>
</tr>
<tr>
<td>3</td>
<td>Subsequent leg shipment</td>
</tr>
<tr>
<td>4</td>
<td>Direct leg shipment</td>
</tr>
<tr>
<td>5</td>
<td>Return leg shipment</td>
</tr>
</tbody>
</table>

Field E2TPTRP-LOCCL: Location category

Departure and destination location categories.

<table>
<thead>
<tr>
<th>Val.</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>PL</td>
<td>Plant</td>
</tr>
<tr>
<td>CU</td>
<td>Customer</td>
</tr>
<tr>
<td>SU</td>
<td>Vendor</td>
</tr>
<tr>
<td>OC</td>
<td>One-time customer</td>
</tr>
<tr>
<td>NO</td>
<td>Transportation connection point, distribution center</td>
</tr>
<tr>
<td>SP</td>
<td>Shipping point</td>
</tr>
<tr>
<td>CA</td>
<td>Service agents</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
</tr>
</tbody>
</table>

Field E2TPTRP-TZONxx: Time zone

Time zone code. Value area according to R/3 table field TTZZ-TZONE.
SAP System Settings and Modifications

This section provides an overview of the necessary settings within the SAP R/3 System as well as information on additional adjustments made available in the R/3 customer functions.

Overview of Information Sources

You can also use the following sources of information:

- **Implementation Guide/SAP Reference IMG (Online)**
  
  - Tools → Customizing → Implementation projects → SAP Reference IMG → Logistics Execution → Transportation → Interfaces → Transportation Planning in Cooperation with Forwarding Agents
  
  The overview shows you which settings you must carry out in the R/3 system in order to activate and configure the transportation planning interface. Details about specific parts of the interface follow:

- **Master Menu (Online)**
  
  - Logistics Execution → Transportation → Transportation Planning → External Planning System → ALE Monitoring
  
  The ALE functions allow you to monitor IDocs that you sent or received.

- More in-depth can be found in the following printed documentation:
  - RFC manual
    - Exact technical description of the programming interface
  - ALE consultant’s manual
    - General information about ALE and its functions
  - Workflow manual
    - General information on the workflow concept (see error processing)

Standard Error Processing with ALE

Transferring IDocs using Remote Function Call takes place on the Transmission Control Protocol/Internet Protocol (TCP/IP) basis. If an error occurs during this process, the connection between transmitter and recipient is interrupted. The transmitter can use the return codes of the RFC functions to control whether the function was successfully called up in the recipient system or not. If there are any TCP/IP errors, the connection must be disconnected and the IDoc must be re-transmitted.

Errors in the ALE service layer that occur during transmission or receipt of the IDoc are indicated as technical errors. The R/3 system generates a work item for every incorrect IDoc when technical or logical errors occur (see below). A work item is part of the workflow processing. For the most part, the work item is an error message that is sent to all the users in the system who are assigned to a particular position. The error message contains an error text. If one of the users views the message in the inbox, analyzes the error and posts the document, the error message will disappear from all inboxes.
SAP System Settings and Modifications

On receipt, the IDoc is saved in the database before any processing begins, thus unlinking the communication from processing. In this way, the communication is unlinked from processing. If an error occurs during processing, such as updating with disallowed or incorrect transaction type (=logical application error), SAP creates a work item with the appropriate error text.

Activating Standard Error Processing

If a logical error occurs during processing of an IDoc, a message is sent to one or several users. The following text describes how error processing is set up.

Technically, the system triggers a standard task specific to the message category. The standard task must be assigned to a position that has either a user or holder.

You can create one or several positions. These are contained within a central organizational unit.

You then have the following options:

- You can enter an organizational unit in the partner definition but no further specifications in the partner profile per message category. All the messages will then go to the users assigned to that organizational unit who have a position where the standard task appeared.
- You enter a certain position instead of the organizational unit in the partner definition.
- You override the entry in the partner definition with entries in the partner profile for a message category.

Normally, you would use the first alternative. However, if you have two subsystems that serve two different transportation planning points, where the administrators for the errors are two different people, you could use the second alternative to send the same error via the two different partner numbers.

Display in the Inbox

The inbox display can be adjusted individually. The following describes a setting that allows you to display the messages by IDoc category:

Call up transaction SIN1. Click on Configuration under settings and create a new configuration. Choose the switch for “Start configuration”. In this way you ensure that you always use this configuration automatically. Save to the database.

Select Settings → Group and choose the required field in the right-hand column for sorting in the overview display. Significant fields are (1) Task and (2) Creation date.

Modification Concept (Customer Functions)

This section provides an overview on the customer functions and change options in processing that affect the interface.

Inbound Processing (Receipt of IDocs from Subsystem)

The following modifications are possible:

- You are using standard IDoc TPSSHT01, but you want to process the IDoc according to your own requirements.
- You are using standard IDoc TPSSHT01 but want to influence the standard IDoc processing method, (error processing are to be modified or IDoc contents are to be interpreted according to the customer’s requirements, for example).
- You are using a modified IDoc with your own segments and want to implement a certain processing for the data in these segments.
- You are using a modified IDoc with your own segments and want to process the IDoc according to your own requirements.
- You are using your own IDoc with a new message type and need to process the IDoc according to your own requirements.

The following describes individual modification options.

Once an IDoc has been received and saved, a framework function module in the SAP application is triggered which takes over the processing of the IDoc. This provides the first option where you can generate your own processing function module. In order to call this up you will have to enter it in an ALE Customizing table (transaction WE42: Process codes inbound → Inbound with ALE service → Processing by function module). You can then specify the defined process code in the inbound partner profile. Available framework function modules are assigned according to the following message categories:

Inbound Framework Function Module

<table>
<thead>
<tr>
<th>Message type</th>
<th>Function module</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIPPL</td>
<td>IDOC_INPUT_SHIPPL</td>
<td>Shipment document</td>
</tr>
</tbody>
</table>

The framework function module filters out the user data per IDoc and calls up your own processing function module in the application for every IDoc in a loop. All data is then saved together in the database.

A customer function is implemented before and after processing each IDoc and after saving all shipment data.

You can use the customer function before processing the IDoc to manipulate data in the IDoc before it is transferred to the application functions. After IDoc processing, the customer function allows you to process your own segments.

Customer functions for the transportation planning interface can be found in function group XV56 in the R/3 system with the description EXIT_SAPLV56I_0xx. You can use transaction SMOD to access enhancements. The names begin with ‘V56I’. The documentation for each function module describes how to use the available customer functions. Activating customer functions
takes place in transaction CMOD. Consult the R/3 System online documentation for instructions on how to use SMOD and CMOD.

Customer Functions Inbound Shipment

<table>
<thead>
<tr>
<th>EXIT_SAPLV56I_010</th>
<th>Modification of IDoc segments</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIT_SAPLV56I_011</td>
<td>Modification of shipment tables</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_012</td>
<td>Save your own shipment tables</td>
</tr>
</tbody>
</table>

When creating your own function module or using customer functions, you must make sure that you do not set Commit work, because the function module branches back into the ALE service level after processing. Application errors are copied, IDoc status is set and rollbacks may be listed in the ALE service level. After Commit work, a rollback can no longer be carried out if an error occurs. This could lead to partially-posted IDocs and therefore to inconsistencies during error processing.

Keep in mind that further I/Os that occur in the customer functions can reduce performance.

You can define your own IDoc segments in IDoc maintenance (WE30). Refer to the corresponding documentation for the ALE group.

You can define your own IDoc the same way you maintain your own segments. This IDoc needs to be assigned to a new output type. For this output type, you must set a partner profile. You must also maintain the tables for entry in transaction WE42.

You have the following modification options for the individual modification scenarios:

- For IDoc processing, you can create your own processing function module, which can be copied from the standard function module and then adjusted, if necessary.
- You can activate the customer functions in the standard function module. If you want to change error processing, you must enhance the customer function after IDoc processing by adding Own error status and then activating it. If you want to modify IDoc processing, then you need to activate and use customer function Own update.
- You can define your own IDoc segments in the standard IDoc and use the customer function for Own update in order to process the data from your own segments.
- You can define your own IDoc segments in the standard IDoc and create your own processing function module as in scenario 1.
- You can define your own IDoc and create your own processing function module. When creating the function module, you can use the standard help function modules.

Outbound Processing (Transmitting IDocs to a Subsystem)

The following modifications are possible:

- You are using standard IDoc TPSDLS01, but want to change standard processing (the structure or content of this IDoc, for example).
- You are using a modified IDoc with your own segments and want to set your own processing to assemble the data from this segment.
- You use a modified IDoc with your own segments and want to process the IDoc structure according to your own requirements.
Modification Concept (Customer Functions)

- You are using your own IDoc with a new message type and need to process the IDoc according to your own requirements.

The following describes individual modification options.

The formatting for the transmission of IDocs is carried out in the application. The IDoc is assembled, the partner is determined and the configurations are made for the ALE layer. IDoc assembly is carried out in the application function modules.

This is your first opportunity to carry out modifications by creating your own function modules. To ensure that this is called up by the application, you have to link it to the required application menu yourself.

The following function modules from function group V561 are used in the transportation planning interface for constructing and transmitting standard IDocs:

**Function modules outbound processing**

<table>
<thead>
<tr>
<th>IDOC_OUTPUT_CFPREQ</th>
<th>Individual planning requests (when transmitting using message control)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDOC_OUTPUT_SHIPPL</td>
<td>Shipment status</td>
</tr>
<tr>
<td>IDOC_OUTPUT_STATUS_TPS</td>
<td>Error status</td>
</tr>
</tbody>
</table>

For the outbound function modules for transmission of planning requests, the following customer functions are available for adding your own IDoc segments and/or changing the standard IDoc construction. The following list displays all available customer functions for outbound processing of planning requests. The function groups and transactions displayed for inbound processing are also valid for customer functions in outbound processing.

**Customer Functions for Outbound Planning Requests**

<table>
<thead>
<tr>
<th>EXIT_SAPLV56I_001</th>
<th>Modification of the delivery header segment in the IDoc</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXIT_SAPLV56I_002</td>
<td>Modification of the delivery item segments in the IDoc</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_003</td>
<td>Modification of the packing data segments in the IDoc</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_004</td>
<td>Modification of the entire IDoc before transmission</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_005</td>
<td>Modification of material cumulation</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_006</td>
<td>User-specific location substitution</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_007</td>
<td>Deactivation of the conversion block for deliveries</td>
</tr>
<tr>
<td>EXIT_SAPLV56I_020</td>
<td>Change in IDoc control record</td>
</tr>
</tbody>
</table>

As mentioned in inbound processing, you define your own IDoc segments in IDoc maintenance. A customer-specific IDoc can also be defined for outbound processing. Apart from IDoc definition, you only need to maintain the partner profile for outbound processing here.

You have the following modification options for the individual modification scenarios:

- For IDoc processing, you can create your own processing function module, which can be copied from the standard function module and then adjusted, if necessary.
You can activate the customer function in the standard function module in order to change the standard IDoc structure.

You can define your own IDoc segments in the standard IDoc and use the customer exit to fill your own segment with data.

You can define your own IDoc segments in the standard IDoc and create your own function module that can be copied from the standard function module of the corresponding message type and then adjusted as required.
Parcel Tracking for Express Delivery Companies

Use
You can use this function to track the path of individual deliveries or parcels that were sent via express delivery company. You can also exchange the necessary data with the express delivery company and ship-to parties and print the labels needed for parcel tracking.

Integration
The data determination procedure occurs in the background of the delivery.
As the system saves data, it checks whether express-delivery-company processing is activated. The data fields defined for the express delivery company are determined in the order specified. If a value cannot be determined, the system makes an entry in the incompletion log.
Parcel tracking for the express delivery company is available for both inbound and outbound deliveries.

Prerequisites
The following prerequisites must be met in order to implement parcel tracking for express delivery companies:

- The express delivery company is entered in the system as a service agent.
- The express delivery company has been created in the system and is active (see also: Creating an Express Delivery Company in the System [Ext.] )
- An express-delivery-company indicator is assigned to the service agent.
- At least one shipping point is assigned to the express delivery company.
- Label printing is set up [Ext.]
- IDoc interface between partners and service agents is established.

Range of Functions
Parcel tracking for express delivery companies with express-delivery-company processing offers you the following options:

- You can define any number of fields for each express delivery company. These fields are then automatically filled in when a delivery is created and then made available to the IDocs.
- Express-delivery-company processing makes available additional information that the express delivery company may need. This function allows you to use XML-enabled Remote Function Call (RFC) interfaces.
- The necessary information can be printed right on the package label. This allows the parcels to pass thorough the express delivery company's automatic sorting machines, for example. Settlement is also made easier, thanks to this function.
- The parcel-tracking status in the SAP System is set automatically via the parcel-tracking interface. This way, the sender can display all tracking data in the document flow, the delivery or in a separate transaction in the SAP System. A workflow connection makes it easier to implement customer-specific processes.
The ordering party can also track the progress of his or her order. The ordering party can either make an inquiry via Internet or receive the necessary data via the delivery IDoc. If the ordering party also has an SAP System, he or she can access the same function from an incoming delivery point-of-view.

- XML-enabled Remote Frequency Call (RFC) interfaces are available for master data maintenance.
- Express-delivery-company data can be processed directly from the delivery.
Creating a Manifest for Express Delivery Companies

Use
A manifest is a shipment IDoc that is sent to an express delivery company. It contains all deliveries that are transported in the express delivery company's truck, which is typically loaded once every evening with all parcels.

The express delivery company uses this list of data for simple invoice creation and also for double-checking against the list of parcels that were actually scanned. Manual entry of parcels is thus no longer necessary.

Prerequisites
You will find the required settings for setting up a link to an express delivery company in your system in the Implementation Guide under Logistics Execution → Shipping → Deliveries → Set Link to Express Delivery Company [Ext.].

You must first set up a partner profile for the express delivery company in question so that you can send this list to the express delivery company via IDoc. If this list is intended for printing, you must also set up a print profile [Ext].

See also: Output control [Page 27]

Procedure
In order to create a manifest, you must first create a selection variant for delivery selection that finds all deliveries for a certain express delivery company with a certain loading point and the current date.

Start from the Create shipments in collective proc. [Page 83] screen.
1. Enter a variant name. Choose Maintn to maintain a variant.
2. Enter the loading point in the Point of departure section of the selection screen.
3. Enter the Number of the forwarding agent for which the deliveries are to be selected in the Transportation planning section.
4. Choose Enter.

You can now either print the list of selected deliveries or send it to the express delivery company via IDoc.
Communication via Internet

Use
Web-based communication enables you to integrate data directly into the system of a business partner using the traditional communication through telephone, Fax, or e-mail. In this way, new forms of business relationships ensue: consumers or business partners can communicate with a partner system via Web applications.

Integration
The possibility to call for tenders for shipments directly through the Internet provides an addition to the planning functions in Transportation. The interaction between the planner and the service agent runs completely via the system. Planners can also include forwarding agents who do not have the SAP System into the decision-making process; these can then process the data via their own system.

Prerequisites
The Internet Browser user interface uses the SAP Internet Transaction Server, which controls screen processing and the data exchange between the Browser User Interface and the SAP System.

You can use the standard safety functions. The workstation-based ITS control information that is required for an Internet Browser user interface contains DES-coded passwords.

Features
Transportation planning and processing has been extended to include this new function.

- With the function Requesting Tenders for Service Agents [Page 439], planners can offer shipments to forwarding agents through the Internet. A planner can react to the offers made by the forwarding agents and can also supervise the status of the tenders for his shipments. Planners can select the forwarding agents to whom they wish to offer the shipments, they can set the tender status, and also specify conditions for shipment processing. Forwarding agents can call up the Internet page of the planner and react to the offers made. Planners see the tendering status in the Monitor for Tendering and can react to the information at an early point (Logistics → Logistics Execution → Transportation → Transportation Planning → Lists and Logs → Shipment Tendering Status Monitor).

- Shipment Tendering Through a Freight Exchange [Page 443]
  The shipper transmits the shipment data and the price data to the freight exchange. The latter finds a forwarding agent who meets his requirements and transmits this information directly to the system of the shipper.

- Transportation Planning with Forwarding Agents Through the Internet [Page 446]
  If there is cooperation between the shipper and the forwarding agents, parts of this transportation planning process can be outsourced. The forwarding agent takes on planning functions and thus makes the transportation planning easier for the shipper.
  Grouping and changing of shipments occur systematically at the forwarding agent’s system site. The forwarding agent can assign deliveries to shipments and specify data in the shipment through the Internet Transaction Server (ITS).
Communication via Internet

- Tracking Information [Page 444]
  The tracking function makes it possible for data to be exchanged between the shipper and the forwarding agent. Both the forwarding agent and the shipper have an input and display function that enables them to maintain or display as a list the time and location of planned or occurring events for exactly one shipment at a time. Using the tracking display, customers can access the Web site of the shipper and there they can monitor the status of order processing.
Shipment Tendering for Service Agents Through the Internet

Purpose

The option of offering shipments directly through the Internet provides a useful addition to the planning functions in the Transportation component. Planners can also include forwarding agents who do not have the SAP System in the decision-making process; these forwarding agents can then use their own systems to process the data.

A planner can react to the offers made by the forwarding agents and can also supervise the tendering status for his or her shipments. The planner receives tendering statistics and can also judge the service quality of a service agent.

Prerequisites

In the Implementation Guide (IMG), you can define all the basic settings that are required for transportation planning and for the status and event confirmation by forwarding agents under the path Logistics Execution → Transportation → Shipments → Configuration of Transportation Processing for Forwarding Agents [Ext.].

To ensure data security, you should set up a personal user master record for the SAP System for the service agent. System access can be monitored using user safety profiles and authorization objects that are assigned specially for the tendering status tasks. The service agents can then only call up those shipments that were offered personally to them.

Process Flow

1. The shipper creates a shipment in the SAP System. Before this is listed for tendering, it must be scheduled; that is, the service agent and the stages must be defined already.

2. The shipper offers the shipment to the service agent through the Internet (tendering).

   Planners can select the forwarding agents to whom they wish to offer the shipments, set the tendering status, and also specify conditions for shipment processing.

3. The service agent has access via Internet to the shipments offered and he can accept, reject, or accept under certain conditions.

4. The shipper sees the tendering status and receives an overview of the most important information about the shipment tendering process.

   The Shipment Tendering Status Monitor gives an overview of the respective tendering status for each transportation planning point. The number of shipments is listed by status. In this way, the transportation planner can react quickly to situations and also have a complete overview of the overall status of all shipments listed for tendering. You can display all shipments for which no answer has been received from the forwarding agent, although a timeframe was specified.

   For example, it is important to offer rejected shipments as soon as possible to other forwarding agents since each delay at this stage means a delay in the shipment itself.

   In addition, the planner has a type of control function for the current processing status.

5. The shipper confirms the acceptance or rejection of the service agent and passes on further information, if required.
Shipment Tendering for Service Agents Through the Internet

6. The service agent commences with processing the shipment by defining the planned data and setting the status in the shipment.

   A tendering list provides the service agent with information on newly offered shipments at all times. The service agent can use the status list to view the processing status of accepted shipments.

See also:

Tendering Shipments for Service Agents [Page 441]
Tendering Shipments for Service Agents

Use

Planners can offer shipments to forwarding agents directly by using the Internet.

Prerequisites

You can make all the necessary settings in the Implementation Guide (IMG) under Logistics Execution → Transportation → Shipments → Configuration of Transportation Processing for Forwarding Agents [Ext.].

Procedure

Tendering shipments

1. On the shipment screen [Ext.], choose Shipment → Create. Enter the transportation planning point and shipment type.
2. Choose a forwarding agent on the Processing tab on the Create Shipment overview screen. Enter the forwarding agent’s external ID.
3. Enter the shipment data in the Stages section and set the shipment status to Planned.
4. Change the tendering status on the Tender tab to New offer from shipper. Otherwise, the shipment will not be displayed for the service agent.
5. In the Quotation section, enter the date until which the offer is valid in the Valid to field, the length of loading platform that is required for the shipment in the LgthLoadingPltf field, and the upper price range that the forwarding agent should not exceed in the Maximum price field. Also enter the dates for pick-up and delivery. If you want to provide the forwarding agent with more information or conditions for this shipment, you can do so in the Tender text field.

   ![Image of maximum price field](Page 184)

   The field Maximum price field is filled in automatically if you choose Estimate [Page 184].
6. Save your entries.

Service agent’s actions

The forwarding agents have access via Internet to the shipments offered and they can accept, reject, or accept under certain conditions. They use selection variants (such as North route) to select the shipments that are offered to them. They can also display details about the shipments. If a forwarding agent wants to take on one of the shipments that is offered, he or she sets the tendering status to Accepted by forwarding agent. Forwarding agents can enter data such as deadlines, means of transport or tracking data directly in the shipper’s system for shipments that they have accepted.

Overview: Confirming shipment tendering and shipments

7. You can display an overview of accepted or rejected shipments in the Shipment Tendering Status Monitor.
Tendering Shipments for Service Agents

For example, you can display all shipments that have the status Accepted fwdg agent and the status Fwdg agent rejected. You can choose the shipments that you want to accept from this list.

Choose Logistics Execution → Transportation → Transportation Planning → Lists and Logs → Shipment Tendering Status Monitor and enter the selection criteria.

8. After the forwarding agent has accepted the shipment, the planner can confirm or reject the transfer order.

On the overview screen, set the tendering status on the Processing tab to Confirmed by shipper or to Offer canceled.

The forwarding agent can enter notes such as “Delays of approximately one hour are possible” in the Tender text field. If the planner does not want to accept such delays, he or she can enter another forwarding agent in the FwdAgent field and reset the tendering status to New offer from shipper. The shipment is then offered to the next forwarding agent.
Transportation Tendering Through a Freight Exchange

Purpose

Freight exchanges provide their members, who can be either shippers or forwarding agents, with the service of interactively bargaining on prices and transportation conditions. The shipper and the forwarding agent receive information on prices and conditions, and they can come to an agreement, just like in the real marketplace. As soon as the shipment is confirmed, the freight exchange issues an invoice to the shipper and pays the forwarding agent.

Transportation planners can use the freight exchange service in particular for smaller shipments in order to find a forwarding agent who can include the shipment in a load that is not fully used up (LTL) and therefore demand a more reasonable price. Shippers can work together in an SAP System and a freight exchange through the Internet. In this way, the transportation planner can use capacity to the fullest, thus lowering shipment costs. The transportation planner also always has an automatic update of the shipment status.

Prerequisites

You can make all the necessary settings in the Implementation Guide (IMG) under Logistics Execution → Transportation → Shipments → Configuration of Transportation Processing for Forwarding Agents [Ext.].

Process Flow

Transportation tendering through a freight exchange:

1. The shipper transmits shipment information, such as attributes, conditions, and the maximum price for the shipment that the forwarding agent does not want to exceed, to the freight exchange.

2. The freight exchange analyzes the data and compares it to the list of forwarding agents available through the freight exchange. Based upon the criteria specified by the shipper, the system creates a ranking list of forwarding agents that match the profile and have the required capacity. A confirmation with the data from the forwarding agent who meets the requirements of the shipper and is also most reasonably priced is transmitted to the shipper’s system. This confirmation contains the actual price that the forwarding agent requires for the shipment and data such as time of shipment transfer, order number, and the forwarding agent’s tracking number.

3. When this information is received through the forwarding agent, the contract is completed. The shipper no longer needs to react to the offer since the forwarding agent selected by the freight exchange meets the previously-defined requirements of the shipper exactly.

4. The shipment document is automatically updated with the forwarding agent’s data, the actual price, and the planned times.

The procedure is the same as the one described in Tendering Shipments for Service Agents [Page 441]. The freight exchange is simply treated as if it were a forwarding agent.
Tracking Information

Use

The shipper and the forwarding agent have a simple tracking system for monitoring the shipment status. The tracking function makes it possible for data to be exchanged between the shipper and the forwarding agent through the Internet. The shipper and the forwarding agent have an input and display function for time and location of planned or unplanned events concerning a shipment. The customer can also display this shipment data through the Internet. Typical tracking information includes data as to whether a shipment has been picked up, reloaded, unloaded, delivered, or delayed. These are either predefined events (that is, planned by the transportation planner) or freely-definable events that result from the circumstances surrounding the transportation process and are defined later during the transportation process.

Integration

The tracking display enables cooperation with business partners through the Business-to-Business or Business-to-Customer mySAP.com initiative.

Prerequisites

The shipper have the parcel tracking functionality of the SAP system installed. (For more information, refer to the section Parcel Tracking for Express Delivery Companies [Page 434]). The forwarding agent must have Internet access.

Features

Both the shipper and the forwarding agent can display and process a list with tracking information on a shipment. The customer can only display the list.

Business relations between SAP users and other partners can exist. Only the shipper must have an SAP System available.

The tracking information is entered manually by the forwarding agent or the shipper, or loaded as an SML file from the forwarding agent’s database into the database of the shipper.

Forwarding agents and shippers must log on to the system and be checked for information input. Each customer has an official user who enables the display of the event chain. Security at this level is ensured by knowledge of the required inputs (for example, order number).

- Tracking Display for Transportation Planner
  The shipper can call up tracking functions, and thus recognized delayed shipments at an early point and react accordingly.
  The SAP System offers the display of tracking information and the shipment status in two ways:
  - Display of forwarding agent’s Web site in an SAP user interface window
  - Displaying and changing tracking data from the shipper’s database

- Tracking Display for Customer
  Using the tracking display, customers can access the web site of the shipper and there they can monitor the status of order processing.
Using appropriate search criteria, the customer can call up information on the shipment status. A fixed search template serves as input (for example, order number, customer number, and so on).

- Status Input of Forwarding Agent

  Through a Web application, the forwarding agent confirms the status of shipment processing in the shipper’s system. The forwarding agent and the shipper work together closely; the shipper, however, always has control over the shipment itself.

  The event information, with the exception of shipments whose forwarding agents support the express delivery company interface, is dependent upon manual verification of the forwarding agents.
Transportation Planning with Forwarding Agents Through the Internet

Purpose

The cooperation between the shipper and the forwarding agent can have synergic effects that save both partners time and money. Particularly in business relationships where a forwarding agent works primarily for a particular shipper, there can be many advantages to having joint transportation planning. The forwarding agent takes over planning functions in cooperation with the shipper, and thus simplifies transportation planning for the shipper. The entire planning process occurs right in the system through Web transactions in the Internet. The Internet function enables the forwarding agent to select and consolidate deliveries, and to specify data through an Easy Web Transaction in transportation. The forwarding agent has access to the shipper’s system through an Internet portal. In this way, he can save the costs for EDI or software. The shipper can accept or reject the planned shipments of the forwarding agent at any time.

The same applies to the procurement scenario.

Integration

This function facilitates the cooperation of the shipper with forwarding agents within the framework of the business-to-business initiative.

In the standard business setting, the transportation planner selects deliveries for the respective shipment while he or she is creating the shipments.

If the shipper and the forwarding agents cooperate, parts of this transportation planning process can be outsourced. Grouping and changing of shipments occur systematically at the forwarding agent’s system site.

Prerequisites

The shipper retains control over the planning process since he is the one who makes the respective settings in the Implementation Guide under the path Logistics Execution → Transportation → Shipments → Configuration of Transportation Processing for Forwarding Agents → Configuration of Transportation Processing for Forwarding Agents [Ext.]. These settings are the basis for transportation planning as well as status and event confirmation by forwarding agents. He can also determine which planning functions are retained by the forwarding agent, and which data the forwarding agent can display and change.

The forwarding agents work in the sender’s SAP System through the Internet, or, in the case of an event confirmation, through a WAP-enabled mobile telephone. For this purpose, they require an SAP system user.

The output determination [Page 28] must be set in the Implementation Guide under the path Logistics Execution → Transportation → Basic Transportation Functions → Output Control → Maintain Output Determination for Shipments [Ext.].

Process Flow

The transportation planning process in cooperation with the forwarding agent takes place as follows:

1. The shipper offers deliveries to the forwarding agent through a Web interface.
2. The forwarding agent receives a list of deliveries from the shipper.

3. The forwarding agent sets up shipments on the basis of these deliveries and transmits the planned shipments back to the shipper.

4. The shipper decides whether to accept the planned shipments from the forwarding agent or to offer the deliveries to a different forwarding agent.

5. If the shipper sets the tendering status to *Confirmed*, an E-mail message (output type CPAC) can be sent automatically to the forwarding agent using output control [Page 27].

The procedure is the same as the one described in *Tendering Shipments for Service Agents* [Page 441]. The difference is that deliveries (rather than shipments) are being offered in the tendering process.